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About These EnterpriseOne PeopleBooks 
Preface 

EnterpriseOne PeopleBooks provide you with the information that you need to implement and use 
PeopleSoft EnterpriseOne applications. 

This preface discusses: 

• EnterpriseOne application prerequisites 

• Obtaining documentation updates 

• Typographical elements and visual cues 

• Comments and suggestions 

Note 

EnterpriseOne PeopleBooks document only fields that require additional explanation. If a field is not 
documented with the process or task in which it is used, then either it requires no additional 
explanation or it is documented with common elements for the section, chapter, PeopleBook, or 
product line.  

 

EnterpriseOne Application Prerequisites 
To benefit fully from the information that is covered in these books, you should have a basic 
understanding of how to use EnterpriseOne applications.  

See the Foundation Guide.  

You might also want to complete at least one EnterpriseOne introductory training course. 

You should be familiar with navigating the system and adding, updating, and deleting information by 
using EnterpriseOne menus and forms. You should also be comfortable using the World Wide Web 
and the Microsoft Windows or Windows NT graphical user interface. 

These books do not review navigation and other basics. They present the information that you need to 
use the system and implement your EnterpriseOne applications most effectively.  

Obtaining Documentation Updates 
You can find updates and additional documentation for this release, as well as previous releases, on 
the PeopleSoft Customer Connection Website. Through the Documentation section of PeopleSoft 
Customer Connection, you can download files to add to your PeopleBook Library. You can find a 
variety of useful and timely materials, including updates to the full PeopleSoft documentation that is 
delivered on your PeopleBooks CD-ROM. 
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Note 

Before you upgrade, you must check PeopleSoft Customer Connection for updates to the upgrade 
instructions. PeopleSoft continually posts updates as the upgrade process is refined. 

 

See Also 
PeopleSoft Customer Connection Website, http://www.peoplesoft.com/corp/en/login.jsp  

Typographical Conventions and Visual Cues 
This section discusses: 

• Typographical conventions 

• Visual cues 

Typographical Conventions 
The following table contains the typographical conventions that are used in EnterpriseOne 
PeopleBooks: 

Typographical Convention 
or Visual Cue 

Description 

Italics Indicates emphasis, topic titles, and titles of PeopleSoft or other 
book-length publications. Also used in code to indicate variable 
values.  

Key+Key A plus sign (+) between keys means that you must hold down the 
first key while you press the second key. For example, Alt+W 
means hold down the Alt key while you press W. 

Monospace font Indicates a PeopleCode program or other code example. 

“ ” (quotation marks) Indicates an adjective that is used in a way that might not be 
readily understood without the quotation marks, for example "as 
of" date, “as if” currency, "from" date, and "thru" date. 

Cross-references EnterpriseOne PeopleBooks provide cross-references either below 
the heading “See Also” or preceded by the word See. Cross-
references lead to other documentation that is pertinent to the 
immediately preceding documentation. 
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Visual Cues 
EnterpriseOne PeopleBooks contain the following visual cues:  

• Notes 

• Cautions 

Notes  
Notes indicate information that you should pay particular attention to as you work with the 
PeopleSoft system. 

Note 

Example of a note. 

 

Cautions  
Text that is preceded by Caution is crucial and includes information that concerns what you must do 
for the system to function properly. 

Caution 

Example of a caution. 

 

Comments and Suggestions 
Your comments are important to us. We encourage you to tell us what you like, or what you would 
like to see changed about PeopleBooks and other PeopleSoft reference and training materials. Please 
send your suggestions to: 

PeopleSoft Product Documentation Manager, PeopleSoft Inc., 4460 Hacienda Drive, Pleasanton CA 
94588 

Or you can send e-mail comments to doc@peoplesoft.com. 

While we cannot guarantee an answer to every e-mail message, we will pay careful attention to your 
comments and suggestions. 
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PeopleSoft EnterpriseOne Report Writing 
Overview 

PeopleSoft EnterpriseOne provides fully integrated applications for managing information throughout 
your enterprise. This information can include employee data, accounts receivable and payable 
information, your company's financial data, and product information. EnterpriseOne allows you to 
view and evaluate this information to make critical decisions about improving your business 
operation and profitability. You can also distribute this data to others with whom you do business, 
such as shareholders, employees, and business consultants. 

Reports allow you to view data in an organized and useful format online or as printed material. 
EnterpriseOne provides report templates that are suitable for general use. However, some of your 
reporting needs are truly specific to your business. To meet these needs, you must be able to design a 
report to extract and present the information that is vital to your company. You can use the Report 
Design tool to customize report templates or design your own reports.  

The EnterpriseOne Reporting solution includes a report design tool to create reports and batch 
processes, a batch engine for processing, and an output management system to output information.  

The Report Design Tool 
You can use Report Design to create a variety of simple and complex reports. Report Design's 
interface is simple enough to use without programming expertise, yet powerful enough to create the 
most complex reports. You can use Report Design to create batch applications and create reports. 

Report Design uses the Report Design Director to guide you through the report creation process. You 
can create different types of reports, including reports for specific uses such as financial reporting. In 
addition, you can configure the Director to help users create various reports that your company needs.  

After using the Director to create your initial report, you can enhance your report by:  

• Adding report sections or date fields  

• Formatting 

• Positioning 

• Business logic processing 

• Performing data field calculations and comparisons  

Report Design also lets you set your preferences for the workspace on the Report Design form. You 
can configure your design workspace by changing user options, selecting toolbars, and moving 
docked windows.  

You can use Report Design on terminal servers. However, as in a client/server environment, when 
you check out a report template on a terminal server, other terminal server users cannot access that 
template.  
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Reports Guide  
PeopleSoft EnterpriseOne provides more than 300 commonly used reports across the Financial 
Management, Human Capital Management, Logistics, and Manufacturing systems. You can easily 
generate and view these application reports online and in PDF format. You can also export reports so 
that you can view and manipulate them in other software programs, such as a spreadsheet program. 
You can copy and customize any of the PeopleSoft EnterpriseOne reports to meet your specific needs 
instead of creating a completely new report.  

Report Processing 
Report processes are a type of batch process. A report becomes a batch process after it is designed 
and submitted for processing. Once submitted, a batch runs without user interaction. When you 
submit a report, you do not interact with it again until the report is completed.   

After you start a batch process, you have no control over the flow of the logic within the batch 
process. If you need to change the flow of the logic within the process or report, you make those 
changes by using Report Design and then resubmitting the report.  

Output Management 
Typically, after a report has been created, you want to see the output. You can send reports to 
different file types, printers, forms, and paper sizes. EnterpriseOne accommodates simple output 
processes, such as printing a report online or directly to a printer, and more complex output processes, 
such as using a batch process to print three different versions of the same report to three different 
printers.  

Report Components  
A report exists as a set of metadata that allows EnterpriseOne Report Writing software to identify and 
process it. You can create variations of a report that are based on a single report template. The first 
step in creating a report is to create a report object within EnterpriseOne. The report that you then 
create becomes a template from which additional versions can be created.  

Furthermore, each report itself is comprised of one or more sections. These sections are the building 
blocks of all reports. Within the template, you can add, remove, and rearrange report sections as 
needed.  

Report Object 
EnterpriseOne is object-based; therefore, each report is an object in the Object Management 
Workbench with a type of UBE (Universal Batch Engine). When you add a report object, you create a 
header record that contains information about the report, such as its name and description. The header 
record is stored in the Object Librarian Master table (F9860).  
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Report Template 
Report templates hold the master metadata, which you add through Report Design. The metadata 
describes the report to EnterpriseOne and specifies how the data is selected, sorted, displayed, and 
formatted. When fully designed, the template becomes the basis for all versions of the report.  

Batch Versions 
Many of a template’s properties can be overwritten at the version level, including data selection, data 
sequencing, event rules, and layout. Batch versions enable you to preserve template integrity. Instead 
of creating a template for each variation of a report that you might need, you can create different 
batch versions of a single template. For example, you might design a monthly variance report that 
contains totals for the entire company. However, if you need to run a quarterly variance report that 
includes only data for the Western region, you can create a batch version of the monthly variance 
report.  

Each batch version is based on a specific report template. Typically, batch versions vary slightly from 
the report template upon which they are based in the data that they display or in their processing 
options. A batch version processes the metadata that is specified in the template and any changes that 
are overwritten in the version. You can create additional batch versions by copying an existing batch 
version.  

Report Sections 
Report sections are the basic components of a report. Most reports have more than one section. You 
can reference one section in another section; or use sections for special purposes, such as performing 
calculations and totaling. Report sections include: 

• Header section 

• Footer section  

Header and footer sections appear at the top and bottom of pages or reports. They commonly 
use constants and variables data fields. 

• Detail section 

Detail sections contain the information that the report was designed to convey. The three 
types of detail sections are: 

• Columnar  

• Group  

• Tabular  

The data that appears in detail sections is based on business views. A business view is used to access 
data from database tables. The business view selects specific columns from one or more tables, for 
which you have defined a relationship. Choosing columns from the business view provides a link 
between the data in your database and the report that you are creating.  

In addition to selecting business view columns to build the report sections, you can define and add 
data fields, such as constants and variables. 
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In a report, a set of records that all have the same value for one of the fields is said to be in the same 
level. For example, in a report that is sequenced by telephone numbers, all of the records having the 
same area code are in the same level. When the value in that field changes, a level break occurs. 
Level breaks are useful because you can add processing when they occur. Two special report section 
types make adding processing to level breaks easy:  

• Level-break header section 

• Level-break footer section  

Characteristics of a Columnar Section 

A columnar section consists of several column headings with associated column values listed under 
the headings. Each data field is a column, and each record is a row. The column heading is linked to 
its column data, and the two cannot be disconnected in the report. If one is deleted, the other is also 
deleted. Because you cannot change the column format, the columnar section is the least flexible 
detail section.  

The following illustration is a columnar section: 

 

 

Within a columnar section, you can: 

• Attach any business view 

• Sequence data and designate level breaks, based on the data fields in the business view 

• Select data that is based on designated criteria 

• Total columns by using level-break sections 

• Attach event rules (logic statements that you create and attach to report objects) 

• Call business functions (related groups of logic statements), such as period activity and 
journal entry 
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• Call system functions. (logic that performs operations on ERP objects), such as a workflow 

• Use subsection joins 

• Make the section conditional (that is, it processes directly called from event rules) 

You can include multiple columnar sections in a report. 

To print level-break headers and totals on a columnar report, level-break header and footer sections 
are required. When the level break occurs, the level-break header prints above the column headings. 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with Event Rules for information on event rules  

� Attaching a System Function to an Event for information on system functions 

� Joining Subsections for information on subsection joins  

When to Use a Columnar Section 
The following criteria can help you decide when to use a columnar section in your report:  

• The column layout is appropriate.  

• The totaling levels in the report are mostly static; therefore, they are not subject to change at 
run time.  

• The section needs to be joined to other sections.  

• The section needs to be conditional.  

Characteristics of a Group Section 

Group sections have a free-form layout; they are not restricted to standard column and row layout. 
The group section type is the most flexible because you can place data fields anywhere in the group 
section. Data fields within group sections are called database groups. Database groups are composed 
of constants and variables. Initially, the constant and variable of the database group are linked; 
however, you can disconnect the constant and variable to meet your reporting needs. Because of the 
free-form layout, group sections are almost always used for level-break header and footer sections.  
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The following illustration is a group section: 

 

 

Within a group section, you can: 

• Attach any business view 

• Sequence data and designate level breaks, based on the data fields in the business view 

• Select data that is based on designated criteria 

• Total data by using level-break sections 

• Attach event rules (logic statements that you create and attach to report objects) 

• Call business functions (related groups of logic statements), such as period activity and 
journal entry 

• Call system functions (perform operations on ERP objects), such as workflow 

• Add subsection joins 

• Make the section conditional (that is, it processes only if directly called from event rules) 

You can use multiple group sections for each report. Any description or heading in a group section 
prints for each row that is processed.  

To print level-break headers and totals on a group report, level-break header and footer sections are 
required.  
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See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with Event Rules for information on event rules  

� Attaching a System Function to an Event for information on system functions 

� Joining Subsections for information on subsection joins  

When to Use a Group Section 
The following criteria can help you decide when to use a group section in your report:  

• Free-form layout is appropriate.  

• The totaling levels in the report are mostly static; therefore, they are not subject to change at 
run time.  

• The section needs to be joined to other sections.  

• The section needs to be conditional.  

Characteristics of a Tabular Section 

Although a tabular section appears in the same column-and-row format as a columnar section, it has 
built-in spreadsheet functions so it is suitable for presenting numerical data that needs to be 
summarized with subtotals and grand totals.  

The following illustration is a tabular section: 
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Within a tabular section, you can: 

• Attach any business view 

• Sequence data and designate level breaks, based on the data fields in the business view 

• Select data that is based on designated criteria 

• Calculate grand totals 

• Attach event rules (logic statements that you create and attach to report objects) 

• Call business functions (related groups of logic statements), such as period activity and 
journal entry 

• Call system functions (performs operations on ERP objects), such as workflow 

• Select data at the column level 

• Use drill-down functions (to research values in the report by creating a link between your 
report output file and the associated EnterpriseOne application) 

You can include multiple tabular sections in a report. The section processes when a level-break field 
changes.  

Tabular sections automatically include the Description column. This column displays descriptions for 
rows, based on data sequencing and level-break fields. 

Totaling is dynamic in a tabular section. If a column does not require totaling, you can turn the 
totaling function off. Because the totaling logic is built into a tabular section, you do not have to use 
level-break footer sections for totals, so you can change the totaling without redesigning the report. 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with Event Rules  

� Attaching a System Function to an Event  

� Joining Subsections  

� Working with the Drill Down Feature 

Advantages of Using Tabular Sections  
The advantages of using tabular reports are: 

• Totaling is automatic.  

• An audit trail can be created with the drill-down feature.  

• Totaling levels can be changed easily by designating level breaks.  

• Multiple descriptions can be displayed in the Description column.  

When to Use a Tabular Section 
The following criteria can help you decide when to use a tabular section in your report:  

• You need to do row level processing, such as calculations.  

• You need to work with individual cell properties.  
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• The report requires totaling.  

• The totaling level changes frequently.  

• Data selection is required at the column, row, or cell level.  

• You need to calculate grand totals.  

• Drill-down functionality is required.  

Characteristics of a Report Header Section 

A report can contain only one report header, which prints once at the beginning of the report. The 
report header can include the report title, the date when the report was processed, and a list of the 
names of the people who receive the report. Typically, report headers include data fields, such as 
constant and run-time fields; and alpha, numeric, and date variables.  

The following illustration is a report header as it might appear on a report: 

 

 

Characteristics of a Page Footer Section 

A report can contain only one page footer, which prints once at the end of each report page. A page 
footer might have an explanation about the contents of the report. Typically, page footers include data 
fields, such as constant and run-time fields; and alpha, numeric, and date variables.  
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The following illustration is a page footer as it might appear on a report: 

 

 

Characteristics of a Report Footer Section 

A report can contain only one report footer, which prints once at the end of the report. The report 
footer can contain a reminder that the contents of this report are for internal use only. Typically, 
report footers include data fields, such as constant fields; and alpha, numeric, and date variables.  

The following illustration is a report footer as it might appear on a report: 

 

 

Characteristics of a Page Header Section 

A report can contain only one page header, which prints once at the beginning of each report page. A 
page header can have a company name, page number, and date. Page headers are usually generated by 
the system. However, you can manually create your own page header and include data fields, such as 
constant and run-time fields; and text, numeric, and date variables.  
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The following illustration is a page header as it might appear on a report: 
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Report Design  

Before you can create a report, you must design it so that it is functional, useful, and complete. Report 
design entails determining user needs by asking questions of the stakeholders, creating a model of the 
report, and determining which sections to include on the report. 

Surveying Stakeholders 
To determine user needs, you must answer the following questions: 

• What is the purpose of the report? 

• Who will use the report? 

• What do the users want to see in the report? 

• What information in the report will come directly from the database and what information 
needs to be calculated? 

• What are the best business views to use? 

• What data fields and records should be included in the report? 

• In what order should the data be presented? 

• What is the most useful format in which to present the information? 

• What reports are used to produce this information now? 

• Does a report already exist that could be copied or modified? 

• Will a new version of an existing report meet the users’ needs? 

• How frequently will the report be run? 

• Does the report output need to be exported to another software package by using output 
stream access (OSA) or comma separated values (CSV)? 

Creating a Report Model 
Once you have determined user needs, you should create a report model, which helps you determine 
how you want to format the data and what section types best meet the users’ requirements.  
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For example, suppose that you are creating a report that will be used for invoicing or ordering. A 
sample of a report model is shown below:  

 

 

Determining the Report Sections 
After the user and you agree on the model, you need to determine the sections of the report. For the 
previous example, you determined that the report should include a page header section to provide 
general information, level-break headers and footers (group sections) that display account information 
and subtotals, a columnar section that presents data in a columnar format, and a group section that 
displays totals 

To determine what sections belong in a report, consider the following questions: 

• Is a report header required at the beginning of the report for clear and meaningful 
presentation of the information?  

• Is a report footer required at the end of the report to highlight an important function of or fact 
about the report?  
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• Is a page header required to present information on each page of the report?  

• Is a page footer required to give the reader vital information on each page of the report?  

• Does a business view already exist that contains the data fields on which you want to report?  

• Do you need to create a subsection join?  

• What is the best format to present the information?  

• Do you want the free-form format of the group section?  

• Do you want the columnar format of a columnar or tabular section?  

• Do you need the flexibility of a tabular section to create rows in your report?  

• If you use a group or columnar section, do you need to add level-break headers or footers for 
totaling purposes?  

• Would the automatic totaling features of a tabular section make it the best choice for your 
report?  

• Does a director template exist to help you create a specific application report?  

• Do you need to modify a director template or create a new one?  

• How can you sequence the data fields and records from the business view?  

• How can you sort the rows from your business view?  

• What enhancements need to be made to report objects to make the report more useful? For 
example, do you want to emphasize the information in one column by changing the column 
spacing? Do you want to change the font size of the column's contents to call attention to the 
information?  

• Are event rules required to define conditional, mathematical, or other logic for the report?  

• Is an audit trail required?  

After you have finished designing your report, you are ready to create it using the Report Design 
Director. 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Report Sections for information on the characteristics of each section type and criteria for 
using a specific section  

� Report Design Director for more information on creating a report by using this tool 

� Basic Report Enhancements for information on modifying how your report looks and 
functions 

� Advanced Report Enhancements for advanced information on modifying how your report 
looks and functions 

� Batch Versions for Reports for information about creating and modifying batch versions 

� Submitting a Report for information on how to select data and processing options, and how to 
view and print your report 
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PeopleSoft Naming Conventions  
To provide consistency for developers and users, all EnterpriseOne objects follow standard naming 
conventions. The naming conventions require that each object, such as a table, report, interactive 
application, or menu, have a unique name. The naming conventions help you identify types of objects 
and prevent users from creating objects with duplicate names. 

Understanding PeopleSoft Naming Conventions  
An EnterpriseOne application is composed of multiple objects. When you create a new object, you 
must name the object and provide a description. Naming conventions provide a standard for each 
object type that you can create.  

You may further define the characteristics within the object. For example, when you create a table, 
you may designate a key that consists of more than one field within that table. When you create the 
index of the table, you should follow the standard for naming that index.  
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Naming Conventions for Objects  

Use the following chart as your guide when you name objects:  
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System Codes  

The system code is included in an object name. For a complete list of EnterpriseOne system codes, 
see UDC table 98/SY.  

If you are performing PeopleSoft custom work, use system codes 60-69.  

Example: Program and File Names  

The following chart shows examples of the naming conventions for tables, forms, and applications: 

 

 

Text Overrides and Jargon  

EnterpriseOne provides several options for overriding text in forms and reports to allow for different 
terms and languages. However, you should be aware of the following restrictions when you decide 
how to override text and use jargon:  

• You can use jargon in the data dictionary to override text for the entire system, but if the text 
is overridden again in Form Design Aid or Report Design Aid, then jargon terms do not 
appear.  
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• You can use text variables to present different text strings under different conditions; but in 
such cases, it is difficult to determine whether you have allowed enough space on the form or 
report for translation. 

Object Naming Conventions for Batch Applications  
Object naming conventions ensure consistency and make batch applications easier to identify and 
locate.  

Batch Applications  

Object naming conventions ensure consistency and make batch applications easier to identify and 
locate. For batch applications, the name can be a maximum of eight characters and should be 
formatted as Rxxyyyyy, such as R09800, R30440, and so on, where:  

R = Batch (report) application  

xx = System code  

yyyyy = For these digits, follow the same naming convention as you use on the iSeries.  

The Function Use field follows the same naming standards as the iSeries, such as:  

130-139 = Batch Processes  

160-169 = Reports  

Report Category Codes follow the same standards as the Form Design standards.  

Section Names  

A section name within a report can be a maximum of 10 characters and should be formatted as 
SzzzzzzzzA, such as S09800A, S30440B, and so on, where:  

S = Report section name  

zzzzzzzz = Program name  

A = A sequentially assigned letter  

The tool set uses next numbers to automatically assign section names. Examples include S1, S2, S3, 
and so on.  

The section description should include the section type, such as Batch Total Section, Payment Level 
Break Header Section.  

Sections should be logically arranged in report rendering.  

Purge Table Program 

The Table Conversion-Batch Delete program is the generic purge program in EnterpriseOne that 
removes selected records from a table and stores the data in a backup file. To use this batch program, 
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you must first create a table conversion in the Object Management Workbench (OMW), rather than a 
new version, for the table that you want to purge.  

The purge table conversion name can be a maximum of eight characters and should be formatted as 
Pxxxxxxp, where: 

P = The purge table  

xxxxxxp = The table (file) name  

See Also  
See the following topics in the EnterpriseOne Report Writing Guide: 

� Creating a Batch Version for more information on batch versions 

� To save a report for information on how to save a report 

Versions  

When you create a new version, provide a description of the version.  The description should indicate 
what the report does and how to set the processing options for the version.  The description may be up 
to 60 characters long. 

XJDE versions are used for demo purposes and are typically batch applications. When called from a 
menu, batch applications display the versions list so that clients can create production versions. 
During an installation, EnterpriseOne may overwrite XJDE versions. 

ZJDE versions are used for default purposes and are typically interactive applications, or they are 
called from another application. You usually attach these versions to a menu. Clients can set these 
versions. When called from a menu, interactive applications with a version are called with a blind 
execution based on predetermined processing option values. ZJDE versions are not overwritten 
during installation upgrades.  

See Also  
� Creating a Batch Version in the EnterpriseOne Report Writing Guide 

Variables 

You define a variable to have one value until some condition is true, in which case you change the 
value of the variable. You can use a variable to control the flow of a function or statement; it allows 
you to check for certain conditions while your function progresses.  

Batch Event Rule Variables  

An event rule variable name within a report should be formatted as xxx_yyzzzzzz_AAAA, where: 

xxx = A prefix that the system automatically assigns, depending on the scope. For example:  

evt_ (event scope)  

rpt_ (report scope)  

sec_ (section)  
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yy = Hungarian Notation for C variables, such as:  

c - Character  

mn - Math numeric  

sz - String  

jd - Julian date  

id - Pointer  

zzzzzz = A programmer-supplied variable name. Each word is capitalized. 

AAAA = A data dictionary alias (all upper case). 

For example, an item event rule variable would be rpt_mnItemNumber_ITM. Do not include any 
spaces.  

If report global variables are used, global variables are defined in a conditional group section that is 
never called. This section is named Defined Global Variables. Global variables are placed in the 
section in logical groupings. Use constants to comment on the use of the global variables.  

Event Rule Variables  

Event Rule variables are named similar to C variables and should be formatted as 
xxx_yyzzzzzz_AAAA, where: 

xxx = A prefix that varies depending on the scope. The system automatically assigns the 
prefix, such as:  

frm_ (form scope)  

evt_ (event scope)  

yy = Hungarian Notation for C variables, including:  

c - Character  

h - Handle Request  

mn - Math Numeric  

sz - String  

jd - Julian Date  

id - Pointer  

zzzzzz = A programmer-supplied variable name. Capitalize the first letter of each word. 

AAAA = The data dictionary alias (all upper case). 
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For example, a branch/plant event rule variable would be evt_szBranchPlant_MCU. Do not include 
any spaces. 

Text Variables  

The system automatically assigns a name using the format TVzzzzzzzz, where: 

TV = Text Variable 

zzzzzzzz = Programmer-supplied variable name 

See Also  
� Working with Event Rule Variables in the Development Tools Guide 

Report Objects  
A report must be defined as a UBE object type in the Object Librarian Master table (F9860). A report 
object must have at least a name, a description, and a product code to which the object is connected. 
After you have created the report object, you can save it and add additional specifications, such as the 
report format, at a later time.  

Default Settings for Reports  
When you create a new report or another batch application, the system automatically applies the 
following standards. 

Font 7 point, Arial, regular font. 

Report name Appears in the upper-left corner of the report header (for 
example, such as R09800). 

Actual run date and run time values Appears on the right side of the first and second lines of the 
report header. 

Label Page, followed by the page 
number 

Appears in the upper-right corner of the report header. 

Report titles Centered at the top of the report header. 

Company name Appears on the first line of the report title in the report header. 

Creating a Report Object 
EnterpriseOne categorizes each report object in one of two ways: as a report template or as a batch 
version.  

EnterpriseOne offers two methods for creating report objects: the Report Design tool and Object 
Management Workbench (OMW). You can also create batch versions with the Batch Versions tool. 
When you create a report object with the Report Design tool, you create a new report template and, 
optionally, a batch version. This instance is the only time that you can use Report Design to create a 
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batch version; any other batch versions that you need must be created with either OMW or the Batch 
Versions tool.  

You can also create a report template using OMW, a change management tool that allows you to 
create either a template or a batch version that is based on an already existing template.  

See Also  
� Object Management Workbench in the Development Tools Guide for more information on 

using the OMW  

� Batch Versions for Reports in the EnterpriseOne Report Writing Guide for more information 
on using the Batch Versions tool to create batch versions  

► To create a report object with Report Design 

From the Report Writer menu (GH9111), choose Report Design Tool.  

1. On Report Design, click New.  

2. On Create New Report, complete the following fields:  

• Report Name 

By default, the report name appears in the upper-left corner of the page header. The 
EnterpriseOne naming convention begins report names with the letter R, followed by the 
product code, and ending with a unique identifier.  

• Description 

The description appears in the center of the page header below the company name. 
PeopleSoft recommends that you make this description into a useful identifier, such as 
G/L by Batch - Columnar.  

• Product Code 

Codes 55 - 59 are reserved for customers. Use these codes to ensure that your object 
remains unaltered by EnterpriseOne software upgrades.  

The Report Design Director opens.  

3. Select one of the following options and click OK: 

• No Update Report 

Any user can design a No Update Report. A No Update Report cannot update the 
database from Report Design. 

• Update Report 

Only Update Users can design an Update Report. An Update Report can update the 
database from report design. 

Note 

If you are not an Update User, the Update Report option does not appear and the No Update 
Report option is selected. The system administrator designates Update Users. See Setting Up 
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User Roles in the System Administration Guide for information on setting up a user as an 
Update User. 

 

4. Continue with the Report Design Director to design the report. The option to create a version 
based on the report template you just created appears on the final Report Design Director 
form.  

Note 

When you create a version, the system uses the current report level values. If you change the 
report level values after you create the version, the new report level values are not reflected in 
the version. 

 

► To create a report template with OMW 

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench (P98220).  

1. On Object Management Workbench, click Find.  

2. On the project list, choose the project to which the new report object will be added, and then 
click Add. 

3. On Add J.D. Edwards Object to the Project, choose to create a Batch Application, and then 
click OK.  

4. On Add Object, complete the following fields:  

• Object Name 

Object Name is the name of the report. By default, the name appears in the upper-left 
corner of the page header. The EnterpriseOne naming convention begins report names 
with the letter R, followed by the product code, and ending with a unique identifier. 

• Description 

The description appears in the center of the page header below the company name. 
PeopleSoft recommends that you make this description into a useful identifier, such as 
G/L by Batch - Columnar.  

• Product Code 

Codes 55 - 59 are reserved for customers. Use these codes to ensure that your object 
remains unaltered by EnterpriseOne software upgrades.  

• Product System Code 

Use either the product code of the report or the business view.  

• Object Use 

26 



Depending on how you want to classify the report's use, you can use one of codes 160 - 
166, which are all report-related classifications.  

5. Select one of the following options and click OK: 

• No Update Report 

Any user can design a No Update Report. A No Update Report can read the database, but 
cannot update it from Report Design. 

• Update Report 

Only Update Users can design an Update Report. An Update Report can update the 
database from report design. 

Note 

If you are not an Update User, the Update Report option does not appear and the No Update 
Report option is selected. The system administrator designates Update Users. See the System 
Administration Guide for information on setting up a user as an Update User. 

 

6. On Batch Application Design, click the Design Tools tab, and then click Start Report Design 
Aid.  

Continue with the Report Design Director to design your report.  

► To copy a report template with OMW 

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench (P98220). 

1. On Object Management Workbench, click Find. 

2. On the project list, highlight the report you want to copy and click Copy. 

3. On Copy Object, complete the following fields: 

• Copy to 

The name of the new report. By default the name appears in the upper-left corner of the 
page header. The EnterpriseOne naming convention begins report names with the letter 
R, followed by the product code, and ending with a unique identifier. 

• Description 

The description appears in the center of the page header below the company name. 
PeopleSoft recommends that you make this description into a useful identifier, such as 
G/L by Batch – Columnar. 

• Product Code 

Codes 55 – 59 are reserved for customers. Use these codes to ensure that your object 
remains unaltered by EnterpriseOne software upgrades. 

• Product System Code 

Use either the product code of the report or the business view. 
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• Object Use 

Depending on how you want to classify the report’s use, you can use one of the report-
related classification codes 160 – 166. 

4. Select one of the following options and click OK: 

• No Update Report 

Any user can design a No Update Report. A No Update Report cannot update the 
database from Report Design. 

• Update Report 

Only Update Users can design an Update Report. An Update Report can update the 
database from report design. 

Note 

If you are not an Update User, the Update Report option does not appear and the No Update 
Report option is selected. The system administrator designates Update Users. See the System 
Administration Guide for information on setting up a user as an Update User. 

 

5. On Batch Application Design, click the Design Tools tab, and then click Start Report Design 
Aid. 

Continue with the Report Design Director to design your report. 

► To create a batch version with OMW 

From Cross Application Development Tools (GH902), choose Object Management Workbench.  

1. On Object Management Workbench, click Find.  

2. On the project list, choose the project to which the new report object will be added, and then 
click Add. 

3. On Add J.D. Edwards Object to the Project, choose Batch Version, and then click OK.  

4. On Adding a Version, enter the report template's name, or use the Search button to search for 
the report template, and then click OK.  

5. On Version Add, complete the following fields, and then click OK: 

• Print Cover Page 

• Version 

• Version Title 

• Prompting Options 

This field is disabled if no processing options are associated with the report template.  

• Security 

• Job Queue 

• Version Detail 
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► To copy a batch version using OMW 

From Cross Application Development Tools (GH902), choose Object Management Workbench. 

1. On Object Management Workbench, click Find. 

2. On the project list, choose the batch version to copy, and then click Copy. 

3. On Version Copy, complete the following fields, and then click OK: 

• New Version 

• Security 

• Version Title 

4. On Batch Version Design, click the Tools tab, and then click Report Design. 

Continue with Report Design to design your version. 

Deleting a Report Object  
From time to time, you might need to delete report objects from your system. You can delete batch 
versions and report templates. If you delete a report template, all of its batch versions are deleted 
automatically.  

You can delete a report object at three different levels:  

• You can delete an object from the check-in server.  

• You can delete an object from your local environment only.  

• You can delete the object completely from the system.  

Note  

You can delete report objects only if they are checked in, and you have the proper roles and 
permissions to delete them. For more information, see Object Management Workbench in the 
Development Tools Guide. 

 

See Also 
� Object Management Workbench in the Development Tools Guide for information on checking 

in report object, and roles and permissions 

► To delete a report object 

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench.  

1. On Object Management Workbench, click Find.  

2. On the project list, choose the object that you want to delete and click Del (delete).  
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3. On Delete of, click one of the following options:  

• Delete Object from Server 

• Delete Object Locally 

• Remove Object from ALL Locations 

4. Click OK.  

The deleted object appears in bold text in the project window and is deleted when you close 
EnterpriseOne.  

Opening an Existing Report  
If you know the name of an existing report, you can open the report to make changes with Report 
Design. However, the first time that you try to open the report, you might receive an error message 
that tells you that the report does not exist on your workstation. You must then get the specifications 
from the server before you can work with the report.  

You can open either a report template or a batch version. If you open and modify a report template, 
the changes that you make are reflected in the template's versions (unless prohibited by overrides in 
the batch versions). Open a batch version if you want to modify it or define overrides for it.  

When you open an existing report, the Director is not available to assist with changes. Rather, the 
report template or batch version opens automatically to the Report Design form. You can open a 
report object with Report Design or OMW.  

See Also 
� Object Management Workbench in the Development Tools Guide for information on getting 

object specifications 

► To open a report object with OMW  

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench.  

1. On Object Management Workbench, click Find.  

2. On the project list, choose the report object you want to open and click the Design button in 
the center column.  

If the report object that you want to open is not in your project list, you must add it to one of 
your projects before you can work with it.  

If you chose a report template, on Batch Application Design, click the Design Tools tab, and 
then click Start Report Design Aid.  

If you chose a batch version, on Batch Version Design, click the Tools tab, and then click 
Report Design.  

See Also 
� Object Management Workbench in the Development Tools Guide for information on adding 

objects to your projects 

30 



Creating Detail Sections  
The Director guides you through the steps of creating a detail section. You might, however, need to 
modify an existing section or need to add one or more columnar, group, or tabular sections. Report 
Design provides features to help you accomplish these tasks.  

To create an additional section using Report Design, forms similar to those displayed in the Director 
are available to help you design your section. This topic shows you how to add a detail section to a 
report.  

Adding a Detail Section 
Report Design lets you manually create as many group, columnar, or tabular sections as are required 
for your report. You can design each detail section by choosing a business view and adding individual 
columns from it.  

► To add a detail section 

1. On Report Design, from the Section menu, choose Create.  

2. From Create, choose one of the following:  

• Group  

• Columnar  

• Tabular  

The Report Director appears to help you select a business view.  

3. To create a new section, proceed through the director forms as they appear.  

See Also 
� Report Design Director in the EnterpriseOne Report Writing Guide for information about 

using the forms of the Report Design Director 

Selecting a Business View 
Business views are the link between your report and the data in EnterpriseOne tables. A business 
view defines the data fields from one or more tables that a report uses. Report Design lets you limit 
your business column selection to only those columns that you need in your report.  

► To select a business view 

1. On Report Design, click inside the detail section.  

2. From the Section menu, choose Select Business View.   

3. On Business View Director,  choose one of the following tabs; and then proceed to the 
appropriate instructions:  

• Select Business View 

• Favorite Business Views 
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See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� To use the Select Business View tab to find a business view  

� To use the Favorite Business Views tab to find a business view  

► To use the Select Business View tab to find a business view 

1. On Business View Director, click the Select Business View tab.  

2. On Select Business View, click Find or press Enter.  

The form displays a list of all available business views. You can narrow your search by 
entering search criteria in the QBE line. Search for a business view using the following 
naming conventions:  

The business view name starts with the letter V and is a maximum of 10 characters. It is 
formatted as follows: VxxzzzzzzzA.  

• xx = the product code (55-59 is reserved for clients).  

• zzzzzzz = the characters of the primary table.  

• A = the letter to designate the view. For example, V0101A is the first view over the table 
F0101, and V0101B is the second view over the same table.  

3. Choose a business view, and then click OK  

See Also  
� Business View Design in the Development Tools Guide for more information about business 

views  

► To use the Favorite Business Views tab to find a business view 

1. On Business View Director, click the Favorite Business Views tab.  

2. From the Favorites list, choose the folder that contains the business view you want to use for 
your detail section. Click the + icons to expand the folders until you see the business view 
that you want to see.  

3. Click the Description tab to see a brief description of the business view that you have chosen.  

4. Click the Columns tab to see the data fields that are included in the business view which you 
have chosen.  

5. When you have chosen the business view that you want to use, click OK.  

Whether you chose a business view through the Select Business Views tab or Favorite Business 
Views, the title bars in the Report Tree and Report View windows now reflect the business view that 
you selected.  

See Also  
� Setting up Business Views as Favorites in the EnterpriseOne Report Writing Guide for 

information about adding your own business views to this list 
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Adding Business View Columns to a Detail Section  
Business view is the link between your report and the data in your EnterpriseOne tables. A business 
view defines the data field from one or more tables that a report uses. Report design lets you limit 
your business column selection to only those columns that you need in your report. 

Based on the business view that you choose, you can add new business view columns to a detail 
section of your report.  

► To add business view columns to a detail section 

1. On Report Design, click a detail section with an associated business view.  

2. From the Section menu, choose Quick Section.  

The Quick Section form appears.  

3. On Quick Section, from the Available Business View Columns, choose columns, and then do 
one of the following:  

• Click the right arrow to move one or more columns to Selected Columns.  

• Drag columns to Selected Columns.  

• Click the right double-arrow to move all columns to Selected Columns.  

4. To remove a column from your report, from the Selected Columns list, choose the column, 
and then do one of the following:  

• Click the left arrow or press Delete to remove only the selected columns.  

• Click the left double-arrow to remove all columns.  

5. To change the order that the columns appear on your report, from the Selected Columns list, 
choose the column, and then do one of the following:  

• Click the up or down arrow to move the selected column up or down one line in the list.  

• Drag a column to change its order.  

• Click the up or down double-arrows to move the selected column to the top or bottom of 
the list.  

If you are creating a group section, the Number of Columns field appears below the Available 
Business View Columns list. This field determines how Report Design organizes the fields 
initially in the number of stacks it creates in the section. For example, if you have selected six 
business view columns and then set Number of Columns to 2, Report Director arranges the 
business view columns in two stacks, each three-business view columns deep. The first three 
appear in descending order in the first stack and the last three in descending order in the 
second. If you set Number of Columns to 3, however, it arranges the business view columns 
three across and two down. The default value is 2.  
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If you are creating a tabular section, the Description column is automatically added as a 
column on your report. This column appears in the Selected Columns list on the Section 
Layout form and appears as the first column on your report.  

6. When you finish the layout of your section, click OK.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Adding Smart Fields to an Application Report for information about how to define smart 
fields 

� Working with Columns in Tabular Sections for information about how to define calculations 

Defining Section Data Sequencing 
Data sequencing determines the order in which records are read from the database and displayed on 
the report.  For example, you might want to order records by address book number and then by name. 

Because EnterpriseOne  can sequence the records in the report by any column in the record 
(regardless of whether you choose to display the column in the report), the data sequencing columns 
that you choose in this task do not need to match the business view columns chosen on Section 
Layout.  

► To define section data sequencing 

1. On Report Design, click the detail section for which you created the section layout in the 
previous task.  

2. From the Section menu, choose Define Data Sequence.  
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3. On Data Sequencing, click the Section Data Sequencing tab.  

4. To choose columns for data sequencing, from the Available Columns list, choose columns, 
and then do one of the following:  

• Click the right arrow to move one or more columns to Selected Columns.  

• Drag columns to Selected Columns.  

• Click the right double-arrow to move all columns.  

5. To remove a column from the Selected Columns list, choose the column, and then do one of 
the following:  

• Click the left arrow or press Delete to remove only the selected columns.  

• Click the left double-arrow to remove all columns.  

Caution 

If you define a data sequencing column as a level break or page break (as explained in the 
next task), do not move that column from the Selected Columns list back to the Available 
Columns list.  

 

6. To change the order that the business view columns appear on your report, from the Selected 
Columns list, choose the column, and then do one of the following:  

• Click the up or down arrow to move the selected column up or down one line in the list.  

• Drag a column to change its order.  

35 



• Click the up or down double-arrows to move the selected column to the top or bottom of 
the list.  

When you finish determining the sequence order for your detail section, you can begin defining the 
sort properties.  

Defining Sort Properties 
After you choose data fields to use for data sequencing, you can define sort properties for those data 
fields. The sort properties determine whether the rows are sorted in ascending or descending order, 
whether a level break should occur, and whether the level break should produce a page break. For 
example, you can sequence your information for Search Type in ascending order, designate Search 
Type as a level break, and have a new page begin for each Search Type.  

See Also  
� Working with Level-Break Header and Footer Sections in the EnterpriseOne Report Writing 

Guide for detailed information about working with level breaks  

► To define sort properties 

  

From the Section menu, choose Define Data Sequence. 

1. On Data Sequencing, click the Define Sort Properties tab.  

 

2. Complete  the following field:  
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• Sort Order  

Click once to display an up arrow for ascending order. Click twice to display a down 
arrow for descending order. 

3. Turn on the following fields and click OK: 

• Level Break  

• Page Break  

Note 

To set an object as a page break, you must first set the object as a level break.  

 

Defining Section Data Selection 
Section data selection lets you define criteria whereby only specific, relevant records are included in 
your report.  

The Section Data Selection form filters the data for one detail section only. If your report contains 
only one detail section, your report displays only the records that match the criteria entered on this 
form. If you add other detail sections to your report, you must define data selection for each section.  

To limit the records retrieved from the EnterpriseOne tables, specify data selection criteria, such as is 
equal to and is less than between the following:  

• Data fields in the EnterpriseOne tables  

• Values that define the data in the data fields, such as ledger types, search types, or account 
numbers  

► To define section data selection 

1. On Report Design, click a detail section for which you have defined section data sequencing 
and sort properties.  

2. From the Section menu, choose Define Data Selection.  

3. On Section Data Selection, Where is the default value in the Operator column for the first set 
of criteria.  

For subsequent statements, And and Or become the available values for the Operator column 
and are selected by double-clicking the appropriate one.  

4. Click in the Left Operand column to display the list of available objects, and then perform 
one of the following:  

• Scroll through the list until you find the desired object, choose the object, and then 
double-click the object to populate the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to bring you to the 
object in the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the Comparison 
column automatically appears.  
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5. Select one of the following comparison operators:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

6. Click the Right Operand column to display an available list of objects, special values, or 
variables. Your choices in this column depend on the choice you made in the Comparison 
column. Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal Allows you to enter specific values (see the following step for information on entering 
specific values)  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

BC  Indicates a business view column available for this report  

FI  Indicates a value passed through form interconnection to this report  

PC  Indicates the previous business view column  

PO  Indicates a processing option value for this report  

PV  Indicates the previous variable  

RC  Indicates a constant from this report  

RV  Indicates a variable from this report  

SV  Indicates a system variable  

SL  Indicates a system literal  

VA  Indicates an event rule variable  

7. If you chose to enter a literal in the Right Operand column, the form that opens automatically 
enables you to enter the following:  

• Single value  

Enter a single value, and then click OK. For example, a value might be for a particular 
company.  

• Range of values  
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Enter a range of values, and then click OK. For example, a range of values might include 
companies from 00001 to 00060. Only is equal to and is not equal to are valid logical 
operators when using range of values.  

• List of values  

To add values to or remove values from the list, do the following:  

• Type each value in the field, and then press Enter or click the Add button at the top of 
the form.  

• Repeat this process until your list of values is complete. For example, a list of values 
might include several user defined codes for search types such as C for Customers, E 
for Employees, and V for Vendors. Only is equal to and is not equal to are valid 
logical operators when you are using list of values.  

• Delete a value by choosing the value, and then click the Delete button at the top of 
the form.  

• Click OK when you are finished.  

 

8. To delete a line of criteria on Section Data Selection, choose the row header to highlight the 
row, and then click the Delete button at the top of the form.  

9. To change the order of the criteria, choose the row header to highlight the row, and then click 
the up or down button.  
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Report Design Director 

The Report Design Director (Director) gives a quick start to designing a report by leading you 
through a linear process to set up some basic elements. As you proceed through the Director, you 
answer simple questions, such as whether you want header and footer sections, what type of detail 
section to use, on what business view the data selection will be based, what columns to include in the 
report, and how to sequence and sort the records in your report. Based on your answers to these 
questions, the Director sets up a report and opens it in Report Design. You can then use Report 
Design to format and enhance the report and change anything set up through the Director.  

The Director also includes director templates to help you create an application report. These templates 
contain default criteria, such as a recommended business view, a list of smart fields, data selection, 
and data sequencing options to include. When you choose one of the templates in the Director, the 
Director reads the template specifications (stored in EnterpriseOne tables) and presents the default 
criteria through the Director forms. Several director templates are included with PeopleSoft 
EnterpriseOne software. You can also create your own templates with the Smart Field Activation 
(P91420) and Report Director Templates (P91400) programs.  

If you want to design your report without assistance of the Director, bypass the Director by clicking 
Finish or Cancel; then build your report, section by section, within Report Design.  

See Also  
See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with Director Templates for more information about modifying and adding report 
director templates  

� Creating Detail Sections for information about creating sections by using Report Design 
rather than the Director  

Creating a Columnar Report  
The columnar report is the simplest report that you can create by using the Report Design Director. It 
presents information from a business view in columns. Each data field is a column and each record is 
a row. 

Use the Director to design a columnar report. The Director leads you through the process for creating 
a columnar report by asking you questions about the structure and content of the report. After you 
create the report, you can enhance it by using additional features of Report Design. 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Characteristics of a Columnar Section for an overview of columnar sections and criteria for 
using them  

� Creating a Report Object for information about starting the report design process and the 
Director 
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Prerequisite 
� Create a report object. The last step in creating a report object opens the Report Design 

Director automatically. See Creating a Report Object in the EnterpriseOne Report Writing 
Guide for information about creating a report object. 

► To choose report sections to include in the columnar report 

Note 

After you create a report object, Report Design Director starts with a Welcome form. The Director 
includes a Navigation Assistant pop-up box that shows you where you are in the report creation 
process. You can hide the Navigation Assistant by right-clicking it and choosing Hide. 

 

 

1. On Welcome to the Report Design Director, click the following options for the headers and 
footers that you want to include in your report:  

• Report Header 

• Page Header 

• Page Footer 

• Report Footer 

2. Click the Columnar option, and then click Next.  

If you chose a page header, the Page Header Details form appears. 
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Note 

If you did not choose a page header, the Business View Selection Option form appears. Go to one of 
the next tasks: To choose from a list of favorite business views or To use Select Business View to find 
a business view. 

 

3. On Page Header Details, select one of the following options to automatically include the 
following standard data fields: 

• Automatically add the default informational fields shown below to my page header 
section. 

• Automatically add the default informational fields “Page n or Total” shown below to my 
page header section. 

Note 

After you complete the report using Report Director process, you can use Report Design to 
add or delete data fields from the page header.  

If you do not select either of the options above, the Director creates an empty page header. 
You can manually add data fields to the page header from the Section menu on the Report 
Design form.  

 

4. Click Next.  

Business View Selection Option appears. 

► To choose from a list of favorite business views 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'd like help finding an 
appropriate business view, and then click Next.  

2. On Favorite Business Views, open the folder that contains the business view that you want to 
use for your report section. Click the + icons to expand the tree until you see the business 
view that you want.  

3. Click the Description tab to see a brief description about the business view that you have 
chosen, if a description is available.  
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4. Click the Columns tab to see the data fields that are included in the business view that you 
have chosen.  

 

43 



5. When you have chosen the business view that you want to use, click Next to see Section 
Layout.  

See Also  
� Setting up Business Views as Favorites in the EnterpriseOne Report Writing Guide for 

information about adding your own business views to the favorites list  

► To use Select Business View to find a business view 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'll find a business view myself. 

2. Click Next.  

3. On Select Business View, click Find or press Enter.  

The form displays a list of all of the available business views. You can narrow your search by 
entering search criteria in the QBE row.  

4. Choose a business view, and then click Next to see Section Layout.  

See Also  
� Business View Design in the Development Tools Guide  

► To add business view columns to the section 

After you choose a business view as described in the previous task, Section Layout appears. 

1. From the Available Business View Columns list, choose the columns that you want in the 
report, and then click the arrow that is pointing to the right to move them to the Selected 
Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow to move all of the columns from the Available Business View 
Columns list to the Selected Columns list.  

The first item in the list appears as the left column in the report.  

2. To remove a column from your report, choose a column in the Selected Columns list, and 
then click the arrow pointing to the left to move it to the Available Business View Columns 
list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Business View Columns list.  

3. To change the order that the columns appear on your report, choose a column in the Selected 
Columns list, and then click the up or down arrow to move the selected column up or down 
one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. When you complete the layout of your section, click Next to see Section Data Sequencing.   
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► To define section data sequencing for the section 

After you select business view columns as described in the previous task, Section Data 
Sequencing appears. 

 

1. To select columns for section data sequencing, choose the columns from the Available 
Columns list, and then click the arrow that points to the right to move them to the Selected 
Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow that is pointing to the right to move all of the columns from the 
Available Columns list to the Selected Columns list.  

Note  

To define sort properties in the next task, you must select the column on which you plan to 
sort in this task.  

 

2. To remove a column from the Selected Columns list, choose a column in the Selected 
Columns list, and then click the arrow that points to the left to move it to the Available 
Columns list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Columns list.  
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3. To change the order of the columns that you selected for data sequencing, choose a column in 
the Selected Columns list, and then click the up or down arrow to move the selected column 
up or down one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. When you finish the section data sequencing for your report, click Next to see Define Sort 
Properties.   

See Also  
� Working with Level-Break Header and Footer Sections in the EnterpriseOne Report Writing 

Guide for detailed information about working with level breaks 

► To define sort properties for the section 

After you define data sequencing as described in the previous task, Define Sort Properties 
appears. 

 

1. On Define Sort Properties, complete the following field:  

• Sort Order 

2. If you want to specify level and page breaks, complete the following fields:  

• Level Break 
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Caution 

If you define a section data sequencing column as a level break, returning to the Section 
Data Sequencing form and then moving that column from the Selected Columns list back 
to the Available Columns list could cause unpredictable results.  

 

• Page Break 

3. When completed, click Next to see Section Data Selection.  

► To select records to include in the section 

After you define sort properties for the section in the last task, the Section Data Selection form 
appears. 

1. On Section Data Selection, click in the Operator column and choose an operator.  

Where is the default value in the Operator column for the first set of criteria. For subsequent 
statements, And and Or become the available values for the Operator column, and are 
selected by double-clicking the appropriate word.  

2. Click in the Left Operand column to display the list of available objects, and then perform 
one of the following actions:  

• Scroll through the list until you find the desired object, choose the object, and then 
double-click the object to populate the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to display the object in 
the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the Comparison 
column automatically appears.  

3. Double-click one of the following comparison operators to select it:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

When you double-click the object for the Comparison column, the list in the Right Operand 
column automatically appears. The objects, special values, and variables that are available 
depend on the comparison operator that you choose.  

4. Double-click a value from the list in the Right Operand column to select it.  
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Your choices in this column depend on the choice that you made in the Comparison column. 
Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal  Allows you to enter specific values, as described below  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

BC  Indicates that a business view column is available for this report  

FI  Indicates that a value passed through form interconnection to this report  

PC  Indicates the previous business view column  

PO  Indicates a processing option value for this report  

PV  Indicates the previous value for the variable  

RC  Indicates a constant from this report  

RV  Indicates a variable from this report  

SV  Indicates a system variable  

SL  Indicates a system literal  

TV Indicates a text variable 

VA  Indicates an event rule variable  

If you chose Literal for the Right Operand column, the form that appears enables you to enter 
any of the value types that are described below.  

5. Select one of the following tabs, define the values, and then click OK.  

• Single value 

Enter a single value, and then click OK. For example, you might enter the address book 
number for a particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might include 
companies from 00001 to 00060. Only is equal to and is not equal to are valid logical 
operators when using range of values.  

• List of values  

To add values to or remove values from the list, perform the following:  
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• Type each value in the field, and then press Enter or click the Add button at the top of 
the form.  

• Repeat this process until your list of values is complete. For example, a list of values 
might include several user-defined codes for search types, such as C for Customers, E 
for Employees, and V for Vendors. Only is equal to and is not equal to are valid 
logical operators when using a list of values.  

• Delete a value by choosing the value, and then clicking the Delete button at the top of 
the form.  

6. Repeat steps 1 through 5 to define more selection criteria rows.  

7. To delete a line of criteria on Section Data Selection, choose the row header to highlight the 
row, and then click the Delete button at the top of the form.  

8. To change the order of the criteria, choose the row header to highlight the row, and then click 
the up or down button.  

9. When you have completed defining selection criteria, click Next to see the Director's Finish 
form.  

► To create a batch version of the report 

After you define the data selection for the section, the Director’s Finish form appears. 

1. On the Finish form, click Yes, create a version of this report to automatically generate a batch 
version of the template.  

2. Enter the version name in the field beneath Yes, create a version of this report. 

3. To review your choices, click Back to move backwards through the Director forms, or click 
the form on the Navigation Assistant that you want to review.  

4. When you are satisfied, click Finish.  

Caution 

When you click Finish, you can no longer access the Director for this report. Prior to clicking 
Finish, you have one more opportunity to review your choices on all forms of the Director, as 
described in step 3.  

 

Report Design - Report View appears.  

See Also  
� Object Management Workbench in the Development Tools Guide for information on using 

OMW to create a batch version 

� Batch Versions for Reports in the EnterpriseOne Report Writing Guide for information on 
creating a batch version 
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► To save a report  

After you click Finish on the Director’s Finish form, the Report Design form appears. 

On the Report Design form, perform one of the following actions:  

• From the File menu, choose Save.  

• Click the Save button on the toolbar.  

See Also 
� Object Management Workbench in the Development Tools Guide for more information on 

checking in a report 

See the following topics in the EnterpriseOne Report Writing Guide for information about using 
Report Design to modify or enhance your report: 

� Basic Report Enhancements 

� Advanced Report Enhancements 

Reviewing the Results of the Director 
When you click Finish, the Director process is complete. Based on the choices that you made during 
the process, Report Design displays the sections of your report and the data fields that you included in 
them. Each section includes the following:  

• An icon that displays the section type  

• Corner brackets enclosing each field within the section  

• A title description  

The title of the main detail section of the report uses a bold font to distinguish it from the 
titles of the other report sections.  

Example: Creating a Columnar Report with the Director  
The sample columnar report below, used for an annual salary review, was created with the Director. It 
is based on the business view V060116A - Employee Master, and it uses the following columns from 
that business view:  

• Address Number  

• Name - Alpha  

• Business Unit - Home  

• Pay Class (H/S/P)  

• Date - Original Employment  

• Rate - Salary, Annual  
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A columnar report format was selected for this report because the information is best displayed in 
rows and columns of data since the listing is straightforward  

► To create the example columnar report  

1. Launch the Report Design tool.  

2. On Report Design, choose New from the File menu.  

3. On Create New Report, complete the following fields.  

• Report Name 

• Description 

• Product Code 

The text that you enter in the Report Name field appears on the left side of the page header 
and the text that you enter in the Description field appears in the center of the page header 
under the company name.  

4. Select the following option and click OK. 

• No Update Report 

5. On Welcome to the Report Design Director, choose Page Header and Columnar, and then 
click Next.  

6. On Page Header Details, click Next.  

7. On Business View Selection Option, click on the option under I'll find a business view myself, 
and then click Next.  

8. On Select Business View, search for and choose the V060116A - Employee Master business 
view, and then click Next.  

9. On Section Layout, use the horizontal arrow buttons to select the following columns and 
move them to the Select Columns column:  

• Address Number  

• Name - Alpha  
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• Business Unit - Home  

• Pay Class (H/S/P)  

• Date - Original Employment  

• Rate - Salary, Annual  

10. Ensure that the columns are ordered as listed above. Use the vertical buttons to change the 
order of the selected view, if necessary. 

Note  

Check the correlation between the order of the columns on this form and the order of the 
columns on the report illustration.  

 

11. Click Next when the selected columns are arranged as shown in the example.  

12. On Section Data Sequencing, use the horizontal arrow buttons to select and move the Name - 
Alpha column to the Selected Columns column, and then click Next.  

13. On Define Sort Properties, ensure that the sort arrow points up (to alphabetize the report in 
ascending order by name), and then click Next.  

14. On Section Data Selection, click Next.  

No data selection is defined for this example.  

15. On the Director's Finish form, enter the version name. 

16. Click Finish.  

17. On Report Design, click Save on the toolbar to save the report.  

18. Click the Preview tab to see the report.  

19. On Report Preview, click Yes. 

20. Exit Report Design by selecting Exit from the File menu. 

Creating a Group Report  
Group reports provide the greatest flexibility in arranging the data in a report. Each group on the 
report presents data from one record. They present data in groups of labeled data fields, called data 
items. Each data item displays data from a business view column.  

You can specify how many of the data items that you selected should be listed vertically before the 
next vertical grouping begins. The default value is two. For example, if you selected six business 
view columns, they would appear initially as two across and three deep. If you changed the value to 
three, the columns would be arranged three across and two deep.  

BV Column 1 BV Column 4 
BV Column 2 BV Column 5 
BV Column 3 BV Column 6 

 

Number of Columns = 2 
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BV Column 1 BV Column 3 BV Column 5 

BV Column 2 BV Column 4 BV Column 6 

 

Number of Columns = 3 

 

 

Note  

The term "business view column" might be confusing in relation to a group section because a group 
section is not organized in a columnar fashion. Remember, a business view column is simply a field; 
despite its name, it is not truly a column in and of itself. The business view column data can appear in 
columnar format, as it does in columnar and tabular sections, or in a free-floating field, as it does in 
group sections.  

 

After you create a new report object, use the Director to design a group report. The Director leads you 
through a linear process for creating a group report by asking you questions about its structure and 
content. When you have completed creating the report, you can enhance it by using additional 
features of Report Design.  

See Also  
� Characteristics of a Group Section in the EnterpriseOne Report Writing Guide for an 

overview of group sections and criteria for using them  

Prerequisite 
� Create a report object. The last step in creating a report object opens Report Design Director 

automatically. See Creating a Report Object in the EnterpriseOne Report Writing Guide for 
information about starting the report design process and the Director. 

► To choose report sections to include in the group report 

After you create a report object, the Director's Welcome form appears.  

The Director includes a Navigation Assistant in a pop-up box that shows you where you are in the 
report creation process. You can hide the Navigation Assistant by right-clicking it and choosing Hide. 
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1. On Welcome to the Report Design Director, click options for the headers and footers that you 
want to include in your report:  

• Report Header 

• Page Header 

• Page Footer 

• Report Footer 

2. Click the Group option, and then click Next.  

If you choose page header, Page Header Details appears.  

If you did not choose a page header, Business View Selection Option appears. Go to the tasks that 
follow and describe how to select a business view.  

3. On Page Header Details, check the following options to automatically include the following 
standard data fields: 

• Automatically add the default informational fields shown below to my page header 
section. 

• Automatically add the default informational fields “Page n of Total” shown below to my 
page header section. 

Notes 

After you complete the report using Report Director, you can use Report Design to add or 
delete data fields from the page header.  
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If you turn both options off, the Director creates an empty page header. You can manually 
add data fields to the page header on the Report Design form.  

 

4. Click Next to see Business View Selection Option. 

► To choose from a list of favorite business views 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'd like help finding an 
appropriate business view, and then click Next.  

2. On Favorite Business Views, open the folder that contains the business view that you want to 
use for your report section. Click the + icons to expand the tree until you see the business 
view that you want.  

3. Click the Description tab to see a brief description about the business view that you have 
chosen, if a description is available.  

 

4. Click the Columns tab to see the data fields that are included in the business view that you 
have chosen.  
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5. When you have chosen the business view that you want to use, click Next to see Section 
Layout.  

See Also  
� Setting up Business Views as Favorites in the EnterpriseOne Report Writing Guide for 

information about adding your own business views to the favorites list  

► To use Select Business View to find a business view 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'll find a business view myself. 

2. Click Next.  

3. On Select Business View, click Find or press Enter.  

The form displays a list of all of the available business views. You can narrow your search by 
entering search criteria in the QBE row.  

4. Choose a business view, and then click Next to see Section Layout.  

See Also  
� Business View Design in the Development Tools Guide  
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► To add business view columns to the group section 

After you choose a business view as described in the previous task, Section Layout appears. 

 

1. From the Available Business View Columns list, choose the columns that you want in the 
report, and then click the right arrow to move them to the Selected Columns list.  

Alternately, you can drag each column the Selected Columns list, or you can click the right 
double-arrow to move all of the columns from the Available Business View Columns list to 
the Selected Columns list.  

The first item in the list appears as the left column in the report.  

2. To remove a column from your report, choose a column in the Selected Columns list, and 
then click the left arrow to move it to the Available Business View Columns list.  

Alternately, you can click the double-arrow that is pointing to the left to move all of the 
columns from the Selected Columns list to the Available Business View Columns list.  

3. To change the order in which the columns appear on your report, choose a column in the 
Selected Columns list, and then click the up or down arrow to move the selected column up 
or down one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. To change the initial number of vertical groupings in the report, enter the desired number in 
Number of Columns.  

5. When you finish the layout of your section, click Next to see Section Data Sequencing.   
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► To define section data sequencing for the section 

After you select business view columns as described in the previous task, Section Data 
Sequencing appears. 

 

1. To select columns for section data sequencing, choose the columns from the Available 
Columns list, and then click the arrow that points to the right to move them to the Selected 
Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow that is pointing to the right to move all of the columns from the 
Available Columns list to the Selected Columns list.  

Note  

To define sort properties in the next task, you must select the column on which you plan to 
sort in this task.  

 

2. To remove a column from the Selected Columns list, choose a column in the Selected 
Columns list, and then click the arrow that points to the left to move it to the Available 
Columns list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Columns list.  
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3. To change the order of the columns that you selected for data sequencing, choose a column in 
the Selected Columns list, and then click the up or down arrow to move the selected column 
up or down one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. When you finish the section data sequencing for your report, click Next to see Define Sort 
Properties.   

► To define sort properties for the section 

After you define data sequencing as described in the previous task, Define Sort Properties 
appears. 

 

1. On Define Sort Properties, complete the following field:  

• Sort Order 
2. If you want to specify level and page breaks, complete the following fields:  

• Level Break 

Caution 

If you define a section data sequencing column as a level break, returning to the Section 
Data Sequencing form and then moving that column from the Selected Columns list back 
to the Available Columns list could cause unpredictable results.  
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• Page Break 

3. When completed, click Next to see Section Data Selection.  

► To select records to include in the section 

After you define sort properties for the section in the last task, the Section Data Selection form 
appears. 

 

1. On Section Data Selection, click the Operator column and choose an operator.  

Where is the default value in the Operator column for the first set of criteria. For subsequent 
statements, And and Or become the available values for the Operator column, and are 
selected by double-clicking the appropriate word.  

2. Click in the Left Operand column to display the list of available objects, and then perform 
one of the following actions:  

• Scroll through the list until you find the desired object, choose the object, and then 
double-click the object to populate the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to display the object in 
the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the Comparison 
column automatically appears.  
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3. Double-click one of the following comparison operators to select it:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

When you double-click the object for the Comparison column, the list in the Right Operand 
column automatically appears. The objects, special values, and variables that are available 
depend on the comparison operator that you choose.  

4. Double-click a value from the list in the Right Operand column to select it.  

Your choices in this column depend on the choice that you made in the Comparison column. 
Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal  Allows you to enter specific values, as described below  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

BC  Indicates that a business view column is available for this report  

FI  Indicates that a value passed through form interconnection to this report  

PC  Indicates the previous business view column  

PO  Indicates a processing option value for this report  

PV  Indicates the previous value for the variable  

RC  Indicates a constant from this report  

RV  Indicates a variable from this report  

SV  Indicates a system variable  

SL  Indicates a system literal  

TV Indicates a text variable 

VA  Indicates an event rule variable  

If you chose Literal for the Right Operand column, the form that appears enables you to enter 
any of the value types that are described below.  
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5. Select one of the following tabs, define the values, and then click OK.  

• Single value 

Enter a single value, and then click OK. For example, you might enter the address book 
number for a particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might include 
companies from 00001 to 00060. Only is equal to and is not equal to are valid logical 
operators when using range of values.  

• List of values  

To add values to or remove values from the list, perform the following:  

• Type each value in the field, and then press Enter or click the Add button at the top of 
the form.  

• Repeat this process until your list of values is complete. For example, a list of values 
might include several user-defined codes for search types, such as C for Customers, E 
for Employees, and V for Vendors. Only is equal to and is not equal to are valid 
logical operators when using a list of values.  

• Delete a value by choosing the value, and then clicking the Delete button at the top of 
the form.  

6. Repeat steps 1 through 5 to define more selection criteria rows.  

7. To delete a line of criteria on Section Data Selection, choose the row header to highlight the 
row, and then click the Delete button at the top of the form.  

8. To change the order of the criteria, choose the row header to highlight the row, and then click 
the up or down button.  

9. When you have completed defining selection criteria, click Next to see the Director's Finish 
form.  

See Also  
� Working with Level-Break Header and Footer Sections in the EnterpriseOne Report Writing 

Guide for detailed information about working with level breaks 

► To create a batch version of the report 

After you define the data selection for the section, the Director’s Finish form appears. 

1. On the Finish form, click Yes, create a version of this report to automatically generate a batch 
version of the template.  

2. Enter the version name in the field beneath Yes, create a version of this report. 

3. To review your choices, click Back to move backwards through the Director forms, or click 
the form on the Navigation Assistant that you want to review.  

4. When you are satisfied, click Finish.  
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Caution 

When you click Finish, you can no longer access the Director for this report. Prior to clicking 
Finish, you have one more opportunity to review your choices on all forms of the Director, as 
described in step 3.  

 

Report Design - Report View appears.  

See Also  
� Object Management Workbench in the Development Tools Guide for information on using 

OMW to create a batch version 

� Batch Versions for Reports in the EnterpriseOne Report Writing Guide for information on 
creating a batch version 

► To save a report  

After you click Finish on the Director’s Finish form, the Report Design form appears. 

On the Report Design form, perform one of the following actions:  

• From the File menu, choose Save.  

• Click the Save button on the toolbar.  

See Also 
� Object Management Workbench in the Development Tools Guide for more information on 

checking in a report 

See the following topics in the EnterpriseOne Report Writing Guide for information about using 
Report Design to modify or enhance your report: 

� Basic Report Enhancements 

� Advanced Report Enhancements 

Reviewing the Results of the Director 
When you click Finish, the Director process is complete. Based on the choices that you made during 
the process, Report Design displays the sections of your report and the data fields that you included in 
them. Each section includes the following:  

• An icon that displays the section type  

• Corner brackets enclosing each field within the section  

• A title description  

The title of the main detail section of the report uses a bold font to distinguish it from the 
titles of the other report sections.  
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Example: Creating a Group Report with the Director  
The sample group report below was created with the Director. It is based on the business view 
V41021E - Item Location, Item Master Join; and it uses the following columns from that business 
view:  

• Location  

• Item Number - Short  

• Primary Location (P/S) 

• Category G/L  

• Quantity on Hand - Primary units  

• Quantity on Backorder  

• Business Unit  

Additionally, the report displays items from Business Unit 27 only.  

 

► To create the example group report  

1. Launch the Report Design tool.  

2. On Report Design, choose New from the File menu.  

3. On Create New Report, complete the following fields: 

• Report Name 

• Description 

• Product Code 

The text that you enter in the Report Name field appears on the left side of the page header, 
and the text that you enter in the Description field appears in the center of the page header 
under the company name.  
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4. Select the following option and click OK. 

• No Update Report 

5. On the Director's Welcome form, choose Page Header and Group, and then click Next.  

6. On Page Header Details, click Next.  

7. On Business View Selection Option, choose the option under I'll Find a business view myself, 
and then click Next.  

8. On Select Business View, search for and choose the V41021E - Item Location, Item Master 
Join business view; and then click Next to see Section Layout. .  

9. On Section Layout, use the horizontal arrow buttons to select the following columns and 
move them to the Selected Columns column:  

• Location  

• Item Number - Short  

• Primary Location (P/S) 

• Category G/L  

• Quantity on Hand - Primary units  

• Quantity on Backorder  

• Business Unit  

10. Ensure that the columns are ordered as listed above. Use the vertical buttons to change the 
order of the selected business columns, if necessary.  

Note  

Check the correlation between the order of the columns on this form and the order of the 
columns on the report illustration.  

 

11. When the selected columns are arranged as shown, enter a 3 in the Number of Columns field, 
and then click Next.  

12. On Section Data Sequencing, use the horizontal arrow buttons to select and move the 
Location and Item Number - Short columns to the Selected Columns column.  

13. Ensure that the columns appear in the Selected Columns list as indicated in the figure above. 
Items on the report are sorted first by location and second, by item number.  

14. Click Next when the selected columns are arranged as shown.  

15. On Define Sort Properties, ensure the sort arrows point up (to alphabetize the report in 
ascending order in both categories), and then click Next to see Section Data Selection.  

Note 

Steps 15 and 16 limit the report to displaying records that are associated with Business Unit 27 only. 
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16. On the Section Data Selection form, fill out the grid fields as follows: 

• Operator - Where  

• Left Operand - Business Unit (F41021) (MCU) (BC) 

• Comparison - is equal to  

• Right Operand - <Literal>  

When you double-click <Literal>, Single value appears.  

17. Click the Single value tab, enter 27 in the Business Unit field, and click OK.  

18. On the Section Data Selection form, click Next.  

19. On the Finish form, enter the name of the version. 

20. Click Finish.  

21. On Report Design, click Save to save the report.  

22. Click the Preview tab to see the report.  

23. On Report Preview, click Yes. 

The report should look similar to the sample report illustration at the beginning of this 
section.  

24. Exit Report Design by clicking Exit from the File menu. 

Creating a Tabular Report  
A tabular report looks a lot like a columnar report, but it provides several additional features. A 
tabular report automatically totals columns. It also allows you to link the data in a column to the data 
in the database so that users viewing the report can click on data and see the database entry. This 
process is especially helpful for auditors and other users who need to see how an amount was derived. 
This feature is called the drill-down feature. 

After you create a new report object, use the Director to design a tabular report. The Director leads 
you through a linear process for creating a tabular report by asking you questions about its structure 
and content. When you have completed creating the report, you can enhance it by using additional 
features of Report Design. 

Prerequisite 
� Create a report object. The last step in creating a report object opens Report Design Director 

automatically. See Creating a Report Object in the Enterprise Report Writing Guide for 
detailed instructions on creating a report object. 

See Also  
� Characteristics of a Tabular Section in the EnterpriseOne Report Writing Guide for an 

overview of tabular sections and criteria for using them  
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► To choose report sections to include in the tabular report 

After you create a report object, Welcome to the Report Design Director appears.  

The Director includes a Navigation Assistant pop-up box that shows you where you are in the report 
creation process. You can hide the Navigation Assistant by right-clicking it and choosing Hide. 

 

1. On Welcome to the Report Design Director, click from the following headers and footers to 
include them in your report:  

• Report Header 

• Page Header 

• Page Footer 

• Report Footer 

2. Click the Tabular option, and then click Next.  

If you choose page header, Page Header Details appears. 

If you did not choose a page header, Business View Selection Option appears. Go to the next task. 

3. On Page Header Details, click one of the following options: 

• Automatically add the default informational fields shown below to my page header 
section. 

• Automatically add the default informational fields “Page n of Total” shown below to my 
page header section. 
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Notes 

After you complete the report using the Report Director process, you can use Report Design 
to add or delete data fields from the page header.  

If you turn both options off, the Director creates an empty page header. You can manually 
add data fields to the page header from the Section menu on the Report Design form.  

 

4. Click Next to see the Business View Selection Option.  

► To choose from a list of favorite business views 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'd like help finding an 
appropriate business view, and then click Next.  

2. On Favorite Business Views, open the folder that contains the business view that you want to 
use for your report section. Click the + icons to expand the tree until you see the business 
view that you want.  

3. Click the Description tab to see a brief description about the business view that you have 
chosen, if a description is available.  

 

4. Click the Columns tab to see the data fields that are included in the business view that you 
have chosen.  
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5. When you have chosen the business view that you want to use, click Next to see Section 
Layout.  

See Also  
� Setting up Business Views as Favorites in the EnterpriseOne Report Writing Guide for 

information about adding your own business views to the favorites list  

► To use Select Business View to find a business view 

After you choose the report sections for the report, Business View Selection Option appears.  

1. On Business View Selection Option, click the option under I'll find a business view myself. 

2. Click Next.  

3. On Select Business View, click Find or press Enter.  

The form displays a list of all of the available business views. You can narrow your search by 
entering search criteria in the QBE row.  

4. Choose a business view, and then click Next to see Section Layout.  

See Also  
� Business View Design in the Development Tools Guide  
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► To add business view columns to the section 

After you choose a business view as described in the previous task, Section Layout appears. 

1. From the Available Business View Columns list, choose the columns that you want in the 
report, and then click the arrow that is pointing to the right to move them to the Selected 
Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow to move all of the columns from the Available Business View 
Columns list to the Selected Columns list.  

The first item in the list appears as the left column in the report.  

2. To remove a column from your report, choose a column in the Selected Columns list, and 
then click the arrow pointing to the left to move it to the Available Business View Columns 
list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Business View Columns list.  

3. To change the order that the columns appear on your report, choose a column in the Selected 
Columns list, and then click the up or down arrow to move the selected column up or down 
one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. When you complete the layout of your section, click Next to see Section Data Sequencing.   
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► To define section data sequencing for the section 

After you select business view columns as described in the previous task, Section Data 
Sequencing appears. 

 

1. To select columns for section data sequencing, choose the columns from the Available 
Columns list, and then click the arrow that points to the right to move them to the Selected 
Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow that is pointing to the right to move all of the columns from the 
Available Columns list to the Selected Columns list.  

Note  

To define sort properties in the next task, you must select the column on which you plan to 
sort in this task.  

 

2. To remove a column from the Selected Columns list, choose a column in the Selected 
Columns list, and then click the arrow that points to the left to move it to the Available 
Columns list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Columns list.  
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3. To change the order of the columns that you selected for data sequencing, choose a column in 
the Selected Columns list, and then click the up or down arrow to move the selected column 
up or down one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

4. When you finish the section data sequencing for your report, click Next to see Define Sort 
Properties.   

► To define sort properties for the section 

After you define data sequencing as described in the previous task, Define Sort Properties 
appears. 

 

1. On Define Sort Properties, complete the following field:  

• Sort Order 
2. If you want to specify level and page breaks, complete the following fields:  

• Level Break 

Caution 

If you define a section data sequencing column as a level break, returning to the Section 
Data Sequencing form and then moving that column from the Selected Columns list back 
to the Available Columns list could cause unpredictable results.  
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• Page Break 

3. When completed, click Next to see Section Data Selection.  

See Also  
� Working with Level-Break Header and Footer Sections in the EnterpriseOne Report Writing 

Guide for detailed information about working with level breaks 

► To select records to include in the section 

After you define sort properties for the section in the last task, the Section Data Selection form 
appears. 

 

1. On Section Data Selection, click the Operator column and choose an operator.  

Where is the default value in the Operator column for the first set of criteria. For subsequent 
statements, And and Or become the available values for the Operator column, and are 
selected by double-clicking the appropriate word.  

2. Click in the Left Operand column to display the list of available objects, and then perform 
one of the following actions:  

• Scroll through the list until you find the desired object, choose the object, and then 
double-click the object to populate the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to display the object in 
the list, and then double-click the highlighted object.  
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When you double-click the object for the Left Operand column, the list in the Comparison 
column automatically appears.  

3. Double-click one of the following comparison operators to select it:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

When you double-click the object for the Comparison column, the list in the Right Operand 
column automatically appears. The objects, special values, and variables that are available 
depend on the comparison operator that you choose.  

4. Double-click a value from the list in the Right Operand column to select it.  

Your choices in this column depend on the choice that you made in the Comparison column. 
Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal  Allows you to enter specific values, as described below  

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

BC  Indicates that a business view column is available for this report  

FI  Indicates that a value passed through form interconnection to this report  

PC  Indicates the previous business view column  

PO  Indicates a processing option value for this report  

PV  Indicates the previous value for the variable  

RC  Indicates a constant from this report  

RV  Indicates a variable from this report  

SV  Indicates a system variable  

SL  Indicates a system literal  

TV Indicates a text variable 

VA  Indicates an event rule variable  
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If you chose Literal for the Right Operand column, the form that appears enables you to enter 
any of the value types that are described below.  

5. Select one of the following tabs, define the values, and then click OK.  

• Single value 

Enter a single value, and then click OK. For example, you might enter the address book 
number for a particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might include 
companies from 00001 to 00060. Only is equal to and is not equal to are valid logical 
operators when using range of values.  

• List of values  

To add values to or remove values from the list, perform the following:  

• Type each value in the field, and then press Enter or click the Add button at the top of 
the form.  

• Repeat this process until your list of values is complete. For example, a list of values 
might include several user-defined codes for search types, such as C for Customers, E 
for Employees, and V for Vendors. Only is equal to and is not equal to are valid 
logical operators when using a list of values.  

• Delete a value by choosing the value, and then clicking the Delete button at the top of 
the form.  

6. Repeat steps 1 through 5 to define more selection criteria rows.  

7. To delete a line of criteria on Section Data Selection, choose the row header to highlight the 
row, and then click the Delete button at the top of the form.  

8. To change the order of the criteria, choose the row header to highlight the row, and then click 
the up or down button.  

9. When you have completed defining selection criteria, click Next to see the Director's Finish 
form.  

► To create a batch version of the report 

After you define the data selection for the section, the Director’s Finish form appears. 

1. On the Finish form, click Yes, create a version of this report to automatically generate a batch 
version of the template.  

2. Enter the version name in the field beneath Yes, create a version of this report. 

3. To review your choices, click Back to move backwards through the Director forms, or click 
the form on the Navigation Assistant that you want to review.  

4. When you are satisfied, click Finish.  
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Caution 

When you click Finish, you can no longer access the Director for this report. Prior to clicking 
Finish, you have one more opportunity to review your choices on all forms of the Director, as 
described in step 3.  

 

Report Design - Report View appears.  

See Also  
� Object Management Workbench in the Development Tools Guide for information on using 

OMW to create a batch version 

� Batch Versions for Reports in the EnterpriseOne Report Writing Guide for information on 
creating a batch version 

► To save a report  

After you click Finish on the Director’s Finish form, the Report Design form appears. 

On the Report Design form, perform one of the following actions:  

• From the File menu, choose Save.  

• Click the Save button on the toolbar.  

See Also 
� Object Management Workbench in the Development Tools Guide for more information on 

checking in a report 

See the following topics in the EnterpriseOne Report Writing Guide for information about using 
Report Design to modify or enhance your report: 

� Basic Report Enhancements 

� Advanced Report Enhancements 

Reviewing the Results of the Director 
When you click Finish, the Director process is complete. Based on the choices that you made during 
the process, Report Design displays the sections of your report and the data fields that you included in 
them. Each section includes the following:  

• An icon that displays the section type  

• Corner brackets enclosing each field within the section  

• A title description  

The title of the main detail section of the report uses a bold font to distinguish it from the 
titles of the other report sections.  

76 



Example: Creating a Tabular Report with the Director  
The sample tabular report below was created with the Director. It shows the total amount in 
outstanding purchase orders for each business unit in a company. It is based on the business view 
V4311A - Purchase Order Detail Browse, and it uses the following columns from that business view:  

• Business Unit  

• Order Type  

• Amount Open  

The report is organized by company and displays item names. It is filtered to display only those 
purchase orders (as opposed to items ordered by other methods, such as purchase requisitions) for 
stocked parts that have a balance and are not yet closed. While this stipulation might seem obvious, 
you must plan for and define a filter when you set up the report.  

A tabular report format was selected for this report because of the automatic totaling and Display 
Column features of tabular reports.  

► To create the example tabular report  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose New from the File menu.  

2. On Create New Report, complete the following fields: 

• Report Name 

• Description 

• Product Code 

The text that you enter in the Report Name field appears on the left side of the page header, 
and the text that you enter in the Description field appears in the center of the page header 
under the company name.  

3. Select the following option and click OK. 

• No Update Report 

4. On Director's Welcome, choose Page Header and Tabular, and then click Next.  

5. On Page Header Details, click Next.  

6. On Business View Selection Option, choose the option under I'll find a business view myself, 
and then click Next.  

7. On Select Business View, search for and choose the V4311A - Purchase Order Detail Browse 
business view, and then click Next to see Section Layout.  

The Director has added a Description column for you already in Selected Columns.  

8. On Section Layout, use the horizontal arrow buttons to select the following columns and 
move them to the Select Columns column:  

• Business Unit  

• Order Type  
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• Amount - Open  

9. Ensure that the columns are in the order that is listed above. Use the vertical buttons to 
change the order of the selected business columns, if necessary.  

Note  

Check the correlation between the order of the columns on this form and the order of the 
columns on the report illustration.  

 

10. Click Next when the selected columns are arranged as shown.  

11. On Section Data Sequencing, use the horizontal arrow buttons to select and move the Order 
Company (from table F4311) and 2nd Item Number columns to the Selected Columns 
column. Ensure that the columns are in the order that is shown below, and then click Next.  

Note 

Note that this report is sorted on business view columns that are not included for display in 
the report.  

 

12. On Define Sort Properties, ensure the sort arrows point up (to alphabetize the report in 
ascending order by name) and that Level Break is selected for both business view columns. 
Then click Next.  

If these two columns have level breaks, then the Description Column displays properly, and 
the system displays totals for open orders each time that the system displays a new record.  

13. On Section Data Selection, filter data to appear on the report as follows, and then click Next. 
Note that each succeeding line of the filter is connected with an And operator. You must use 
And in this case because every data item must meet all of the criteria to be included in the 
report.  

• To include only purchase orders with a balance:  

• Left Operand - Amount - Open (F4311)  

Although you select Amount - Open (F4311) from the drop-down list, the item 
appears as BC Amount - Open (F4311) (AOPN). BC is a code that indicates the item 
is a business column.  

• Comparison - is greater than  

• Right Operand - <Zero>  

Note that you cannot enter a value of zero as a literal value.  

• To include only purchase order items (purchase orders in the F4311 table are indicated by 
the code PO):  

• Operator - And  

• Left Operand - Order Type (F4311)  

• Comparison - is equal to  

• Right Operand - OP  
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OP is a literal value. To insert it, select <Literal>. The Single value form appears. 
Click the Single value tab, enter OP in the Order Type field, and click OK.  

• To include only open purchase orders (indicated in the F4311 table by any code except 
999):  

• Operator - And  

• Left Operand - Status Code - Next (F4311)  

• Comparison - is not equal to  

• Right Operand - 999  

999 is a literal value.  

• To include only stocked items (indicated in the F4311 table by a code of S):  

• Operator - And  

• Left Operand - Line Type (F4311)  

• Comparison - is equal to  

• Right Operand - S  

S is a literal value.  

14. On Director's Finish, select No, I will create a version of this report later, and then click 
Finish.  

15. On Report Design, click Save to save the report.  

16. Click the Preview tab to see the report.  

17. Exit Report Design by choosing Exit from the File menu. 

Creating an Application Report with the Director 
Application reports can be created only through the Director. It provides director templates to help 
you create specific reports for EnterpriseOne systems, such as Financial Management, Asset 
Lifecycle Management, or Job Cost. EnterpriseOne provides director templates that contain common 
default criteria for the type of reports that are created. When you choose one of the templates, the 
Director reads the template specifications and presents the default criteria through the Director forms. 
You can modify these templates or create your own templates.  

Director templates allow you to use smart fields, which are data dictionary items (glossary group K) 
that are designed to retrieve and manipulate specific EnterpriseOne table data. For example, by 
adding the smart field FINRPTAB - Account Balance to your report, you create a column that 
calculates the account balance as of a specified financial period and fiscal year.  

Smart fields call business functions or named event rules. Business functions are programs that use 
data structures to do the following tasks:  

• Request specific data from EnterpriseOne tables.  

• Return the data to the established parameters in the data structure.  

• Perform some type of calculation or other manipulation on the data.  
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• Send the desired information, such as column headings and complex calculations, to your 
report.  

A named event rule is a business function that is created by using the event-rules scripting language. 
This scripting language is platform-independent and stored in a database as an EnterpriseOne object.  

Because the smart fields have already been created for you, you can include complex logic in your 
report without having to do any programming.  

For each smart field that you add to your report, you are prompted to define parameters that are 
specific to that smart field through a series of forms. Although the number and content of the forms 
vary, based on the smart field, the process occurs in three phases:  

• First, you are prompted to define how you want the column to appear in the report.  

• Second, you are prompted to define parameters, such as period number offset, journal entry 
amount, fiscal year offset, and so on. Some smart fields have only one parameter and, 
therefore, only one form in this phase; others have multiple parameters that you specify 
through a series of forms in this phase.  

• Third, you are prompted to limit the data that is returned by the report through data selection. 

Application reports also allow you to define calculation columns. Calculation columns contain values 
that are the result of a calculation involving two or more smart field columns. You can also perform a 
calculation between calculation columns. In a report based on a director template, the Director is 
aware only of the smart fields that are attached to the template; therefore, data fields included in the 
business view cannot be used in a calculation. After you complete the Director process, you can use 
Report Design to add calculation columns, based on other columns in the report.  

Note 

Values in calculation columns are based on how the amounts appear on the report, not on how they 
are stored in the data tables.  

 

In addition, application reports allow you to set additional properties. Additional properties provide 
the same functions as tabular section properties. They govern how the report runs and displays 
information. For example, if you do not want your report to display revenues as a negative value (-) 
and expenses as a positive value (+) as they appear in the database tables, you can choose to display 
them both as positive values. The additional properties that you can select can change, based on the 
selections that you made in the Report Director Templates program.  

Because application reports templates are customized, not all forms described in the tasks below 
appear. Some forms might not be relevant for the report template that you select. 

See Also  
See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with Director Templates for information about setting up templates to use when 
creating an application report  

� Creating a Report Object for information about starting the report design process and the 
Director 
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Prerequisite 
� Create a report object. The last step in creating a report object opens Report Design Director 

automatically. See Creating a Report Object in the EnterpriseOne Report Writing Guide for 
detailed instructions on creating a report object. 

► To choose an application report template 

After you create a report object, Welcome to the Report Design Director appears.  

The Director includes a Navigation Assistant pop-up box that shows you where you are in the report 
creation process. You can hide the Navigation Assistant by right-clicking it and choosing Hide. 

 

1. On Welcome to the Report Design Director, click the following options to indicate which 
headers and footers you want to include in your report:  

• Report Header 

• Page Header 

• Page Footer 

• Report Footer 

2. Under the Application Reports heading, click the down arrow to display a list of available 
director templates.  

3. Choose the template that is most appropriate for the type of report that you are creating and 
click Next. 

If you choose to include a page header, Page Header Details appears.  
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If you did not choose to include a page header, Business View Selection Option appears. Go 
to the next task.  

4. On Page Header Details, click one or both of the following options: 

• Automatically add the default informational fields shown below to my page header 
section. 

• Automatically add the default informational fields “Page n of Total” shown below to my 
page header section. 

Notes 

After you complete the report using the Report Director, you can use Report Design to add or 
delete data fields from the page header.  

If you turn both options off, the Director creates an empty page header. You can manually 
add data fields to the page header from the Section menu on Report Design.  

 

5. Click Next to see Business View Selection Option.  

► To choose from a list of favorite business views 

After you chose the report sections for the report, Business View Selection Option appears. 

1. On Business View Selection Options, click the option under I'd like help finding an 
appropriate business view, and then click Next.  

2. On Favorite Business Views, choose a business view. Click the + icon to expand the tree and 
view the available business views.  
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Click the Description tab to review a description of the business view. Click the Column tab 
to review the data fields included in the business view. 

 

3. Click Next to access Section Layout form.  

Caution 

The smart fields described in the task To add smart fields to an application report rely on 
business view columns in the default business view of the application report. If you select a 
business view other than the default, that business view must contain the business view 
columns that are required by the smart fields which you choose later; otherwise, the smart 
fields do not function properly. 

 

 

See Also  
� Business View Design in the Development Tools Guide for information about creating your 

own business views  

� Setting up Business Views as Favorites in the EnterpriseOne Report Writing Guide for 
information about setting up folders to hold frequently used business views  

► To use Select Business View to find a business view 

After you chose the report sections for the report, Business View Selection Option appears. 

1. On Business View Selection Option, click the option under I'll find a business view myself, 
and then click Next.  

2. On Select Business View, click Find or press Enter.  
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The form displays a list of all of the available business views. You can narrow your search by 
entering search criteria in the QBE row.  

3. Choose a business view, and then click Next. 

Caution 

The smart fields described in the task To add smart fields to an application report rely on 
business view columns in the default business view of the application report. If you select a 
business view other than the default, that business view must contain the business view 
columns that are required by the smart fields, which you choose later; otherwise the smart 
fields do not function properly. 

 

See Also  
� Business View Design in the Development Tools Guide  

► To add smart fields to an application report 

After you select a business view as described in the previous task, the Select Columns form 
appears.  

 

The Director automatically includes the Description column. When you are done using the Director, 
you can use Report Design to change the Description column size, column heading name, and 
position on the report.  

1. Drag the appropriate field from the Available Smart Fields list to the Columns in Report 
Section list.  

The Smart Field Name form appears and marks the first phase of defining data for the smart 
field.  
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2. Complete the following fields, and then click Next:  

• Variable Name  

Assign the smart field a unique variable name. If you attach event rules to this report or 
want to use the column in a calculation, and require this column to appear in the event or 
calculation, you can easily identify the column by what appears in this field.  

• Report Column Headings  

Enter the name for the smart field that you want to appear on the report.  

• Smart Column Heading  

Turn on this option if you want the report to include a name that corresponds to the 
specific value that is entered on the Smart Field Parameter - Column Heading form. For a 
financial smart field on a financial or distribution report, this name might be the name of 
the period, such as June. If the option is not turned on, the value of the Report Column 
Headings field appears on the report.  

• Show Multiples Parameters per Page 

Turn on this option if you want the report to show multiple parameters on each page. This 
will put five smart field parameters on each page of the director for easier viewing. 

One or more Smart Field Parameters forms might appear during the second phase of entering 
data for the smart field.  
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Note 

The Smart Field Parameter form varies, depending on which smart field you included. For 
example, if you chose the FINRPTAB smart field, the appropriate Smart Field Parameter 
form appears. 

 

3. Complete the following field, and then click Next:  

• Enter the Literal  

Leave the field blank to use the current year, enter a specific period number, or enter a 
number that is an offset to the current period number. For example, entering a 6 results in 
data for period 6 being retrieved. Entering a -1 results in data for the month prior to the 
current month being retrieved.  
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4. On Smart Field Parameters (Fiscal Year Offset), complete the following field, and then click 
Next:  

• Enter the Literal  

Leave the field blank to use the current year; enter the last 2 digits of a specific fiscal 
year, such as 05; or enter a number that is an offset to the current fiscal year, such as +1 
or -1.  

On Smart Field Data Selection, the fields vary, depending on the director template that you 
are using. This form marks the third phase of entering data for the smart field. 

 

5. Complete the fields to define the data that you want retrieved for the smart field column 
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6. If the displayed fields meet your data selection criteria, click Finish.  

If the displayed fields do not meet your data selection criteria, you can define your own data 
selection by choosing the Advanced option. When you click Next, the Column Data Selection 
form appears. From this form, you can define the criteria by which records are included in 
your report. 

 

7. Repeat steps 1 through 5 for each smart field column that you want to include in the report.  

You can click the Define Smartfield button on the Define Smartfields form to revise choices 
that you made for any of the smart fields.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Understanding the Description Column for additional information about the Description 
column 

� To performing manual data selection for information about how to use Column Data 
Selection 

► To create calculation columns  

1. On Select Columns, click Define Calculation.  

2. On Define Calculation, complete the following field:  

• Calculation Name  

This field appears on the report as the column heading.  

3. Choose one of the following calculation types:  

• Difference between  

• Percent variance between 
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• Undefined 

• Total of  

• Product of  

4. To define the Operands for your calculation column, perform one of the following tasks, and 
then click Finish:  

• If you chose Difference between, Percent variance between, or Product of, perform the 
following:  

• Under Operands, click the down arrow of the first operand field to display the 
existing columns, and then choose the column that you want to use as the first 
column in the calculation.  

• Under Operands, click the down arrow of the second operand field to display the 
existing columns, and then choose the column that you want to use as the second 
column in the calculation.  

• If you chose Total of, in the first Operands field, choose the columns that you want to 
include in your calculation total.  

To choose multiple columns, click each column that you want included.  

To remove a column from your calculation total, click the column to deselect it. It 
disappears from the Calculation Name field.  

• If you chose Undefined, a percent column is created without a calculation. You can 
define the percent calculation for the column after completing the steps of the Director 
and after rows have been created.  

5. On the Select Columns, repeat steps 1 - 4 for each calculation column that you want to create.  

6. When you have defined all of the calculation columns for your report, click Next on Select 
Columns to see Data Sequencing Help.  

See Also 
� Defining a Percent Calculation in the EnterpriseOne Report Writing Guide  

► To define section data sequencing with the Advanced option off 

When you select a smart field or a calculation on the Select Columns form, the director guides you 
through the process of setting up the smart field or calculation.  

When the smart field or calculation setup is complete, click Finish, and the Select Columns form 
appears. 

1. On Select Columns, click Next. 

2. On Data Sequencing Help, select the groups by which you with to sequence the report, and 
then click Next. 

Note 

If Help with Section Data Selection appears, proceed with the task To select records to 
include in an application report in the Enterprise Report Writing Guide. This form appears if 
the Display Financial Criteria option is chosen on the Report Director Templates Revisions - 
Properties tab for the template that you chose.  
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If Section Data Selection appears, you can define the criteria by which records are included in 
your report. This form appears if the Display Generic Criteria option is chosen on the Report 
Director Templates Revisions - Properties tab for the template that you chose. Proceed with 
the task To perform manual data selection in the Enterprise Report Writing Guide. 

 

 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Adding or Modifying Director Templates for information about the Display Financial Criteria 
and Display Generic Criteria options  

� To perform manual data selection for information about using Section Data Selection  

► To define section data sequencing with the Advanced option on 

When you select a smart field or a calculation on the Select Columns form, the director guides you 
through the process of setting up the smart field or calculation.  

When the smart field or calculation setup is complete, click Finish, and the Select Columns form 
appears. 

1. On Select Columns, click Next. 

2. Perform one of the following tasks:  

• Turn the Advanced option on to further define the sequencing for default Report 
Grouping or Report Detail fields.  

• Turn the Advanced option on and deselect the fields in the Report Grouping or Report 
Detail lists so that you can select your own data sequencing and level breaking.  

3. Click Next. 
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4. On Section Data Sequencing, to select columns for section data sequencing, choose the 
columns from the Available Columns list, and then click the right arrow to move them to the 
Selected Columns list.  

Alternately, you can drag each column individually into the Selected Columns list, or you can 
click the right double-arrow to move all of the columns from the Available Columns list to 
the Selected Columns list.  

5. To remove a column from the Selected Columns list, choose a column in the Selected 
Columns list, and then click the left arrow to move it to the Available Columns list.  

Alternately, you can click the left double-arrow to move all of the columns from the Selected 
Columns list to the Available Columns list.  

6. To change the order of the columns that you selected for data sequencing, choose a column in 
the Selected Columns list, and then click the up or down arrow to move the selected column 
up or down one line in the list.  

Alternately, you can drag a column to a new location in the list, or you can click the up or 
down double-arrows to move the selected column to the top or bottom of the list.  

7. When you have completed the section data sequencing for your report, click Next.  

If you selected any columns in addition to the default columns, Define Sort Properties 
appears. 
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8. On Define Sort Properties, complete the following fields, and then click Next:  

• Sort Order 

• Level Break 

Any report that includes a system-generated description column should sort on at least 
two columns, and the first two columns should be set as level breaks.  

• Page Break 

Note 

If Help with Section Data Selection appears, proceed with the task To select records to 
include in an application report in the Enterprise Report Writing Guide. This form appears if 
the Display Financial Criteria option is selected on the Report Director Templates Revisions - 
Properties tab for the template that you chose.  

If Section Data Selection appears, you can define the criteria by which records are included in 
your report. This form appears if the Display Generic Criteria option is selected on the Report 
Director Templates Revisions - Properties tab for the template you chose. Proceed with the 
task To perform manual data selection in the Enterprise Report Writing Guide. 
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See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Adding or Modifying Director Templates for information about the Display Financial Criteria 
and Display Generic Criteria options  

� To select records to include in an application report for information about data selection  

► To select records to include in an application report 

After defining section data sequencing using Data Sequencing Help or Section Data Sequencing, 
Help with Section Data Selection appears. This form appears only if the Display Financial Criteria 
option is selected on the Report Director Templates Revisions - Properties tab for the template that 
you chose.  

From Data Sequencing Help or Section Data Sequencing, click Next. 

On Help with Section Data Selection, perform one of the following tasks, and then click Next:  

• To select data only from the balance sheet accounts, click Select only BALANCE SHEET 
accounts from the automatic accounting instruction. This selection includes data fields that 
are appropriate for a balance sheet--that is, the account range that is established in your 
company's General Purpose (GLGxx) automatic accounting instructions.  

The Additional Properties form appears. 

• To select data only from the income statement accounts, click Select only INCOME 
STATEMENT accounts from the automatic accounting instructions. This selection includes 
data fields that are appropriate for an income statement--that is, the account range that is 
established in your company's General Purpose (GLGxx) automatic accounting instructions.  

The Additional Properties form appears. 

• To base your data selection on the default balance-sheet data selection, but add your own 
criteria, click Select only BALANCE SHEET accounts from the automatic accounting 
instructions, and then click I'll add my own data selection to the above balance sheet or 
income statement criteria. This procedure provides the criteria for including balance sheet 
accounts while letting you define additional criteria as well.  

The Section Data Selection form appears. 

• To base your data selection on the default income-statement data selection, click Select only 
INCOME STATEMENT accounts from the automatic accounting instructions, and then click 
I'll add my own data selection to the above balance sheet or income statement criteria. This 
option provides the criteria for including income statement accounts while letting you define 
additional criteria as well.  

The Section Data Selection form appears.  

• To set up data selection manually, click Set up data selection manually. This option lets you 
define criteria for which records appear in your report.  

The Section Data Selection form appears.  
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See Also  
� To perform manual data selection in the EnterpriseOne Report Writing Guide for information 

about using Section Data Selection  

� Understanding AAIs for General Accounting in the General Accounting Guide for more 
information about automatic accounting instructions 

► To perform manual data selection  

1. On Section Data Selection, click in the Operator column and choose an operator.  

Where is the default value in the Operator column for the first set of criteria. For subsequent 
statements, And and Or become the available values for the Operator column, and are 
selected by double-clicking the appropriate word.  

2. Click in the Left Operand column to display the list of available objects, and then perform 
one of the following tasks:  

• Scroll through the list until you find the desired object, choose the object, and then 
double-click the object to move it to the Left Operand column.  

• Type the first letters of the object name in the Left Operand field to display the object in 
the list, and then double-click the highlighted object.  

When you double-click the object for the Left Operand column, the list in the Comparison 
column appears.  

3. Double-click one of the following comparison operators to select it:  

• is equal to  

• is greater than  

• is greater than or equal to  

• is less than  

• is less than or equal to  

• is not equal to  

When you double-click the object for the Comparison column, the list in the Right Operand 
column automatically appears. The objects, special values, and variables that are available 
depend on the comparison operator that you choose.  

4. Double-click a value from the list in the Right Operand column to choose it.  

Your choices in this column depend on the choice that you made in the Comparison column. 
Some of the following options could be available:  

Blank  Enters a blank (space) value  

Literal  Allows you to enter specific values, described in step 5 

Null  Indicates that no value is associated with the field  

Zero  Enters a value of zero  

94 



BC  Indicates that a business view column is available for this report  

FI  Indicates that a value passed through form interconnection to this report  

PC  Indicates the previous business view column  

PO  Indicates a processing option value for this report  

PV  Indicates the previous value for the variable  

RC  Indicates a constant from this report  

RV  Indicates a variable from this report  

SV  Indicates a system variable  

SL  Indicates a system literal  

TV Indicates a text variable 

VA  Indicates an event rule variable  

5. If you chose Literal for the Right Operand column, click one of the following tabs: 

• Single value 

Enter a single value, and then click OK. For example, you might enter the address book 
number for a particular company.  

• Range of values 

Enter a range of values, and then click OK. For example, a range of values might include 
companies from 00001 to 00060. Only is equal to and is not equal to are valid logical 
operators when using range of values.  

• List of values  

To add values to remove values from the list, perform the following tasks:  

• Type each value in the field, and then press Enter or click the Add button at the top of 
the form.  

• Repeat this process until your list of values is complete. For example, a list of values 
might include several user defined codes for search types, such as C for Customers, E 
for Employees, and V for Vendors. Only is equal to and is not equal to are valid 
logical operators when using a list of values.  

• To delete a value, click the value, and then click the Delete button at the top of the 
form.  
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6. Click OK.  

7. Repeat steps 1 through 6 to define more selection criteria rows.  

8. To delete a line of criteria on Section Data Selection, choose the row header, and then click 
the Delete button at the top of the form.  

9. To change the order of the criteria, choose the row header, and then click the up or down 
button.  

10. When you have completed defining selection criteria, click Next to see Additional Properties.  

► To define additional properties for an application report 

After you define data selection using Help With Section Data Selection or Section Data Selection, 
click Next.  

1. On Additional Properties, choose the following options, as applicable: 

• AAI (Automatic Accounting Instructions) Subtotaling, based on Financial Statement 
(FSxx) AAIs  

• Reverse Sign For  

• Account Level of Detail Rollup  

• Drill Down  

• Zero Row Suppression  

If you choose Suppress Zero Detail Rows Only, header accounts print even if the detail 
accounts have a zero balance.  

2. Click Next to see Director's Finish.  

See Also  
� Understanding AAIs for General Accounting in the General Accounting Guide for more 

information about automatic accounting instructions  
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� Working with Objects in Report Sections in the EnterpriseOne Report Writing Guide for 
information about tabular section properties  

� Adding or Modifying Director Templates in the EnterpriseOne Report Writing Guide for 
information about displaying all, some, or none of the additional properties  

► To create a batch version of the report 

After you define the data selection for the section, the Director’s Finish form appears. 

1. On the Finish form, click Yes, create a version of this report to automatically generate a batch 
version of the template.  

2. Enter the version name in the field beneath Yes, create a version of this report. 

3. To review your choices, click Back to move backwards through the Director forms, or click 
the form on the Navigation Assistant that you want to review.  

4. When you are satisfied, click Finish.  

Caution 

When you click Finish, you can no longer access the Director for this report. Prior to clicking 
Finish, you have one more opportunity to review your choices on all forms of the Director, as 
described in step 3.  

 

Report Design - Report View appears.  

See Also  
� Object Management Workbench in the Development Tools Guide for information on using 

OMW to create a batch version 

� Batch Versions for Reports in the EnterpriseOne Report Writing Guide for information on 
creating a batch version 

► To save a report  

After you click Finish on the Director’s Finish form, the Report Design form appears. 

On the Report Design form, perform one of the following actions:  

• From the File menu, choose Save.  

• Click the Save button on the toolbar.  

See Also 
� Object Management Workbench in the Development Tools Guide for more information on 

checking in a report 

See the following topics in the EnterpriseOne Report Writing Guide for information about using 
Report Design to modify or enhance your report: 

� Basic Report Enhancements 

� Advanced Report Enhancements 
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Reviewing the Results of the Director 
When you click Finish, the Director process is complete. Based on the choices that you made during 
the process, Report Design displays the sections of your report and the data fields that you included in 
them. Each section includes the following:  

• An icon that displays the section type  

• Corner brackets enclosing each field within the section  

• A title description  

The title of the main detail section of the report uses a bold font to distinguish it from the 
titles of the other report sections.  
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Basic Report Enhancements 

After you create a report, either manually or through the Report Design Director, Report Design 
offers many features to help you refine the data, structure, and physical appearance of your report. 
You can add report sections and data fields; modify the properties of entire sections and individual 
data fields; add, move, or delete columns and rows; and perform calculations. You can also preview 
your report from the Report Design form as you make your changes. 

The Report Design user interface provides you with various views of the report and its component 
objects, tools for creating those objects, and tools for configuring your design workspace. These tools 
can do the following: 

• Preview reports. 

• Add attachments or comments.  

• View properties of report sections, fields, columns, and rows.  

• Configure your design workspace. 

• Add smart fields. 

• Create header and footer sections. 

• Work with level-break header and footer sections. 

• Join subsections. 

• Work with objects in report sections. 

• Modify the appearance of report objects. 

Previewing a Report from Report Design 
The Preview tab lets you see, while in design mode, how your report will appear when printed. Use 
the report preview to review your report for content and format as you make design changes.  

► To preview a report from Report Design 

On the Report Design form, display the report template. 

1. Click the Preview tab.  

The Report Preview form appears, asking if you want to run the preview.  

To prevent this form from appearing prior to previewing your report, from the View menu, 
choose User Options. Turn the Prompt before Running Preview option off.  

2. Click Yes on Report Preview.  

If you made changes since you last saved your report, Report Design prompts you to save 
prior to previewing your report.  

3. Click Yes to save the changes.  
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Report Design uses the Adobe Acrobat Reader to show the preview. You can use all of its 
functions to view the report.  

4. Each time that you make changes to the report, you must refresh the preview. To refresh your 
preview, perform one of the following:  

• From the View menu, choose Refresh Preview Window.  

• If the View toolbar is displayed, click the Refresh Preview Window button.  

• Push F5 on your keyboard.  

5. To change the number of table records to process and display in Preview mode, from the 
View menu, choose User Options.  

6. On User Options, complete the following field to indicate how many table records to process 
in the preview:  

• Rows to preview  

Adding Attachments or Comments  
You can attach media objects to reports and versions. A media object can be text, an image, a 
shortcut, or any file that conforms to the OLE (object linking and embedding) standard. For example, 
you can use attachments to provide generic help text about selected application reports that need to be 
made company-specific or to document changes that you made to a report. You cannot print 
attachments with a report; you can only view the attachments in Report Design.  

In addition to adding attachments to reports, you can attach text-only comments to individual data 
fields within your report.  

► To add or delete attachments to a report  

On the Report Design form, display the report template. 

1. Click the Attachments tab.  

The Attachments workspace is split into two panes. The left pane is the icon pane, and the 
right pane is the viewer pane.  

2. To add text, type the desired text in the viewer pane.  

You can use the formatting tools at the top of the viewer panel to format the text of your note.  

3. If you want to add an object that is not text, right-click in the icon pane.  

4. From the pop-up menu, choose New, and then choose one of the following:  

• Image  

• OLE  

• Shortcut  

• URL/File 

5. To remove an object, right-click the object's icon in the icon pane and choose Delete from the 
pop-up menu.  

100 



See Also  
� Working with Media Objects in the Foundation Guide for more information about image, 

OLE, and shortcut attachments  

► To add, modify, or delete comments to a data field 

On the Report Design form, click the Report tab (or Version tab if you are working with a 
version).  

1. Right-click the object to which you want to attach the comment, and then choose Insert 
Comment.  

 

2. Type the text, and then click anywhere in the design workspace to close the text window.  

A red flag appears in the upper-right corner of the object to indicate that a comment is 
attached to this object.  

3. To modify, delete, show, or hide the comment, right-click the object and choose the 
appropriate option from the pop-up menu.  
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Viewing Properties for Report Sections, Fields, 
Columns, and Rows  

Use Report Design to view the properties of a section, field, column, or row. 

• Section properties that you can view include general, font, color, fields, and advanced. You 
can view section properties using either the menu method or the double-click method. 

• Field properties that you can view include general properties, font, color, style, display, 
options, and advance properties. You can view data field properties using either the report 
section method or the double-click method. 

• Columns (both the headings and the variables) are treated by Report Design as fields, so you 
can use the same methods of viewing column properties as you can for viewing field 
properties. In addition, Report Design offers a third way to view column properties: the 
column tab method. 

• Rows exist in tabular sections only. You can view row properties by using either the report 
section method or row tab method. 

Throughout the remainder of this guide, to access Section or Properties forms, you are instructed to 
use the double-click method. If you prefer the other methods, then substitute them as desired. 

► To view a report section's properties using the menu method 

On the Report Design form, click the Report tab.  

1. Click the section for which you want to view properties.  

2. From the Section menu, choose Section Properties.  

Depending on the section type, the appropriate Section form appears.  

► To view a report section's properties using the double-click method 

From the Report Design form, click the Report tab.  

Double-click the section for which you want to view properties.  

Depending on the section type, the appropriate Section form appears.  

► To view a data field's properties using the report section method 

From the Report Design form, click the Report tab.  

1. Double-click the section containing the data field for which you want to view properties.  

Depending on the section type, the appropriate Section form appears.  
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2. Click the Fields tab. 

The Fields tab lists all of the data fields in the section. The various field types are represented 
by different icons in the Visible column as follows:  

• XXX. This icon represents a constant field.  

• Dual-shaded box. This icon indicates a column object. If the arrow is pointing to the top 
section, the icon refers to the column header. If the arrow is pointing to the bottom 
section, the icon refers to the column variable.  

• Gray, black, and white diamond. This icon represents a run-time field, such as report 
date, report time, page number, company title, or report title.  

• Multicolored diamond. This icon represents a variable in a group section. 

In all cases, if the data field is invisible, a circle with a line through it appears next to the 
icon. Double-click the icon to toggle the visible or invisible property.  

Note  

If a column header is invisible, its associated column variable is also invisible.  

 

3. Choose the data field for which you want to view properties and click Field Properties.  

Depending on the field type, the appropriate Properties form appears.  

► To view a data field's properties using the double-click method 

On the Report Design form, click the Report tab.  

Double-click the data field for which you want to view properties.  
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You can double-click data fields on the Report Design form and in the Report Tree form. 
Depending on the field type, the appropriate Properties form appears.  

► To view a column's properties using the column tab method 

On the Report Design form, click anywhere within the tabular section for which you want to view 
column properties.  

1. Click the Column tab.  

2. Right-click anywhere on the Column form grid.  

3. Click Field Selection.  

4. On Object Design Properties, use the Basic or Advanced tab to turn off or on any of the 
default field options, and then click OK.  

This action lets you determine what fields are displayed on the Column form grid.  

5. To change a property, from the Column form grid, double-click any field. Depending on the 
property that you are changing, an appropriate control appears.  

► To view a row's properties using the report section method 

On Report Design, click the Report tab.  

1. Double-click the tabular section containing the row for which you want to view properties.  

2. On Tabular Section, click the Row List tab.  

The Row List tab lists all of the rows in the section. The various row types are represented by 
different icons in the Visible column.  

In all cases, if the row is invisible, a circle with a line through it appears next to the icon. 
Double-click the icon to toggle the visible or invisible property.  

3. Choose the row for which you want to view properties and click Row Properties.  

Depending on the row type, an appropriate Properties form appears.  

► To view a row's properties using the row tab method 

From a tabular report, on Report Design, click the Row tab.  

1. Right-click anywhere on the Row form grid.  

2. Choose Field Selection.  

3. On Object Design Properties, use the Basic or Advanced tab to turn off or on any of the 
default field options, and then click OK.  

This action lets you determine what fields show on the Row tab grid.  

The Row grid displays fields, such as Display Decimals and Display Length, that override 
column properties. These fields appear with no data if they are not overriding what was set at 
the column level. 

4. If you want to change a property, from the Row tab grid, double-click any field. Depending 
on the property that you are changing, an appropriate control appears.  
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Configuring Your Design Workspace 
Report Design offers a variety of ways to configure your design workspace. Use Report Design to do 
the following tasks: 

• Set user options. 

User options let you show or hide the elements of the user interface, such as rulers and tabs. 
You can also set user options to control the number of rows to process for preview. 

• Set grid alignment. 

• Show and hide the display tree. 

The display tree is a dockable window in Report Design that lists the fields of your report in a 
hierarchical tree structure. 

• Show and hide the Business View Column Browser. 

The Business View Column Browser is a dockable window in Report Design that lists the 
business view columns you can use in your report.  

• Show and hide the Data Dictionary Browser. 

The Data Dictionary browser is a dockable window in Report Design that allows you to 
search the data dictionary for fields to use in your report.  

► To set user options 

On Report Design, from the View menu, choose User Options.  

1. On User Options, click any of the following options under the General heading, and then 
click Apply to see your changes immediately:  

• Show Invisible Sections at Startup  

• Show Section Titles  

This option displays the titles of sections to the left of each section. 

• Show Right Margin  

Showing the right margin is helpful when you change the orientation of your report 
because it enables you to see whether any fields fall outside the page's new margins.  

• Show Tabs  

This option displays the Report, Preview, Attachments, and other tabs at the top of the 
design workspace. 

• Show Navigational Assistant 

Compared to hiding the Navigation Assistant, which turns off the Navigation Assistant 
for the current report only, disabling the Navigation Assistant option turns off the 
Navigation Assistant for the current report as well as all o the reports that you create in 
the future.  

• Show Data Dictionary Text Overrides  
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This option displays a small triangle in the bottom right corner of the fields where the 
display name is not the same as the data dictionary name. The indicator appears in Report 
Design only; it does not print on the report.  

• Allow Smart Field Template Selection 

2. To show rulers at the top and side of the report, click the following option under the Rulers 
heading:  

• Show Rulers  

3. If you selected Show Rulers, complete the following field: 

• Ruler Units  

4. To display a prompt before running preview, click the following option under the Preview 
heading: 

• Prompt Before Running Preview 

5. If you selected Prompt Before Running Preview, complete the following field: 

• Rows to Preview 

6. Click OK. 

See Also 
� Previewing a Report from Report Design in the EnterpriseOne Report Writing Guide for 

information on how to preview a report 

► To set the grid alignment 

On Report Design, choose Grid Alignment from the Layout menu.  

1. On Alignment Grid, change the following spacing fields:  

• Horizontal  

Note 

If you are exporting your output to a Comma Separated Values (CSV) file on the Printer 
Setup form, PeopleSoft recommends that you set the Horizontal spacing to 52. This 
number corresponds to the default width of a column in Microsoft Excel. You should also 
turn on the Snap to Grid option. 

 

• Vertical  

The spacing value represents pixels on the workstation that are used for designing the 
report. The value is converted to a workstation-independent measurement when it is 
saved. This action ensures that the report maintains the same proportions when it is 
displayed on a different workstation.  

2. Choose the following options:  

• Display Grid  

This option displays grid lines in the workspace.  
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• Snap to Grid  

This option aligns objects to the nearest grid line. The option functions whether the grid 
lines are visible or not.  

3. Click OK.  

See Also 
� To export to Comma Separated Value (CSV) files in the EnterpriseOne Report Writing Guide 

for more information about the exporting to a CSV file   

► To show and hide the display tree 

On Report Design, display the report. 

1. To toggle the display tree on or off, on Report Design, from the View menu, choose Report 
Tree View.  

The display tree displays the sections that are included in the report as well as the objects 
which are associated with each section. Even invisible fields appear in the tree structure. The 
top-most component of the tree displays the name of the report. Under the report name, the 
first created section is displayed. Next to each component is a + or - sign. 

2. Expand (+) and collapse (-) the Report Tree by clicking the + or - sign.  

Expanding the first section displays a Fields folder. By expanding this folder, a list of objects 
that are included in this section appears (rows and cells do not appear in the Report Tree). If 
you expand a detail section and its Fields folder, two entries for each field appear. One entry 
represents the constant (header portion of field) and the other represents the variable (data 
portion of field).  

3. To view or change an object’s properties, double-click the object in the tree structure.  

Note 

The Report Tree shows only the structure of your report; it does not represent the processing 
flow for your report. You can use the Preview tab to see how your report will be formatted. 

 

 

► To show and hide the Business View Column Browser 

On Report Design, click on a detail section in your report.  

1. To toggle on or off the browser, from the View menu, choose Business View Columns 
Browser.  

Note 

Because you can only add business view columns to detail sections, you can only access the 
browser when a detail section is active.  
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2. To add a business view column to your report, drag it from the Business View Column 
Browser and drop it where you want it.  

► To show and hide the Data Dictionary Browser 

On Report Design, click on a detail section in your report.  

1. To toggle the browser on or off, from the View menu, choose Data Dictionary Browser.  

2. To add a data dictionary item to your report, drag it from the Data Dictionary Browser and 
drop it where you want it. 

Adding Smart Fields  
You can add smart fields to one or more detail sections of your report. Smart fields provide the ability 
to add complex, reusable calculations to your report. Smart fields are grouped by smart field 
templates. Therefore, before you can add a smart field, you must first attach a smart field template to 
the detail section.  

Every smart field template is based on a particular business view. If you attach a smart field template 
to a section and the section's business view is different from the business view that is required by the 
smart field template, then the system provides you the opportunity to change the section's business 
view.  

Caution 

If the business view attached to the section is not the same as the business view that is required by the 
smart field template, then any smart field which you add to the section might not function correctly.  

 

 

See Also 
� To add smart fields to an application report in the EnterpriseOne Report Writing Guide for 

more information on using the Smart Field Director 

► To choose a smart field template  

On Report Design, choose User Options from the View menu.  

1. On User Options, choose the following option, and then click OK.  

• Allow Smart Field Template Selection 

2. On Report Design, click the detail section to which you want to add a smart field.  

3. From the Section menu, choose Section Properties.  

4. On the Section form, click the General tab.  

5. Choose a smart field template from the Smart Field Template field, and then click OK.  
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► To add a smart field  

On Report Design, choose Smart Field from the Insert menu.  

On Create New Smart Field, choose a smart field.  

The Smart Field Director prompts you to set up the smart field.  

Creating Header and Footer Sections  
Report header and footer sections and page header and footer sections are special-purpose sections 
that contain constant, variable, and run-time fields. Typical information to insert in headers and 
footers includes your company name, the name of your report, the date when the report is printed, and 
page numbers. Because header and footer sections typically provide commentary or system-related 
information rather than data from tables, they are not associated with business views.  

When you create header and footer sections, they are added to the bottom of the report view in Report 
Design. However, when you print your report, the sections print in the order that is appropriate for the 
designated type of section.  

A report can contain only one report header, which prints once at the beginning of the report. A report 
header might include the title of the report or any other special notation. 

A report can contain only one report footer, which prints once at the end of a report. A report footer 
might include a legal disclaimer or some other text to conclude the report. 

A report can contain only one page header, which prints once at the beginning of each page of the 
report. A page header might include such data items as a company name, date title, page number, and 
date. 

A report can contain only one page footer, which prints once at the end of each page of the report. A 
page footer might include an explanation about what is found in the report. 

The properties of report headers and footers and page headers and footers are similar to the properties 
of group sections. 

See Also 
� Working with Objects in Report Sections in the EnterpriseOne Report Writing Guide for more 

information about adding data fields to a section and about modifying properties   

► To create a report header 

On Report Design, from the Section menu, choose Create, choose Headers and Footers, and then 
choose Report Header.  

An icon is added to the Report Tree window and a frame is added to the Report View 
window for the report header.  

1. Click the report header. 

2. Select fields from the Insert menu and add them to your section as needed by dropping them 
where you want them to appear. You can add any type of data field except business view 
columns; no business view is associated with this section.  
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3. From the Section menu, choose Section Properties or double-click the Report Header section 
to open the Report Header form.  

The Report Header form appears.  

► To create a report footer 

On Report Design, from the Section menu, choose Create, choose Headers and Footers, and then 
choose Report Footer.  

An icon is added to the Report Tree window and a frame is added to the report view window 
for the report footer.  

1. Click the report footer. 

2. Select fields from the Insert menu and add them to your section as needed by dropping them 
where you want them to appear. You can add any type of data field except business view 
columns; no business view is associated with this section.  

3. From the Section menu, choose Section Properties or double-click the Report Footer section 
to open the Report Footer form.  

► To create a page header 

On Report Design, from the Section menu, choose Create, choose Headers and Footers, choose 
Page Header, and then choose one of the following:  

• Section Only  

Choose his option to create a page header without any fields.  

• Auto Create  

Choose this option to create a page header that includes the system date, page number, 
company name, title, and report name fields.  

An icon is added to the Report Tree window, and a frame is added to the report view window 
for the page header.  

1. Click on the page header.  

2. Select fields from the Insert menu and add them to your section as needed by dropping them 
where you want them to appear. You can add any type of data field except business view 
columns; no business view is associated with this section.  

3. From the Section menu, choose Section Properties or double-click the Page Header section to 
open the Page Header form.  

The Page Header form appears.  

Note 

You can add extra white space between the report body and the header by placing a blank 
constant field below the header text.  
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► To create a page footer 

On Report Design, from the Section menu, choose Create, choose Headers and Footers, and the 
choose Page Footer.  

An icon is added to the Report Tree window, and a frame is added to the report view window 
for the page footer.  

1. Click the page footer.  

2. Select fields from the Insert menu and add them to your section as needed by dropping them 
where you want them to appear. You can add any type of data field except business view 
columns; no business view is associated with this section.  

3. From the Section menu, choose Section Properties or double-click the Page Footer section to 
open the Page Footer form.  

Note 

You can add extra white space between the report body and the footer by placing a blank 
constant field above the footer text.  

 

 

Working with Level-Break Header and Footer Sections  
In a report, a set of records that has the same value for one of its fields is said to be in the same level. 
For example, in a report that is sorted by telephone numbers, all of the records having the same area 
code would be in the same level. When the value in that field changes, that is known as a level break. 

Level breaks are useful because you can add processing when they occur. Two special report sections 
make adding processing to level breaks easy: the level-break header and level-break footer sections.  

Associated with detail sections, level-break headers and footers are used to group large numbers of 
records into smaller, more manageable units. You can define any data field as a level-break field. 
When the system processes the report, the level break triggers an event, such as the printing of a 
heading or total.  

You can also designate the level break to cause a page break. For example, you could designate 
Company as a level-break field and have a new page begin each time the value in the Company field 
changes.  

Level-break headers appear at the beginning of a level to define the information within a detail 
section. For example, if the level break is associated with telephone numbers, the level-break header 
announces the next group of phone numbers within a particular area code.  

Level-break footers define the information that is presented after a level break has occurred in the 
preceding level. You could use a level-break footer in an employee listing to produce salary totals by 
department.  

You can also make a level-break header or level-break footer section conditional so that it prints only 
if you tell it to print through a processing option. For example, you can create a report in which you 
want a total to print only when called by attaching the Hide Section system function to the level-break 
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header or footer section in Event Rules. Then, in the Initialize Section event, you add an event rule for 
a processing option that shows or hides the section, depending on the user's preference.  

By using Report Design, you can do the following: 

• Add a level-break header. 

A level-break header presents a descriptive heading that you want to appear at the beginning 
of a level of records. For example, in a report in which the Company field is a level break, a 
level-break header could print the company number and its description at the beginning of 
each level of company. Because of their free-form layout, group sections are used for level-
break headers. 

• Hide a level-break header. 

If you add a level break header, you might have the same data field in both your level-break 
section (if you turned on the Display selected columns as part of this section option) and your 
detail section. However, to avoid having it print in both sections, you can hide the data field 
in the detail section. 

• Associate a description with a level-break header. 

You might want to add a description to a field in your level-break header to make it more 
meaningful to the report reader. When you associate a description, the system displays the 
description that relates to the current level-break header record being read. For example, 
Company 00060 might have a description of Financial Reporting Company associated with it. 
When the level-break header is processed, this description prints along with the Company 
number. 

• Add a level-break footer. 

A level-break footer presents information that appears after the level break. Often, fields 
within the level-break footer are used for accumulating totals. If you are using the level-break 
footer to accumulate totals, then the values in those fields are calculated dynamically at run 
time. 

• Insert a description into a level-break footer. 

Add a description to the fields in your level-break footer to make it more meaningful to the 
report readers. 

After you create a level-break header or footer, you can modify its properties. A level-break header is 
always a group section. A level-break footer might be either a group or columnar section. 

See Also 
� Working with Objects in Report Sections in the EnterpriseOne Report Writing Guide for more 

information about modifying section properties 

► To create a level-break header 

On Report Design, click the detail section to which you want to attach a level-break header.  

1. From the Section menu, choose Create, and then choose Level Break Header.  
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2. On Level Break, under the Show heading, choose one of the following options:  

• all columns  

This option displays a list of all available fields in the business view that are associated 
with the detail section which you created.  

• only existing sort columns  

This option displays the fields that you chose as your data sequencing fields when you 
created the detail section.  

3. Choose one of the fields to designate it as a level-break field.  

4. If you want the field chosen as the level break to appear in the level-break header on the 
report, turn the Display selected column as part of this section option on.  

5. Click Finish.  

You can designate another field as a level-break field by modifying the section properties of 
the level-break header.  

In the report tree, the level-break header appears one branch below the section to which it is 
attached. In the report view, the level-break header appears within the detail section. The 
name of the level-break header usually begins with "On..." to indicate with which field of the 
section the level break is associated.  

► To hide the level-break field in the detail section 

On Report Design, select the detail section containing the level-break field that you want to hide. 

1. Double-click the variable or column variable portion of the level-break field.  

2. On Variable or Column Variable Properties, on the Advanced tab, turn the Visible option off.  

If you ever need to make this field visible again, in the report tree, double-click the object and 
turn the Visible option on. Alternatively, you can display the Section Properties form by 
double-clicking the detail section, click on the Fields tab, and toggle Visible on. 

See Also 
� Configuring Your Design Workspace in the EnterpriseOne Report Writing Guide for more 

information about using the report tree window   

► To associate a description with a level-break header 

On Report Design, click the variable portion of the level-break header field.  

1. From the Edit menu, choose Associate, and then choose Description.  

The cursor changes, allowing you to add the description to the level-break header.  

2. Place the Description field anywhere within the level-break header. As with any field, you 
can drag it to a new location.  

3. To change the properties of this field, double-click the field.  

4. On Associated Description Properties, change options as required.  
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► To create a level-break footer 

On Report Design, click the detail section to which you want to attach a level-break footer.  

1. From the Section menu, choose Create, and then choose Level Break Footer.  

2. On Level Break Footer, click one of the following options, and then click OK:  

• Group Section  

• Columnar Section  

3. On Level Break, under the Show heading, choose one of the following options:  

• all columns  

This option displays a list of all of the available fields in the business view that is 
associated with the detail section.  

• only existing sort columns  

This option displays the fields that you chose as your data sequencing fields when you 
created the detail section.  

4. Choose one of the fields to designate it as a level-break field.  

5. Click Next.  

 

An aggregate object is an object that holds the result of a calculation on the values in other fields. For 
example, the calculation could be a sum of values, an average of values, or a count of how many 
records exist. After adding a level-break footer and assigning the totaling conditions to the aggregate 
object within the level-break footer, you might need to change the totaling conditions to meet other 
reporting requirements.  

114 



6. On Aggregations, define the Operator and Operand.  

The Operator logic that you choose determines your choice of Operands. Choose one of the 
following Operators:  

Average of  Reports the average of all the amounts in the column  

Count of  Reports how many entries or records are in the column  

Maximum of  Reports the maximum amount for a record in this column  

Minimum of  Reports the minimum amount for a record in this column  

Total of  Reports the sum of the values in this column  

7. Click one of the following options under the Item display style heading:  

• Single overline  

• Double underline  

8. Click the Reprint section at page break option, if necessary.  

This option causes the last line from the previous page to be reprinted as the first line of the 
next page.  

9. Click Finish.  

Any time in the future, you can modify the aggregate object or add additional aggregate 
objects by clicking the level-break footer and choosing Add Aggregates from the Section 
menu.  

In Report Design, hover the pointer over the aggregate object; the fields in the detail section upon 
which the aggregate's calculations are based change color.  

In the report tree, the level-break footer appears one branch below the section to which it is attached. 
In the report view, the level-break footer appears within the detail section. The name of the level-
break footer usually begins with "On..." to indicate the field of the section with which the level break 
is associated.  

The level-break footer field appears below the column that it is totaling. 

See Also  
� To align fields or columns within or across report sections in the EnterpriseOne Report 

Writing Guide for information about aligning the level-break field with columns in the detail 
section  

► To insert a description into a level-break footer 

On Report Design, click the level-break footer section.  

1. From the Insert menu, choose Constant Field.  

2. Insert the constant field by clicking in the level-break footer where you want the object to 
appear.  
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3. Double-click the constant field.  

4. On Constant Properties, change the Variable Name field to a meaningful description.  

See Also 
� Working with Objects in Report Sections in the EnterpriseOne Report Writing Guide for more 

information about changing an object's associated text description 

Example: Adding Level Breaks to a Detail Section  
This example illustrates adding a level-break header and footer to an existing report. 

Note 

For this example, you will modify the example report described in Creating a Columnar Report. See 
that task for information about creating the base report. The report below differs from that report in 
that a level-break header and footer is associated with the business unit field.  

 

Even though an aggregate function is performed on one column (totaling the salaries), that field is not 
designated as a level break. Business unit is the level break for the footer because the report totals all 
of the salaries for each business unit.  

► To add level breaks to a detail section  

Launch the Report Design tool and open the R5607COL report.  

1. To create the level-break header, choose Create from the Section menu, and then choose 
Level Break Header.  

2. On Level Break, choose Business Unit – Home, choose to display the data field in the header, 
and then click Finish.  

Report Design displays the header section within the columnar section.  

The sample report includes a description for Business Unit - Home as well as its number.  

3. To include the description, click the variable part of the Business Unit - Home field and 
choose Associate Description from the Edit menu. 

4. Click the header section to place the description field, and then move it next to the Business 
Unit - Home field.  

The sample report does not repeat the Business Unit - Home column in the columnar section.  

5. To hide the field, double-click Home Business Unit in the columnar section, click the 
Advanced tab on the resulting Properties form, and choose to make the field invisible.  

6. Click OK.  

7. To create the level-break footer, click the columnar section and then choose Cerate Level 
Break Footer from the Section menu.  

The Level Break Footer form appears.  
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8. Because the columnar section is visible and the example lines up the salary totals with the 
salary columns, choose Group Section and click OK.  

9. On Level Break, Choose Business Unit - Home and click Next.  

 

10. To sum the annual salaries for each business unit, set the Operator to Total of and set the 
Operand to Rate - Salary, Annual.  

11. Choose a single overline and click Finish.  

Report Design displays the footer section within the columnar section. 

Note  

The order of the header and footer sections within the columnar section have no bearing on 
how they appear in the printed report.  

 

12. Click the Preview tab to see the report, which should look similar to the sample report 
illustration at the beginning of this section.  

Joining Subsections  
Suppose you need to create a report, and none of the business views that are available have all of the 
data fields which are required for the report. Must you create your own business view to include all 
the required fields? Not necessarily. Rather, you can create two sections in your report with two 
different business views that share common fields. Then you can join these two sections by using a 
process called a subsection join. A link is established between the two sections by using the common 
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fields that exist between the business views. The two sections are referred to as the parent (generally 
a master table) and child (generally a secondary table) sections. The parent section regulates the 
processing of the report. After each field in the parent section is processed, all of the corresponding 
records in the child section are processed. 

For example, you can create a report to join A/P Voucher Details – PO Match (V0411V) information 
to G/L Transaction Detail Report  (V0911G) information. Because the A/P Voucher and G/L 
Transaction business views both include the Document Type and Document Number fields, you can 
establish the subsection join based on these fields.  

Using Report Design, you can do the following: 

• Create a subsection join. 

• Modify or sever a subsection join. 

After creating a subsection join, some modification might be required. For example, you 
might need to change the fields on which the sections are joined. You can also choose to 
sever the join between the two sections. 

• Join two existing detail sections. 

If your report contains two detail sections that share common business view fields, you can 
create a subsection join between these two sections. 

Prerequisite 
� This documentation assumes that the detail section to be used as the parent section has 

already been created. If this detail section has not been created, see Creating Detail Sections 
in the EnterpriseOne Report Writing Guide for information about creating the parent section.  

► To create a subsection join 

On Report Design, click the columnar or group section to be used as the parent section.  

1. From the Section menu, choose Create, Sub-Section Join, and then one of the following 
options to create the child section:  

• Group 

• Columnar 

2. On Business View Selection Option, choose the business view for the child section in the 
same way as you would for any detail section, and click Next.  

The business view that you choose for the child section must have at least one field that is 
also in the business view for the parent section.  

3. On Favorite Business Views, choose the business view that you need, and then click Next. 

4. On Section Layout, choose the business view columns to include in the child section, and 
click Next.  

5. On Sub Section Join, under the Parent heading, click the following field and choose the 
parent section to which you want to join the subsection:  

• Join to  

6. Choose business view columns from the list boxes in the Child columns that are common 
with the business view columns in the Parent columns and variables.  
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7. Click the following option as necessary:  

• Join only at level breaks defined in the parent section  

This option processes the records in the child section only after all of the records for 
defined level breaks in the parent section have first been processed. This action is critical 
when joining tables that have a many-to-many relationship-- for example, a detail file 
joined to a transaction file.  

8. After you have completed entering columns in the child section to join with the parent 
section, click Finish.  

9. The child section has a chain-link icon, indicating that it is now joined to and resides within 
the borders of the parent section.  

10. If necessary, define data sequencing for the child section by performing the following: 

• Click the child section.  

• From the Section menu, choose Define Data Sequence.  

• On Section Data Sequencing, choose any data fields that you want to use to sequence 
your report.  

• Click OK.  

11. Modify the fields in the child section as necessary to enhance the report's appearance.  

See Also 
� To select a business view in the EnterpriseOne Report Writing Guide for more information 

about finding a business view 

► To modify or sever a subsection join 

Use one of the following navigations:  

On Report Design, to make modifications to the subsection join, double-click the child section.  

From the Section menu, choose Section Properties.  

The Columnar Section or Group Section form appears, depending on what section type you 
used to create the child section.  

1. From the Sub Section Join tab, modify as necessary.  

2. To sever a join, click the Sub Section Join tab, and click No Join.  

3. Click OK.  

The child section is now separated from the parent section.  

► To join two existing detail sections 

On Report Design, click the detail section you want to join to another section in the report.  

This section will become the child section.  

1. From the Section menu, choose Sub-Section Join.  
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2. On Define Sub-Section Join form, under the Parent heading, click the following field and 
choose the parent section to which you want to join:  

• Join To  

3. Choose columns from the list boxes in the Child columns (data fields from the business view 
of the child section) that are common with the columns in the Parent columns and variables 
(data fields from the business view of the parent section).  

4. Choose the following option as necessary:  

• Join only at level breaks defined in the parent section  

This option processes the records in the child section only after all records for defined 
level breaks in the parent section have first been processed. This action is critical when 
joining tables that have a many-to-many relationship-- for example, a detail file joined to 
a transaction file.  

5. After you have completed entering columns in the child section to join with the parent 
section, click OK.  

6. The child section has a chain-link icon, indicating that it is now joined to and resides within 
the borders of the parent section.  

Working with Objects in Report Sections  
Report sections can contain numerous report objects. These objects are data fields. A specialized type 
of data field is a column. This section  discusses the properties of various report objects, including: 

• Business view columns  

• Data fields 

• Tabular sections 

See Also  
� Modifying the Appearance of Report Objects in the EnterpriseOne Report Writing Guide for 

information about changing a data field's size, font, color, and so on  

Working with Business View Columns 
You can add business view columns to and remove them from any detail section that has a business 
view associated with it.  

► To add or remove a business view column in a detail section 

On Report Design, click the detail section.  

1. From the View menu, choose Business View Columns Browser.  

The form that appears lists the columns in the business view that are associated with the 
section.  

2. Drag one or more columns to your detail section.  
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3. To close the Business View Columns Browser, from the View menu, click Business View 
Columns Browser 

Alternatively, you can click the Close (X) button on the title bar of the form.  

4. To move the column, drag it to the new location.  

5. To remove a column, choose it (either the header or the body) and from the Edit menu, 
choose Delete.  

Understanding Data Fields 
Residing in report sections, data fields are individual data containers. Page numbers, dates, and the 
name of the report are all examples of data fields. You can add data fields to any type of report 
section, although not every data field type can be added to every report section type. You might have 
already added some data fields such as report name, date, and so forth to the report when you created 
it.  

After creating the report, you can do the following: 

• Add data fields. 

• Delete data fields. 

• Change a data field’s variable name. 

• Change a column header’s text. 

• Disconnect a constant’s text from its variable in a group section. 

At times you might want to separate the text from the variable that it describes. For example, 
your report might contain a data field called Business Unit and another field called 
Description. Changing the constants of the two data fields to read Business Unit Number and 
Name might render the report easier to understand. By disconnecting the text from the 
variable, you can still retrieve the value for Business Unit from the EnterpriseOne table; 
however, you can present the data to the reader with a more meaningful description. 

• Perform in-section totaling. 

Most of the time, when you perform a calculation on a column, you want to format and 
display the total so that the report is easy to read. In these cases, you typically perform the 
totaling in a level-break footer. Occasionally, you might not be concerned with how the 
calculation is displayed. For example, you might perform a calculation in one hidden section 
for use in another. When formatting is not an issue, you can perform calculations easily 
within a section. You can calculate a total, a grand total, or both. 

• Change decimal scaling. 

Decimal scaling allows you to simplify the way in which a report displays large numbers. 
You can change decimal scaling for a single field in a tabular section, for all fields in a 
tabular section, or for all fields in all detail sections. 
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The following table describes the data fields that you can insert directly:  

Constant 
Field  

A static item that is used to display a string of text, such as a company name inserted 
in the page header. Constant fields can be inserted into any report section. 

Alpha 
Variable  

A field that is used to hold alphanumeric information defined by an event rule. 
Alpha variables can be inserted into any report section. 

Numeric 
Variable  

A field that is used to hold numbers, typically with calculation columns. Numeric 
variables can be inserted into any report section. 

Date Variable  A field that is used to hold dates. Date variables can be inserted into any report 
section. 

Report Date  A run-time field that is used for the date when the report is run. Report dates can be 
inserted into any report section except columnar and tabular. 

Report Time  A run-time field that is used for the time the report is run. Report times can be 
inserted into any report section except columnar and tabular. 

Page Number  A run-time field that is used for the current report page number. Page numbers can 
be inserted into any report section except columnar and tabular. 

Page n of 
Total  

A run-time field that is used for the current report page number with the total 
number of pages in the report appended (such as "Page 4 of 10"). Page n of total can 
be inserted into page headers and footers only.  

Company 
Title  

A run-time field that is used for the name of the default company (company 00000). 
Company titles can be inserted into any report section except columnar and tabular. 

Report Title  A run-time field that is used for the title of the report. A report title can be inserted 
into any report section except columnar and tabular. 

Data 
Dictionary 
Field  

A field from the data dictionary. Data dictionary fields can be inserted into any 
report section. 

Text Variable A field that is used to hold text. Text variables can be inserted into any report 
section. 

Data fields inserted into columnar and tabular sections appear in columnar format. The heading is a 
constant and the body is a variable. The heading and body are linked so that if you move or delete 
one, Report Design moves or deletes the other.  

In group sections, data fields are also made of a constant and a variable portion, although initially 
they appear side by side instead of in a columnar format. Unlike columnar and tabular sections, 
however, the two components can be moved independently of each other. Furthermore, by 
disconnecting the two, you can separate the constant from the variable and delete it without deleting 
the variable.  

You can modify the appearance of a data field by changing its heading, moving it, changing its size, 
font, or color, or associating lines or a box with it. You can modify the behavior of a data field by 
associating an event rule with it.  
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See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Modifying the Appearance of Report Objects for information about changing a data field's 
size, font, color, and so on  

� Working with Event Rules for information about creating event rules and associating them 
with a data field  

► To add or remove a data field in a report section 

On Report Design, click the report section that you want to modify.  

1. From the Insert menu, choose the field you want to add.  

Your data field choices vary, based on the report section that you selected.  

In columnar and tabular sections, the data field is automatically inserted to the right of any 
column on which you are focused. If you did not focus on a specific column, the field is 
inserted to the left of the first column.  

In group sections, you must click in the group section to place the data field after selecting it 
from the Insert menu.  

2. To move the field or column, drag it to the new location.  

3. To remove a data field, click it and choose Delete from the Edit menu.  

► To change a data field variable name  

On Report Design, double-click the data field that you want to change.  
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1. If the data field is based on a business view column, you must override the business view 
column name by clicking the one of the following options:  

• Change Name  

• Override Name 

The Variable Name field is disabled until you click the Change Name or Override Name 
option.  

2. Change the text in the Variable Name field and click OK.  

Note 

A change in the variable name of a constant field in any section, except columnar and tabular 
sections, is reflected on the report itself. All other variable name changes do not affect the 
data field's appearance directly. If you change a component's variable name, you should 
change its partner's variable name as well to make managing the data field easier (especially 
if you will be attaching event rules to the data field).  

 

 

► To change a column header's text  

On Report Design, double-click the column header that you want to change.  

The Column Heading Properties form appears.  

 

1. If the column is based on a business view column, you must override the business view 
column names by clicking the following option: 

• Override Col Headings.  

The Column Description fields are disabled until you click Override Col Headings again.  
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2. Change the text in the Col Heading 1 and Col Heading 2 fields and click OK.  

Columns can have two-line headings. Col Heading 1 corresponds to the top line of the 
column heading, and Col Heading 2 to the bottom.  

Note 

You should always change a data field's variable name to match its column name if you 
change its column name; this action makes managing the data field easier (especially if you 
will be attaching event rules to the data field).  

 

 

► To disconnect constant text from its variable in a group section 

Caution 

After you disconnect the constant text from its variable, the two cannot be reconnected on the report. 
If necessary, you can delete the disconnected text and variable and then place the business view 
column on the report again. The new data field appears as it did originally with a constant field linked 
to its variable.  

 

Click the constant or its associated variable.  

1. From the Edit menu, choose Disconnect.  

2. You can now move, format, or delete the text and the variable independently.  

► To perform in-section totaling  

On Report Design, choose Report Properties from the File menu.  

1. On Properties, click the Report Properties tab. 

2. Choose one or both of the following options, and then click OK:  

• Print Totals Only 

• Print Grand Totals 

3. Double-click the variable portion of a numeric column for which you want to calculate a 
total.  

Note 

The variable portion of a numeric column is signified by a formatted series of “9”s; for 
example “99,999.99-“. 

 

4. On Column Variable Properties, click the Totaling tab.  

5. Choose one or both of the following options:  

• Total  
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• Grand Total  

These two options correspond to the two options you selected in step two. You must choose 
Print Totals Only on the Properties form for the Total function to work correctly. Likewise, 
you must choose Print Grand Totals on the Properties form for the Grand Total function to 
work correctly.  

6. Choose an aggregate function, and then click OK.  

Depending on the options you selected, the system adds one or two lines to the bottom of 
each column before each section break. If you selected both Total and Grand Total, the Total 
line appears before the Grand Total line. The lines are not labeled; in fact, except for the 
column showing the total, information for each column is repeated in the total line.  

You can suppress totals for fields you are not totaling and that you do not want to display on this line. 

Changing Decimal Scaling  
Decimal scaling allows you to simplify how a report displays large numbers. For example, if your 
report is scaled to 1000, the report would show the following amounts:  

Original Value  Displayed Value  
100,000.42  100  

10,041.62  10  

1,021.75  1  

1,512.69  1.5  

  

► To change decimal scaling for a field in a tabular section 

On Report Design select the tabular section containing the column you wish to change, 

1. Double-click the variable portion of the numeric column that you want to change.  

2. On Column Variable Properties, click the Decimal Scaling tab and select the level of decimal 
scaling that you want.  

To return all of the section's fields to their default decimal scaling settings, click Defaults.  

3. When finished, click OK.  

► To change the decimal scaling for all fields in a tabular section 

On Report Design, double-click the tabular section that you want to change, or click the section 
and choose Section Properties from the Section menu.  

1. On the Section form, click the Decimal Scaling tab and select the level of decimal scaling that 
you want.  

To return all of the the section's fields to their default decimal scaling settings, click Defaults.  
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Changes that you make on this form affect all of the numbers in the section, except for those 
fields that have been changed individually. To override individual settings and apply the 
changes to all fields in the section without exception, choose Apply settings to all Objects.  

2. When finished, click OK.  

► To change decimal scaling for all fields in all detail sections of a report 

On Report Design, from the File menu, choose Report Properties.  

1. On Properties, click the Decimal Scaling tab and select the level of decimal scaling that you 
want.  

To return all of the report's fields to their default decimal scaling settings, click Defaults.  

Changes that you make on this form affect all numbers in the report, except for those fields 
that have been changed individually. To override individual settings and apply the changes to 
all of the fields in the report without exception, choose Apply settings to all Objects.  

2. When finished, click OK.  

Note  

Changes to properties at the report level are not reflected in the report's existing batch 
versions.  

 

 

Working with Tabular Sections  
Tabular sections are a specialized type of columnar section that presents report data in columns, rows, 
and cells. When you include data fields that display numeric values, tabular sections automatically 
total the values in the fields. For example, if you include an object that displays Open Amounts, 
tabular sections calculate a grand total of all the Open Amounts in the section. 

When you create a tabular section, observe the following guidelines for columns, rows, and cells: 

Defining 
columns only  

Define columns when you base the information for your report solely on the data 
that is contained in tables. When you define columns only, Report Design creates 
rows that are based on selection, sequence, and level break criteria that you provide. 

Defining 
columns and 
rows  

Row information is set up horizontally on your report. Define rows in addition to 
columns when you include details in your report, such as underlines, spaces, and 
blank lines, as well as special calculations, such as interim totals. Tabular sections 
are the only detail section for which you can define rows.  

Defining 
columns, rows, 
and cells  

A cell is the intersection of a column and row. Define cells if you want to override 
information that is defined by columns and rows in individual cells.  
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Working with Columns in Tabular Sections  

Although columnar and tabular sections both contain columnar data, tabular sections differ from 
columnar sections because they offer a variety of special-purpose columns as well. These columns 
include smart field columns, calculation columns, description columns, and percent calculation 
columns. 

Creating Smart Field Columns 

Smart fields are data dictionary items (glossary group K) designed to retrieve and manipulate specific 
EnterpriseOne table data. For example, by adding the smart field FINRPTAB - Account Balance to 
your report, you create a column that calculates the account balance as of the specified financial 
period and fiscal year.  

Smart fields call business functions or named event rules. Business functions are programs that use 
data structures to do the following:  

• Request specific data from EnterpriseOne tables.  

• Return the data to the established parameters in the data structure.  

• Perform some type of calculation or other manipulation on the data.  

• Send the desired information, such as column headings and complex calculations, to your 
report.  

A named event rule is a business function that is created by using the event rules scripting language. 
This scripting language is platform independent and stored in a database as a EnterpriseOne object.  

Because the smart fields have already been created for you, you can include complex logic in your 
report without having to do any programming.  

When you choose to create a smart field from the Column menu, the smart field director leads you 
through a series of forms to help you set up the smart field parameters and values. The option to 
create smart field columns is grayed out if no smart fields are associated with the attached business 
view.  

► To create or delete smart field columns 

On Report Design, click the section that you want to change.  

Note 

When you create a smart field, you define what type of section it is used in.  If you have not created a 
smart field for the type of section you are editing, the Smart Field option is not available in the Create 
menu. Because there are several predefined smart fields for application reports, smart fields are 
always available to the main section of an application report. For information on defining smart 
fields, see Adding Smart Fields in the Enterprise Report Writing Guide. 

 

1. From the Column menu, choose Create and then Smart Field.  

The Create New Smart Field form appears with a list of smart fields included in the template 
associated with the section. 

2. Choose the smart field that you want to work with, and then click Next.  
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3. Repeat steps 1-4 for each smart field column that you want to create.  

4. To move the column, drag it to the new location.  

5. To delete the column, click it and select Delete from the Edit menu.  

See Also 
� To add smart fields to an application report in the EnterpriseOne Report Writing Guide for 

information about working with the smart field forms that appear  

Defining Calculation Columns 

Calculation columns contain values that are the result of a mathematical calculation. You can perform 
a calculation involving any number of columns or no columns. The columns that the calculations are 
performed on can include any columns in the business view, including columns that contain smart 
fields or other calculations.  

Caution 

Calculation columns are based on the amount signs as they appear in the report, not the actual value 
(debit or credit).  

 

The following instructions discuss: 

• Defining calculation columns 

• Removing a column calculation  

► To define calculation columns 

On Report Design, select the tabular section in which you need to add a calculation column. 

1. Insert a field (usually a data dictionary or numeric variable field) to hold the calculated value. 

Note 

For information on adding a variable field, see To add or remove a data field in a report 
section in the Enterprise Report Writing Guide. 

 

2. To move the column, drag it to the new location.  

3. Click the newly created column.  

4. From the Column menu, choose Define Calculation.  

5. On Expression Manager, define your calculation by performing the following actions, and 
then click OK:  

a. Double-click fields from the Available Information list.  

b. Click the calculator functions to build your expression.  

c. Repeat until your calculation expression is complete.  
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► To remove a column calculation 

On Report Design, click the Column variable that has a calculation attached.  

1. From the Column menu, choose Remove Calculation.  

The Remove Calculation form appears, asking if you want to delete the calculation for this 
column.  

2. Click Yes.  

See Also  
� To create an event rule assignment in the EnterpriseOne Report Writing Guide for 

information about attaching a calculation to a column  

Understanding the Description Column 

When you create a report using a tabular section, the Description column is automatically included. 
When the report prints, the data in this column is based on fields that are designated as level-break 
fields. If the system cannot retrieve a description for the field (the field must have a data dictionary 
trigger), the key for the field is printed instead. For example, if the level-break field is company 
00001, the description Financial Reporting Company prints if a trigger exists. Otherwise, the key 
00001 prints.  

Except as noted below, at the lowest level break of a tabular section, this column becomes the row 
description. At higher level breaks, the Description column becomes level-break header or footer text.  

The Description column has a special capability for level breaks that are associated with the 
Subledger, Cost Object, and Object Subsidiary fields. When a row of a tabular section prints due to a 
level break caused by a change in one of the following fields, the Description row automatically 
appears:  

• Subledger and Subledger Type  

• Cost Object and Cost Object Type  

• Object Subsidiary and Object Subsidiary Type  

► To create a Description column manually 

On Report Design, click the tabular section to which you need to add the Description column. 

From the Column menu, choose Create, and then choose Row Description Column. 

The Description column appears. To move it, drag it to a new location. 

► To delete the Description column 

On Report Design, select the Description column. 

From the Edit menu, select Delete. 
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Defining a Percent Calculation 

You might need to present numbers in one column as a percent of their total in another column. This 
type of calculation is used in all reporting types but most often in standard income statements. When 
used in income statements, the percent calculation is referred to as the percent of revenue.  

Prerequisites 
� Do one of the following:  

� Create a percent calculation column in the Director. For example, if you are creating a 
financial report that is based on Account Balances, create a column called Percent of 
Revenue. See Working with Columns in Tabular Sections in the Enterprise Report 
Writing Guide for information about creating the column.  

� Create a numeric variable column from Report Design. See Understanding Data Fields 
in the Enterprise Report Writing Guide for additional information on creating a numeric 
variable column   

� Add rows to your report. This step is necessary to create the 100% cell to use in the 
denominator. For example, add data rows to hold the revenue sales and a calculation row to 
hold the total revenue.  

► To define a percent calculation 

From Report Design, after adding the appropriate rows to your tabular section, click the column 
that you created for the percent calculation.  

In this example, it would be the Percent of Revenue column.  

1. From the Column menu, choose Define Calculation.  

2. On Expression Manager, define the percent calculation.  

For example, to get the Account Balance percent of each revenue class, divide the report 
variable (RV) Account Balance by the tabular cell [tabular cell (TC) Total Revenue: Account 
Balance * 100].  

3. Click OK.  

Working with Rows in Tabular Sections 

In a tabular section, a row consists of information that is set up horizontally. Typically, rows contain 
data that is read from individual database records; however, you can add rows to include details in 
your report such as underlines, blank lines, and special calculations. Tabular sections are the only 
detail sections for which you can define rows. In all cases, after creating a row, you can move it by 
dragging it to the desired location, or you can delete it by clicking it and selecting Delete from the 
Edit menu.  

By using report design, you can add the following types of rows: 

• Data rows 

Data rows contain data from EnterpriseOne tables. They represent groups of data fields that 
are associated with the columnar amounts. For example, you could have a data row that tells 
you the Revenue (Column) for a certain range of items. In addition, you might add a row that 

131 



tells you the direct costs for another range of fields. You must define the rows and identify 
the data from the business view that goes into them. 

• Calculation rows 

Calculation rows contain amounts calculated from other rows. For example, you could 
calculate the gross margin of the Revenue and Direct Costs rows. 

• Sum rows 

A sum row defines a special type of calculation. The calculation performs totaling for all 
numeric columns in a range of rows. The total can optionally include or exclude rows within 
the sum range that are themselves row calculations. 

• Underline rows 

Underline rows let you create an underline to separate various rows in your report.  

• Constant rows 

Constant rows contain text only. They are used to describe or label information on your 
report, such as identification information for a group of rows.  

• Automatically generated rows 

In a tabular section, EnterpriseOne can automatically generate rows that define a Chart of 
Accounts for a business unit or represent the merging of accounts from several business units. 
Additionally, you have the option to create rows that calculate account rollup totals at various 
levels of detail. For example, you might want EnterpriseOne to automatically generate rows 
to create a balance sheet report that is based on a company's current month and its prior year 
account balance. 

The system optimizes rows with two or fewer logical expressions (nodes) that are joined by an AND 
operator. The optimization accelerates report processing speed. If you opt to include a cover page on 
your report, you will see which rows the system is optimizing. In the Optimized Row column, the 
system prints a Y next to the rows that are optimized and an N next to the rows that are not. The 
cover page also includes the total number of rows that are optimized (Number of Optimized Inclusion 
Rows) and the total number that are not (Number of Non Optimized Inclusion Rows). You can also 
find the total number of optimized rows in the UBE log file (Tabular Optimization). 

As a troubleshooting measure, you can disable row optimization. To do so, add the following line to 
the UBE section of the JDE.ini file: 

UBETabOpt=0 

To re-enable row optimization, set the variable to 1, or delete the row from the JDE.ini file altogether. 

► To add a data row 

On Report Design, click a tabular section.  

1. From the Row menu, choose Create, and then choose Data.  

2. On Data Row Properties, click the General tab and complete the following fields:  

• Name  
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The Name appears in the Name field on the Tabular Section - Row List tab and on the 
Sum Row Properties form.  

• Description  

The Description appears on the report in the Description field on the Tabular Section - 
Row List tab, and in the Description field on the Sum Row Properties form. This 
description can be multiple lines to allow for as much description as needed. You must 
enter spaces in front of text to allow for indentation on the report.  

3. Set other properties as desired on other tabs and click OK.  

4. On Data Selection, define the specific criteria that you want applied to the data row, and then 
click OK.  

At any time in the future, you can modify the data selection by clicking this row and choosing 
Define Data Selection from the Row menu.  

5. Add data rows as needed.  

To add rows directly beneath the last row you worked on, ensure that the last row is selected 
on your report section (indicated by a black box around the row).  

See Also  
� To select records to include in the section in the EnterpriseOne Report Writing Guide for 

additional information about selecting data 

► To add a calculation row 

On Report Design, click a tabular section.  

1. From the Row menu, choose Create, and then choose Calculation.  

2. On Calculation Row Properties, click the General tab and complete the following fields:  

• Name  

• Description  

3. Set other properties as desired on other tabs and click OK.  

4. On Expression Manager, define your calculation, and then click OK.  

5. Add calculation rows as needed.  

To add rows directly beneath the last row you worked on, ensure that the last row is selected 
on your report section (indicated by a black box around the row).  

See Also  
� To create an event rule assignment in the EnterpriseOne Report Writing Guide for 

information about attaching an expression to a calculation row  

► To add a sum row 

On Report Design, click your tabular section.  

1. From the Row menu, choose Create, and then choose Sum Row.  

2. On Sum Row Properties, click the General tab and complete the following fields:  
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• Name  

• Description  

The Description appears on the report. This description can be multiple lines to allow for 
as much description as needed. You must enter spaces in front of text to allow for 
indentation on the report.  

• From Row  

From Row lists rows that can be used as the beginning row in a range of rows.  

• To Row  

To Row lists rows that can be used as the ending row in a range of rows.  

• Include Intermediate Calculation  

Choose whether interim calculation rows should be included in the sum.  

3. Set other properties as desired on other tabs and click OK.  

4. Add sum rows as needed.  

To add rows directly beneath the last row you worked on, ensure that the last row is selected 
on your report section (indicated by a black box around the row).  

► To add an underline row 

On Report Design, click your tabular section.  

1. From the Row menu, choose Create, and then choose Underline.  

2. On Underline Row Properties, click the General tab and complete the following field:  

• Name  

3. Set other properties as desired on other tabs (for example, click the Font/Color tab to modify 
the line's color; click the Options tab to modify the line's thickness and spacing).  

4. Add underline rows as needed.  

To add rows directly beneath the last row you worked on, ensure that the last row is selected 
on your report section (indicated by a black box around the row).  

5. Click OK.  

► To add a constant row 

On Report Design, click your tabular section.  

1. From the Row menu, choose Create, and then choose Constant.  

2. On Constant Row Properties, click the General tab and complete the following fields:  

• Name  

• Description  

3. Set other properties as desired on other tabs and click OK.  

4. Add constant rows as needed.  
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To add rows directly beneath the last row you worked on, ensure that the row is selected on 
your report section (indicated by a black box around the row).  

► To generate rows automatically 

On Report Design, click a tabular section.  

1. From the Row menu, choose Automatic Row Generation.  

2. On Financial Account Level of Detail Row Generation, complete the following fields, and 
then click OK. Depending on how the section is designed, some fields might not appear on 
the form.  

• Business Unit 

You can enter a business unit and an account range. Based on the Chart of Accounts that 
is defined for the business unit, the program generates all of the row specifications within 
that account range.  

• From Account 

If you leave the From Account field blank, no accounts are generated.  

• Thru Account 

If you leave the Thru Account field blank, no accounts are generated.  

• Ledger Type (Optional) 

If specified, the ledger type is included in the data selection for that row.  

• Level of Detail 

Optional account level of detail rows can be generated at level of detail breaks. The 
default is to generate total rows. The row amounts are based on account ranges that are 
specified through selection criteria.  

• Totals 

3. Choose one of the following options under the Add Row Options heading: 

• Replace 

• Insert  

• Append 

The range of rows that are generated are either appended to the bottom of existing rows 
or inserted after a selected row, or all previously defined rows are replaced. The default is 
to replace any existing rows. However, the Append and Insert options are useful for 
building hybrid account structures from several different business units.  

Overriding the Properties of Individual Cells 

A cell contains information that is located at the intersection of a column and row. You can define 
cell overrides to override the information in the cell that is the result of the column and row 
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specifications for the cell. For example, if you want to emphasize the data in a specific cell, you can 
override its properties, increase the size of the font, and make the font bold.  

In Report Design, cells with cell overrides enabled are surrounded by a box with dashed lines. You 
can override variable cells in the following types of rows: 

• Data rows 

• Calculation rows 

• Constant rows 

• Underline rows 

► To override a data row variable 

On Report Design, click a tabular section.  

1. From the Cell menu, choose Cell Mode.  

When Cell Mode is turned on, clicking on a variable encloses the cell in a solid black box. If 
Cell Mode is not turned on, clicking on a variable encloses the entire row in a solid black 
box.  

2. Click the cell that contains the data row variable that you want to override.  

3. From the Cell menu, choose Create Override, and then choose Data.  

4. On Cell Properties, click the General tab and complete the following fields:  

• Name  

• Description  

5. Set other properties as desired on other tabs, and then click OK.  

6. On Data Selection, define the criteria that you want applied to the cell override.  

7. Click OK to update the row in the tabular section.  

A dashed border around the cell indicates an override.  

See Also 
� Defining Section Data Selection in the EnterpriseOne Report Writing Guide   

► To override a calculation row variable 

On Report Design, click a tabular section.  

1. From the Cell menu, choose Cell Mode.  

2. Click the cell that contains the calculation row variable that you want to override.  

3. From the Cell menu, choose Create Override, and then choose Calculation.  

4. On Cell Properties, click the General tab and complete the following fields:  

• Name  

• Description  

5. Set other properties as desired on other tabs, and then click OK.  
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6. On Expression Manager, define your calculation by performing the following actions, and 
then click OK:  

• Double-click fields from the Available Information list.  

• Click the calculator functions to build your expression.  

• Repeat until your calculation expression is complete.  

► To override a constant row variable 

On Report Design, click a tabular section.  

1. From the Cell menu, choose Cell Mode.  

2. Click the cell that contains the constant row variable that you want to override.  

3. From the Cell menu, choose Create Override, and then choose Constant.  

4. On Cell Properties, click the General tab and complete the following fields:  

• Name  

• Description  

5. Set other properties as desired on other tabs, and then click OK.  

► To override an underline row variable 

On Report Design, click a tabular section.  

1. From the Cell menu, choose Cell Mode.  

2. Click the cell that contains the underline row variable that you want to override.  

3. From the Cell menu, choose Create Override, and then choose Underline.  

4. On Cell Properties, click the General tab and complete the following fields:  

• Name  

• Description  

5. Set other properties as desired on other tabs, and click OK.  

Modifying the Appearance of Report Objects  
Every object in a report, such as a section, column heading, column variable, run-time field, or 
constant has its own properties. To modify how an object looks or behaves, you change those 
properties. For example, you can change the font size of a column heading or change the text to 
reflect company jargon. You can also modify the format of your report by changing column and row 
spacing and object alignment. 

Changing Detail Section Descriptions 
You can change the name of a detail section as it appears on the Section Tile of Report Design.  
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► To change a detail section description 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access your report in which you want to make a change. 

2. Double-click the detail section that you want to change.  

3. On Columnar Section, on the General tab, enter a new name in the Description field and then 
click OK. 

Hiding Report Sections 
You can hide or display an entire report section outright, or you can set a detail section to appear or 
not based on certain criteria. To toggle displaying hidden report sections in Report Design (but not in 
the printed report), choose Hide/Show Invisible Sections from the View menu.  

See Also  
� Working with Event Rules in the EnterpriseOne Report Writing Guide for more information 

on creating event rules  

► To hide or display a report section unconditionally 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to hide or display a section. 

2. Double-click the report section you want to change.  

A Section form appears. The form and its name vary slightly, according to the type of section 
selected. 

3. Click the Advanced tab.  

4. Select the Visible option to display the report section or deselect the Visible option to hide 
the report section.  

5. Click OK.  

► To display a detail section conditionally 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to display a detail section. 

2. Click the section from which you want to launch the conditional section and choose Event 
Rules from the Edit menu.  

3. Click the down arrow to open the pulldown menu in the toolbar and select the Do Section 
event rule. 

4. From the Insert menu, select If/While and define the criteria for displaying the conditional 
section. 

5. Position you cursor below the If/While statement and then select System Function from the 
Insert menu. 

6. Under the Function Selection tab, from the Section folder, select Do Custom Section. 
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The Parameter Mapping tab displays. 

7. Double-click the report section to display conditionally. 

The section displays in the Values column of the Parameters table. 

8. Save the event rule.  

9. On Report Design, double-click the report section you want to be the conditional section.  

Depending on the section type, an appropriate Section form appears.  

10. Click the Advanced tab.  

11. Select the Conditional option and click OK.  

Aligning Fields or Columns within or across Report Sections  
When you create report sections, data fields or columns might not line up properly. Report Design 
(P00890) provides alignment options to let you precisely adjust the appearance of your report output.  

When you align data fields, use the following guidelines:  

• Clear your focus in all sections before you select the objects for alignment. 

• Designate one object to act as an anchor to which other objects are aligned. The anchor is 
indicated by a black border; the objects to align with it are indicated by a gray border.  

• The black border indicates the currently selected data field.  

• The entire object must be selected for alignment, not just the constant text or its variable.  

• The anchor can be a disconnected constant or variable object.  

• The objects selected can be within the same or across sections.  

• The fields themselves are aligned, not the text within the fields. This is especially noteworthy 
when you center-align fields, since the objects are centered based on field length and not on 
the length of the text within the fields.  

• The alignment process cannot be used on tabular rows.  

When you align columns with other columns or with data fields, use the following guidelines:  

• To align tabular and columnar section columns with group section objects, the column in the 
tabular or columnar section must be the anchor for the alignment.  

• To align tabular and columnar columns with columns in other columnar or tabular sections, 
you can only select one column in each tabular or columnar section to align.  

See Also  
� To change text justification for a report object in the EnterpriseOne Report Writing Guide for 

information on aligning the text within data fields  

► To align fields or columns within or across sections 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to align fields or columns. 
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2. Select an object you want to align with another. 

3. Hold down the Ctrl key, and then click the objects that you want to align to each other.  

As you select objects, they appear with a gray or black border. The object with the black 
border is the anchor. The last object you click is always the anchor.  

4. From the Layout menu, choose Align.  

5. On Align Objects, click one of the following options under the Left to Right heading:  

• Left Edges  

• Center  

• Right Edges  

• No Changes  

6. Click one of the following options under the Top to Bottom heading: 

• Top Edges  

• Middle  

• Bottom Edges 

• No Changes  

Note 

These options are available only when you choose to apply changes to the current section.  

 

7. Click one of the following options under the Apply to heading: 

• Current Section  

• All Sections  

8. Click Apply.  

Your changes appear immediately.  

9. With Align Objects still open, click different options and click Apply until you are satisfied 
with how the objects are aligned.  

10. When the objects are aligned the way you want, click OK.  

Changing Field Length and Column Width 
You can change the length of most of the variable and system fields in your report. You can also 
change the width of column headers and their associated variables. In all cases, the system defaults to 
text wrapping; that is, if a field is too short to display its text, as much text as possible is placed in the 
space allowed and then is continued on succeeding lines. Turning this feature off is possible to 
display all of a field's text on a single line, despite the field length.  

Changing a field's length and changing a column's width are not the same. To change a field's length 
is to change the number of characters the batch engine places in the field. To change a column's width 
is to change the amount of space allotted for display. If a field's length is 30 and the column's width is 
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very small, you might only see five or six characters, but the batch engine has filled all 30 characters. 
Conversely, if a field's length is five and the column's width is very large, you see only five characters 
followed by a large amount of white space.  

► To change a field's length 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to change the length of a field. 

2. Double-click the field you wish to change.  

3. On the applicable Properties form, click the Display tab.  

If the Properties form does not have a Display tab, then you cannot change the field's length.  

4. Enter a new length in the Display Length field, or use the arrow buttons to increase or 
decrease the length.  

5. Click OK.  

► To change the width of a column 

From the Report Writer menu (GH9111), choose Report Design Tool from the Report Writer 
menu (GH9111). 

1. On Report Design, access the report in which you want to change the length of a field. 

2. Click the column heading.  

Note 

The small black box inside the selection box to the right indicates that you can manually 
resize the object.  

 

3. Place your cursor over the small black box until the cursor changes to a horizontal line with 
an arrow on both ends.  

4. Click and drag the black box until the column is the size you wish, and then release the 
mouse button.  

► To turn text wrapping on and off (absolute position) 

Note 

You cannot toggle text wrapping for individual fields; instead, you must apply text wrapping to an 
entire report section. Furthermore, you cannot apply text wrapping to a column.  

 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to change the length of a field. 

2. Double-click the section for which you wish to toggle text wrapping.  
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3. On the applicable Section form, click the Advanced tab.  

4. Select the Absolute Position option to turn text wrapping off or deselect the Absolute Position 
option to turn text wrapping on.  

If the Advanced tab does not have an Absolute Position option, then you cannot turn text 
wrapping off for the section.  

5. Click OK. 

Changing Column or Row Spacing 
Column spacing (the space between columns) can be changed to create a larger or smaller spacing 
between all columns or to create a visible gap between individual columns (logical groups of data).  

You can also change the spacing of rows to make the report look better. 

► To change column spacing 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to change the column spacing. 

2. Click anywhere within the columnar or tabular section in which you want to modify column 
properties.  

3. From the Layout menu, select Spacing.  

Depending on the section you chose, an appropriate Section Spacing form appears.  

4. On the Column Spacing tab, perform one of the following to apply the spacing to columns:  

• Click the Select All Columns button to apply the spacing to all columns in the section  

• Choose specific columns from the grid to which you want to apply the spacing  
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5. In the Space before selected columns field, set the number of spaces you want to appear 
before the columns. The default is set at 5 spaces.  

6. Click OK.  

► To change row spacing for a columnar section 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to change row spacing. 

2. On Report Design, select the columnar section you want to change.  

3. From the Layout menu, choose Spacing.  

4. On Columnar Section Spacing, click the Row Spacing tab, then choose a Header to Detail 
option and a Detail to Detail option:  

• Single  

• Single + Half  

• Double  

Note 

Only Single spacing is supported for Comma Separated Values (CSV) files. Only Single and 
Double spacing is supported for line printers. See Submitting a Report in the EnterpriseOne 
Report Writing Guide for more information about CSV files and printing to line printers.  

 

5. Click Apply, and then click OK.  

► To change row spacing for a tabular section with added rows 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to change row spacing. 

2. Double-click on the row in your tabular section that you want to create a space above.  

3. On Row Properties, click the Options tab.  

4. Enter a value in the Space Before field and click OK.  

Changing Font Properties 
A font is a set of print characters. Examples of font sets include Courier New and Arial. Typically, a 
font set includes variations such as bold and italic; properties such as alignment and spacing are not 
considered font variations and may be applied separately to any text in your report. You can use 
multiple fonts in a single report. Some fonts may be converted to PDF, PostScript, or PCL files; line 
printers are fairly limited in the types of fonts they can print.  

Fonts can broadly be classified in two ways:  

• Proportional Fonts  

• Non-Proportional Fonts  
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A proportional font is one in which different characters have different pitches (widths). In a 
proportionally spaced font, the letter I is narrower than the letter q and the letter m wider. Examples 
of fonts with proportional spacing are Arial and Times New Roman. While proportionally spaced 
fonts generally create a more visually pleasing document, it can be difficult to perform certain kinds 
of alignment because of the varying widths of data. 

Non-Proportional fonts refer to fonts in which every character has the same width. Most typewriters 
and line printers use fixed-pitch fonts. An example of a non-proportional font is Courier New and MS 
Gothic.  

Non-proportional Font: W i n d o w s 

Proportional Font: W i n d o w s 

The PDF generation, PostScript and PCL conversion can support any font size. For Line Printer, it is 
recommended to generate the PDF file with non-proportional fonts and font size of 10.  

The base 14 fonts Report Design supports are shown in the following table where X is supported and 
blank is not supported:  

Font Faces  Postscript  PCL  Line  PDF  

Courier New  X    X  X  

Courier New - Bold  X      X  

Courier New - Italic          

Courier New - Bold Italic          

Arial  X  X    X  

Arial - Bold  X      X  

Arial - Italic          

Arial - Bold Italic          

Symbol        X  

Times New Roman  X  X    X  

Times New Roman - Bold  X      X  

Times New Roman - Italic          

Times New Roman - Bold Italic          

ZapfDingbats        X  
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Courier New  X    X  X  

Courier New - Bold  X       

Courier New - Italic          

Arial         

Arial – Bold X    X  

Arial – Italic       

Arial – Bold Italic     

Symbol    

Times New Roman X X  X 

Times New Roman – Bold X   X 

Times New Roman – Italic     

Times New Roman – Bold Italic     

Zapf Dingbats    X 

Double Byte Fonts  

In a double byte environment, fonts receive special treatment within UBE (Universal Batch Engine) 
and Output Management. In Report Design, you can select any font available to the system and assign 
it to the report, section, or object level. PDF will support one type of font with multiple font sizes in 
Simplified Chinese, Traditional Chinese, and Korean. However, in a double byte environment, only 
the fonts shown in the table below are supported when the PDF (Portable Document Format) file is 
generated:  

Language  Font Name  

Simplified Chinese  STSong-Light-Acro  

Traditional Chinese  Mhei-Medium-Acro  

Korean  HYGothic-Medium-Acro  

Japanese  HeiseiMin-W3-Acro, MS Gothic (true type font)  

The CJK languages (Japanese, Simplified Chinese, Traditional Chinese and Korean) do not support 
PCL.  
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Bar code Fonts  

Report Design supports Code 39 fonts for both PCL and PostScript conversion. The true type font 
name is BC C39 3 to 1 Medium. The barcode fonts can be seen in Report Design, previewed, and then 
printed. Since font vendors do not sell PCL fonts that can be scaled, only fixed-point size is supported 
for PCL.  

The recommended point sizes that can be used for PostScript are between 8 and 24 points.  

Working with Bar Codes  

You can use bar code fonts to create bar codes in your reports. Report Design provides base bar code 
functionality for your report and batch job output. You can use any true-type bar code font. Bar codes 
print on both PCL and postscript printers.  

To specify a particular barcode, you must enter the encoding for that barcode in the constant 
properties. The encoding is a series of characters and numbers preceded and followed by a * to let the 
system know this is a bar code.  

► To create an object with a bar code font  

On Report Design, double-click a constant.   

1. On  Constant Properties, click the Font/Color tab  

2. Complete the following fields:  

• Font  

The font is the bar code font name-- for example, the bar code font BC C39 3 to 1 
Medium.  

• Font Style  

• Size  

You can see a sample of what the font will look like in case you need to make changes.  

3. Click the General tab.  

4. Enter the correct encoding sequence for the bar code in the following field and click OK.  

• Name  

You can see the bar codes in Report Design. They should look similar to the ones shown 
below.  

5. View the PDF file in Preview mode to display the bar codes.  

When you submit your job, the Job Submission form should also display the bar codes 
properly.  

After you set up the bar code in your report, you must link the printer font name and the true 
type font name to a physical printer in the Bar Code Support application before you print to 
either a PostScript or PCL printer.  

6. From the Batch Processing Setup menu (GH9013), choose Bar Code Support, and complete 
the following fields:  
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• Printer Name  

• True Type Font Name  

• Printer Font Name  

The printer font name comes from the font vendor, for example Code39Three.  

• Printer Definition Language  

If you are printing to a PCL printer you must also complete the following field:  

• Symbol Set ID  

Note 

Because font vendors do not sell scaleable PCL true-type bar-code fonts, only fixed-point 
size is supported for PCL. You should use point sizes between 8 and 24 for postscript.  

 

After you set up your bar code, you can use a scanner to test the bar code output.  

Using Dynamic Positioning 

Dynamic positioning is a feature that: 

• Allows you to designate a new font to be automatically applied when the report is printed on 
a line printer or in a foreign language 

• Automatically adjusts the width of objects on a report so that they do not overlap when a font 
substitution occurs  

This feature is most useful when you print reports in multiple languages. For example, you print a 
report in English, Greek, and Chinese. You might want to print the English reports in Arial; the Greek 
report, in Haettenschweiler; and the Chinese report, in SimSun. Since the German and Chinese fonts 
are wider than the English, the objects on the report are automatically repositioned to prevent overlap.  

Dynamic positioning is also useful when you send many reports to a line printer and want them in 
different fonts so they will be easier to read. When sending reports to a line printer, you must use 
non-proportional fonts. 

Dynamic positioning does not adjust for the height of report objects when you substitute fonts. If you 
are going to use font substitution for a report, space report object on different lines a little farther 
apart. 

To use dynamic positioning, you must do the following: 

• Turn dynamic positioning on for the machine where the reports are processed. 

• Define font substitutions for languages and line printers. 

Once you have turned dynamic positioning off for a machine, you should not turn it off. You can, 
however, turn dynamic positioning off for an individual report.   

You can also view a report with font substitutions applied.  
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Activating Dynamic Positioning for a Server or Client 

You must enable dynamic positioning on the server or client that processes reports by inserting a line 
in the jde.ini file. If you run reports, to which you want to apply dynamic positioning, on more than 
one machine, you must enable dynamic positioning on each machine.  

Once dynamic positioning is enabled, you should not disable it at the machine level. You can override 
it for an individual report.  

► To activate dynamic positioning for a server or client 

Using Notepad, open jde.ini. 

1. In the [UBE] section, type the following line: 

UBEDynamicPositioning=1 

2. Save and close the jde.ini file. 

Defining Font Substitutions  

Use the Bar Code font Support table (F986166) to tell the system which fonts to replace on a report 
when processing occurs. For example, if reports are created using the Arial font but you want them to 
print in Times Roman, you would enter this substitution on the font substitution table. 

Font substitution is most useful for the following: 

• To define fonts to be used when reports are sent to a line printer 

• To define fonts to be used when a report is printed in a foreign language  

The font substitution table allows you to indicate a new font, not a font size. When the font 
substitution is made, dynamic positioning automatically allows adjusts the position of items on the 
report to accommodate the width of the new font. It does not adjust the height of items on the report. 

► To view font substitutions by language type 

From the Batch Processing Setup menu (GH9013), choose Font Substitution by Language Type. 

On Work with Font Substitution by Language Type, enter the language type in the QBE line and 
click Find. 

The form displays all defined font substitutions for the language type that you entered. 

► To define font substitutions for a language or line printer 

From the Batch Processing Setup menu (GH9013), choose Font Substitution by Language Type. 

1. On Work with Font Substitution by Language Type, click Add. 

2. On Font Substitution by Language Revisions, complete the following fields and then click 
OK: 

• Language Type 

If you are defining a font substitution for a line printer, leave this field blank to select 
Domestic Language. 
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• Original Font Name 

For a line printer, enter *JDE LINE. 

• New Font Name 

For a line printer, you must use a non-proportional font, such as Courier New. 

► To change font substitutions by language type 

From the Batch Processing Setup menu (GH9013), choose Font Substitution by Language Type. 

1. On Work with Font Substitution by Language Type, double-click the font substitution to edit. 

2. On Font Substitution by Language Type Revisions, complete the following field and click 
OK: 

• New Font Name 

Turning On or Off Font Substitutions for a Report 

If the report is already in the font you want, you can turn off font substitution for the report by 
selecting override. Once you turn off font substitution and save the report, font substitution remains 
disabled for the report. You must re-enable font substitution by deselecting override if you want font 
substitution in the future. 

► To turn font substitutions for an individual report on or off 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you wish to turn on or off font substitution. 

2. From the File menu, choose Report Properties. 

3. On Properties, click the Advanced tab. 

4. In the System Language Font section, select Override.  

If Override is checked, font substitution is turned off. If Override is not checked, font 
substitution is turned on. 

5. Click OK. 

Once you have saved the report with the Override turned on, the system does not apply font 
substitutions to the report.   

Applying Font Substitutions to a Report Template 

To view how a new font looks on a report before processing the report, you can apply the font 
substitution to the report template.  

If the new font is also listed for substitution in the Font Substitution table, it will be replaced when 
you process the report. For example, if the Font Substitution table states that Arial should be replaced 
by Times New Roman and Times New Roman should be replaced by Courier and you apply the font 
substitution to an Arial report, the report appears on the report template in Times New Roman. If you 
then print the report, the system replaces the Times New Roman font with Courier.  To prevent this 
replacement, turn off font substitution for the report after it appears in the font you want. 
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► To apply font substitutions to a report template 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report template to which you wish to apply font substitutions. 

2. From the File menu, select Report Properties. 

3. On Properties, click the Advanced tab. 

4. In the System Language Font section, click Use System Language Font. 

If a font substitution has been defined for the font currently used on the report, the system 
replaces the current font and dynamically positions items on the report to accommodate the 
new font. 

Using TrueType Fonts 

When you submit a report, a PDF file is generated on the server using TrueType fonts. PeopleSoft 
provides several TrueType fonts, similar to Arial, Courier, and Times New Roman, to be used on the 
server. In addition to these fonts, or as substitution for them, you can purchase or download additional 
TrueType fonts. 

To download Times New Roman, Arial, and Courier fonts, go to sourceforge.net. If you want a PDF 
to contain bout Asian and European Long (WGL4) characters, PeopleSoft recommends you purchase 
or download a font similar to Arial Unicode MS. 

By default, all PDFs are generated using Arial. To override Arial, use the Work with Fonts form to 
assign fonts by report language. 

► To assign a font by report language 

In the Fast Path field, type P98980. 

1. On Work With Fonts, complete the following field and click Find.  

• Language 

The fonts assigned to the language display. 

2. If there is no font assignment for the language selected and you want to add one, click Add. If 
there is a font assignment for the language selected and you wish to change it, highlight the 
line for the language in the grid and click Select. 

3. On Language Font Revisions, click the Font button by each of the following fields. 

• Font ID-Form 

• Font ID-Report 

• Font ID-Grid 

4. On Font, select the complete the following fields and click OK. 

• Font 

• Font style 

• Size 
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• Script 

The selected font displays on the Language Font Revisions form. 

5. Click OK to save the fonts assigned to the language. 

Color  

Although you can choose any color from the Font dialog to display, for printing only 8 colors for 
PCL, 16 colors for PostScript and black for line printers are supported. Both PostScript and PDF 
generation use the RGB model for color and PCL uses the Simple Color RGB model that provides 8 
colors only.  

Refer to the Color Support Table below, where X is supported and blank is not supported:  

Font Colors  PostScript  PCL  Line  PDF  

Black  X  X  X  X  

Blue  X  X    X  

Cyan  X  X    X  

Dark Blue  X      X  

Dark Cyan  X      X  

Dark Green  X      X  

Dark Gray  X      X  

Dark Magenta  X      X  

Dark Red  X      X  

Green  X  X    X  

Light Gray  X      X  

Magenta  X  X    X  

Olive Green  X      X  

Red  X  X    X  

Yellow  X  X    X  

White  X  X    X  

► To change the font properties for a field 

From the Report Writer menu (GH9111), choose Report Design Tool. 
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1. On Report Design, access the report and select the field you want to change. 

2. Right-click the field you want to change and select Properties from the resulting pop-up 
menu.  

Depending on the field type, an appropriate Properties form appears.  

3. Click the Font/Color tab and choose an option for the following headings:  

• Font  

• Font Style  

• Size  

• Color  

To return all the section fields to their default font settings, click Defaults.  

4. When you are done making your selections, click OK.  

► To change the font properties for all fields in a report section 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then double-click the report section that you want to 
change, or click the section and choose Section Properties from the Section menu.  

2. On the applicable Section form, click the Font/Color tab and choose options for the following 
headings:  

• Font  

• Font Style  

• Size  

• Color  

To return all the section fields to their default font settings, click Defaults.  

Changes you make on this form affect all text in the section except for those fields that have 
been changed individually. To override individual settings and apply the changes to all fields 
in the section without exception, choose Apply settings to all Objects.  

3. When you have made your selections, click OK.  

► To change the font properties for all fields in a report 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then choose Report Properties from the File menu. 

2. On Properties, click the Font/Color tab and choose options under the following headings:  

• Font  

• Font Style  

• Size  

• Color  
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To return all the report fields to their default font settings, click Defaults.  

Changes you make on this form affect all text in the report except for those fields that have 
been changed individually. To override individual settings and apply the changes to all fields 
in the report without exception, choose Apply settings to all Objects.  

3. When you have made your selections, click OK.  

Changing Text Justification 
Justification refers to how lines of text line up vertically in reference to each other. You can affect the 
alignment of text in columns and in most variables. You cannot set text justification for constants, 
however. In Report Design, you can align text in one of three ways:  

• Right alignment  

• Left alignment  

• Center alignment  

Justification is relative to the object's frame. For example, if you center align text, the text is centered 
within its frame instead of being centered on the page. The Batch Engine supports left and center 
alignment for all fonts and languages.  

Out of the CJK (Chinese, Japanese, Korean) languages, right alignment is fully supported only for 
Japanese 7, 8 and 9-point size MS Gothic fonts. In the case of Chinese and Korean fonts, right 
alignment is not supported. 

Bar codes must be left aligned in Report Design.  

See Also  
� Aligning Fields or Columns within or across Report Sections in the EnterpriseOne Report 

Writing Guide for information on aligning the report objects themselves  

► To change text justification  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then double-click the field for which you want to 
specify its text justification.  

2. On the applicable Properties form, click the Display tab.  

3. Select the appropriate justification style, or click Defaults to return the object to its default 
justification style; then click OK.  

Changing Numerical Formatting 
In Report Design, you can control the number of decimal places to be displayed. Through edit codes, 
you can control whether to use commas, how to display positive and negative values, and how to 
display monetary values.  
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Note 

You can also control the display of positive and negative numbers using processing options. 
Processing options override the settings entered using Report Design. 

 

 

See Also  
• Changing Decimal Scaling in the EnterpriseOne Report Writing Guide for information about 

changing decimal scaling  

► To change how numbers are displayed 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then double-click the field for which you want to 
change the numerical formatting.  

2. On the applicable Properties form, click the Display tab.  

3. Enter the number of decimal places you wish to display in the Display Length field, or use 
the arrow buttons to increase or decrease the number of decimal places.  

Note  

Setting display decimals is ineffective if currency has been enabled for the system.  

 

4. If available, select the Edit Code field and use the Visual Assist to select a formatting style 
you want.  

5. Click Defaults to return the object to its default style.  

6. After you have made your selections, click OK.  

See Also 
� Edit Code Table in the EnterpriseOne Report Writing Guide for a description of the edit code 

fields 

Associating Lines and Boxes 
You can enclose most fields in a box. Additionally, you can include single and double lines above or 
below most fields. You cannot enclose columns or entire report sections in boxes.  

► To associate lines and boxes 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then double-click the field you want to enclose in a 
box or attach lines to.  

2. On the applicable Properties form, click the Style tab.  

3. Deselect No Lines to activate the other options on the form.  

154 



4. To enclose the field in a box, select Single Rectangle. Otherwise, select the line style you 
desire.  

The sample box on the form illustrates your selection.  

5. After you make your selections, click OK.  

Inserting Page Breaks 
In columnar and group sections, you can cause the last line printed on a page to be reprinted on the 
following page.  

You can insert a manual page break (that is, cause the report to stop printing on the current page and 
start printing on the next) after detail sections and report headers. You cannot use these two features 
simultaneously, however.  

► To print the last line on a page as the first on the succeeding page 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then double-click the group or columnar section that 
you want to affect.  

2. On the applicable Section form, click the Advanced tab.  

3. Select Reprint At Page Break and click OK.  

► To insert a manual page break 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report, and then double-click the detail or report header section 
that you want to affect.  

2. Click the Advanced tab.  

3. Select Page Break After and click OK.  
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Advanced Report Enhancements  

In addition to the basic functional capabilities of Report Design, you can also use advanced features 
to create reports with greater depth of information and functions. The following table lists the 
available advanced features:  

Event Rules  Event rules enable you to perform logical operations such as:  

• Processing conditional logic  
• Moving values into or between objects  
• Performing calculations and complex expressions  
• Attaching existing business functions or system functions  

Date Titles  For financial reports, a date title in the page header makes the report more 
meaningful. EnterpriseOne software includes commonly used date titles. The 
date title business function lets you choose the type of date title you want to 
display on your report.  

Drill Down  The drill down feature creates a link to an interactive application. When you view 
a report using Adobe Acrobat Reader software, you can click a value in the report 
viewer to directly access the data in the report.  

Favorites  A favorite is a simplified method that you can use to access information. In 
Report Design, favorites allow you to create a directory that contains only the 
business views that you require for your reporting needs.  

Processing 
Options 
Templates  

Processing options control how the system processes the data for a report or other 
batch application. They are version driven; therefore, different processing options 
can be specified for different versions of the same application.  

Director 
Templates  

The Director uses director templates to help you create application reports. These 
templates, included with EnterpriseOne, contain default criteria. You can modify 
the EnterpriseOne templates and create your own.  

Text Attachments  You can add text attachments to records from the EnterpriseOne interactive 
applications. In addition, you can design a report to include any text attachments 
that exist for a record.  

Report 
Properties  

Report Design lets you modify your report and version output by changing report 
properties.  

See Also  
� Smart Fields in the EnterpriseOne Report Writing Guide for information about smart fields 

See the following topics in the Development Tools Guide: 

� Changing Report Data Structures for information about report data structures 

� Working with Business Functions for information about business functions 

� Creating a Table I/O Event Rule for information about creating an event rule 
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� Creating Report Interconnections for information about creating report interconnections 

Working with Event Rules  
As a report is processed, the run-time engine pauses at certain points to process logic that has been 
attached. These points are called events, and you can use these events to insert custom logic for 
processing. Event rules are logic statements that you create and attach to an event without the difficult 
syntax that comes with most programming languages. Event rules process when an event, such as a 
page break, occurs. Events are attached to controls, such as a variable, a constant, a section, or a 
report.  

The event to which you attach your event rule varies depending on the purpose of the event rule and 
the type of section in which the event occurs. For example, if you are adding an event rule to a 
columnar or group section, you might attach the event rule to the Do Section event. In a tabular 
section you might attach an event rule to the Do Tabular Break, Do Balance Auditor, or Column 
Inclusion events. Smart fields are automatically attached to the Column Inclusion event rule. If you 
are attaching an event rule to a variable, you might choose the Do Variable event.  

Most event rules consist of two parts: 

• An if/while statement 

• An assignment 

The if/while statement states the condition when an assignment should occur. Conditions include 
equal to, less than, greater than, not equal to, and combinations of these. 

An assignment states what should happen when the condition of the if/while statement is met. All 
assignments take the form or “X equals Statement” where X is the variable being assigned a value, 
and Statement is the value assigned to the variable. Statement can be a simple value or a calculation. 

Example 
Team C uses a different rating scale for employees than any other team. To be able to compare 
employees across teams, you need to multiply the employee ratings of Team C employees by 10. The 
if/while statement would be: 

If Team is equal to C  

The “is equal to” is the condition. 

The assignment would be: 

Rating equals Old Rating times 10 

“Rating” is the variable being assigned a value. “Old Rating times 10” is the statement where that 
value is calculated. 

See Also 
See the following topics in the Development Tools Guide:  

� Understanding Event Rules for information on predefined events  

� Event Rules Design for information about designing event rules and working with the event 
rule buttons  
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� Creating Report Interconnections for information about using event rules to use a report to 
launch other reports  

See the following topics in the EnterpriseOne Report Writing Guide: 

� Events for information about which event rules are available for which sections  

� Defining Section Data Selection for information about using the Criteria Design form for data 
selection   

Prerequisite 
� Before you create an If/While statement, you might need to insert a field on your report to 

hold the result of the event rule. If the event rule will return text, you will most likely use a 
text variable. If your event rule is a calculation, you will need to decide between a numeric 
variable and a data dictionary item. See Adding and Attaching Text Variables in the 
EnterpriseOne Report Writing Guide for more information about text variables.   

► To create an If/While statement in an event rule 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to create an if/while statement. 

2. Click a section or the variable portion of a data field. 

3. From the Edit menu, choose Event Rules.  

Alternatively, you can click the right mouse button, and then choose Event Rules. 

  

4. On Event Rules Design, from the pull-down menu of the Events list, choose an event.  

158 



For example, choose the Do Section event. This event is illustrated because it is the most 
commonly used event in columnar and group sections. When an event rule is written in the 
Do Section for a columnar or group section, multiple If statements with attached assignments 
or expressions can be written for multiple fields in that section.  

5. Choose If/While from the Insert menu.  

Alternatively, you can click the If/While button on the toolbar.  

 

6. On Criteria Design, define the specific criteria you want applied to this event rule.  

7. Click OK to save the If statement and return to Event Rules Design.  

The If statement appears on Event Rules Design.  

After creating the If statement, you can attach an event rule assignment to the If statement.  

You can move an event rule line to a new location by selecting it and then dragging it to the desired 
position.  

Note  

Changing the sequence of event rule statements can result in improper syntax. If you detect syntax 
errors, you can either disable the event rule and continue; or edit the event rule to eliminate the errors.  

 

 

► To create an event rule assignment 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, open the report in which you want to create an event rule assignment. 

2. From the Edit menu, choose Event Rules. 
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3. On Event Rules Design, click an If, Else, or End If statement that you want the conditions of 
the assignment to follow, and then choose Assignment/Expression from the Insert menu.  

 

4. On Assignment, select the To Object by clicking on an available field from the list under the 
To Object heading. For example, the To Object might be the report variable (RV) from a 
column you inserted into the report to hold this value.  

An available field is represented by a two-character, alphabetical code that characterizes the 
source of data and determines how the field data is used in an application at run time. The 
available fields could have the following prefixes: 

BC A column in the business view. These columns are filled with values from the database when a 
fetch is performed and are the values that are saved when you add or update.  
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PO A value passed from a processing option.  

VA  Event rules variables. These objects represent any variables set up in the event rule. They are not 
manipulated by the system.  

RC Report constant.  

RV  Report variable.  

RS  Report sections. These values may not be used when creating an event rule assignment.  

The selected field appears in the gray area under the To Object heading. This field is the 
recipient of your assigned value.  

5. To create a logical statement, choose an object from the From Object/Literal list on the right.  

6. To assign a literal statement for an alpha variable, enter a literal expression (such as a number 
or text) in the From Object/Literal.  

7. To create an expression or mathematical function for a numeric variable, click the f(x) button.  

 

8. On Expression Manager, enter an expression and click OK. 

9. On Event Rules Design, choose Save from the File menu.  

Alternatively, you can click the check mark on the toolbar.  

Adding and Attaching Text Variables 
In an event rule assignment, you may need a text variable (prefix TV ). Text variables are stored as 
strings and attached to your report through an event rule. They are used as an alternative to hard 
coding text strings in assignments. Because text variables are not hard-coded, they provide easier 

161 



maintenance of event rules. Instead of changing each event rule where the text resides, you can 
simply change the text variable.  

To use a text variable, you must first add it, and then attach it to the event rule. 

► To add text variables 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to add text variables. 

2. Click the detail section to which you want to add text variables and then choose Text 
Variables from the Section menu.  

3. On Text Variables, type the text that you want to appear on your report under the Text String 
heading.  

 

4. Press Enter or click Add.  

You must press Enter after each entry for the Report Design tool to recognize your entry. 
When you press Enter, another blank line appears.  

5. Repeat Steps 3 and 4 for all text strings required on your report, and then click OK.  

► To attach text variables to an event rule 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to attach text variables to an event 
rule. 

2. Click the detail section to which you added the text variables, and then choose Event Rules 
from the Edit menu.  

Alternatively, you can right-click and then choose Event Rules. 
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3. On Event Rules Design, choose the event to which you want to attach the text variables from 
the pull down events list.  

Events with associated event rules display a green plus sign (+).  

4. Click the If, Else, or End If statement to which you want the conditions of the text variables 
to apply, and then choose Assignment/Expression from the Insert menu.  

Alternatively, you can click the x= button on the toolbar.  

5. On Assignment, choose the To Object field (recipient of your text variable) by clicking on a 
field from the list under the To Object heading. For example, RV Required Approval.  

6. Choose the From Object/Literal field by clicking a field with a TV (text variable) prefix from 
the list under the From Object/Literal heading. For example, click TV "Director Approval."  

7. Click OK.  

The Event Rules Design form appears with the If statement that now includes the text 
variable condition.  

8. Repeat Steps 4-7 to add more text variables to the event rule, and then click the check mark 
on the toolbar to save and exit Event Rules Design.  

Attaching a System Function to an Event  
Occasionally instead of using an assignment, you might need to use a PeopleSoft EnterpriseOne 
system function if the condition stated in the if/while statement is met. System functions are 
predefined and allow you to perform complex calculations without adding code.  

For example, you might need to hide one column heading on your report. You can do this task by 
attaching a system function to an event rule to hide this object.  

► To attach a system function to an event 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to attach a system function. 

2. Click a section or the variable portion of a data field and then choose Event Rules from the 
Edit menu.  

Alternatively, you can click the right mouse button, and then choose Event Rules.  
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3. On Event Rules Design, choose an event from the pull-down events list. 

4. Choose System Function from the Insert menu.  

Alternatively, you can click the f(s) button.  

 

5. On the Function Selection tab of the System Functions form, double-click the folder icon next 
to the system function to see all available functions within that category, and then choose a 
system function.  

6. Click the Parameter Mapping tab to define the parameters.  
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For example, if you want to hide an object, you can open the Object folder and choose the 
Hide Object system function. 

  

7. On the Parameter Mapping tab, choose a field from the Available Objects list, and then click 
the right arrow to move this value to the Parameters Value column.  

In this example, you would choose the column you want to hide.  

8. Click OK to return to Event Rules Design.  

9. On Event Rules Design, click the check mark to save and return to Report Design.  

Creating an Event Rule Variable 
An event rule variable (prefix VA) is a user-created object that inherits the characteristics of a 
selected data dictionary field. The variable is not, however, stored in the data dictionary. Rather, each 
variable exists only within the report where it was created. You determine whether the variable can be 
used for a specific event, for the section, or for the entire report. After you create a variable, it is 
added to the list of available fields used to create event rules.  

► To create an event rule variable 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to create an event rule variable. 

2. Click the section to which you want to attach the event rule variable and choose Event Rules 
from the Edit menu. 

3. On Event Rules Design, choose an event from the pull-down events list.  
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4. Choose Variables from the Insert menu. Alternatively, you can click the Variables button.  

 

5. On Event Rules Variables, click Add.  

6. On Variable Item Selection, complete one of the following:  

• Click Find to display the valid data dictionary fields.  

• Use the QBE line to limit your search, and then click Find.  

7. Choose the data item whose characteristics you want the variable to inherit, and then click 
Next.  

8. On Variable Options Selection, click one of the following Scope options, depending on the 
purpose for which the variable is being created. For example, you can reference a report 
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variable globally in the report, a section variable within the section, or an event variable only 
within the event where it was created.  

• Section  

• Report  

• Event  

9. Type a meaningful name in the field provided, and then click Finish.  

The Event Rules Variables form reappears displaying the event rule variable you just created.  

The variable is assigned one of the following prefixes based on the scope you specified.  

• evt_ (Event)  

• rpt_ (Report)  

• sec_ (Section)  

An event rule variable cannot be modified after it is added. However, you can delete it and 
create a new event rule variable.  

10. Click OK to return to Event Rules Design.  

11. On Event Rules Design, click the check mark to save and return to Report Design.  

Column Inclusion Versus Do Section Event Rules 
The most common event rule used for a tabular section is the Column Inclusion event rule. In a group 
or columnar section, the Do Section event is the most common. When a group or columnar section is 
processing data, the Do Section event occurs after each record is fetched. Because of the automatic 
totaling on a level break, tabular sections are processed differently. In a tabular section, the Do 
Section event is processed only at each level break. Therefore, the Column Inclusion event is used in 
a tabular section to process the data after each record is fetched, rather than waiting until the level 
break.  

No matter the section type, do not use a Column Inclusion event rule when you are performing a 
calculation between columns (such as when calculating variance) or between variables within a 
column. For these situations, use a Do Section event.  

When using the Column Inclusion event rule, you must attach individual event rules for each column 
in the section to which you want to attach logic.  

See Also  
� To create calculation columns in the EnterpriseOne Report Writing Guide 

► To use the Column Event Rule 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to use the column event rule. 

2. Click the column in the tabular section to which you want to add the event rule.  

Ensure that you click the column itself and not its header.  
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3. From the Edit menu, choose Event Rules.  

4. On Event Rules Design, choose Column Inclusion from the pull-down Events list.  

If you are working with a smart field column, this event could have a green + next to it. This 
plus sign indicates that an event rule already exists for this column.  

5. The type of event rule you want to create determines which button you choose.  

For example, if you want to create an If/while statement, you would choose If/While from the 
Insert menu.  

6. Perform Steps 1-5 for each column to which you want to add an event, and then click the 
check mark to save and return to Report Design.  

Creating Custom Sections  
Custom sections allow you to control, through event rules, the information that prints on a report. 
You can use custom sections to force a page break by creating a custom section with no objects, and 
then activate Page Break After Print in that section's Section Properties. You can also use custom 
sections to print variable text, or for sections that present the same information, but are formatted 
differently. For example, you might use a custom section in a report that exists in two different 
modules, but depending on a user's needs, calls a different section that displays information specific 
to that particular module.  

Another example of using a custom section is when you want to print additional information 
depending on certain criteria. For example, you might have an accounts receivable report that shows a 
customer's payment history, but you want the batch engine to print additional information if a 
customer is delinquent in his payments. In this case, you can create a custom section to display if the 
customer is 30, 60, or 90 days overdue, and then attach a processing option that calls that custom 
section. When the processing option is activated, and when the batch engine encounters a record that 
contains overdue information, the custom section prints; if no overdue information exists, the custom 
section does not print.  

You can use the DO_CUSTOM_SECTION system function in columnar, group, or tabular sections to 
call the custom section. The number of custom sections you can use in a report is unlimited. Custom 
sections are allocated and treated like any other level-two section.  

Custom sections can contain business view fields, variables, or data dictionary fields. Your report 
processes the same way regardless of the objects contained within it.  

Attaching Logic for a Custom Section 

Custom sections are launched using a system function in Event Rules. You attach the logic for a 
custom section to the section preceding the custom section. For example, if you want a custom 
section to process before a columnar section, you call the custom section using the system function 
DO_CUSTOM_SECTION from the columnar section's DO_SECTION event. Likewise, if you want 
a custom section to process before a level-break footer, you call the custom section using the system 
function DO_CUSTOM_SECTION from the INIT_LEVEL_BRK_FOOTER event.  

You can call a custom section event from any section. Furthermore, you can use any event rule logic 
along with a custom section, such as If and While statements, business functions, table I/O, and so on.  
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You can call a custom section from any event rule except INIT_Section. If you try to call a custom 
section using INIT_Section, your report will not process.  

When you use a custom section, you specify the section as Conditional in Section Properties, then 
attach the system function event rule DO_CUSTOM_SECTION to the section preceding the custom 
section. 

► To use a custom section  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report for which you want to use a customer section. 

2. Click the section from which you want to call the custom section, and then choose Event 
Rules from the Edit menu.  

3. Choose the event at which you want to process the custom section.  

4. Click the System Function button.  

5. On System Functions, choose Section from the System Functions tree view, and then choose 
Do Custom Section.  

The system populates the Available Objects window with the sections in your report.  

All of the sections in your report appear in the Available Objects window, not just the ones 
that you have specified as conditional.  

6. Click the Parameter Mapping tab, choose the conditional section you want to define as a 
custom section, and then click the right arrow to move it to the Parameters window.  

7. Click OK.  

Working with the Date Title for Financial Reports  
For reports showing financial data, a date title in the page header makes the report more meaningful. 
EnterpriseOne includes commonly used date titles. While a predefined date title lets you add a date 
title quickly, it might not be specific to your company's reporting needs. Therefore, you can add your 
own company-specific date title. By calling the User Defined Date Title business function 
(B8300007), you can add an existing date title to your report or create a date title specific to your 
reporting needs.  

Prerequisite 
� Create a financial report to which you can add a date title. See Creating an Application 

Report with the Director in the EnterpriseOne Report Writing Guide for information about 
using the Financial Reports template to create a financial report.  

Adding a Date Title to a Financial Report  
The following date titles are included with EnterpriseOne:  

A (As of)  "As of 03/31/05"  
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B (Balance sheet)  "As of March 31, 2005"  

P (Profit and Loss)  "For the Three Months Ending March 31, 2005"  

S (Single period)  "For the Month Ending March 31, 2005"  

The User Defined Date Title business function (B8300007) uses the company number to determine 
the fiscal year. The company number is also used to determine the default reporting period if the 
processing option values for reporting month and year are blank.  

► To add a date title to a financial report 

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report to which you want to add a date title. 

2. Click the Page Header section, and then choose Alpha Variable from the Insert menu.  

3. Click to insert the field in the Page Header.  

4. Double-click the alpha variable field that you just inserted.  

5. On Variable Properties, on the Description tab, complete the following field:  

• Variable Name  

Label the variable so that you can identify it easily with a name such as DateTitle.  

6. Click the Display tab and modify the following:  

• Justification  

Click Center.  

• Display Length  

Type 100. If the date title is over 100 characters, the date title will be truncated to fit the 
available space.  

7. Click the Advanced tab and turn on the following option:  

• Global Variable  

Turning on this option makes the variable available in the Available Objects list (on the 
Business Functions form) for sections other than the one in which it is defined.  

8. Click OK.  

9. Align the object with the other objects in the section.  

10. Click the detail section of your report (do not click the page header section), and then choose 
Event Rules from the Edit menu.  

11. On Event Rule Design, click Yes to save your changes. 

12. On Event Rules Design, choose Before Level Break from the pull-down Events list. 

13. Choose Business Function from the Insert menu. Alternatively, you can click the f(b) 
(Business Function) button.  
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14. On Business Function Search, type B8300007 in the Source Module field of the QBE line, 
then press Enter or click Find.  

15. Click Select.  

The Business Functions form appears. You must assign values to each data item in the data 
structure. The remaining steps in this procedure show you how to assign these values. Refer 
to the illustration at the end of this procedure to see a complete data structure for the User 
Defined Date Title. 

 

 

 

16. Click in the Value column next to the data item cDateTitleType, and then double-click 
<Literal> in the Available Objects list.  

17. On Single value, click the visual assist button.  

18. On Date Title Search, choose a value, and then click Select.  

19. On Single value, click OK. The value you selected appears in the Value list.  

The Directional arrow is set automatically.  

20. Click in the Value column next to the data item szLanguagePreference.  

21. To have the date title print in the language of the user running the report, double-click SL 
LanguagePreference (system value for language preference in user profile) from the 
Available Objects list. If you do not have a language preference, skip to step 24.  

22. To have the date title print in a specific language, regardless of the user preference of the user 
running the report, use the system double click <Literal> in the Available Objects List. 

23. On Single value, click the visual assist button. 

24. Choose a value, and then click Select.  

25. On Single value, click OK. The value you selected appears in the Value list.  

The Directional arrow is set automatically.  

26. Click in the Value column next to the data item szCompany, and then double-click <Literal> 
in the Available Objects list.  
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27. On Single value, enter the company number, or click the visual assist button to search for a 
company number to enter.  

28. On Single value, click OK.  

The company number you entered appears in the Value column and determines the fiscal date 
pattern.  

The Directional arrow is set automatically.  

29. Click in the Value column next to the data item mnPOPeriodNumber, and then double-click 
PO PeriodNoGeneralLedger in the Available Objects list to copy the object to the Value 
column.  

This is the period number designated in the Financial Reports processing options (T83PO). 
This processing option will appear automatically at runtime to prompt the user for a value.  

The Directional arrow is set automatically.  

30. Click in the Value column next to the data item szPOFiscalYear, and then double-click PO 
szFiscalYear in the Available Objects list to copy the object to the Value column.  

This is the fiscal year from the Financial Reports processing options (T83PO). This 
processing option will appear automatically at runtime to prompt the user for a value.  

The Directional arrow is set automatically.  

31. Click in the Value column next to the data item szDateTitle, and then double-click the report 
variable (RV) name (this is the name you assigned to the alpha variable inserted in the Page 
Header) in the Available Objects list to copy the object to the Value column.  

The Directional arrow is set automatically.  

After completing the szDateTitle parameter, the Business Functions form is complete with 
the following parameters in the Value and Data Item lists:  

32. On Business Functions, click OK.  

33. On Event Rules Design, click the check mark to save the User Defined Date Title event rule 
and return to Report Design.  

See Also 
� To align fields or columns within or across sections in the EnterpriseOne Report Writing 

Guide for information about aligning objects within a section    

Customizing the Date Title 
While a predefined date title is helpful, a company-specific date title could be more informative for 
users. Therefore, you can customize the date title by defining your own parameters to better suit your 
reporting needs. In addition, you can create the same date title in multiple languages. The date title 
parameters are stored in the Date Title table (F83100).  
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See Also 
� To assign your accounting periods to the column headings in the EnterpriseOne Report 

Writing Guide for more information about defining the period names 

► To set up a custom date title 

From the Advanced Report Setup menu (GH9141), choose Date Titles.  

1. On Work With Date Titles, click Add.  

2. On Date Title Revisions, complete the following fields:  

• Date Title Type 

• Description 

• Language 

3. Complete the Elements fields.  

The maximum length of a date title is 100 characters.  

The maximum number of elements is 14, and each of these elements can be a literal text 
string or a text substitution parameter. The following lists the available text substitution 
parameters (stored in user defined code list 83/TS). These parameters are filled in at run time.  

• @1: Period Name  

This value is assigned by defining the name of the period for a fiscal date pattern. This is 
generally the name of the month associated with the period. The information is stored in 
the Date Title table (F83110).  

• @2: Day Period Ends  

This value is read from the Date Fiscal Patterns table (F0008). For example, this 
parameter would return 31 for a period that ends on the 31st of the month.  

• @3: Century and Year  

For example, you might enter 2005 (the year the report is based upon).  

• @4: Year  

For example, you might enter 05 (the year the report is based upon).  

• @5: Text for Period Number 

These values are stored in and read from user defined code list 83/PT. This UDC holds 
text for the number of periods through the current period. For example, period 2 would 
retrieve two.  

• @6: Date (06/30/05)  

4. To revise the Text for Period Number (@5) values, choose Period Text from the Form menu.  

5. On Date Title Revisions, click OK.  
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► To preview a custom date title 

From the Advanced Report Setup (GH9141) menu, choose Date Titles. 

1. On Work With Date Titles, click Find to bring up a list of valid date title types.  

2. Choose the Date Title you want to preview, and then choose Preview from the Row menu.  

3. On Date Title Preview, change or complete the following fields:  

• Date Title Type 

• Language 

• Company 

• Period Number 

If you leave this field blank, the value is retrieved from the Financial Reporting Date in 
the Company's application.  

• Fiscal Year 

If you leave this field blank, the value is retrieved from the Financial Reporting Date in 
the Company's application.  

4. Choose Run Preview from the Form menu.  

The date title appears on the form in the same format that it would appear in the report.  

If the date title is over 100 characters, you will receive an error message, and the date title 
will be truncated to fit the available space.  

If language-specific versions of the date title are not found, the date title appears in the 
default language.  

5. Click OK. 

Assigning Your Accounting Periods to the Column Headings 
Each fiscal date pattern type is assigned a name for each period, for example, Period One is equal to 
June. The name assigned to a period is used in the Date Title and in the Smart Column Headings 
associated with smart fields. Each Fiscal Date Pattern type can have its own period names to 
accommodate company-specific fiscal date patterns. For example, a fiscal date pattern that begins in 
October might have column heading October for Period 1, whereas a regular fiscal date pattern might 
have column heading January for Period 1.  

See Also  
� Smart Fields in the EnterpriseOne Report Writing Guide for additional information on Smart 

Column Headings 

► To assign your accounting periods to the column headings 

From the Advanced Report Setup menu (GH9141), choose Column Headings.  

1. On Work With Column Headings, click Add.  
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2. On Column Headings Revisions, complete the following fields to set up a fiscal date pattern 
type, and then click OK:  

• Fiscal Date Pattern 

• Language 

• Period 1 - 14  

Working with the Drill Down Feature  
In reports that show summary information, particularly financial reports, the report reader often needs 
to research beyond the summary information and into the detail from which the information was 
derived. For example, in a report that shows unpaid balances for customers, you might want to review 
each unpaid invoice that contributes to the total unpaid balance. You can design a report that uses the 
drill down feature to associate data on a report with a EnterpriseOne interactive application. When 
reading an online report, a user can click data in the report, which automatically launches the 
EnterpriseOne application.  

When the EnterpriseOne application opens, an audit trail is created that shows detail about the data on 
the report. The audit trail records are static. Therefore, the information in the audit trail might differ 
from the information in the records you are auditing. For example, if someone posts a transaction 
after you run a report and generate new audit trail data, the change is immediately reflected in the 
table, but it is not reflected in the audit trail. You cannot create an audit trail for tabular reports 
containing row or cell specifications or calculation fields.  

Caution 

Because the drill down feature requires significant system resources, activate it only when necessary. 
In addition, the Balance Audit Work File table (F83UI001) does not automatically purge itself; 
therefore, you need to purge this work file periodically to improve processing time. The Drill Down 
program (P83001) is on the Advanced Report Setup menu (GH9141).  

 

 

Activating the Drill Down Feature  
You can activate the drill down feature during the following activities:  

• When you edit or revise the report using Report Design. This method will be described in the 
following task.  

• When you create the report using the Report Design Director.  

• When you are modifying or creating a report director template.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� To define additional properties for an application report for information about additional 
properties for application reports 
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� Adding or Modifying Director Templates for information about activating the drill down 
feature 

Prerequisite 
� When enabling drill down in a batch version, override the specifications for the section layout 

and the event rules first. See To override version specifications in the EnterpriseOne Report 
Writing Guide for instructions on overriding specifications.  

► To activate the drill down feature  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report in which you want to activate the drill down feature. 

2. Click in the tabular report section for which you want to activate the drill down feature.  

3. Choose Section Properties from the Section menu.  

4. On Tabular Section, click the Financial tab or the tab that relates to the director template-- for 
example, Financial Reports.  

5. Click the following option, and then click Define:  

• Drill Down  

6. On Work With Applications, click Find.  

This form displays a list of all available applications. You can limit your search by entering 
search criteria in the QBE line.  

7. Choose an application, and then click Select.  

Choose an application to be called from the report. This is the application that you want to 
drill into to investigate balances.  

8. On Work With Forms, choose a form, and then click Select.  

Many EnterpriseOne applications consist of multiple forms. Choose the form to open when 
you drill into the application.  

If more than one version exists for a given form and application, the Work With Versions 
form appears.  

9. On Work With Versions, do one of the following:  

• Choose a version, and then click Select.  

• Click Close to avoid choosing a specific version.  

If the report has attached processing options, you are prompted to provide the parameters.  

10. On Form Interconnections, from the Available Objects column, double-click the object in the 
Available Objects list that you want to pass to the Value column.  

Data items come from the application that you just specified.  

11. Click the Directional arrow in the Dir column until it toggles to the right arrow icon 
(indicating that the data flows from the source to the target).  

12. Continue defining parameters for available objects.  
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Ensure that you move your cursor down to the next field in the data structure before choosing 
the next available object.  

Note 

Available objects vary, depending on the field type.  

 

13. After you have finished defining the form interconnection parameters, click OK.  

14. On Tabular Section, click OK to return to the Report Design form.  

Proceed with the task of Reviewing an Audit Trail.  

Reviewing an Audit Trail  
If you are viewing a report online that uses the drill down feature, you can click data in the report and 
automatically launch the EnterpriseOne application. This establishes an audit trail whereby you can 
see detail about the data on the report.  

Prerequisite 
� Run the report and view it online. See To submit a report for batch processing in the 

EnterpriseOne Report Writing Guide for instructions on running a report and sending the 
output to your screen. 

► To review an audit trail  

View your report online. 

1. On your online report, hover the cursor over the record you want to research until the cursor 
becomes a pointing index finger, then click.  

The Acrobat Reader displays a message asking if you want to launch the application.  

2. On Acrobat Reader, click Yes to open the application form you want to research.  

The form that is associated with this report appears for that record.  

3. Choose the record for which you want to display details, and then click Select.  

4. The form that is associated with this report appears with details about the record you are 
investigating.  

5. When you are finished with your evaluation of the form, click Close.  

6. When you are completely finished with your evaluation of the records, click the Tabular 
Section - Financial tab and turn the Drill Down option off.  

If you are creating an application report, the tab is named the same as the director template. 
For example, if you choose the Financial Reports template in the Director, the tab is named 
Financial Reports.  
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Purging Drill Down Work Files  
Each time that you activate the drill down feature in a report to review an audit trail, the system 
creates a work file which remains in the system until purged. Typically, a system administrator is 
responsible for purging drill down work files.  

► To purge drill down work files  

From the Advanced Report Setup menu (GH9141), choose Drill Down Table Purge.  

1. On Purge Financial Reporting Drill Down Work File, click Find.  

A list of all existing drill down work files appears in the grid.  

2. Choose a file, and then click Delete.  

Setting Up Business Views as Favorites  
A business view favorite is a simplified method to access information. In Report Design, favorites 
allow you to create folders that contain only the business views that you require for your reporting 
needs. You can organize these business views in any logical grouping to simplify the selection 
process. For example, set up a group by reporting system, common functionality, or frequency of use.  

During the report creation process, the Director allows you to choose business views from the 
favorites directory, but the Director interface is read-only. To modify the favorites, you must use the 
Favorites program, which you can access from the Advanced Report Setup menu (GH9141).  

When setting up your favorites, you create a tree structure. The tree structure comprises folders and 
subfolders that allow you to logically categorize the business views that you designate as favorites. 
The tree structure appears in the left portion of the form, and any notes attached to the favorites 
appear in the right portion of the form. You can place subfolders directly into a predefined folder 
upon creation. The Work with Favorites form displays the information for favorites lists based on the 
user ID of the creator of the list. 

You can also choose the language in which the text of the notes displays for your favorites.  

Creating a Favorites Folder or Subfolder  
The folder is the top level of your favorites list. In the tree structure, your folders appear beneath the 
Favorites heading. You can place favorites directly into a folder and then create a subfolder to further 
categorize your favorites within that folder.  

► To create a favorites folder  

From the Advanced Report Setup menu (GH9141), choose Favorites.  

1. On Work With Favorites, click Add.  

2. On Object Folder Revisions, complete the following fields and click OK:  

• Folder 
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• Description 

• Folder Owner 

• Category Code 1 

• Category Code 2 

• Category Code 3 

• Category Code 4 

• Category Code 5 

• Category Code 6 

► To create a favorites subfolder  

Note 

Because subfolders reside in folders, the folder in which you want to specify subfolders must already 
exist before you can add subfolders to it.  

 

From the Advanced Report Setup menu (GH9141), choose Favorites.  

1. On Work With Favorites, click the folder to which you want to add a subfolder, and then 
choose Add Subfolders from the Row menu.  

2. On Object Folder Revisions, complete the following fields:  

• Folder 

• Description 

• Folder Owner 

• Category Code 1 

• Category Code 2 

• Category Code 3 

• Category Code 4 

• Category Code 5 

• Category Code 6 

3. Ensure that the Subfolder box has been selected, and then click OK.  

Adding Business Views to a Favorites Folder or Subfolder  
After you add folders to a favorites list, you can add business views to the favorites folder. If you set 
up subfolders beneath your folders in your favorites list, you can also add business views to these 
subfolders.  

► To add business views to a favorites folder or subfolder  

From the Advanced Report Setup menu (GH9141), choose Favorites.  
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1. On Work With Favorites, choose a folder or a subfolder.  

2. From the Row menu, choose Revise Favorites.  

3. On Favorites Revisions, click in the Object Name field, and then click the visual assist icon.  

4. On Object Search, click Find to display a list of available business views.  

You can refine your search by entering search criteria in the QBE line.  

5. Choose a business view in the detail area, and then click Select.  

6. Repeat Steps 3-5 until you have added all the required business views to the folder or 
subfolder, and then click OK.  

Using Notes with a Favorite, a Folder, or a Subfolder  
You can add notes to a favorite or a folder to describe its use or its contents. For example, you might 
include text that describes when to use a particular business view and the name of the business view. 

► To add notes to a favorite, a folder, or a subfolder  

From the Advanced Report Setup menu (GH9141), choose Favorites.  

1. On Work With Favorites, choose a favorite, folder, or subfolder.  

2. From the Row menu, choose Note Revisions.  

3. On Notes Revisions, type your note, and then click OK.  

4. On Work With Favorites, choose the appropriate item and notice that your note appears in the 
right portion of the form.  

► To delete notes from a favorite, a folder, or a subfolder  

From the Advanced Report Setup menu (GH9141), choose Favorites.  

1. On Work With Favorites, choose a favorite, a folder, or a subfolder.  

2. From the Row menu, choose Note Revisions.  

3. On Notes Revisions, delete the text, and then click OK.  

Translating Descriptions of Favorites  
If you need to set up your system to handle multiple languages, you can enter alternate descriptions 
for your favorites to support the available languages. You can use the Favorites program (P91100) to 
include translations of items that appear in your favorites lists.  

► To set up favorites description translations  

From the Advanced Report Setup menu (GH9141), choose Favorites Description Translation.  

1. On Work With Favorites Description Translation, choose a language from the grid, and then 
click Select.  

2. On Revise Favorites Description Translation, complete the following field, and then click 
Find:  
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• Skip To Favorite 

3. Type the Alternative Description in the detail area for the favorite you would like to translate, 
and then click OK.  

► To view a favorites list with alternative descriptions  

From the Advanced Report Setup menu (GH9141), choose Favorites.  

On Work With Favorites, complete the following field, and then click Find:  

• Language 

If a favorite exists in the specified language, it displays; otherwise, the favorite displays in the 
domestic language.  

Notice that the notes are blank to allow for notes to be entered in the translated language.  

Working with Processing Options Templates  
Processing options control how a report or batch application processes data. They are version-driven; 
therefore, unique processing option values can be attached to different versions of the same report. 
Processing options for a report can be set to appear automatically at runtime to prompt the user for 
specific values. You can use processing options to:  

• Control how a report processes data.  

• Set up default values.  

• Customize an application for different companies or even different users.  

• Control the format of reports.  

• Control page breaks for reports.  

• Control totaling for reports.  

A processing options template contains one or more processing options. Each processing option 
appears on a row within the template and is defined by its title, which includes its valid values if they 
exist.  

The following overview outlines the process to create and use processing options templates:  

1. Create processing options by building a list of parameters called a template.  

2. Attach this template to a report and create event rules for the report to make use of these 
values.  

3. Create versions of the report.  

4. Specify how the processing options will be handled at run time by specifying different 
processing option values for different versions.  

5. At run time, a processing option template displays a set of tabs within an area called a page. 
Each tab represents a category of processing options. When you click the tab, the page 
changes to show the set of processing options for that category. At run time, depending on 
how you set up the report, one of the following occurs:  
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• The processing options appear, allowing the user to supply values.  

• A versions list appears, with each version holding a preselected set of processing option 
values.  

• The report runs with a preselected set of options, such as data selection and data 
sequencing, and with preselected processing option values. 

This section contains detailed instructions for Steps 1 and 2 of the overview. 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� To create a batch version for information on creating versions of a report   

� To change processing options for batch versions for information on specifying how 
processing options will be handled at run time 

� To submit a report for batch processing for information on running a report   

Designing Processing Options Templates  
You can create a processing options template that lists the values for data items passed to the report at 
run time. You can also add tabs to the processing options template. 

► To create a processing options template  

In EnterpriseOne, enter OMW in the fast path. 

1. On Object Management Workbench, click Add.  

2. On Add J.D. Edwards Object to the Project, choose the following option and click OK.  

• Data Structure 

3. On Add Object, complete the following fields:  

• Object Name 

• Description 

• Product Code 

• Product System Code 

• Object Use 

Object Use should reflect the object being created. You can create your own valid value 
for Object Use. To do so, click the visual assist; then from the Form menu choose 
Revisions. On Work With User Defined Codes, click Add. On User Defined Codes, 
scroll to the bottom of the list to a blank row in the grid and enter a new code and 
description. 

4. Choose Processing Option Template and click OK.  

5. On Processing Option Design, click the Design Tools tab, and then click the Start the 
Processing Option Design Aid.  
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6. On Processing Options Design, click on the <New Tab>, right-click; and from the pop-up 
menu, choose Current Tab Properties.  

7. On Tab Properties, complete the following fields, and then click OK:  

• Short Name  

• Long Name  

8. To display data dictionary items on the Data Dictionary Browser form, perform one of the 
following:  

• Click the Search icon located directly beneath the Data Dictionary Browser heading.  

• Right-click on this form, and then choose Find.  

• Enter a value on the QBE line, and then press Enter.  

9. Use one of the following methods to select items that you want to add to your processing 
options:  

• Double-click the item in the Data Dictionary Browser. The item appears in the left side of 
the form under your tab.  

• Drag the item from the Data Dictionary Browser to the position you want it in on the tab.  

10. To reposition an item on the tab, click the item and drag it to its new position.  

The Processing Options tool automatically adjusts the size and position of data items to fit the 
width of the tab.  

11. Double-click the text portion of the item to delete or overwrite it.  

12. Right-click the data item and choose Properties from the resulting pop-up menu.  

13. On JDE.DataItem Properties, on the General tab, change the Alias field, if necessary.  

The Alias description must be a unique identifier.  

14. Click the Help Override Data Item tab and modify the following field, if necessary:  

• Data Item Help Override Name  

15. Click OK.  

► To add a tab to a processing options template  

In EnterpriseOne, enter OMW in the fast path. 

1. On Object Management Workbench, click Add. 

2. On Add J.D. Edwards Object to the Project, choose the following option and click OK: 

• Data Structure 

3. On Add Object, complete the following fields and click OK: 

• Object Name 

• Description 

• Product Code 

• Product System Code 
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• Object Use 

4. On Processing Option Design, click the Design Tools tab, and then click Start the Processing 
Option Design Aid. 

5. On Processing Options Design, click on the <New Tab>, right-click; then choose New Tab 
from the pop-up menu.  

A second <New Tab> is added to the form, and the Tab Properties form appears.  

6. On Tab Properties, complete the following fields, and then click OK:  

• Short Name  

• Long Name  

7. When your processing option is complete, you can choose Test from the Edit menu to see 
how it will display.  

From this point, you can test the visual assist to ensure that you have chosen the correct data 
item for your processing option. You must save your changes before you exit.  

Attaching a Processing Options Template to a Report  
You must attach a processing options template to a report to use the functionality at run time. Because 
the template exists as a separate object, you can attach the same template to multiple reports.  

► To attach a processing options template to a report  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access your report to which you want to attach a processing options 
template. 

2. Choose Select Processing Options from the File menu.  

3. On Select Processing Option Template, choose the template you want to use, and then click 
OK.  

A check mark appears next to Select Processing Options on the File menu, indicating that a 
processing options template is attached to this report.  

4. To confirm that the correct processing options template is attached to the report, from the 
Report menu, choose Report Properties.  

The Processing Options field indicates the processing options template that is attached to the 
report.  

5. To remove an existing processing options template, choose Select Processing Options from 
the File menu.  

6. On Select Processing Option Template, choose the template and click Remove.  
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Working with Director Templates  
The Report Director aids you in report design by helping you create a report object and guiding you 
step-by-step through the design process. In addition to creating a group, columnar, or tabular section 
through the Report Director, the Director uses director templates to help you create application 
reports, such as financial reporting, fixed assets, or job cost. These templates, included with 
EnterpriseOne, contain default criteria. When you choose one of the templates in the Director, the 
Director program reads the template specifications (stored in EnterpriseOne tables) and presents the 
default criteria through the Director forms. You can modify the EnterpriseOne templates and create 
your own through the Smart Field Activation (P91420) and Report Director Templates (P91400) 
programs. For each director template you create, you must determine the following specifications:  

• Which business view to use as the default view  

• Which processing options to attach to the report  

• Which Director forms to display  

• Which smart fields to display for column selection  

• The preferred smart field data selection  

• The preferred data sequencing  

• Which additional properties to include  

The template specifications are stored in the following EnterpriseOne tables:  

Report Director Templates (F91400)  This table contains the default business view and 
processing option information.  

Report Director Templates Sequence 
Items (F91410)  

This table contains the information about the preferred 
data sequencing.  

Report Director Templates Smart Field 
Activation (F91420)  

This table contains the information about which smart 
fields to display.  

Smart Field Template Criteria (F91430)  This table contains the information about smart field 
data selection.  

Working with Smart Field Templates  
A smart field template lets you group smart fields so that you can include them collectively in a 
director template. For example, the smart field template called "S09001 - Financial Reporting" 
contains all the smart fields for financial reporting. EnterpriseOne includes predefined smart field 
templates. Through the Smart Field Activation program (P91420), you can add new or modify 
existing smart field templates to meet your reporting needs.  

When you create a director template, you must attach a smart field template to the director template. 
The smart fields and data fields that are included in the smart field template determine which template 
you attach to the director template. For example, if you are creating a financial report, the smart field 
template called "S09001 - Financial Reporting" might contain all the smart fields and data fields that 
you require. Therefore, you could specify S09001 as the smart field template to attach to your director 
template. When you use the director template to create a report, the smart fields in the specified 
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template appear in the Available Smart Fields area of the Select Column form of the Report Director. 
From this form, you can choose any of the fields to include in your report.  

In addition to specifying which smart fields you want to include in the template, you can also include 
fields used for data selection within the smart field column. These fields appear on the Smart Field 
Data Selection form of the Report Director.  

Prerequisite 
� Before you can create a smart field template, the smart fields to include in that template must 

already exist. See Attaching a Smart Field Trigger in the Development Tools Guide to create 
smart fields. 

► To create a new smart field template  

From the Advanced Report Setup menu (GH9141), choose Smart Field Templates.  

1. On Work With Smart Field Templates, click Add.  

2. On Smart Field Template Revisions, complete the following fields:  

• Smart Field Template 

• Description 

3. Click in the Data Item field and click the Search button.  

4. On Smart Field Search & Select, click the following option:  

• Smart Field  

5. Click Find to display a list of all available Smart Fields.  

Use the QBE line to limit your search.  

6. Choose a smart field, and then click Select.  

7. Repeat Steps 3-7 until you have added all smart fields you want to include in the smart field 
template.  

8. On Smart Field Template Revisions, click OK.  

The Smart Field Template Criteria Revisions form appears. This form lets you determine 
smart field data selection.  

9. On Smart Field Template Criteria Revisions, click the visual assist icon in the Data Item 
field.  

Note 

The search form allows you to choose from all data items in the system. Select only those 
appropriate to your business views.  

 

10. On Data Dictionary Search and Select by Alias, click Find to display a list of available data 
items.  

Use the QBE line to refine your search.  

11. Choose the data item, and then click Select.  
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12. On Smart Field Template Criteria Revisions, in the row of the data item that you selected, 
complete the following field:  

• Range Values 

Enter a 0 to indicate that the data item will have a single value only. Enter a 1 if you want 
a data item to accept a range of values, such as Object Account: From and Object 
Account: Thru. These data items appear on the Smart Field Data Selection form in the 
Director.  

13. Repeat Steps 9-12 to select all data items for smart field data selection, and then click OK.  

Note 

Only five data items are allowed. A range of values counts as two data items.  

 

14. Use Display Sequences to determine the order in which you want the data items to appear on 
the Smart Field Data Selection form when you create an application report using the Report 
Director.  

To use a smart field template, you must attach it to a director template.  

See Also 
� Adding or Modifying Director Templates in the EnterpriseOne Report Writing Guide for 

information about connecting the smart field template to the director template   

► To modify an existing smart field template  

From the Advanced Report Setup menu (GH9141), choose Smart Field Templates.  

1. On Work With Smart Field Templates, choose the template to be modified, and then click 
Select.  

2. On Smart Field Template Revisions, add or delete smart fields from the template, and then 
click OK.  

3. On Work With Smart Field Templates, choose Template Criteria from the Row menu to 
change the smart field data selection for the modified template.  

4. On Smart Field Template Criteria Revisions, click the Data Item visual assist icon.  

5. On Data Dictionary Search and Select by Alias, click Find to display a list of available data 
items.  

Use the QBE line to refine your search.  

6. Choose the data item, and then click Select.  

7. On Smart Field Template Criteria Revisions, in the row of the data item that you selected, 
complete the following field:  

• Range Values 

Enter a 0 to indicate that the data item will have a single value only. Enter a 1 if you want 
a data item to accept a range of values, such as Object Account: From and Object 
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Account: Thru. These data items appear on the Smart Field Data Selection form in the 
Director.  

8. Repeat Steps 4-7 to select all data items for smart field data selection, and then click OK.  

Note: 

Only five data items are allowed. A range of values counts as two data items.  

 

9. Use Display Sequences to determine the order in which you want the data items to appear on 
the Smart Field Data Selection form when you create an application report using the Report 
Director.  

To use a smart field template, you must attach it to a director template.  

See Also 
� Adding or Modifying Director Templates in the EnterpriseOne Report Writing Guide for 

information about connecting the smart field template to the director template   

Adding or Modifying Director Templates  
This section describes how to use the Report Director Templates program (P91400) to create and 
modify director templates. When created or modified, the templates are available to you on the Report 
Director's Welcome form.  

Caution 

Smart fields associated with a director template rely on business view columns in the template's 
associated business view. If you change the business view or select a different business view, the 
associated smart fields might not function correctly. Before making any such changes, ensure that you 
know which business view columns that the smart fields in question require. 

 

 

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� To choose an application report template for information about how the description appears 
on the Report Director's Welcome form  

� To define section data sequencing with the Advanced option off or To define section data 
sequencing with the Advanced option on for information about the Data Sequencing Help 
form as it appears in the Report Director 

Prerequisite 
� Using the director template, specify the name of a smart field template or create a smart field 

template, if a suitable one does not exist. See Working with Smart Field Templates in the 
EnterpriseOne Report Writing Guide for information about how to add or modify a smart 
field template. 
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► To add or modify a director template  

From the Advanced Report Setup menu (GH9141), choose Report Director Templates.  

1. On Work With Report Director Templates, click Add to add a director template.  

To modify an existing director template, click Find, choose the template to modify and click 
Select.  

2. On Report Director Templates Revisions, complete the following fields:  

• Report Template 

• Description 

The description appears when you click the down arrow on the Report Director's 
Welcome form.  

3. On the Building Blocks tab complete the following fields:  

• Section Type 

• Default View 

• Default Processing Options 

• Smart Field ID 

This field is active only if you chose to create a tabular section type.  

4. Click in the Data Item field under the Default Sequence and Level Breaks column to display 
the Search button.  

5. Click the Search button.  

6. On Data Dictionary Search and Select by Alias, click Find to display a list of available data 
items.  

Use the QBE line to narrow your search.  

7. Choose a data item in the detail area, and then click Select.  

8. On Report Director Templates Revisions, click in the next Data Item field.  

The Description and Display Sequence form automatically appears for the data item selected 
in step 7.  

9. Repeat steps 4-8 for every data item that you want to include on your report.  

The first two data item descriptions listed in the detail area are reflected in the Report 
Grouping column, and the subsequent data item descriptions are reflected in the Report Detail 
column on the Data Sequencing Help form of the Report Director.  

10. On Report Director Templates Revisions, click the Properties tab.  

11. Click the following options as necessary:  

• Use Financial Description 

• Display Level of Detail 

• Display AAI Subtotal 
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• Display Adjust Sign 

• Display Suppress Zero Rows 

• Display Generic Criteria 

• Display Financial Criteria 

12. Click the Drill Down tab, and then click the Drill Down option.  

By turning the Drill Down option on, the Drill Down option appears on the Additional 
Properties form of the Report Director. After designing your report with the Director, you can 
drill into the application, form, and version identified in the director template to see the detail 
of the data that appears on the report.  

13. On Work With Applications, locate and choose the application to launch when the report 
reader wants to research report information.  

14. Click Select.  

15. On Work With Forms, choose a form, and then click Select.  

If there are versions for a given form and application, the Work With Versions form appears.  

16. On Work With Versions, choose a version, and then click Select.  

17. On Report Director Templates Revisions, click OK.  

Adding Text Attachments to a Report  
EnterpriseOne allows you to attach text to records in your database. For example, you might attach a 
comment to clarify a transaction, such as "Customer notified us that their payment was sent 
02/01/99." Users can add text attachments to records from PeopleSoft EnterpriseOne software 
interactive applications.  

You can design a report to show any text attachments that exist for a record. In this way, anyone who 
reads the report can see the same text attachments that are available in the interactive applications.  

The following illustrates how a text attachment (shown under the Comments heading) might appear 
on your report:  
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See Also 
� To create an If/While statement in an event rule in the EnterpriseOne Report Writing Guide 

for information about creating this criteria 

Prerequisites 
� Ensure that you have already created text attachments for the records you want to include in 

the report. See Media Object Attachments in the Foundation Guide for information about 
adding text attachments. 

� Access an existing report or create a new report that prints the records to which you have 
attached the text. See Creating a Report Object or Report Design Director in the 
EnterpriseOne Report Writing Guide documentation for information about accessing an 
existing report or creating a new report. 

� Specify the name of the data structure that the interactive application uses to associate records 
with their text attachments. EnterpriseOne uses data structures to associate records with their 
text attachments. You can use Object Management Workbench to see a list of all media 
object data structures (object type GT). See Creating a Media Object Data Structure in the 
Development Tools Guide for more information about media object data structures. 
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► To add text attachments to a report  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report and then select the detail section to which you want to 
add the text attachment. 

2. From the Insert menu, choose Alpha Variable.  

3. Insert the variable into the detail section.  

4. Double-click the alpha variable field (the body, not the header) that you just inserted.  

An appropriate Variable Properties form appears.  

5. On the Description tab, change the following field:  

• Variable Name  

Change the column or variable properties to a meaningful name-- for example, 
Comments.  

6. Click the Display tab and modify the following field to a length that accommodates the text 
attachment for this field. If the text is longer than the display length, the text will wrap.  

• Display Length  

7. Click OK.  

8. Click anywhere in the detail section of your report to deselect the newly created alpha 
variable, and then choose Event Rules from the Edit menu. 

9. On Event Rules Design, choose the Do Section event from the pull-down Events list.  

10. Choose System Function from the Insert menu.  

11. On System Functions, on the Function Selection tab, double-click the Media Objects folder to 
see all available functions.  

12. Choose the media object data structure that was attached to the original application.  

13. Click the Parameter Mapping tab.  

Other than the Action and Status parameters, the parameters that appear on this screen vary 
depending on the criteria that you established.  

14. Define the following two parameters:  

• Action  

Choose <Get Text> from the Available Objects. This action calls a function to retrieve 
the generic text associated with the parameter.  

• Status  

When you choose <Get Text> for the Action, this data item automatically changes to 
Text. Text designates the variable into which you input the retrieved text.  

Choose RV Comments from the Available Objects.  
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15. Define all other parameters using the available business view columns, and then click OK.  

An event rule similar to the one below appears on the Event Rules Design form. This rule 
varies, depending on the criteria that you entered.  

16. On Event Rules Design, click the check mark to save and return to Report Design.  

17. Preview or run your report.  

For any record that has generic text attached, the text prints where you placed the alpha 
variable on the report.  

To see generic text for specific records, establish If/While criteria. If no generic text for the 
record exists or if the record is excluded by the If/While logic, no text prints in the alpha 
variable location.  

Working with Report Properties  
Report Design lets you modify your report and version output by changing report properties. Report 
properties include details such as the report format, the number of records a report displays, various 
font types and colors, and more advanced properties.  

You can also modify your report dimensions to support a custom form type. For example, if you want 
to print information on mailing labels, tax forms, or a preprinted check, you can define the 
dimensions of your report to match the dimensions of the hard-copy form type. Also, you can change 
the fonts on your report to print correctly on a line printer.  

The properties that can be modified include report format and number of records displayed, default 
fonts and colors, cover page options, decimal scaling, and advanced properties.  

See Also 
� Transaction Processing in the Development Tools Guide for additional information about 

using the Transaction Processing option 

► To work with report properties  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, access the report, and then choose Report Properties from the File menu.  

2. On Properties, click the Report Properties tab, and click the following options as necessary:  

• Print Totals Only  

• Print Grand Totals  

• Suppress All Output  

• Limit Number of Primary Table Rows  

3. Click the Font/Color tab.  

4. Choose Apply settings to all Objects, click Defaults, or change other options.  

Apply Settings to all Objects overrides any font/color choices you made at the individual 
field level.  
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5. Click the Cover Page Options tab.  

6. Click the following options as necessary:  

• Print Cover Page  

Cover pages provide information about the report or batch process including report 
properties, system properties, printer properties, and processing options. In addition, 
information is provided at the section level, including section properties, object 
properties, data selection and sequencing, and row properties. You can choose what level 
of detail your cover page will display for these properties.  

If you choose Print Cover Page on Properties for the report template, a cover page does 
not print for the versions of the report. If you want to specify a cover page for a version, 
you need to turn this option on using Version Detail or Advanced Version Detail.  

• Report Properties  

• System Properties  

• Printer Properties  

• Processing Options  

• Section Properties  

• Data Selection  

• Data Sequencing  

• Object Properties  

7. Click the Decimal Scaling tab and click one of the following options:  

• No Scaling  

• Scaling from 1 - 1,000,000,000  

• Apply settings to all Objects  

8. Click the Advanced tab, and choose or update the following options and fields as necessary:  

• Subsystem  

• Wait Time (ms)  

• Custom  

• Enabled  

• Target  

• Source  

• Prompt for overrides at runtime  

9. Click OK to save your changes.  
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Using Business View V8300005 in Financial Row 
Reports 

In ERP 9.0, a new business view, V8300005, was added to improve the system performance of 
Financial Row Reports. V8300005 is a simple join of the F0901, F0902, and F0006 tables. The output 
of a report using this business view will show only accounts with balances. It will not show header or 
title accounts. Use this business view in a financial row report where each row is individually defined. 

If you did not receive V8300005 as part of ERP 9.0, but received it as part of an electronic software 
update (ESU), you need to manually change the report director template for financial row reports to 
use the new business view.  

► To change the financial row reports director template to use business view V8300005 

From the Advanced Report Setup menu (GH9141), choose Report Director Templates. 

1. On Work With Report Director Templates, click Find to display the list of report director 
templates. 

2. Choose S09003, Financial Row Reports and click Select. 

3. On Report Director Templates Revisions, on the Building Blocks tab, change the value of the 
business view from V8300001 to V8300005, and then click OK. 
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Batch Versions for Reports  

In EnterpriseOne, a batch version is a user-defined set of specifications. These specifications control 
how batch processes run. Typically, batch versions are associated with reports or batch processes, and 
run as batch jobs on a EnterpriseOne enterprise server.  

Batch versions for reports are a predefined set of specifications contained in a file that is separate 
from the base report or batch specifications. These specifications control the logical functions and the 
appearance of the report. The version contains the processing instructions, which are a complete set of 
preselected processing options and additional characteristics specific to report design. Depending on 
how you assign security to your EnterpriseOne applications, end users can choose or create different 
versions based on business requirements.  

Versions are a powerful and convenient way to modify the behavior of reports. Typically, 
administrators control the creation, modification, and location of the initial batch version files. When 
you upgrade EnterpriseOne or a specific application to a new release level, you can apply the existing 
batch versions without additional modification.  

When you start a batch application (that is, when you submit a batch job) you must use a batch 
version. Depending on how the report was designed, you might have the option to override 
processing option values for the version. You also might be able to perform data sequencing and data 
selection, override default locations, or override the basic layout of the base report.  

For example, suppose you have a report that prints the same financial information to two different 
audiences: an American subsidiary and a French subsidiary. You can create an American version, 
which shows financial information in dollars for a specific time period and formats the report for 
American-sized paper. You also can create a French version, which shows the financial information 
in Euros for a different time period and formats the report for European-sized paper. For the French 
subsidiary, you also could display additional information on the report by adding data items in the 
French version.  

Characteristics of Batch Versions  
A batch version is defined by the following characteristics:  

• Data sequencing at the version level. For example, you can sort checks by date or by check 
number, you can sort address book records by employee or customer, or you can sort records 
alphabetically.  

• Data selection at the version level. For example, you can specify which records to fetch, such 
as Business Unit 10-30 and 70, or all Address Book records with Category 1=North.  

• Additions or overrides in the version at the section level. At the section level, report designers 
can use batch versions to add or override functionality using the report template. These 
section-level overrides differ from the version-level overrides in that they apply only to 
individual sections. At the section level, the report designer can override section layout, data 
selection, data sequencing, event rules, and database output. You cannot delete functionality 
if it exists in the base report.  

• A specific set of processing option values. For example, you can set a processing option value 
to run G/L Post to print a different account number format on the report.  
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For batch versions, processing options do the following:  

• Change functionality. For example, you can set a processing option to purge records to a 
history file after a report runs.  

• Change input parameters. For example, you can set a processing option to specify which 
category code to use when processing a report.  

• Define data. For example, you can set a processing option to define the fiscal year for 
which you want to run a report. You can also define the number of aging days in an 
Accounts Receivable aging report.  

Batch Versions Created Using the Web Client  
If you use a Web client, you can create a new batch version of a report using the Add or Copy options 
on the Web client Work With Batch Versions - Available Versions form. The system indicates that 
these new batch versions are Web Only. To change the data selection, sequencing, or processing 
options of a Web Only version, choose the Data Selection, Data Sequencing, or Processing Options 
option from the Row menu. 

To run a Web Only version in an environment other than the Web client, use Object Management 
Workbench to check the version out, and then check it in using the standard client. Object 
Management Workbench automatically converts the Web Only version to work on a standard client. 

To permanently remove the Web Only flag, so that it becomes a standard version, generate the batch 
version using the eGenerator tool after converting the version.  Since there must be specifications on 
the machine where the eGenerator tool is run, either run the conversion process on the same machine 
that runs the eGenerator tool, or use a “Get” within Object Management Workbench to bring the 
specification to the client running the eGenerator tool. 

You cannot copy a batch version with a Web Only indicator. 

See Also 
� Generating EnterpriseOne Serialized Objects in the Web Server Installation Guide for 

instructions on using eGenerator 

Working with Batch Versions  
For batch versions, EnterpriseOne uses the same process as the Object Management Workbench to 
check in, check out, and erase checkouts for versions. You use Object Management Workbench to 
control the movement of versions between the workstation and the server. Batch versions are 
submitted directly from the batch application.  

Just like base report specifications, when you create a batch version, the specification records for that 
version exist only on your workstation. To make the version available to other users, you must check 
the version into the server. When you check in a version, EnterpriseOne copies the version's 
specification records to the central objects data source (server) according to the path code of your 
current environment.  

After you check in your version, you can still make specific changes to the version without checking 
it out. For example, when you make changes to the processing options, these changes are effective 
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immediately, even if you have not checked in your local version. This is because a version's 
processing options are stored directly as a field in the version record that is stored in the server 
Versions List table (F983051).  

When you check a batch version into the central objects data source (server), anyone who installs and 
runs the version will be ensured of having the updated version. A version cannot be checked out by 
more than one user. The Version Detail form displays the user that has checked out a version.  

You can create a new batch version that is not based on an existing version. For example, you might 
create a new version because you do not want to use the layout or data selection of the existing 
version. When you create a new version, you use the specifications provided by the base report.  

If you make changes to the base (template) report, EnterpriseOne automatically "pushes" any changes 
to all of the versions that exist for that base report, unless you created a version that contains 
overrides.  

If you copy a version, the copied version inherits the same data selection and data sequencing as the 
existing version.  

See Also 
� Changing the Design of a Batch Version in the EnterpriseOne Report Writing Guide for 

information about overrides  

Running a Batch Version  
If batch versions are associated with a form, you can access them for viewing and printing from the 
form's Reports menu. Base reports and versions of those reports are available on menus as icons.  

In most cases, you submit batch versions to an enterprise server, which can more efficiently handle 
the processing. The EnterpriseOne environment that you log on to specifies where your batch 
versions will run, although you can override this location when you submit a batch version. When 
you submit your batch job to the server, you can preview the report and use the Work With Servers 
program (P986116) to monitor the progress of your job in the queue.  

When you submit a report to the enterprise server, if the report specifications do not currently reside 
on your workstation, the central objects data source (server) first performs JITI (just-in-time 
installation) to transfer the specifications to your workstation. After the JITI, your workstation 
continues with the submission of the report to the enterprise server, and EnterpriseOne transfers the 
local version specifications (any changes you made to the version) to the enterprise server.  

If a batch version is flagged as Web Only, and you are running the batch version on a fat client you 
must convert it into a flat client version before you can run it. To convert the web only batch version, 
use Object Management Workbench to check the batch version in, then check it out. 

See Also  
� Submitting a Report in the EnterpriseOne Report Writing Guide for complete information 

about running a batch version  

� The Work with Servers Program in the Configuration Planning and Setup: System 
Administration Guide for information about the Work With Servers form 
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Accessing the Work With Batch Versions Form  
You can access the Work With Batch Versions - Available Versions form, which is the entry point to 
managing batch versions, in one of several ways.  

► To access the Work With Batch Versions form  

Open PeopleSoft Solution Explorer. 

From the Report Writer (GH9111) menu, choose Batch Versions (P98305).  

The Work With Batch Versions – Available Versions form appears.  

Related Tasks 

Other methods of accessing the Work With Batch Versions form include: 

• From any menu with a batch application, choose the batch application and then, from the Edit 
menu, choose Prompt for Versions.  

• From any menu with a batch application, right-click the batch application and then, from the 
pull-down menu that appears, choose Prompt for Versions. If no versions are associated with 
the batch application, you must copy or add a version and run that version as explained in this 
section.  

• On the Menu bar, choose Tools and then Batch Versions. 

Changing the Design of a Batch Version  
To change the specifications for a version, you do not need to change the base report template; 
instead, you can override the report specifications at the version level. The changes you make to the 
report specifications for the version do not affect any other version associated with the base report 
template. However, if you change the specifications at the report template level, those changes will 
not be pushed down to the version if an override has been applied to that specification type.  

When you change the specifications at the version level, you should include a description of your 
modifications in the Version Detail field on the Version Detail form. The description should include 
any differences between the base report specifications and the version specifications.  

The following can be changed in a report version:  

• Section Layout  

• Section Data Selection  

• Section Event Rules  

• Section Database Output  

• Section Sort Sequence  
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Note 

If you are using the Web client, you can only make run-time changes to a version if the version is not 
flagged as Web Only. Run-time changes do not persist.  

 

See Also 
� Working with Version Detail for Batch Versions in the EnterpriseOne Report Writing Guide 

Prerequisites 
� Override specifications only at the version level. To copy or create a version to override, see 

Copying a Batch Version or Creating a Batch Version in the EnterpriseOne Report Writing 
Guide. 

� Check out the version before you access Report Design to create a version override; see 
Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide. 

� Close the Report Design tool if it is open on your computer. 

► To change the design of a batch version  

Use the Batch Versions program (P98305) to locate and run versions of reports. In addition, you can 
modify version detail information, data selection, and data sequencing.  

From the System Administration Tools menu (GH9011), choose Batch Versions. 

1. On Work With Batch Versions - Available Versions, complete the following field: 

• Batch Application 

For example, to locate a version for the One Line Per Address program, type R014021.  

2. Click Find to locate the versions available on your workstation.  

When you click Find, the Read Only Report field displays whether the report template is for 
an update report (Y) or a non update report (N). A read only report can read the database, but 
cannot update the database. 

3. For alternate lists of versions in the EnterpriseOne environment, choose Display from the 
Form menu, and then choose one of the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

You can delete any version (depending upon your application and user security) unless you 
are on a web client. If you are on a web client, you can only delete the versions that have a 
Web Only flag. If you try to delete a version that is not on your machine, a warning message 
appears.  

4. In the detail area, choose a version with which you want to work.  
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5. From the Row menu, choose Advanced.  

Note 

Before you can complete the following steps, you must have already checked out a version of 
the report.  

 

6. On Advanced Operations, choose Design Version from the Row menu.  

Report Design opens with the report specifications for the version.  

7. On Report Design, click in a section and then choose Override Version Specifications from 
the Section menu.  

You cannot make any changes to a section until you access the Override Version 
Specifications form and choose what you want to change.  

Any overrides you make to a section are valid only for that section. You need to override 
additional sections individually.  

8. Choose any of the following overrides, and then click OK:  

Note 

Remember that if you override any version specifications, those specifications are not 
updated if you then make changes to those specifications in the base report template. For 
example, if you turn on the Section Data Selection override and make changes to the version's 
data selection, and then later you change the data selection of the report template, the report 
template data selection changes will not be pushed to the version.  

 

• Section Layout  

Select this override if you need to change section properties or to delete a column, add a 
new column, move a column, or change column headings on a report version.  

• Section Data Selection  

Select this override if you need to have report versions that utilize specific data selection, 
such as a version for customer information only and a version for employee information 
only.  

• Section Event Rules  

Select this override if you need a report version that utilizes a specific event rule, such as 
a version for employee information with a calculated percentage raise amount, date title, 
or Balance Auditor.  

• Section Database Output  

Select this override if you need a report version that prints to a specific location other 
than the default printer location. If you want other sections, such as the page header, to 
also print to this location, you need to override the specifications to each of those sections 
as well.  
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• Section Sort Sequence  

Select this override if you need a report version that is sorted differently than the base 
report. For example, you can have a version sort by name rather than by address number.  

9. The changes you make affect only the version on your local workstation. To make these 
changes available to the enterprise, you must now check in the version. If you do not check in 
the version, verify that you erase your checkout so that others can check out this version.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information about checking batch version 
in and out 

� Erasing the Check-Out Record of a Version for information about erasing version check-out 
records 

Changing Processing Options for Batch Versions  
You can change the processing option settings for an existing batch version to suit your needs. For 
example, you can change the processing option values that direct the system to show or hide a field or 
you can change order activity rules. Not all batch versions have processing options associated with 
them; for example, a list of addresses might not require special prompting.  

Processing option changes are stored for each UBE run. Unlike other changes to versions, changes to 
processing option values do not require you to check in or check out the version. Anyone who uses 
that version after you make the change will not be affected by the new processing option values.  

If you are using a Web client, you can change the processing options of Web Only versions both at 
run time and within the version specifications. If the version is not marked Web Only, you can only 
change the processing options at run time. Run-time changes are not persistent. 

Note  

You should not modify EnterpriseOne demo versions, which contain ZJDE or XJDE prefixes. You 
should either copy these versions or create new versions to change any values, including the version 
number, version title, prompting options, security, and processing options.  

 

Prerequisite 
� If you access processing options from the Row menu of the Work With Batch Versions form, 

you must check out the version to your machine. See Checking Out or Checking In a Batch 
Version in the EnterpriseOne Report Writing Guide.  

► To change processing options for batch versions  

From the System Administration Tools menu (GH9011), choose Batch Versions (P98305).  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. 

For example, to locate a version for the One Line Per Address report, type R014021.  
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2. Click Find to locate the versions available on your workstation.  

Alternatively, on Work With Batch Versions - Available Versions, from the Form menu, 
choose Display and then click one of the following:  

• Available Versions 

All versions available on your workstation are shown.  

• My Versions 

Only the versions you created are shown.  

• All Versions 

All versions that exist for the batch application are shown. When you view All Versions, 
you can work only with versions that appear in black text.  

3. In the detail area, choose the version with which you want to work.  

The Work With Batch Versions form shows only the versions available to your workstation, 
including any versions you create locally. Versions created on another machine must first be 
checked in to the central objects data source (server) before they appear on this form.  

4. From the Row menu, choose Processing Options.  

If processing options do not exist for this version, or if you have been secured from changing 
processing options, a message box appears informing you of this; otherwise, the Processing 
Options form appears for the application. On this form, you can define the values that control 
how your report processes.  

You can also access the Processing Options form in the following ways:  

• Choose a batch application, and then choose Prompt for Values from the Edit menu on 
PeopleSoft Solution Explorer.  

• Right-click the batch application name in PeopleSoft Solution Explorer, and then choose 
Prompt for Values from the pull-down menu that appears.  

5. Click each tab to view and change information on that tab.  

If multiple tabs exist and you cannot see all of them, left and right arrow buttons appear on 
the form. Click the arrow buttons to view the other tabs. You can also resize the Processing 
Options form by pointing to the edge of the form and dragging, or use the scroll bar to view 
additional processing options on a tab.  

6. Change the processing option values as appropriate, and then click OK.  

Accessing Data Selection and Sequencing for Batch 
Versions  

With batch versions, you can choose certain data values to narrow the range of your report. For 
example, you can choose to view only customers from New York. You can also sequence how you 
want your data presented in the report. For example, you can place your search type field first, 
followed by your address number and then the employee name.  
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You can select and sequence your data from one of two places, either from the Work With Batch 
Versions form, as explained here, or from the Version Prompting form.  

If you are using a Web client, you can change the data selection and sequencing for Web Only 
versions both at run time and within the batch specifications. You can only change data selection and 
sequencing in non-Web Only versions at run time.  Run-time changes are not persistent. 

See Also 
� Submitting a Report in the EnterpriseOne Report Writing Guide for information on 

submitting a report 

Prerequisite 
� If you access data selection and sequencing from the Row menu of the Work With Batch 

Versions form, you must check out the version to your machine. See Checking Out or 
Checking In a Batch Version in the EnterpriseOne Report Writing Guide.  

► To access data selection and sequencing for batch versions  

From the System Administration Tools menu (GH9011), choose Batch Versions (P98305).  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

Alternatively, on Work With Batch Versions - Available Versions, from the Form menu, 
choose Display and then click one of the following:  

• Available Versions 

All versions available on your workstation are shown. 

• My Versions 

Only the versions you created are shown. 

• All Versions 

All versions that exist for the batch application are shown. When you view All Versions, 
you can work only with versions that appear in black text. 

3. In the detail area, choose a version with which you want to work. The version must be 
checked out.  

4. From the Row menu, choose one of the following:  

• Data Selection  

The Data Selection form appears.  

• Data Sequencing  

The Selection Data Sequencing form appears.  
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When you are working with table conversion batch applications, EnterpriseOne grays out 
the Data Selection and Data Sequencing menu items because they do not apply to table 
conversions.  

5. To make these changes available to the enterprise, check in the version. 

The changes that you make affect only the version on your local workstation. If you do not 
check in the version, ensure that you erase your check out so that others can check out this 
version.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information on checking batch versions in 
and out 

� Erasing the Check-Out Record of a Version for information on erasing a versions check-out 
record 

Creating Reports of Processing Options  
This task explains how to create reports about processing options for interactive and batch application 
versions. This report shows the tab, text, and value of any processing option attached to an 
application's version (not all versions have processing options).  

Caution 

Run this process only locally (on your workstation).  

 

► To create reports of processing options  

From the System Administration Tools (GH9011), choose Batch Versions or choose Interactive 
Versions.  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field or the Interactive Application field. For example, to locate a version for the 
General Journal by Batch report, type R09301 into the Batch Application field.  

2. Click Find to locate the versions available on your workstation.  

3. Do one of the following:  

• Choose a version and then choose Processing Options from the Row menu to view the 
version's default values.  

• Choose a version and then choose Print Options from the Row menu.  

• Without choosing a version, choose Print Options from the Form menu.  

4. On Report Output Destination, choose one of the following options:  

• On Screen 

• To Printer 

• Export to CSV 
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5. Choose the following option, if needed, and complete the associated field: 

• OSA Interface Name 

6. Click OK. 

The system processes the report.  

Accessing Properties for Table Conversion Versions  
This task is only for table conversion batch applications. You can access the version's properties from 
the Table Conversion Prompting form. You can also access properties directly from the Work With 
Batch Versions - Available Versions form.  

See Also 
� Submitting a Table Conversion in the Table Conversion Guide for an explanation of the 

Table Conversion Prompting form 

► To access properties for table conversion versions  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions – Available Versions, type a table conversion application ID 
in the Batch Application field.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, from the Form menu, choose Display, then choose one of the 
following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which you want to work. The version must be 
checked out.  

4. From the Row menu, click Properties. This menu selection is enabled only for table 
conversions.  

The system displays the Properties form.  

5. The changes you make will affect only the version on your local workstation. To make these 
changes available to the enterprise, you must now check in the version. If you do not check in 
the version, make sure you erase your check out so that others can check out this version.  

See Also 
� Submitting a Table Conversion in the Table Conversion Guide for information about 

changing table conversion properties 
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See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information about checking in the version 

� Erasing the Check-Out Record of a Version for information about erasing a check-out record 

Working with Version Detail for Batch Versions  
Use version detail to review information about a version, such as its title, the prompting options 
associated with it, or the security level. You can also specify whether to print a cover page on a 
report.  

Prerequisite 
� Check out the version before you work with version detail. See Checking Out or Checking In 

a Batch Version in the EnterpriseOne Report Writing Guide. 

► To work with version detail for batch versions  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. Choose a version in the detail area with which you want to work. The version must be 
checked out.  

4. From the Row menu, choose Version Detail.  

The system displays the Version Detail form on which you can change information such as 
the title of the version, how the version uses processing options, and the security level for the 
version. You can also review background information about the report.  

5. On Version Detail, modify or complete the following information:  

• Version Title 

• Prompting 

This option appears only if processing options are attached to the associated report 
template.  
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• Security 

• Version Detail 

• Print Cover Page 

• Job Queue 

If you leave the Job Queue field blank, EnterpriseOne reads the setting in the jde.ini on 
the enterprise server. If you submit the job to an iSeries, EnterpriseOne looks to your user 
profile to determine the job queue.  

• Client Platform 

6. Review the additional information that appears on the form as needed.  

7. Click OK.  

8. Check in this version to make it available to the enterprise.  

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Copying a Batch Version  
You can copy an existing version, if it is not a Web Only version, and then tailor its information to fit 
your needs. The copied version inherits all the report template properties of the original version, 
including any overrides. If you are using a web client and copy a version, the new version you create 
is flagged Web Only. You cannot copy a Web Only version. 

When you copy a batch version, you should add security to the new version. Security settings range 
from none, which means anyone has the authority to modify or run a version, to full security, in 
which only the person who last modified the version can modify and run the version. Version security 
is separate from Security Workbench, which allows you to set security for different EnterpriseOne 
objects, such as applications.  

See Also 
� Security in the System Administration Guide for information about Security Workbench 

► To copy a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  
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• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which to work.  

4. Click Copy on the toolbar.  

5. On Version Copy, complete the following fields:  

• New Version 

• Security 

• Version Title 

6. Click OK.  

The Batch Version Design form appears. On this form, you can select Revise Version to edit 
version information or you can select Run to run the new version. 

7. On Batch Version Design, click OK to save your version.  

When you click OK to copy a report version, if the version specifications do not currently 
reside on your workstation, the central objects data source (server) performs JITI (Just-in-
time Installation) to transfer the specifications to your workstation.  

8. Check in the new version to make this version available to the enterprise.  

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Creating a Batch Version  
You can create a new batch version that is based solely on the specification of the report template. 
Unlike copying a version, when you create a new batch version, the new version does not inherit any 
overrides.  

If you are using a web client to create a new batch version, the new version is flagged Web Only.  

When you create a batch version, you should add security to the new version. Security settings range 
from none, which means anyone has the authority to modify or run the version, to full security, in 
which only the person who last modified the version can modify and run the version. Refer to the 
Security field description for more information. Version security is separate from Security 
Workbench, which allows you to set security for different EnterpriseOne objects, such as 
applications.  

See Also 
� Security in the System Administration Guide for information about Security Workbench 

� Batch Versions Created Using the Web Client in the EnterpriseOne Report Writing Guide for 
information about Web-only versions 
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► To create a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type the batch application upon which 
you want to base the new batch version in the following field: 

• Batch Application 

2. Click Add to create a new version.  

3. On Version Add, complete the following fields:  

• Version 

• Version Title 

• Prompting Options 

If the batch application on which you base your version does not have any processing 
options attached, EnterpriseOne leaves the Prompting Options field inactive. You can 
attach processing options only to a batch application template in Report Design.  

• Security 

• Job Queue 

• Version Detail 

4. Choose the following option, if necessary:  

• Print Cover Page 

5. Click OK to save your version. 

6. Check in the new version to make this version available to the enterprise. 

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Checking Out or Checking In a Batch Version  
To modify a report version using Report Design or to set data selection and sequencing using the 
options from the Row menu, you must first check out the report version. The check-out procedure 
copies the specification records from the central objects location to your workstation. This is based on 
your path code. Only versions in that central objects path code will be visible. You cannot access 
Report Design until you check out the version. A version cannot be checked out by more than one 
user at a time.  

If you have checked out a version but are not going to make changes to it, erase the check-out record 
so others can check out that version. You need to check out a version to make changes that are 
overrides to the base (template) report. You do not need to check out a version if you make the 
following changes at the time you run the version: data selection, data sequencing, override location, 
or processing option values. However, if you make changes to data selection or data sequencing from 
the Work With Batch Versions - Available Versions form, you must check out and check in the 
version to save those changes and make them available to the enterprise.  
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Before you check in a version, make sure that you want to make permanent changes. When you check 
in a version, the system copies the report specifications back to the central objects location. These 
new specifications override the previous specifications for that version. The report specifications on 
your workstation remain intact.  

To convert a Web Only version to run on a client other than a web client, you must check the version 
in and then check it out again. To permanently remove the Web Only indicator, generate the batch 
version using the eGenerator tool after converting the version. 

You can check batch versions in or out with the Object Management Workbench program (P98220) 
or with the Batch Versions program (P98305) as described in the next task.  

See Also 
� Generating EnterpriseOne Serialized Objects in the Web Server Installation Guide for 

information on eGenerator 

► To check out or check in a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field, and then click Find. For example, to locate a version for the One Line Per 
Address report, type R014021.  

2. In the detail area, choose a version with which to work.  

3. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can check in and check out 
versions, and erase the check out for a version, and enter design for the version.  

4. On Advanced Operations, choose a version to check out or to check in.  

5. From the Row menu, choose either Check Out Version or Check In Version.  

6. Click OK.  

Erasing the Check-Out Record of a Version  
Batch versions can be checked out by only one person at a time. Erasing the check out record allows 
another user to check out the version. After you have erased a check-out, you cannot check in that 
version. However, the report specifications on your workstation remain intact.  

The Erase Check-Out procedure changes the status of the server-based record of version check-in and 
check-out. When you erase a check-out of a version, EnterpriseOne updates the Checked Out field in 
the Versions List table (F983051) from a Y to an N. EnterpriseOne also updates the version's 
Location field in the Versions List table. This value is changed from the location of the workstation 
that checked out the version to the machine name of the central object's server.  

You can erase the check-out of batch versions using the Object Management Workbench program 
(P98220) or the Batch Versions program (P98305) as described in the next task.  
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► To erase the check-out record of a version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field and click Find. For example, to locate a version for the One Line Per 
Address report, type R014021.  

2. In the detail area, choose a version with which to work.  

3. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can check in and check out 
versions and reports, erase the check out for a version, and enter the design for the version.  

4. On Advanced Operations, choose the checked-out record that you want to erase.  

5. From the Row menu, choose Erase Check Out.  

Changing Processing Options for the Batch Versions 
(P98305) Application 

This task explains how to change the processing options for the Batch Versions program (P98305).  

Processing option changes are stored for each UBE run. Unlike other changes to versions, changes to 
processing option values do not require you to check in or check out the version. Anyone who uses 
that version after you make the change will not be affected by the new processing option values.  

See Also  
� Changing Processing Options for Batch Versions in the EnterpriseOne Report Writing Guide 

for general instructions about changing processing options for batch versions 

► To change Batch Versions (P98305) processing options  

From the System Administration Tools menu (GH9011), right-click Batch Versions, choose 
Prompt For, and then choose Values.  

1. On Processing Options, complete the following fields:  

• Confirmation Box  

Enter a Y or 1 to enable, or enter N or 0 to disable the overwrite/delete local 
specifications confirmation box. If you enable the confirmation box, it appears when 
EnterpriseOne is about to overwrite or delete specifications on your local machine. For 
example, when enabled, the confirmation box appears when you check out a batch 
version.  

• Schedule Job  

Enter a 0 (or leave the field blank) to not allow users to schedule when their batch 
versions run, meaning their batch version runs as soon as they submit it; enter a 1 to give 
the users the option of scheduling their batch versions; enter a 2 to force the users to 
always schedule their batch versions.  

2. Click OK. 
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See Also 
� Scheduling Jobs in the System Administration Guide for complete information about how to 

schedule batch versions 

Moving Batch Version Specifications to an Enterprise Server  
You can move batch version specifications to an enterprise server without actually running the batch 
version. You need to do this only when you have modified a batch version that is called by another 
batch version. After you modify the version, use this option to move its specifications to the same 
location as the batch version that calls it. This procedure ensures that the batch version calls the 
updated specifications, rather than obsolete specifications.  

► To move batch version specifications to an enterprise server  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, complete the following field, if 
necessary:  

• Batch Application 

2. Click Find to display a list of versions based on the batch application you entered in the Batch 
Application field.  

3. Choose the report version you want to submit, and then click Select.  

4. On Version Prompting, choose Advanced from the Form menu.  

5. On Advanced Version Prompting, choose the following options and click OK:  

• Submit Version Specifications Only 

Turn this option on to move batch version specifications to an enterprise server that you 
specify.  

• Override Location 

Turn this option on to access the JDE Data Sources form, which you use to specify the 
location of the enterprise server to which you want to move the batch version 
specifications.  

6. On Version Prompting, click Submit. 

7. On JDE Data Sources, choose the enterprise server to which you want to move the batch 
version specifications, and then click Select.  

The batch version that you indicated will not run, but EnterpriseOne moves the batch version 
specifications to the enterprise server that you specified. You can use the Work With Servers form to 
monitor the progress of your job on the queue.  

See Also 
� Working with Servers in the System Administration Guide for information about the Work 

With Servers form 
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Overriding Version Specifications 
Usually when you run a report version, the version specifications override the report template 
specifications. Occasionally you may want the report template specifications to override the versions 
specifications.  

An example of when you would want to override the version specifications with the report template is 
when you have changed the report template and want that change pushed down to the version level.  
If you did not override the version specifications, the system would ignore the change at the version 
level. 

Caution 

If a version contains information that is not displayed in the report template, this information will not 
be displayed if you override the version specifications. 

 

► To override version specifications 

From the Report Writer menu (GH9111), choose Batch Versions. 

1. On Work with Batch Versions, enter the number of the report in the following field: 

• Batch Application 

2. Highlight the report version you wish to view. 

3. From the Row exit, select Advanced. 

4. On Advanced Operations, choose Design Version from the Row menu. 

5. On Report Design under the Version tab, select the section of the report for which you wish 
to override version specifications. 

6. From the Section menu, choose Override Version Specifications. 

Depending on the type of section you selected, the appropriate Section form appears. 

7. Select from the following options and click OK: 

• Section Layout 

• Section Data Selection 

• Section Event Rules 

• Section Database Output 

• Section Sort Sequence 

Template specifications now override version specifications. 
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Accessing BrowsER for a Report or Version  
BrowsER is an application you can use to view event rules and design layout for your reports and 
versions. BrowsER displays the structure of sections within a batch application. The sections are 
displayed in a hierarchical structure, with events and event rules for each section. You can enable or 
disable one or more event rules without extensive work in the design tools. This is useful for 
debugging specific event rules.  

See Also 
� BrowsER in the Development Tools Guide for complete information about using BrowsER 

► To access BrowsER for a report or version  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which you want to work.  

4. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can design report specifications 
for the version, check in and check out versions and reports, and erase the check out for a 
version.  

5. On Advanced Operations, choose either Report BrowsER or Version BrowsER from the 
Form menu.  

If you select Report BrowsER, you can enable or disable event rules for the report. If you 
select Version BrowsER, you can enable or disable event rules for a specific version of the 
report. When you are working with table conversion batch applications, EnterpriseOne grays 
out the Version BrowsER button because it does not apply to table conversions.  
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Understanding Database Output  

You can use database output to update the database in conjunction with your report generation. You 
can attach a database output specification to any report section with a business view, but not a report 
or page header or footer.  

You can use database output in Report Design to update, insert, or delete records in a table or text 
file. You can also use a special operation called "Insert or Update". This operation attempts to insert a 
record into a table. If a record with the same primary key exists, the insert fails and the existing record 
is updated.  

You can use database output to load data to EnterpriseOne tables or to text files. Text files can be 
specified as either comma delimited or fixed length text records. The comma-delimited format is 
useful for transferring data to spreadsheets.  

PeopleSoft EnterpriseOne software provides several tools that you can use for batch database 
maintenance.  

Table Conversion  Use for high-performance SQL table-to-table processing. Allows access to non- 
EnterpriseOne tables. No reporting.  

Database Output  Reporting and output must occur simultaneously. Source and destination tables 
can reside in different environments. Allows output to text files.  

Table I/O (in Event 
Rules)  

Reporting and output must occur simultaneously. Input data must be 
transformed before it can be output.  

Database output is performed for every row of data processed in the section. All database operations 
occur on a record-by-record basis using the standard JDE Base middleware APIs.  

Defining database output involves defining the output and then overriding the specific environment.  

► To define database output  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On a report section in Report Design, choose Database Output from the Section menu.  
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2. On Mapping Targets, complete the following fields to define a list of output tables or files 
(targets).  

• Operation  

For tables, choose Insert only, Update, Delete, or Insert or update. For text files, you must 
choose Insert. 

• Type  

EnterpriseOne table, comma delimited text file, or fixed record length text file. 

• Name  

Name of a valid EnterpriseOne table or a valid file used for text file output. 

You can double-click on the Operation and Type fields to see a list of available choices. 
Double-click your choice to select it. 

You can use the source target several times with different operations.  

3. Click Next.  
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4. On Mappings, for each target, specify which of the available section columns or variables 
should be assigned (mapped) to which column in the target.  

Double-click a Source Section or a Source Object cell to display a list of options.  

You can also turn data dictionary overrides on and off here.  

5. On Mappings, click Map Same if you need to map all columns.  

6. On Mappings, click Finish when you have finished your assignments.  

See Also  
� Triggers in the Development Tools Guide guide for information on how to override and 

disable data dictionary triggers  

► To override environments for database output  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On a report in Report Design, choose Report Properties from the File menu.  

2. On Properties, click the Advanced tab.  
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3. Complete the following field or click the Browse button to find the source environment: 

• Source  

4. On Properties, click Prompt for overrides at runtime, if desired.  

5. Complete the following field or click the Browse button to find the target environment: 

• Target  

6. To suppress the database output features, choose between two options:  

• If you do not want database output for the entire report, then override the database output 
in the version and delete the mapping record.  

• If you do not want database output for specific rows of data, then use the Suppress 
Section Write system function. This system function suppresses not only printed output 
but also database mapping.  

7. Click OK. 
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Report Processing  

Reports are processed via a batch process. A batch process is an application that processes 
automatically without your interaction. The engine executes the logic attached to the events within 
the report or process. After a batch process is launched, you have no control over the flow of the logic 
within the batch process. If you need to change the flow of the logic within the process or report, you 
make those changes using Report Design. Examples of batch processes include reports, subsystem 
jobs, database output, and table conversion.  

Subsystem jobs are batch processes that constantly run in the background and offload processor 
resources. You can also use subsystem jobs to move activities along in a process, such as an 
escalation process in Workflow, which moves unanswered messages from one user to another after a 
certain period of time.  

The database output function within Report Design allows you to update or insert records within 
tables. Table conversion transfers data from one table to one or more tables, changes the data or 
schema of a EnterpriseOne table, and transfers data from a single business view to one or more tables.  

This section describes some of the advanced features behind batch and report processing and is 
intended to give you an understanding of how the features of batch and report processes work.  

Understanding Batch Processing  
You create reports and batch processes using the Report Design tool, and you use PeopleSoft Solution 
Explorer to access the reports. You can also associate individual reports and batch processes with 
applicable menus. One difference between a batch process and a report is that a batch process does 
not usually print a report. You can use batch processes to update tables. You can also create a batch 
process that prints a report showing the results of the batch process.  

EnterpriseOne reports contain all the specifications for the report, including section and field layout, 
business views, event rules, data selection, sequencing, and database output. Reports are named with 
a unique identifier.  

Each report contains one or more sections, which you create in Report Design. Sections are self-
contained elements that are used as building blocks to construct a report. You can relate sections to 
one another or use them as stand-alone reports. Sections can also serve a special purpose, such as 
headers and footers.  

Report Sections  
EnterpriseOne sections include headers, footers, and detail sections (columnar, group, and tabular). 
Independent (level-one) sections include:  

• Group  

• Columnar  

• Tabular  

Level-one sections can also be parent sections.  
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Dependent (level-two) sections include:  

• Level-break headers  

• Level-break footers  

• Total sections (used in non-tabular reports)  

• Subsections  

• Custom  

The following graphic illustrates how the batch engine processes sections within a report:  

 

 

The report view within Report Design determines the flow of the report. For example, if you have 
multiple level-one sections within your report, each having their own business view, the first level 
one section (such as V0101E) is executed before the next level-one section (such as V4211A). Any 
level-two sections that exist between the level-one sections are processed when they are called from a 
level-one section or are connected to one. If the report contains a joined section (parent/child section) 
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after the level-one sections, the parent/child section will be processed independently of the first two 
sections. Child sections are in subsection joins.  

The system reads and processes all records in a section from beginning to end within a section based 
on its data selection. If you do not specify data selection, then all the records in the table will be read 
until the end of the file (EOF).  

If your report contains a joined section (parent/child section) after a level-one section, the parent/child 
section is processed independently of the first section.  

The parent/child section in the middle of the graphic illustrates the flow of a joined (parent/child) 
section. Parent/child sections can be called at any point within the process flow. Depending on how 
your sections are joined (one-to-one, one-to-many, or many-to-many), records are fetched from the 
child business view for each corresponding parent record. When all parent records have been 
processed, the system continues to the next section. If any database updates are performed in the first 
section over the V0101 business view, that change will be reflected when the records are fetched for 
the parent/child join section.  

The last section shown in the graphic (the conditional section) can be called from any of the previous 
sections by using the system function Do Custom Section. A conditional section is considered a level-
two section because you must call a conditional section from another section. Memory allocation 
occurs at the beginning of the section, so you must hide and show objects in the section as needed 
because memory is allocated and freed once, instead of each time a section is called. You can place 
conditional logic in your Initialize Section or End Section event to hide and show objects.  

EnterpriseOne processes all section types the same way, except for tabular sections. Tabular sections 
output to the report only when the system encounters a level break. In tabular sections, the system 
does not initialize the Do Section for each record. Instead, it summarizes the records to the lowest 
level-break level. Tabular sections are similar to level breaks in that the output to a report is similar to 
a level-break header section.  

The flow of sections in a report or batch process depends on how you set up the sections in the report 
view in Report Design. In Report View, you can move sections up or down, which might affect the 
sequence of execution for the sections. Moving level 1 sections affects the sequence of execution. In 
report processing, the system processes all level-one sections in the order in which they appear. 
Moving conditional sections, subsections, level-break sections, page-headers, page-footers, and report 
headers will not affect the sequence of execution. Report execution takes place from top to bottom for 
sections, and top to bottom, left to right for objects within a section.  

All level-two sections are processed as dependents of the level-one section. Custom sections appear 
as a level-one section in the report view, but are not processed unless explicitly called by the Do 
Custom Section system function.  

Sections in themselves can be considered "mini reports," or batch processes, and each section can 
contain its own business view. Because other sections in your report might contain different business 
views, you must add any data sequencing and selection to the template for each section using Report 
Design.  

Note  

If a user sets up data sequencing and selection in the batch version at run time, sequencing and 
selection will affect only the first section of the report or batch process. Therefore, when you design a 
report or batch process, consider the impact on the users as they will not be able to change data 
selection and sequencing for any other sections.  
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Whether a level-one section has a business view attached to it or not, it will be executed at least once. 
This is important if you want to execute special event rule logic and you want to attach it to that 
section's Do Section event.  

 

See Also  
� The Table Conversion Guide for information about how to create a table conversion using the 

table conversion tool  

See the following topics in the EnterpriseOne Report Writing Guide: 

� Understanding Subsystem Jobs for information about how to create subsystem jobs  

� Understanding Database Output for more information about the database output function  

� Creating Custom Sections for more information about custom sections 

Understanding Section Processing  
When a report is processed, certain events occur. You can attach logic at these events. Your logic 
might be dependent on what happens before and after a particular event.  

Several events can occur when a batch process or report is processed. You can determine at what 
point in the process you want to attach logic, because your logic could be dependent on what happens 
before and after a particular event.  

The report header is processed before the section is processed, and the level-one section is initialized 
by the Initialize Section event. After Initialize Section, the system processes the Advance Section, 
Page Footer, Page Header, and so on. When the system finishes processing the first level-one section 
and all dependent sections associated with it, it repeats the process for the next level-one section.  
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Processing Group and Columnar Sections  
Group and columnar sections are alike in their processing because they both write to the output after 
each record is read, unlike tabular sections, which write to the output only when there is a level break. 
This output is determined by the data sequencing of that section.  

The following diagram illustrates the typical event flow for group and columnar sections:  
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Processing Tabular Sections  
Tabular sections are comprised of columns, rows and cells. To define what information is contained 
in each column, row, or cell, you define inclusion rules or calculations. An inclusion rule is either a 
set of criteria, a business function, or a named event rule for that row or column. One advantage of 
tabular sections is that you do not have to define additional sections for level-break logic or 
processing as would have to be defined with a group or columnar section. However, you must set up 
the data sequencing correctly because the level-break part of the section is dependent on it.  

The following diagram illustrates the typical event flow for tabular sections:  

 

 

As shown in the following graphic, tabular sections summarize information and print only when there 
is a level break. Because level breaks are dependent on data sequencing, your report can be as 
detailed as your data sequencing allows or as general as is needed. For example, suppose you 
sequence your data in a tabular section by Company only, but you have the objects Object Account 
and Subsidiary included in your report as well. If you sequence by Company only, and only two 
company records exist, the tabular section prints only those two records on the report. If you sequence 
by Company and Object Account, the tabular section prints both Company and Object Account 
information. Likewise, if you sequence on Company, Object Account, and Subsidiary, the system 
prints information for all three objects. Therefore, the more data you sequence and level break in your 
report, the more detailed your report will be.  
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Other features in tabular sections include Drill Down, Account Level of Detail, a summarization 
feature, and automatic totaling. You can use Drill Down to provide a shortcut to an interactive 
application from the viewable output of a report. The interactive application shows the detail for the 
balances on the viewable output of your report. You can use the summarization feature (After Last 
Object Printed) to print or process logic after a section has been processed. The Automatic Totaling 
feature automatically totals any numeric values, regardless of what type of numeric values they are. 
However, keep in mind that the system may try to total any value in your report (numeric or 
otherwise). To keep the system from totaling a particular column, open that column's properties and 
choose the Suppress Printing at Totals option. Note that some items might be defined at the data 
dictionary level to prevent totaling.  

You might have a situation in which you process a report using multiple sections or a combination of 
group and columnar sections. In this case, you might be able to use one tabular section in place of the 
multiple sections. An advantage of replacing multiple sections with a tabular section is that using a 
tabular section improves your system's performance. Instead of calling multiple sections, your system 
calls only one section.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Understanding Batch Events for a discussion of the Do Section 

� Understanding Level-Break Processing for a discussion of the level break section 
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Attaching Logic to Joined Sections  
If you join sections and want to attach logic to the joined sections, you must attach it to the Refresh 
Section event, not the Initialize Section event, to ensure that the logic is processed every time the 
section is processed. When joined sections are processed, the system initializes the Initialize Section 
event the first time the parent/child section is processed, then initializes the Refresh Section event for 
all subsequent times the parent/child section is processed. Therefore, if you attach an event to 
Initialize Section, the logic is processed only once. If you attach it to the Refresh Section event, it is 
processed each time the section is processed.  

Data Selection and Sequencing  
If your report or batch process takes a long time to process because it contains multiple sections, you 
might want to check the data selection for each section because the system will process all the records 
in the table unless you specify otherwise. If you want a level-one section to adopt the data selection 
and sequencing from another section, you can use the Use Data Sel/SeqFromASection system 
function. This system function propagates the data selection and sequencing to other sections. This 
functional capability affects only the level one sections in your report.  

For example, in the Print Pick Slips program (R42520), you can choose from the hundreds of 
columns in the Sales Order Detail File table (F4211) for data selection. In the first section, which is 
hidden and has database output to the F4211 table, the report must first process commitments, which 
could add rows to the F4211 table. The next section in the report needs to display the modified and 
updated F4211 table to show the committed records. Possible solutions are to use a temporary file or 
to change the data selection on multiple sections. In this case, you would use the Use Data 
Sel/SeqFromASection system function, which adopts the data selection and sequencing from a 
previous level-one section.  

The Use Data Sel/SeqFromASection system function allows a section to adopt the sequencing or data 
selection specifications from another section in the same report or from a section in an entirely 
different report. The target section can adopt the data selection criteria, the sequencing information, or 
both, from the source section. The selection or sequencing information from the source section 
replaces the information contained in the target section's specifications.  

To use the Use Data Sel/SeqFromASection system function, access the event rules for the Initialize 
Section event of the target section. The Initialize Section event is the only event that should invoke 
this system function. Access the General folder to locate the Use Data Sel/SeqFromASection system 
function.  

See Also  
� Understanding Level-Break Processing in the EnterpriseOne Report Writing Guide for more 

information about level-break headers and footers and level-break events 

Understanding Custom Sections  
Custom sections allow you to control, through event rules, the information that prints on a report. 
You can use custom sections to force a page break by creating a custom section with no objects, then 
activating Page Break After Print in that section's Section Properties. You can use custom sections to 
print variable text. Custom Sections can also be used for sections that present the same information, 
but are formatted differently. For example, a report that exists in two different modules, but 
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depending on a user's needs, calls a different section that displays information specific to that 
particular module.  

The following graphic illustrates the process flow for custom sections:  

 

 

The batch engine stops processing the current section when it encounters a call for information 
contained within a custom section. After it processes the custom section, it returns to the previously 
held section.  

The system stops processing the current section when it encounters a call for information contained 
within a custom section. After it processes the custom section, it returns to the previously held 
section.  

When you run the report, the batch engine calls and processes each section until it encounters the 
system function for the custom section. The batch engine then retrieves the information for the 
custom section and processes it. When it finishes processing the custom section, it returns to the 
previous section unless instructed to do otherwise by another event rule.  

You can call a custom section from any event rule except Initialize Section. If you try to call a custom 
section using Initialize Section, your report will not be processed.  

The custom section process flow occurs in the same order as the type of section it is defined as, for 
example, group, columnar, or tabular.  

228 



Understanding Level-Break Processing  
You use level breaks to identify a change in a report or batch process's data by comparing the 
previous record to the current record. If there is a change between the records, a level break occurs. 
You can use level breaks to segregate large report listings into smaller, logical groups. For example, 
you could group telephone numbers by area code or employees by department. You can set up level 
breaks to initiate page breaks, totals, headers, or footers. Level breaks can be attached only to 
business view fields and not to any other variables in the report.  

You can attach only one level-break header or level-break footer to one data item. If you try to attach 
more than one level-break header or footer to a data item, the batch system processes only the first 
level-break header or footer section that is attached to that item and ignores any other level-break 
sections that you have attached.  
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The following graphic illustrates level-break logic processing:  

 

 

Before a level-break header or footer is processed, the batch system issues the Init Break Section 
event, which stops processing for the current section and moves to the level-break footer section. 
After the level-break footer section has been processed, the batch system processes the level-break 
header, if specified in the report.  
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See Also  
� Working with Level-Break Header and Footer Sections in the EnterpriseOne Report Writing 

Guide for more information about level-break headers and footers  

Level-Break Section Events  
When you process a report that contains level-break headers and footers, EnterpriseOne automatically 
calls the Init Lvl Brk Footer Section or Init Lvl Brk Header Section event. You can attach event rules 
to these events to control how the batch system processes them.  

For example, if you want to create a report that summarizes information by company, you can design 
the report to read the detail file by company using a level-break footer. You set a level break on the 
Company data item, and when the company changes, the batch system calls the level-break footer for 
the detail section.  

You can attach business functions, table I/Os, or other events to level-break section events.  

Init Lvl Brk Footer Section Event  

When the batch system calls the Init Lvl Brk Footer Section event, the values in the previous section 
are accessed and are either summarized or totaled. For example, if you have a level-break footer set 
up to total the revenue for a company, the level-break footer inserts the total below all the records that 
have been processed in the previous section. The Init Lvl Brk Footer Section event is attached to the 
level-break footer section.  

If you set up multiple level-break footers within a report, the batch system processes the footers 
starting from the lowest section up to the highest section.  

If you need to attach logic to a level-break footer, attach it on the End Lvl Brk Footer Section event 
rather than on the End Section event.  

Init Lvl Brk Header Section Event  

The Init Lvl Brk Header Section event is called after the previous section finishes processing. It is 
also called after the Init Lvl Brk Footer Section event, if you have set one up. The Init Lvl Brk Header 
Section event locates the header section associated with the current level and processes the 
information in the level-break header.  

For example, if you have a level-break footer set up to create a grand total for a section, it will 
process before the level-break header for the next section, which might contain another company's 
revenues. The header section processes new records, or different data, from the previous section.  

If you have set up multiple level-break headers within a report, the batch system processes the 
headers starting from the highest section down to the lowest section in the report.  

End Lvl Brk Header and Footer Section Events  

After the Initialize Level Break events are processed, EnterpriseOne launches the End Lvl Brk Header 
or Footer Section event, which ends the level-break process and returns to the previous section. You 
can attach logic that calls a custom section to the End Lvl Brk Section event. For example, you might 
want to print text, such as a disclaimer, after information in a level-break footer. In this case, you can 
create a custom section that contains the information you want to print and attach the custom section 
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logic to the End Lvl Brk Section event. When you process the report, the disclaimer appears below 
the level-break footer section.  

Understanding Batch Events  
As a report or batch application is processed, the run-time engine pauses at certain points to process 
logic that has been attached. These points are called events, and you can use these events to insert 
custom logic for processing. EnterpriseOne provides you with a set of predefined batch events. The 
basic flow of these events within a section is Initialize, Do, and then End.  

The engine processes some events only if the appropriate type of section exists. For example, Init 
Report Header and End Report Header are initialized only if the report contains a report header 
section. Likewise, Init Lvl Brk Footer and End Lvl Bk Footer are processed only if a level-break 
footer exists.  

The Do Section Event  
The Do Section event is invoked after the system has assigned new values to objects in the report and 
immediately prior to processing objects within a section. You most commonly attach logic to the Do 
Section event because it occurs before any objects are processed, and most often the logic you attach 
at this point will affect the objects in some way.  

When the system processes the Do Section event, it processes the column headings first, then fetches 
the first line. For each object (column) in the line, it runs Init Object, Do Object, and End Object. 
After processing the last object, the system calls After Last Object Printed and then fetches the next 
line and repeats the process. When all lines have been fetched from the database, the system performs 
End Section.  

The system processes the column headings first, then fetches the first line. For each object (column) 
in the line, it runs Init Object, Do Object, and End Object. After processing the last object, the system 
calls After Last Object Printed and then fetches the next line and repeats the process. When all objects 
have been fetched from the database, the engine runs End Section.  

If the object will not fit on the page, the engine invokes Suspend Object, which moves the object to 
the next page.  

If the object is a child section, such as in a joined section, the system invokes Initialize Section the 
first time it is processed. For any subsequent times that the child is processed, the engine invokes 
Refresh Section.  

Additional Batch Events  
In addition to the basic batch events you typically use, other events can give you flexibility in your 
batch processes. These other events include the following: 

• Report Level 

• Section Level 

• Page Header Section Level 

• Page Footer Section Level 
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• Report Header Section Level 

• Report Footer Section Level 

• Constant and Variable 

Report Level Events  

Do 
Initialize 
Printer  

Resolves and validates the printer name.  

Initialize 
Report  

Resets global Report Variable and global Event Rule (ER) Variable values if the event 
point has no ER in a subsystem; preserves global variable values otherwise. The 
Initialize Report event is executed only once per report and is always the first event to be 
processed. If the report is a subsystem report, the ER on this event is executed once as 
the subsystem is starting before any subsystem triggers are processed.  

End 
Report  

Executed once at the end of report processing and is always the last event to be 
processed. If the report is a subsystem, the ER on this event is executed only after the 
system processes an End Subsystem trigger and the subsystem is in the process or 
terminating.  

Section Level Events  

Advance 
Section  

Occurs each time you do a fetch from the database. Use this event if you need to 
perform processing on objects before a fetch. If this section does not have a business 
view attached, then this event is processed once.  

After Last 
Object 
Printed  

Occurs after a row is printed to an output file. Use this event to process information 
after a row has been output.  

Before 
Level Break  

Use this event to do processing after a fetch but before any level breaks are checked.  

Do Balance 
Auditor  

Valid only for tabular sections. Use this eventfor the drill down feature.  

Do Section  Occurs after Advance Section after values have been assigned to print out to a printer 
or an output file. This event occurs before any information for the current record is 
written to the PDF file. This event occurs before Do Cell (if Tabular cells exist) and 
before Do Variable/Do Constant.  

Do Tabular 
Break  

Valid only for tabular sections. This event occurs when any of the business view fields 
set as level breaks change. Use this event to do processing that requires a change of 
values in any of the level break fields.  

End Break 
Section  

Occurs after a level break finishes. Use this event to do processing immediately after a 
level break.  

End Lvl Brk 
Footer

Use this event to do processing immediately after a level break footer.  
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Section  

End Lvl Brk 
Header 
Section  

Use this event to do processing immediately after a level break header.  

End Section  Occurs after a batch process has completed processing the last set of section values. 
Use this event to do processing immediately after a section ends. This event is useful 
for last record and end-of-file procedures.  

Init Break 
Section  

Occurs after a level break begins processing. This event initializes a child section that 
is joined to the parent section on a level break.  

Init Lvl Brk 
Footer 
Section  

Use this event to do processing immediately before a level break footer.  

Init Lvl Brk 
Header 
Section  

Use this event to do processing immediately before a level break header.  

Initialize 
Section  

Occurs when a batch process encounters a section for the first time. Use this event  to 
do processing immediately before a section begins. This even tis useful for working 
with global variables or performing other preparatory procedures. For conditional 
sections, this event is processed each time the section is called.  

Refresh 
Section  

The first time the UBE encounters a child section, it issues an initialize section event. 
Each subsequent time the child section is to be processed, the batch process uses 
Refresh Section. At this point, the internal structures and pointers for the child section 
have been established and the UBE is about to select a new group of records for the 
child section. This logic also works for the level break sections. Use this event to set 
the object values of level two sections based on the parent section. You can also use 
this event to reset or modify data selection and sequencing of the child section.  

Suspend 
Section  

Processes when an overflow page break (that is, information exceeds the space 
available on the page) occurs. This event temporarily stops the section processing. Use 
this event to do processing when a page break occurs.  

Page Header Section Level Events  

Initialize 
Page 
Header  

Occurs at the beginning of a report after any report header logic and before the page 
header section processes for the first time. It also processes every time a page break 
occurs. Use this event to initialize values that cannot be set until after the report header 
logic executes. This event  is similar to Init Section for a normal group, columnar, or 
tabular section, except that it is processed only for a page header section.  

End Page 
Header  

Occurs after the page header finishes processing. Use this event  to do processing 
immediately after a page header.  
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Page Footer Section Level Events  

Initialize 
Page 
Footer  

Occurs at the beginning of the report after any report header logic and before the page 
header section processes for the first time. Use this event  to initialize values to be 
printed in the current page footer section. These assignments typically depend on 
information processed so far on that page.  

End Page 
Footer  

Occurs after the page header finishes processing. Use this event to do processing 
immediately after a page header.  

Report Header Section Level Events  

Initialize 
Report 
Header  

Processes once at the very beginning of the report before anything else in the report 
processes. Use this event to initialize values at the beginning of a report. This event is 
similar to Init Section for a normal group, columnar, or tabular section, except that it 
processes only for a report header section.  

End Report 
Header  

Occurs after the report header processes. Then the report processes the page header for 
a report. Use this event to do processing immediately after a report header.  

Report Footer Section Level Events  

Initialize 
Report Footer  

Occurs once at the very end of a report after everything else processes and before 
the report footer prints. Use this event to initialize values to print in the report 
footer.  

End Report 
Footer  

Occurs after the report footer processes. After processing finishes, the report 
terminates. Use this event to do processing immediately after a report footer.  

Constant and Variable Events  

Do Column 
Heading 
(constant)  

Occurs when the column is initialized. Use this event to populate the column 
heading, based on event rule that is associated with a business function.  

Do Variable/ 
Do Constant  

Occurs just before the font and color are selected and before the value of the object 
is translated into a printable string of characters and is output to the page. Use this 
event to do processing after an object has been processed. This point is your last 
chance to manipulate the value or display attributes of the objects before output.  

End Variable/ 
End Constant  

Occurs immediately after an object processes even if the object is invisible or 
suppressed. Use this event to do processing after an object processes.  

Initialize 
Variable/ 
Initialize 
Constant  

Occurs each time a report object or variable is to be processed. Use this event to do 
processing before an object processes. This event is useful to do processing that 
affects the calculation of an object's position because the object's position on the 
page has not yet been determined.  

Skip Variable/ Occurs when an object does not fit on the current page. The batch process issues a 
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Skip Object 
(constant)  

skip variable to bypass the object until the next page begins processing. Use this 
event to change the value of an object at the page break.  

Suspend 
Object 
(constant)  

If an object requires multiple text strings or column headings and if only part of the 
object fits on a page, then the batch process issues a suspend variable to halt 
processing of the object until the next page has been started. Use this event to 
modify the value at the page break. Because the value of the object has already been 
partially processed, this point is not a good time to manipulate that value.  

Column 
Inclusion  

Valid only for tabular sections, this event occurs after a record is fetched from the 
database. Use this event to perform calculations.  

Do Cell 
(Tabular)  

Occurs during Do Object after processing calculations for a cell. Use this event to 
manipulate cell data before displaying it. This event occurs before Do Variable/Do 
Constant. This event occurs during calculations.  

System Functions within Batch Events  
Batch system functions give you flexibility and control over how your reports are processed. For 
example, you can use batch system functions to hide or show an object, to hide or show a section, to 
generate a message, and so on.  

The batch system functions you might use consist of the following main categories:  

Object  You can use Object system functions to do actions such as hide or show 
objects.  

Section  You can use Section system functions to do actions such as hide or show 
sections or work with totals.  

General  You can use general system functions to do actions such as work with 
selection and sequencing.  

Messaging  You can use message system functions to do actions such as send, update, or 
delete messages.  

Workflow  You can use workflow messages to do actions such as work with processes.  

Transaction 
Processing  

You can use transaction processing system functions to begin, commit, or roll 
back transactions.  

Media Objects  You can use media object system functions to work with media objects.  

Some general batch system functions that are commonly used are:  

Set Sequence 
Append Flag  

This system function allows you to append or add the sequence for a section to the 
report's sequencing.  

Stop Section 
Processing  

Stops processing the current section and moves to the next section. This system 
function is helpful for performance, especially when there is a large amount of event 
rule logic that remains to be performed. For example, if no more customers exist 
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with a credit limit over a certain amount, the system stops processing that section and 
moves to the next section.  

Stop Section Processing differs from Suppress Section Write in that Suppress 
Section Write suppresses only the current record, which causes the engine to process 
the same section for the next record.  

Hide Object  For group and columnar sections, when you hide objects using the Hide Object 
system function in Event Rules, be aware that even though it might be the only 
object on that line, the system still prints a blank line for it. The system has no way 
of knowing whether there are any other objects on that line that need to be printed. 
To keep the system from printing a blank line, place the object in its own conditional 
section and suppress the printing of that section using the Hide Object system 
function.  

See Also  
� Events in the EnterpriseOne Report Writing Guide for a listing of events available in each 

report section and the order in which they are processed 

Understanding Batch Run-time Processing  
The term Batch run-time processing refers to how events, such as initializing a section, and their 
attached event rule logic are evaluated at run time.  

Run-time structures are blocks of memory that hold data as it is read, processed, and written to the 
database.  

Report Design provides several different field types and event rules that are associated with run-time 
structures.  

Available Objects  
An available object is represented by a two-character, alphabetical code that characterizes the source 
of data and determines how the object data is used in a report or batch process at run time.  

During run-time processing, data is stored in memory in an internal data structure. Certain fields of 
the data structure temporarily store data during run time until it is no longer needed. Then data can be 
cleared to process another record.  

The following available objects are defined for batch processing:  

BC  A column in the business view. Business view columns will appear in this list. These 
columns are filled with values from the database when a fetch is performed and are the 
values saved to the database during an add or update.  

PO  A value passed from a processing option. These values are passed into the application when 
it is started and can be accessed by any form in that application. These processing option 
values could have been entered by the user or set up in a particular version of an 
application.  
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VA  Event rules variables. These objects represent variables set up by the developer in event 
rules. They are not manipulated by the system.  

SV  System variables. These objects represent some environment variables that have been made 
accessible to event rules.  

SL  System literals. These objects represent some constant system values that have been made 
accessible to event rules.  

TV  Text variable.  

RC  Report constant (UBE).  

RV  Report variable (UBE).  

PC  Previous business view column.  

PV  Previous report variable.  

Typical Event Flow for a Group Section  
The run-time engine processes events in a certain order. The typical events for a group section and the 
order in which they are processed follow.  

Initialize Section  

The following graphic illustrates, using a group section for an Address Book report, which values are 
in the run-time structures after the following events occur.  

• Initialize Section  
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Advance Section  

The following graphic illustrates which values are in the run-time structures after the following events 
occur:  

• Initialize Section  

• Advance Section  

 

 

Before Level Break  

The following graphic illustrates which values are in the run-time structures after the following events 
occur:  

• Initialize Section  

• Advance Section  

• Before Level Break  

 

 

239 



Do Section  

The following graphic illustrates which values are in the run-time structures after the following events 
occur:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  
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After Last Object  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  
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Advance Section  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  
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Before Level Break  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  

• Before Level Break  
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Do Section  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  

• Before Level Break  

• Do Section  
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After Last Object  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  
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Advance Section  

The following graphic illustrates which values are in the run-time structures after the following events 
occur and what the report looks like:  

• Initialize Section  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  

• Before Level Break  

• Do Section  

• After Last Object  

• Advance Section  
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Report Output  

Reports are created using Report Design Tool in which certain printing properties can be defined for 
the report that can affect the resulting output. After the report is created and submitted, the Batch 
Engine can process the report on the various servers or on the client. After report processing is 
complete, Output Management handles output generation and printing. This topic describes printing 
properties during report creation, submission, output generation.  

Printing Properties in Report Design  
Report Design incorporates printing properties that determine the format of output. In all cases, print 
properties set in Report Design override default properties established for batch processes. Setting 
print properties in a report version overrides the properties specified by the report template. Printer 
properties set in Report Design can be overridden at submission. This topic describes how to set print 
properties in Report Design. 

Note 

Changes in print properties in a report template are not reflected in any of its already existing 
versions.  

 

Overriding a Designated Printer  
A default printer is associated with batch processes. Default printers can also be associated with 
users; a user-associated printer overrides a batch process-associated printer. You can override both of 
these printers by selecting a printer when you design a report in Report Design. The printer you select 
is stored in the print specifications, causing the report to always print to that printer unless overridden 
at submission.  

► To override a designated printer  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose Print Setup from the File menu.  

2. On Print Setup, click the Printer Name button.  

3. On Printer Search & Select, choose the printer to which you wish the report to print, and then 
click Select.  
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4. On Print Setup, choose other options as desired and click OK.  

Selecting Paper Type  
You can select from a group of predefined paper sizes, or you can enter your own paper dimensions.  

The standard predefined selections are A4, Legal, and Letter. Letter is the default paper type. The 
paper size used for PDF generation is the one defined in the Paper Definition table (F986162). Report 
Design inherits the paper size from the same table. Change this table to modify the predefined group.  

Alternately, you can define paper size by width and height in inches. The minimum definable width is 
two inches, and the maximum is 21 inches. The minimum definable height is two inches, and the 
maximum is 24 inches.  
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► To select paper type  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose Print Setup from the File menu.  

 

2. On Print Setup, select a predefined paper type from the drop-down menu in the Size field, or 
click Custom and indicate the paper width and size in inches.  

3. Select other options as desired, and then click OK.  

Specifying Print Orientation  
Orientation refers to how the paper is rotated when it is printed. A vertical orientation is called 
Portrait; a horizontal orientation is called Landscape. Orientation can be applied only to predefined 
paper sizes. The option is disabled for user-defined paper sizes.  

In EnterpriseOne, the default orientation is Landscape. When you are printing to line printers, a 
Portrait orientation is recommended. Orientation does not apply for CSV generation.  

► To specify print orientation in Report Design  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose Print Setup from the File menu.  
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2. On Print Setup, click the desired orientation under the Orientation heading.  

Orientation options are deactivated if you have selected a custom paper size.  

3. Select other options as desired, and then click OK.  

Exporting to Comma Separated Value (CSV) Files  
To view report data in a spreadsheet programs such as Excel or Lotus, you must choose to export the 
data to a CSV file. Before exporting, PeopleSoft recommends that no fields overlap and that the 
horizontal spacing be set to 52 (this spacing corresponds to the default width of a column in Excel). 
Also set the Snap to Grid options set in the grid alignment layout. 

Both a .csv and a .pdf file are created in the Print Queue directory when the report is submitted to the 
screen or to the printer. Note that only single spacing and portrait orientation is supported for CSV 
files. Drill-down links are ignored in CSV generation.  

► To export to Comma Separated Value (CSV) files  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, open the report you are exporting. 

2. Check the layout of columns and fields.  

Ensure that no columns or fields overlap.  

3. Click a report section, and from the Layout menu, select Grid Alignment.  

4. On Alignment Grid, set the horizontal spacing to 52, choose the Snap to Grid option, and then 
click OK.  

Report Design applies this value to the entire report.  

5. From the Report menu, select Print Setup.  
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6. On Print Setup, choose Portrait under the orientation heading.  

7. Choose Export to CSV, and then click OK.  

See Also  
� Modifying the Appearance of Report Objects in the EnterpriseOne Report Writing Guide for 

information on altering field lengths and column widths  

Using System Function K2DoInitPrinter  
You can use the Do Init Printer event to specify a printer when the batch application processes. In this 
way, you could print the same report to different printers based on other criteria that you specify. The 
event rule (ER) for this event is the first ER that is processed when the report is submitted. The 
system function resolves and validates the printer, and the Batch engine then uses the printer name (if 
valid) to obtain a printer device context. Portions of this device context can be overridden if certain 
flags in the report specification are set.  

Printing Properties at Report Submission  
To submit a report, you must select the version of the report to be processed. You can submit the job 
in one of two ways:  

• When a version is submitted locally, the client immediately launches the UBE process, giving 
you the option to view the output on screen or to print it to a printer.  

• The version can also be submitted to an enterprise server that can handle the processing more 
efficiently than the client. When the version is submitted to the server for processing, the 
client packs the version specifications and other information necessary to run the report, 
(such as Processing Option values, Report Interconnect values, Printer Information), and 
sends a message to the server with all this information.  
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When a job is initiated on the server, it can be launched in one of the following ways:  

• By another report or interactive application through a report interconnect. Report 
Interconnects can also be used to submit jobs locally.  

• Through RUNUBE from the command line.  

See Also 
� Creating Report Interconnections in the Development Tools Guide 

Resolving Printers  
When a job is submitted on the client or server, the following applies:  

• If a printer is selected at design time, the printer name is stored in the report specifications. 
On the client, the printer name is passed in at submission time to the Printer Selection dialog 
box.  

• The user can override this printer.  

• If no printer is selected at design time, then during submission the default printer for that user 
is used. The default printer is selected by user, OW environment, and host.  

• Depending on the printer that was selected, the corresponding Printer Definition Language on 
the Advance tab will be enabled.  

If a job was submitted through report interconnects, the child reports inherit the printer name from the 
parent report. At print time, for the child report, the user can override the printer from the Work With 
Servers program (P986116) once the job has completed.  

When a job is submitted through RUNUBE, if a printer name was stored in the specifications it is 
used at print time; otherwise, the default printer for the user is used. At print time, the user can 
override the printer from the Work With Servers program when the job has completed.  

Selecting Paper Type  
If custom paper size is used in Report Design to design the report, then at submission time the user 
will not have an option of changing the paper type.  

The paper type defined for the printer is used during job submission. From the Print Property tab on 
the Printer Selection dialog box, the user can change the paper type. Depending on the printer that the 
user selects, the Paper Type field is automatically populated with the default paper type that is set for 
that printer.  

Specifying Print Orientation  
The orientation selected in Report Design is stored in the report specifications. Orientation from the 
specifications is displayed in the Print Property tab of the Printer Selection dialog box at submission 
time. The user can, however, change the orientation at submission time (locally or on the server).  

However, if custom paper size was selected at design time, the orientation control will be disabled in 
the Printer Selection dialog box. In the case of line printers, the CPI, CPP, LPI, and LPP that are 
defined for the line printer determine the orientation.  
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Using the Print Immediate Option  
On the server, if a job is marked for immediate printing (by setting the Print Immediate flag to TRUE 
in the client JDE.INI file under NETWORK QUEUE SETTINGS), the following is true:  

• The job automatically prints without having to actually click the Print option on the Work 
With Servers program (P986116). The PrintImmediate option comes in checked on the 
Printer Selection dialog box. The user can override this setting.  

[NETWORK QUEUE SETTINGS]  

PrintImmediate=TRUE/FALSE  

• For report interconnects, if the Print Immediate function is turned on then, the function is 
inherited by the child reports from the parent. In this case, the user does not have an option to 
override it.  

• In the case of job submission through RUNUBE, Print Immediate can be passed as an 
argument from the command line. In this case, just like on the server, the job automatically 
prints if the PrintImmediate option is set to TRUE.  

Using the SavePDL (Printer Definition Language) File Option  
If the JDE.INI file has the SavePDL option set to TRUE under NETWORK QUEUE SETTINGS, 
then at submission time the Printer Definition Language File option on the Document Setup tab is 
enabled. However, this option can be changed at submission time.  

[NETWORK QUEUE SETTINGS]  

SavePDL=TRUE/FALSE  

Additionally, if the SavePDL option in the JDE.INI file is set to FALSE, the user has the option at 
submission time to select this option in order to save the intermediate temporary file created. The 
PDL file, when created, resides in the Print Queue directory. In the case of report interconnects, the 
child reports inherit this property from the parent.  

At submission time the user has the option of modifying the Printer Definition Language File option 
and, depending on whether it is checked or unchecked, a PDF and a PDL file is created for that 
particular job only.  

Exporting to Comma Separated Value (CSV) Files  
When you are submitting the job on the client, if the Export to CSV option was selected, the option is 
stored in the report specifications. This option from the specifications is displayed in the Report 
Output Destination dialog. The user can override this option by submitting the job To Printer or to On 
Screen.  

If the user chooses to submit to the printer, the user has the option of overriding the Export to CSV 
option on the Document Setup tab of the Printer Selection form. A .csv and a .pdf file are created in 
the Print Queue directory when this option is selected.  
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When you are submitting the job to the server, if the Export to CSV option was stored in the report 
specifications at design time, then from the Work With Servers program (P986116), the user will 
have the opportunity to modify this option.  

In the case of report interconnects, the export to CSV option is not inherited by the child report from 
the parent. Therefore, the option must be selected at design time to enable this option for the child or 
parent report.  

Storing and Passing Printer Information  
When you launch a UBE on the client, the printer information is stored in the pUBEDs structure and 
this information is passed to the Batch Engine.  

For submission of a job from client to server, the printer information that is obtained from the Printer 
Selection dialog box is stored in the F986110 (Job Control Status Master table) as a BLOB (Binary 
Large Object).  

For job submission through report interconnects, the printer information for the child reports is 
inherited through the PRT_GetInfoFromPreviousReport API from the parent report. The inherited 
values are Printer name, Print Immediate, SavePDL information, Paper Type and Printer flags, 
Number of Copies, and Paper Source, if any. If the child report in its specifications had a printer name 
defined or custom paper type set, then that would override the inherited values.  

In the case of RUNUBE, the printer information, as well as information regarding Print Immediate 
and Save PDL, are packed and stored in the F986110 table.  

Job Submission on Client  
A job can be submitted on the client in one of the following ways:  

• To Printer  

• On Screen (for viewing the PDF file)  

• Export to CSV  

• Export via OSA  

When the job is submitted using the To Printer option, the Printer Selection dialog box is available to 
the user to modify output options.  

When a job is submitted using the On Screen option on the Report Output Destination dialog box, the 
PDF file is displayed through the Acrobat Reader.  

If the user submitted the job to the Export to CSV option, then the report will be automatically 
displayed through a default CSV viewer, such as Excel.  

If the user submitted the job using the Output Stream Access (OSA) option, then the location of the 
output is determined by the OSA's interface functions. For example, the EnterpriseOne XML 
interface creates an XML file in the same directories that are used for PDF and CSV output. An OSA 
library, created by another company, might store the OSA output in a different location.  
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Working with the Integrated File System (IFS) on the AS/400 

When you print a batch version on the iSeries server, the resulting report is sent to the integrated file 
system (IFS) in portable document format (PDF). You can map to the reports using Windows 
Explorer.  

The default PrintQueue directory is under the install directory. If you want to create your own 
PrintQueue directory, you need to define the PrintQueue using a valid IFS file name. 

► To define the PrintQueue directory for the integrated file system (IFS) 

Open the jde.ini file. 

1. Under [NETWORK QUEUE], change OutputDirectory = system, where system is the name 
of the PrintQueue directory. 

2. Save and close the jde.ini file. 
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Report Submission  

When you submit a report, you can modify the data selection and data sequencing and select 
advanced version functions. You can also choose to view the report on screen, send it to the printer, 
export it to a Comma Separated Values (CSV) file, or use Output Stream Access (OSA) to export it to 
another software program.  

Submitting a Report  
To submit a report, you must select a version of the report that you want to process. If you submit and 
process the report version on your workstation, you can specify whether to:  

• View the report online.  

When you view the report online, the report is in a PDF format and is readable only with the 
Adobe Acrobat Reader.  

• Print the report.  

• Export the report to a generic Comma Separated Values (CSV) file  

A CSV file has all of the commas stripped from the data fields. When you export the report to 
a CSV file, the file can be viewed in a default CSV viewer, such as Microsoft Excel or Lotus 
1-2-3. In addition to viewing the CSV file, you can manipulate report data after the report has 
finished processing.  

• Export the report to a specific environment via Output Stream Access (OSA).  

Unlike the generic CSV file, you can direct  to pass data to other software programs during 
batch processing, allowing the second software program to process and format the data 
concurrently. An OSA interface must already be defined before you can employ this option.  

In most business environments, you submit your version to a designated enterprise server that 
manages the processing needs more efficiently than your workstation. Your system administrator 
determines whether the system automatically processes and prints your output, or places it on hold in 
the queue.  

When you submit your version to the server for processing, it is sent to a job queue. Version 
specifications and information required to run the version are sent from the workstation to the servers. 
You can monitor the progress in the queue and preview the version when the processing is complete.  

Submitting a Report for Batch Processing  
You can submit a report using various methods. For example, you can double-click a report icon from 
a menu, choose Batch Versions from the Report Writer (GH9111) menu, or choose Report Versions 
from the Tools menu in PeopleSoft Solution Explorer. The following procedure describes the second 
method.  
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► To submit a report for batch processing  

From the Report Writer menu (GH9111), choose Batch Versions.  

The forms that appear depend on whether you submit the report version to a workstation or a server.  

1. On Work With Batch Versions - Available Versions, choose your report. Use the visual assist 
to more easily locate your report.  

If the report version is new and has not been checked in, other users cannot run the version. If 
you modify the version and run the modified version, the local modified specifications will 
run. If the modified version is executed on the server, the updated version specifications will 
be used when you submit that version.  

2. Click Select.  

3. On Version Prompting, click Submit.  

If your report version exists only on your workstation and you submit the version to the 
server, the Install Specifications form appears. You must first install the version and the 
report specifications to the server that processes the report.  

4. On Install Specifications, click Yes.  

The Remote Job form appears. Run a package install to put the report specifications and 
version information on the server to which the version will be submitted.  

5. Click OK.  

If you receive a communication failure message, resend the information to the server. If you 
continue to get a communication failure message, contact your system administrator.  

If you are submitting a job to run locally, the Report Output Destination form appears.  

6. On Report Output Destination, choose from the following options and click OK:  

• On Screen 

• To Printer 

• Export to CSV 

• OSA Interface Name 

Note 

OSA runs in tandem with one of the first three choices. When you choose OSA Interface 
Name, you must also choose one of the other three options.  

 

If you are submitting a job to run on a server and you have already installed the version and 
its specifications on the server, the Batch Versions - [Printer Selection] form appears. If a 
default printer has been defined for report processing, that printer’s information appears on 
the Batch Versions - [Printer Selection] form. If you selected a different printer in RDA when 
designing your report, it overrides the default printer defined for the report processing.  

7. On Printer Selection, on the Printer Selection tab, enter the number of copies of the report 
you wish to print.  
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8. Click the Print Property tab and select from the following override options as appropriate:  

• Portrait 

• Landscape 

• Number of Copies 

This number reflects the number of copies entered on the Printer Selection tab. The 
default value is 1. Changing the value here changes the value on the Printer Selection tab 
to match. The option is valid only for PostScript and line printers; it is disabled for PCL 
printers.  

If you are printing to an AS/400 line printer, you may need to modify your output queue 
description to enable this feature.  

• Paper Type 

• Paper Source 

The default and maximum values are defined in the Printer Setup application. The option 
is only available for PostScript printers; it is disabled for PCL and line printers.  

The options you select on this form override settings specified in the report itself, but apply to 
the current batch process only.  

9. Click the Document Setup tab and choose from the following options as appropriate:  

• PDF(Portable Document Format) 

• Printer Definition Language File 

• Print Immediate 

• CSV(Comma Delimited) 

• OSA Interface Name 

10. Click the Advanced tab and choose from the following options as appropriate:  

• PostScript 

• PCL 

• Line Printer 

• Custom 

11. Click OK. 

See Also 
� See the following topics in the EnterpriseOne Report Writing Guide: 

• Working with the Printers Application for additional information on printers 

• Overriding Data Selection and Data Sequencing  

• Using Advanced Option Overrides  

� Setting Up a Printer for iSeries in the Server and Workstation Administration Guide  

258 



Comma Separated Values (CSV) Files  

When you export a file to CSV, the following occurs:  

• A CSV file is created in the print queue.  

• A PDF file is created in the print queue.  

• Your CSV file appears in Microsoft Excel, which launches automatically if you are running 
locally. If you are running on a server, from Work With Servers (P986116) choose View 
CSV to launch Excel and view the file.  

You can also use the CSV file for other spreadsheet applications. Microsoft Excel can read a CSV file 
by default.  

If you are running locally and you want to export a report to a CSV file for just a specific instance, do 
one of the following:  

• Click the Export to CSV option when submitting your report.  

• Click Export to CSV (Comma Delimited) on the Document Setup tab of the Printer Selection 
form.  

If you always want a report to export to a CSV file, click Export to CSV in the Printer Setup in RDA 
so that the report specifications are set to export the report to a CSV file.  

If you do not want the report to export to a CSV file for a single instance, even though it is set in the 
report specifications, click Export to CSV to remove the check when submitting your report.  

Reports do not always export to other programs perfectly. For example, group sections with several 
one-character data fields might need some cleanup. Following are several points to consider when 
exporting to CSV files.  

• The startup default column width in Excel is equivalent to about 52 units in Report Design, so 
for best results, set your horizontal grid alignment to 52 and turn on the snap to grid option.  

Each column you see in RDA is now equal to a column in Excel. Align the data so that the 
left edge of each data field is in a column. If a data field overlaps into the next column, the 
data in Excel will be in discrete columns. Since the text comes into Excel in one cell, you can 
then wrap the text in the calls in Excel. Delete unused columns in Excel and reformat 
information as needed.  

• If data fields are vertically off, they appear in separate rows in Excel. If more than one data 
field with the same vertical and horizontal alignment appears in a column, only one of these 
fields will be in the CSV file. The first field to get output occupies the cell in Excel.  

• Some countries use a comma as a decimal marker. In these countries, the decimal separator is 
recognized as a comma when the report exports and a tab-separated file with a .txt extension 
is created. Tabs are stripped out instead of commas.  

The information transfers as flat text, so totaling columns just show text and you must set up 
totaling in Excel.  

• After your report is designed to export into Excel cleanly, you can use the Auto Format 
feature in Excel to further format your report in Excel.  

• Excel uses the same date format you use in your report.  
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Output Stream Access (OSA) Files  

When you use OSA to direct your output, EnterpriseOne passes its output to another program for 
processing. The OSA interface must be predefined; several interfaces may exist for one program, 
depending on the report type and the desired output.  

The benefits of OSA are that it can eliminate the task of manually formatting output (as you must do 
with CSV output) and that it can employ the processing power of the target software program.  

OSA can use its own set of commands, or it can use an XML library. Because many software 
packages already use XML libraries for several functions, creating and using an XML library can 
simplify the interface.  

See Also  
� Creating and Associating OSA Interfaces in the EnterpriseOne Report Writing Guide for 

more information about defining OSA interfaces and libraries  

Defining Processing Options  
Processing option values are stored for each report version in the Versions List table (F983051). This 
table is centrally located and can be accessed by all EnterpriseOne users within a given environment. 
Any changes to processing option values are immediately visible to all other users working with the 
same report version. Jobs running on client machines and jobs running on servers all access the same 
table.  

Processing option values that you enter during submission are used at execution. If there is no 
prompting, values that exist at submission are used at execution. Values that you enter during 
submission are saved in F983051 and will be seen the next time you submit that version.  

Processing options that are defined by a particular user during submission of a report are saved for 
that user. This means that multiple users can run the same report with different processing option 
values and receive the output they desire based on their individual processing option values. For 
example, User A submits User Defined Codes Print (R0005P) to run on a server, changing the 
Language Preference processing option to E for English. The job goes to the server and waits in its 
queue. User B also submits R0005P, changing the Language Preference processing option from E to 
F for French. That job also goes to the server and waits. When User A's job gets to the top of the 
queue and becomes active, it will use the Language Preference value of E, even though User B 
changes the processing option value to F during submission.  

Consider the following scenarios:  

• Submitted on client, running on client.  

During report submission, the user might be prompted for data selection and sequencing 
values. The values that the user specifies during prompting are retained in memory, but are 
not saved to the local RDASPEC files. The values in memory are passed along to the job as it 
processes. If no prompting occurs, then the job will load selection and sequence values from 
the local RDASPEC files at execution.  

• Submitted on client, running on server.  

The submission process begins in the same way as when a report is submitted and running on 
a client, but when the job is transferred to the server, the processing option values are also 
sent to the server, where they are stored in the Job Control Status Master table (F986110). 
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When the job is executed, the processing option values are retrieved from F986110, instead 
of being loaded from F983051.  

Overriding Data Selection and Data Sequencing  
From Version Prompting, you can change the data selection and data sequencing for your report. 
Every user (client machine) has a copy of a given version. Any changes made to a report version 
remain with the copy of the version that resides on that machine.  

Data selection and sequencing values are stored in Report Design specification (RDASPEC) files, 
which can exist on the client as well as the server. In Terminal Server environments, multiple users 
share the same set of client RDASPEC files, so any change to specifications by one user are 
immediately visible to all other users of the same terminal server.  

Values entered during submission are used for processing, but are not saved and will not be seen at 
the next report submission. If no prompting occurs, values that exist locally at submission are used 
during processing. Values entered in Version List or in Report Design are saved in the RDASPEC 
files.  

Consider the following scenarios:  

• Submitted on client, running on client.  

During report submission, you might be prompted for data selection and sequencing. The 
values that you specify during prompting are retained in memory, but are not saved to the 
local RDASPEC files. The values in memory are then passed along to the job as it processes. 
If no prompting occurs, the job will load selection and sequence values from the local 
RDASPEC files at execution time.  

• Submitted on client, running on server.  

When a job is sent to a server, all of the specifications related to the version being submitted 
are copied into packed files that are sent to the server. When the job processes on the server, 
the information from the packed files is merged into the specifications on the server, which 
are then used to run the job. Every user gets his own copy of his report to run on the server.  

If prompting for selection and sequencing values occurs during submission, the values 
retained in memory are copied into the packed files instead of the corresponding RDASPEC 
information, so the values from prompting will be used when the job eventually executes.  

Changing Data Selection  

Data selection uses Boolean logic to determine which records to include in the report. Boolean logic 
uses operators such as And and Or.  

Use And to include only the data that two or more fields in a record have in common. For example, 
suppose you need a list of customers who are located in New York City. You might use the two fields 
Location and Search Type with the following criteria:  

Location = New York  

And  

Search Type = C (customer)  
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Use Or logic to search for records that include data items for either NYC Or C. For example, if you 
need to find any New York City record or any customer record, you would indicate the same 
information for Location and Search Type.  

► To change data selection  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

3. Choose the report version you want to submit, and then click Select.  

4. On Version Prompting, click the following option:  

• Data Selection 

5. Click Submit.  

6. On Data Selection, change the data selections as needed for your version.  

7. Click OK.  

If you are submitting a job to run locally, the Report Output Destination form appears.  

See Also 
� Defining Section Data Selection in the EnterpriseOne Report Writing Guide 

Changing Data Sequence  

You can change the order in which the data in your report appears.  

► To change data sequence  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

3. Choose the report version you want to submit, and then click Select.  

4. On Version Prompting, click the following option:  

• Data Sequencing 

5. Click Submit.  

6. On Section Data Sequencing, change the data sequencing as needed for your version.  

7. Click OK.  

If you are submitting a job to run locally, the Report Output Destination form appears.  
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See Also 
� Defining Section Data Sequencing in the EnterpriseOne Report Writing Guide 

Using Advanced Option Overrides  
Advanced options allow you to override your processing location and use a variety of logging 
features.  

► To use advanced option overrides  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

3. Choose the report version you want to submit, and then click Select.  

4. On Version Prompting, choose Advanced from the Form menu.  

If the menu bar does not appear at the top of Version Prompting, maximize the form.  

5. On Advanced Version Prompting, click one or more of the following options, and then click 
OK:  

• Override Location  

You must have authorization from your system administrator to override your location. If 
you select Override Location, the JDE Data Sources form appears when you click Submit 
from Version Prompting.  

From this form, choose the enterprise server where you want to process your job, and 
then click Select to continue.  

• Logging (JDE.log)  

• Tracing (JDEDEBUG.log)  

• UBE Logging Level  

When you choose a high value to receive more technical information, you also receive all 
the information for the lower values. For example, when you enter a value of 3 (object 
level messages), you also receive information for 2 (section level messages), 1 
(informative messages), and 0 (error messages).  

• Submit Version Specifications Only  

See Also 
� Moving Batch Version Specifications to an Enterprise Server in the EnterpriseOne Report 

Writing Guide for information about working with the Submit Version Specifications Only 
option 
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Command Line Submission  
You can allow non-PeopleSoft software applications to submit batch jobs for processing in 
EnterpriseOne via a command line. EnterpriseOne accepts two types of batch submission command 
lines:  

• runube is a direct command line with which you can define which report and version to run, 
which job queue to use, how the queue is controlled, whether the report is printed or held, and 
where the report is output to. This command line requires no input files. It does not allow you 
to override or change processing options, data selection, or data sequencing from what has 
already been set using a EnterpriseOne client.  

• runubexml is a command line that uses an xml input file to specify to EnterpriseOne about 
how to process the report. It is nearly as flexible as submitting a batch process directly within 
EnterpriseOne, and it does allow you to override the settings in specifications for processing 
options, data selection, and data sequencing. However, you must have an xml input file 
available for each processing variation for each version of each report you want to run.  

Using runube  

The format of the runube command line is as follows:  

runube UID PWD ENV REP VER JQ B/I P/H S/D PTR  

The following is a description of each of the command line components:  

runube The name of the executable that submits the job.  

UID  An EnterpriseOne user ID. You must have access to the report you want to run. If you do not 
enter a printer type and you have requested that the report be printed, the system uses the 
printer assigned as your default printer based on your user ID.  

PWD  The EnterpriseOne password corresponding to the user ID.  

ENV  The EnterpriseOne environment.  

REP  The system name of the report you want to process, such as R0006P.  

VER  The name of the version of the report you want to process; such as XJDE0001. You must 
enter a version; you cannot submit the template of a report.  

JQ  The name of the job queue to which the system should route the batch job, such as 
QBATCH.  

B/I  The processing mode. Enter B to use batch processing. In this case, the system uses the 
F986110 Job Control table to assign the report a place in the queue.  

Enter I for interactive mode, which runs the report immediately outside of the EnterpriseOne 
queuing mechanism.  

P/H  The hold code. Enter P to send the output to a printer immediately after the job completes.  

Enter H to hold the processed file without printing. You can print the job later using the 
Work With Servers program (P986116) located on the System Administration Tools menu 
(GH9011).  
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S/D  The save code. Enter S to save the file after processing is complete. The delete option (D) is 
reserved for future functionality. Currently, the option is disabled.  

PTR  The printer ID. If you do not enter a printer type, the system uses the printer assigned as your 
default printer based on your user ID and environment.  

 

Caution 

If you submit this line command in a UNIX environment, you should be aware of the possible 
security risk. Any user with access to the UNIX system can view this command line, including your 
password, while the runube command is processing.  

 

 

See Also 
� To define a default printer in the EnterpriseOne Report Writing Guide on the Printers 

Application program (P98616) on the Batch Processing Setup menu (GH9013) 

Using runubexml  

To use runubexml, you must create an xml file which is used as input to provide EnterpriseOne with 
batch processing instructions. If you will be routinely submitting the same reports with the same 
options for processing, you might consider creating several xml files for each report.  

Create and submit an xml file that gives EnterpriseOne your ID, password, and environment along 
with the name of the report and version you want to process. The system returns a new xml input file 
that defines the report version and its saved processing options. You can modify this input file and 
even create several variations of it to run.  

You can run this input file as often as you wish. Note that changing the input file does not modify the 
report version as it is saved in EnterpriseOne. The input file only provides the EnterpriseOne batch 
processing engine with data; EnterpriseOne does not maintain any connection between the xml input 
file and the report upon which it is based. If the report is changed in EnterpriseOne and you want 
those changes to be reflected in the output you receive with the xml input file, you must either change 
the input file, or generate a new input file after the report has been altered in EnterpriseOne.  

You must use a file called jdeRequest.xml to instruct the system to create an xml input file based on a 
EnterpriseOne report for you. If you do not have this file available, run the following command:  

runubexml G CREATE_XML jdeRequest.xml  

This command generates the jdeRequest.xml file, which looks like this example:  

<?xml version='1.0' ?>  

<jdeRequest type='ube' user='MYUNAME' pwd='MYPASS' environment='MYENV' 
session=''>  

 <!--This document is automatically generated by the J.D.Edwards APIs-->  

 <ACTION TYPE='CREATE_XML' TEMPLATE_TYPE='LAUNCH_JOB'>  
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  <REPORT_NAME VALUE='MYREPORT'/>  

  <REPORT_VERSION VALUE='MYVERSION'/>  

  <JARGON_SYSTEM_CODE VALUE='1'/>  

  <COMMENTS VALUE='1'/>  

  <DATA_TYPING VALUE='1'/>  

  <BUSINESS_VIEW VALUE='0'/>  

  <!-- Note that Printer Information cannot be overridden at this 
time -->  

  <PRINTER_INFORMATION VALUE='0'/>  

  <POPULATED VALUE='1'/>  

 </ACTION>  

</jdeRequest>  

Edit the jdeRequest.xml file based on the following explanations:  

user = 'MYUNAME'  Substitute an EnterpriseOne user name for MYUNAME.  

pwd = 'MYPASS'  Substitute an EnterpriseOne password for MYPASS. The password 
must be submitted in plain text; therefore, the jdeRequest.xml file 
should be kept in a secure location on your file system.  

environment = 'MYENV'  Substitute an EnterpriseOne environment for MYENV.  

REPORT_NAME VALUE = 
'MYREPORT'  

Substitute the system name of the report, such as R0006P, that you 
want to base the parameters for the xml input file on.  

REPORT_VERSION VALUE = 
'MYVERSION'  

Substitute the name of the batch version that you want to base the 
parameters for the xml input file on. This is a required value; you 
cannot base the xml input file on a report template, such as 
XJDE0001.  

JARGON_SYSTEM_CODE 
VALUE  

Enter 1 to use jargon overrides. Enter 0 to turn jargon off.  

COMMENTS VALUE  Enter 1 to see xml comments in the xml file. Enter 0 to suppress 
comments.  

DATA_TYPING VALUE  Enter 1 to see the data type (numeric, alpha, etc.) populating the 
fields. Enter 0 to suppress data type identification.  

BUSINESS_VIEW VALUE  Enter 1 to see which business view columns are being used to 
generate the report. Enter 0 to suppress business view data.  

PRINTER INFORMATION 
VALUE  

Enter 1 to see information about the printer to which the report is to 
be routed. Enter 0 to suppress printer information. 

Note   

Even though print values are shown in both the 
jdeRequest.xml and the input xml file, you cannot 
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override printer values with the xml input file.  

POPULATED VALUE  Enter 1 to populate the resulting xml input file with the settings and 
options specified for the batch version. Enter 0 to generate a blank 
xml input file. Most of the time you will enter 1 in this field.  

After you have edited and saved jdeRequest.xml, run the following command:  

runubexml S jdeRequest.xml Filename.xml  

This command submits the jdeRequest.xml file for processing and returns the input xml file you will 
need to run a batch job. Substitute the name you want to call this file for Filename. PeopleSoft 
recommends naming the file after the report and version upon which it is based, such as 
R0006P_XJDE0001.  

At this point, you can edit Filename.xml, if you wish. For example, you can modify the processing 
options, data selection, or data sequencing. You might create several input files based on the same file 
with slightly different processing option values to save time if you will be running the variations on a 
regular basis.  

Caution 

The input xml file is precisely formatted according to EnterpriseOne input specifications. Altering the 
format of the file beyond modifying input values might result in errors when the file is run.  

 

After creating, modifying, and saving the xml input file, use the following command line to process 
the batch application the file defines:  

runubexml S Filename.xml jdeResponse.xml  

This command submits your xml input file (substitute the filename for Filename in the above 
command line) for processing and returns the results (including error messages) in a file called 
jdeResponse.xml.  

Working with Submitted Reports  
You can view the status of your submitted reports by accessing Work With Servers (P986116). You 
can change your job priority, the printer, and the job's queue.  

Checking Your Report Status  
After you submit your report, you can review and modify its status.  

► To check your report status  

From the System Administration Tools menu (GH9011), choose Work With Servers.  

1. On Work With Servers, click Find to display the list of available servers.  

If you use the Data Source column in the QBE line to search for the server, you must type the 
server name using uppercase letters for the system to recognize the server.  
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2. Choose the server, and then click Select.  

3. On Submitted Job Search, the status of your report is shown in the following field:  

• Status 

Your system administrator might have set up your configuration to automatically print 
reports. If the report does not automatically print, you can print it or view it online from this 
form.  

4. If you need to check on another person's report or a different job queue, modify one or both 
of the following fields, and then click Find:  

• User ID 

• Job Queue 

5. To review the job, choose the job, and then click Select.  

6. On Job Maintenance, modify the following field as needed:  

• Job Priority 

If you have the proper administrative authority, you can change your job's priority on the 
job queue while your job is at a W (wait) status. You might choose to move more 
important jobs up in the queue and move those with less priority down in the queue.  

7. Review the following fields for information about your report:  

• Job Status 

• Job Queue 

• Host 

• Environment 

• Server Job Number 

• User ID 

• Server Process ID 

• Origination Host Name 

• Date - Job Submitted 

• Time Job Submitted 

• Date - Last Task 

• Time - Last Task 

8. Click OK. 

Viewing and Printing Your Report  
After submitting your report and all processing is complete, you can print a version of the report from 
the Submitted Job Search form. If you choose to submit your report to screen, the output is created in 
Portable Document Format (PDF) format and can be viewed in Adobe Acrobat Reader. If you choose 
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to export to a Comma Separate Value (CSV) file, you can view and manipulate the output through the 
default CSV viewer.  

In addition to one of these three options, if you chose to use an Output Stream Access (OSA) 
interface, your ability to view the result depends on how the target program was instructed to process 
the data and the reviewing tools that the program supports.  

After submitting your report to a server and all processing is complete, you can view an online 
version of the report from the Submitted Job Search form.  

Note 

If you are using an iSeries client, the PDF is stored on the client in the integrated file system (IFS) 
folder you defined in the jde.ini file. See Working with the Integrated File System (IFS) in the 
Enterprise Report Writing Guide for information on defining the PrintQueue directory for the PDFs. 

 

 

Prerequisites 
� Ensure that  Adobe Acrobat Reader is installed on your workstation. 

� You must have a spreadsheet (for example, Microsoft Excel) or other application (for 
example, Lotus 1-2-3) available from which you can view a CSV file. See your default CSV 
viewer's online help for more information about using your CSV viewer. 

► To view and print your report  

From the System Administration Tools menu (GH9011), choose Work With Servers.  

1. On Work With Servers, click Find to display the list of available servers.  

If you use the Data Source column in the QBE line to search for the server, you must type the 
server name using uppercase letters for the system to recognize the server.  

2. Choose the server, and then click Select.  

3. On Submitted Job Search, choose the report you want to view or print and from the Row 
menu, choose one of the following:  

• Print  

Use this option for jobs with a status of E (error in processing) or D (processing is 
complete). Printing jobs with a status of E prints the error log, which helps you 
troubleshoot.  

If you choose this option, the Printer Selection form appears.  

• View PDF  

If you choose this option, the Portable Document Format (PDF) output will be 
downloaded from the server. You can view an online version of your report in Adobe 
Acrobat Reader. All of the Adobe Acrobat Reader functions are available to view and 
zoom the report.  

• View CSV  
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To use this option, you must have chosen the Export to CSV option on the Printer Setup 
form in Report Design or from the Advanced tab of the Printer Selection form. When you 
choose this option, the CSV output will be downloaded from the server and the output 
will display the CSV format in your default CSV viewer, such as Microsoft Excel or 
Lotus 1-2-3.  

• View OSA  

When you choose this option, if the OSA process used to process the report produces an 
output file and if the OSA process passes the location of the output to EnterpriseOne, 
then the system will attempt to launch the software program associated with the output 
file. Otherwise, you will receive an error messaging informing you that output is 
unavailable.  

If you choose the Print option, the Batch Versions - [Printer Selection] form appears.  

See Also  
See the following topics in the Server and Workstation Administration Guide: 

� Troubleshooting the Workstation for more information about error logs and troubleshooting 
error logs 

� Troubleshooting the Enterprise Server for more information about error logs and 
troubleshooting error logs 

See the following topics in the EnterpriseOne Report Writing Guide: 

� Working with the Printers Application for additional information on printing 

� Submitting a Report for additional information on submitting a batch version 

Reviewing Errors  
If your print job shows an E status, this indicates that an error occurred during the process. On the 
Submitted Job Search form, you can print or view the error online and remove the job. Printing a job 
with a status of E prints the error log, which can help you troubleshoot.  

Holding and Releasing Reports on the Queue  
If you submit a report in a wait status (status of W) on the job queue, you can release it to run at a 
more appropriate time. This might be necessary if running a report impacts system resources. If you 
want to stop a report that is processing (status of P), you need to terminate it. The Terminate option 
does not delete the job; rather, it changes the status to E.  

If you do not have authority to change your job queue, contact your system administrator.  

► To review errors  

From the System Administration Tools menu (GH9011), choose Work With Servers.  

1. On Work With Servers, click Find to display the list of available servers.  

If you use the Data Source column in the QBE line to search for the server, you must type the 
server name using uppercase letters for the system to recognize the server.  
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2. Choose the server, and then click Select.  

3. On Submitted Job Search, choose the appropriate job, and then click Select.  

4. To check your report, you can print or view it online.  

5. To remove (delete) the record and the job from the outqueue, click the Delete button.  

You can use this option with jobs that have a status of E (error) or D (done).  

► To hold and release reports on the queue  

From the System Administration Tools menu (GH9011), choose Work With Servers.  

1. On Work With Servers, click Find to display the list of available servers.  

If you use the Data Source column in the QBE line to search for the server, you must type the 
server name using uppercase letters for the system to recognize the server.  

2. Choose the server, and then click Select.  

3. On Submitted Job Search, choose the appropriate job, and then click Select.  

4. From the Row menu, choose Hold.  

The status changes to H (hold).  

5. To release the job, choose Release from the Row menu.  

The H status is removed, and the job is sent to the queue.  

Working with Your Report Output  
You can send your PDF report output as an attachment within an e-mail message or post your reports 
to the Worldwide Web. The EnterpriseOne installation materials include Adobe Acrobat Reader to 
read report output in an e-mail message and Microsoft Internet Explorer, which enables you to read 
portable document format (PDF) files on the Worldwide Web.  

In addition, you can select text and copy the unformatted text to other Windows applications that use 
the Clipboard. See your Adobe Acrobat Reader online help for more information.  

You can view your CSV report output through a default CSV viewer such as Microsoft Excel or 
Lotus 1-2-3.  

Where you submit or how you view your report output determines where the report is stored. Review 
the following:  

• If you view your report output in PDF, CSV or OSA, the output is stored on your 
workstation. By default, your output will be in your \B7\PrintQueue subdirectory on the drive 
where EnterpriseOne is installed. Contact your system administrator to find out the default 
location on your system. From this subdirectory, you can move, copy, and attach a file to an 
e-mail message.  

• If you submit your report on an iSeries server, your PDF or CSV file resides in the 
EnterpriseOne system library. In this library, your PDF file resides in a member called Fxxxx, 
where xxxx represents your job number, in the PRINTQUEUE file. In this library your CSV 
file resides in a member called Cxxxx, where xxxx represents your job number, in the 
PRINTQUEUE file.  
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• For servers other than iSeries, the file resides in the PrintQueue subdirectory on the server. 
The location of the PrintQueue subdirectory depends on the path your system administrator 
sets in the jde.ini file. The following examples display possible settings for your jde.ini file:  

• Windows NT Server jde.ini  

[NETWORK QUEUE SETTINGS]  

OutputPath=c:\PeopleSoft\output\PrintQueue  

• UNIX jde.ini  

[NETWORK QUEUE SETTINGS]  

OutputPath=/usr/PeopleSoft/output/PrintQueue  

In these examples, [NETWORK QUEUE SETTINGS] is the setting that determines the path 
to PrintQueue. For Windows NT Server, the full path for the setting is 
"c:\PeopleSoft\output\PrintQueue." For UNIX, the full path for the setting is 
"/usr/PeopleSoft/output/PrintQueue." The directory where PrintQueue resides for 
each example is output. This directory can be any valid directory on the server.  

Understanding Subsystem Jobs  
Within EnterpriseOne, subsystem jobs are batch processes that continually run independently of, but 
asynchronously with, EnterpriseOne applications. These subsystem jobs function with the system's 
logical process or queue defined for the server platform. You can configure EnterpriseOne to use one 
or more subsystems.  

You use subsystem jobs to offload processor resources or to protect server processes. Examples of 
applications that are suited for use by subsystems include Logistics Warehousing, Inventory, and 
Sales Order Processing. For example, you might execute the Sales Order Entry application on a 
workstation and want to automatically print pick slips when all orders are entered. If you are using a 
version of pick slips that has the subsystem job function enabled in Report Properties, the request is 
executed by a subsystem job. The pick slip request is routed to and processed by the subsystem job on 
the defined enterprise server. As a result, no additional processing resources are required of the 
workstation.  

When an EnterpriseOne application issues a request for a job to run in a subsystem, it places a record 
in the Subsystem Job Master table (F986113). This record is identified by a subsystem job name and 
version, and contains status and operational indicators. Embedded in the record is key information 
that allows the subsystem to process the record without additional interaction with the requesting 
application. The continuously running subsystem monitors the records in this table. If the subsystem 
finds a record with its name, version, and appropriate status indicators, it processes the record and 
updates the status accordingly.  
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The following graphic illustrates how the system processes a subsystem job:  
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Defining Subsystem Jobs  
Subsystem jobs are continuous jobs, processing records from a data queue. This type of job runs until 
you request an end to the job. Subsystem jobs read records one at a time for a subsystem table, 
retrieve information from the particular record, and run a configurable processing engine for each 
record. At the end of the records, instead of ending the job, subsystem jobs wait for a specific period 
and then retrieve the information for each record once again. For each subsystem job, multiple 
records can exist in the subsystem table.  

You start a subsystem job as you would a regular batch job. No difference exists between running a 
subsystem job and running a batch job.  

Before processing, EnterpriseOne ensures that limits for the subsystem job on the particular server 
have not been exceeded. If exceeded, the configurable processing engine does not process the 
subsystem job.  

► To define subsystem jobs  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design open a report, and then choose Report Properties from the File menu.  

2. On Properties, on the Advanced tab, choose the following options, and then click OK:  

• Subsystem  

• Wait Time (ms)  

The value in this field represents the time that the subsystem report will check the 
subsystem file for new records to process.  

3. On Report Design, choose Report Data Structure from the File menu.  

 

4. On Report Data Structure, click the Find button to display a list of data items.  

5. From Dictionary Items, drag items into Structure Members, and then click OK.  

6. On Report Design, choose Report Properties from the File menu.  
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7. On Properties, click the Advanced tab, and then click Generate to create a header file.  

The header file takes the form of Report_Name.h under the \B7\$environ\include 
subdirectory. In an interactive application, from which you will send a record to process in 
the subsystem report, you can use this header file inside a business function to create a 
subsystem record.  

For example, by clicking OK on Sales Order Entry (P4210), you can specify to call a 
business function that uses this report's data structure along with the subsystem's application 
programming interfaces (APIs) to trigger the subsystem report.  

Adding an API Record to the Subsystem Table  
You add an API record to the subsystem table so that the subsystem job can perform the batch 
process. When you add a record to the subsystem table, you create a business function, then attach the 
header file that you generated to that business function using Microsoft Visual C++. After you attach 
the header file to the business function, you attach the business function to the event rule process of 
the program you want to call.  

This API record retrieves data structure and user information from the cache. If the server name is not 
passed, the API finds Object Map Record from the Data Source Master table (F98611). If the record 
exists, it will use the record to send a JDENet Message to the server to add the record to the 
subsystem table on the server. However, if the user provides an Override Server name, the JDENet 
message is sent to that server instead.  

Prerequisite 
� You must generate the header file using Report Data Structure to ensure that the API is called 

from the business function. See Defining Subsystem Jobs in the EnterpriseOne Report 
Writing Guide. 

Example: Subsystem Job Header File  
The following example shows what the subsystem job header file: 

#include <jde.h> 

/************************************************************ 

* Report   : R98SSUBE 

* ReportId : 8123244 

* DSTRId   : 380813 

* 

* Note: 

* Do not edit the following typedef 

* To make modifications, use the Report Design Aid Tool to   

* Generate a revised version. 

*************************************************************/ 

#ifndef REPORT_DS_380813 

#define REPORT_DS_380813 
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typedef struct tagDS_RI_380813 

{ 

 char                         ProgramId[11]; 

} DSRI380813, *LPDSRI380813; 

#define                   IDERRProgramId_1                                 1L 

#endif /* #define REPORT_DS_380813*/ 

#endif /* #define __R98SSUBE_H */ 

► To add a record to the subsystem table  

In EnterpriseOne, create a new business function.  

1. In Microsoft Visual C++, open the business function include file and add the name of the 
header file that you generated.  

In the following example, the include statement is underlined:  

/********************************************************* 

/* Table Header Inclusions 

*********************************************************/ 

 

/****************************************************************************/ 

External Business Function Header Inclusions 

****************************************************************************/ 

#include <R98SSUBE.h>  

 

/***************************************************************************** 

* Global Definitions 

****************************************************************************/ 

 

/***************************************************************************** 

* Structure Definitions 

****************************************************************************/ 

* TYPEDEF for Data Structure 

* Template Name: Report Interconnect Data Structure 

* Template ID:  D983059 

* Generated:  Wed Oct 18 14:01:22 1995  

2. In Microsoft Visual C++, open the business function source file and add lines to declare the 
variable of this data structure type and populate the members of the data structure. 

In the following example, the new line is underlined:  

#include <jde.h> 

/***************************************************************************** 

* Variable declarations 

*****************************************************************************/ 

HUSER hUser=NULL; 
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LPSTR szServer=NULL; 

DSRI380813 dsRI; /* Declare the variable of type REPORT INTERCONNECT DATA STRUCTURE 

*/ 

BOOL bRet=FALSE; 

JDEDB_RESULT rcode; 

/**********************************************************************************

* 

Declare structures 

***********************************************************************************

/ 

/**********************************************************************************

* 

Declare pointers 

***********************************************************************************

/ 

/**********************************************************************************

* 

Check for NULL pointers 

***********************************************************************************

/ 

if ((lpBhvrCom == NULL) || 

 (lpVoid == NULL) || 

 (lpDS == NULL)) 

3. In the source file, call the API to add the record.  

In the following example, the new lines are underlined:  

********************************************************** 

Main Processing 

*********************************************************/ 

memset(&dsRI, 0, sizeof(DSRI380813)); 

/* Populate the members of the Report Interconnect Data Structure */ 

strcpy(dsRI.ProgramId,lpDS->szString01); 

/* Call Subsystem API to add the record to the Subsystem Table */ 

/* Note : As Environment Name is set to NULL, this API will use OCMto find the 

default Environment of this UBE */ 

 bRet=jdeAddSubsystemRecord( hUser,/* User Handle */ 

 ”R98SSUBE”, /* Name of the subsystem */ 

 ”XJDEOOO1”, /* Name of the Subsystem Version*/ 

 NULL,  /* Name of the override env - not     

 used */ 

 szServer, /* Name of the server */ 

 &dsRI);  /* Subsystem Connect DS */ 

/********************************************************/ 
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4. After you call the API to attach the record, attach the business function to the event rule 
process of the program you want to call. This program can be either an interactive or batch 
application.  

See Also  
See the following topics in the Development Tools Guide: 

� Working with Business Functions  

� Working with Event Rules Design  
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Report Printing Administration  

The Printer Definition program (P98616) provides a single point of entry for configuring your report. 
The application allows you to define printers for workstations and enterprise servers. These 
definitions reside in EnterpriseOne tables that are maintained by the Printer Definition program.  

In addition to creating your own reports, EnterpriseOne includes a number of predefined reports and 
report versions, which you can use and modify for your business needs. EnterpriseOne uses the batch 
engine to create reports and generates these reports in Portable Document format (PDF). You can 
view the PDF files using the Adobe Acrobat Reader software.  

Reports process as batch applications without user interaction. When a user submits a report for 
processing, the user makes choices, such as the selection and sequencing of data to include in the 
report, the location where the report will process, logging capabilities to monitor how the report 
processes, and the printer on which the report prints.  

See Also 
� Batch Versions for Reports in the Foundation Guide for more information about submitting 

and printing a report  

Understanding Printing  
When you submit a report, the batch engine generates a portable document format (PDF) file. The 
batch engine uses a device context to create the PDF file. This device context consists of information 
such as page size and the printable area of a page. EnterpriseOne generates this information from the 
printer tables for all platforms.  

EnterpriseOne gives you the option of viewing the report (the PDF file) on your workstation, using 
Adobe Acrobat Reader, or sending the report directly to a printer. You can also print the report from 
the Adobe Acrobat Reader. When you send the report to a printer, EnterpriseOne uses a conversion 
filter to transform the PDF file into one of three Page Description Language (PDL) formats: PCL, 
PostScript, or line-printer text, depending on the type of printer that prints the report.  

The batch engine uses the following logical path to determine to which printer to send a report. If the 
first method does not return a valid printer name, the batch engine uses the subsequent method.  

When the user submits the report:  

1. The batch process triggers the Do Initialize Printer event from Report Design Aid (RDA). If 
this process retrieves a valid printer name, the following processes are ignored.  

2. The user overrides the default printer name at the time that the report is submitted. If the user 
overrides the default printer with a valid printer name, the following processes are ignored.  

3. The RDA specifications pass a printer name to the batch process. If this process retrieves a 
valid printer name, the following process is ignored.  

4. EnterpriseOne uses the Printer Definition table (F98616) to determine a valid default printer 
based upon the current user, the environment that the user is signed onto, and the host that 
processes the report.  
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Running Reports on the Server  
When you submit a report to the server, the engine prompts you for a printer name previously defined 
in the Default Location & Printers program (P400951). Then the server automatically creates a PDF 
file using the settings associated with the selected printer, unless event rules (ER) override those 
printer settings. You can, however, affect how your report prints on the server before you generate a 
PDF file by changing settings, such as the printer, page orientation, PDL, and paper type, on the 
Printer Selection dialog box. When you view the report on the server, EnterpriseOne copies the PDF 
file from the server to the local directory, b7\PrintQueue on your workstation.  

Note 

When you are using an iSeries client, the PDF file is stored on the client in the integrated file system 
(IFS). See Working with the Integrated File System (IFS) in the EnterpriseOne Report Writing Guide 
for information on how to define the PrintQueue directory on the client. 

 

When you run a report, you also have the option of turning on logging capabilities. You do so from 
the advanced form when you submit your report. When you view a log, your workstation stores the 
log file in the \b7\PrintQueue directory.  

See Also  
• Generating and Retrieving Logs for Your Report in the EnterpriseOne Report Writing Guide 

for more information about the location of the PrintQueue directory on a server  

Running Reports on the Workstation  
When you choose to run a report and view the output on the screen, the engine tries to connect to the 
printer defined in Report Design. If the engine cannot connect or if there is no printer defined, the 
engine uses the default printer from the printer tables. Using the settings that it retrieves, the engine 
creates a PDF file and displays the report through Acrobat Reader. The PDF file is stored in your 
local \b7\PrintQueue directory.  

When you run a report locally and send the output to a printer, the engine displays the Printer 
Selection dialog box, which gives you the option to change the printer, page orientation, PDL, paper 
type, and so on. The initial printer shown in this dialog box is the one defined in RDA or the default 
printer, if none was defined. The engine connects to the printer defined in the printer dialog box and 
retrieves the associated settings. Using these settings, the engine creates a PDF file, converts the PDF 
into a PDL file using the conversion filter, and sends the PDL file to a printer.  

Print-Time Characteristics  
The user has the option of overriding the printer at a report's print time. This option is different from 
the option for overriding the printer when the user first submits the report. At submit time, the user 
can choose any valid enterprise printer. At print time, however, the user can override the printer only 
with another printer that supports the same platform, PDL, and paper type as the original printer 
because the batch engine has already created the PDF version of the report and has imbedded into the 
PDF file the platform, PDL, and paper type information.  
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Print Settings for the Workstation jde.ini  
The workstation jde.ini settings control whether a report prints immediately and whether 
EnterpriseOne saves the output after processing the report.  

[NETWORK QUEUE SETTINGS]  

PrintImmediate=TRUE/FALSE  

SaveOutput=TRUE/FALSE  

Setting  Description  
PrintImmediate  Specifies whether the system automatically prints the report after processing is complete. Valid 

values are:  

TRUE.  

The system processes the report on the server, generates a PDF file, converts the PDF to the 
appropriate PDL for the defined printer, and then prints the report.  

FALSE.  

The system processes the report on the server, but does not automatically print the report. Users 
must use the Work with Servers application to manually print the report.  

SaveOutput  Specifies whether the system saves or deletes the output after you view or print the job. Valid 
values are:  

TRUE.  

The system saves the output after you have viewed or printed the job.  

FALSE.  

The system deletes the output after you have viewed or printed the job.  

Working with the Printers Application  
EnterpriseOne provides a single application that uses a director interface to help you set up your 
printer. From this director, you can add new printers, modify existing printers, and define default 
printers for a combination of a user, a host, and an environment. You can also add and modify the 
paper types and custom conversion programs that your printers use at the time that you add and 
modify printer settings.  

Note 

You must set up printers for each server platform that you use in your enterprise.  

 

 

See Also  
� Understanding Printing in the EnterpriseOne Report Writing Guide for information about 

how EnterpriseOne determines which printer to print to when a user submits a report 
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► To add a new printer  

When you add a printer, EnterpriseOne provides a director to help you with each step of the process. 
Instructions appear on each form of the director to guide you through the printer addition process. The 
following procedure should be used in conjunction with the steps that appear on the Printer Setup 
Director form of the Printer Application program (P98616).  

First-time users who are installing their first printer must complete this task and then the task that 
describes how to define a default printer. 

Note 

You must complete all of the fields that appear on the director forms.  

 

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, click Add Printer.  

The welcome page for the Printer Setup Director appears. This page describes the tasks that 
the director helps you to perform.  

2. Review the welcome page and click the Next button.  

The system displays the Platform Type depending on which operating system your 
EnterpriseOne is running on.  

3. Complete the following fields and click Next:  

• Print Server Name  

Type the name of the print server for the printer that you are setting up. You cannot use 
spaces or special characters in this field. EnterpriseOne uses this name, along with the 
print shared name, to create the printer name, which appears grayed-out on the 
subsequent form.  

• iSeries: library name/outqueue name  

For the iSeries, the physical printer name must be the same as the outqueue name. If 
you use the default QGPL library to store your outqueues, you need only enter the 
outqueue name in this field. This information must be entered in upper case.  

Example: DEVDES3A  

If your outqueues reside in a library other than the default QGPL library, you need to 
enter the library name and the outqueue name in this field.  

Example: QUSERSYS/DEVDES3A  

Note 

When you qualify your outqueue name with the library name, you avoid possible name 
conflicts that might result in the submission of your report at an unexpected outqueue.  
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• Windows NT: \\server name\printer name  

Example: \\corprts1\docprf2  

This information must be entered in lower case.  

• UNIX: printer name (no slashes)  

Example: devprn16  

This information must be entered in lower case.  

For printing reports to a non-network printer, leave this field blank.  

• Print Shared Name  

Type the share name of the printer that you are setting up. You cannot use spaces or 
special characters in this field. EnterpriseOne uses this name, along with the print server 
name, to create the printer name, which appears grayed-out on the subsequent form.  

When you click Next, the Printer Setup form appears. Use this form to specify information 
for the printer such as the printer model, physical location of the printer, printer definition 
language, paper types, and encoding selection (iSeries only).  

Note 

When you change an existing printer, you make your modifications to this page. See To 
modify an existing printer in the EnterpriseOne Report Writing Guide. 

 

4. On Printer Setup, on the General tab, complete the following fields, and then click the Details 
tab:  

• Printer Model  

• Printer Location  

5. On the Details tab, inside the box labeled Printer Definition Language, choose any the 
following options:  

• PostScript  

• PCL  

• Line Printer  

When you choose the Line Printer option, the following events happens:  

1. PeopleSoft EnterpriseOne software disables the detail area at the bottom of the form. 
Any paper types that you chose are cleared. PeopleSoft EnterpriseOne software 
automatically provides a printer type of *JDE LINE PAPER for the printer.  

2. Fields appear within a box labeled "Line Printers." You use these fields to set the 
paper dimensions and line parameters. This is fully explained in the following steps.  

3. When you choose the Line Printer option along with the iSeries platform type, fields 
appear within a box labeled "iSeries Only." You use these fields to set the iSeries 
encoding that your printer supports. This is fully explained in the following steps.  
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• Custom  

Caution 

The custom option uses an advanced feature of the Printers application. Only users with 
knowledge about building parameter strings for printers should use this option. This is 
fully explained in the following steps.  

 

Note 

If you choose PostScript or PCL from the left side of the box, EnterpriseOne disables the 
Line Printer option. If you choose the Line Printer option from the left side of the box, 
EnterpriseOne disables the PostScript and PCL options. You can choose multiple printer 
definition languages (PDLs) from the left side of the box, but only one default PDL under the 
Default label on the right side of the box. This sets the PDL that you want to specify as your 
default. You can override this PDL when a batch process is submitted.  

 

6. On the Details tab, when you choose the PostScript option, the Paper Source box appears, 
from which you can change the following fields:  

• Max Number of Paper Sources  

Enter a numeric value in this field to indicate the number of paper trays that this printer 
has available.  

• Default Paper Source  

Enter a numeric value in this field to indicate the default tray number from which you 
want PeopleSoft EnterpriseOne software to draw paper.  

7. When you choose the Line Printer option, fields appear within the Line Printers box. You use 
these fields to set the paper dimensions and line parameters. Complete the following fields:  

• Characters Per Inch  

The value that you enter in this field determines the number of characters that the 
physical printer allows in one horizontal inch.  

• Columns Per Page  

The value that you enter in this field determines the number of characters that appear in 
one line of text in the given report.  

• Lines Per Inch  

The value that you enter in this field determines the number of lines of text that the 
physical printer allows in one vertical inch.  

• Lines Per Page  

The value that you enter in this field determines the number of lines of text that the 
physical printer allows on one printed page.  

• Printer Paper Width  

284 



The value in this field is calculated automatically, based on the numbers you enter in the 
Line Printers box.  

• Printer Paper Height  

The value in this field is calculated automatically based on the numbers you enter in the 
Line Printers box.  

8. When you choose the Line Printer option along with an iSeries server, fields appear within a 
box labeled "iSeries Only." You use these fields to set the iSeries encoding that your printer 
supports. Choose one of the following:  

• ASCII Encoding  

• EBCDIC Encoding  

Note 

If you choose a PostScript or PCL printer along with an iSeries server, the ASCII 
Encoding option is automatically checked and the "iSeries Only" box is disabled.  

 

9. To use the Custom option, complete the following:  

Note 

The custom option uses an advanced feature of the Printers application. Only users with 
knowledge about building parameter strings for printers should use this option.  

 

• Click the Custom checkbox.  

A field appears beneath the Custom button.  

• Enter the name of the conversion filter that you want to use.  

You can either type a conversion filter name into the field below the custom option, or 
you can use the Search button to select a filter.  

• To change or add a conversion filter, choose Advanced from the form menu. This option 
is enabled only when Custom has been chosen.  

• On Work With Conversion Programs, either click Add, or choose one of the filters and 
click either Copy or Select.  

• On Advanced Conversion Program, change the following fields, and then click OK:  

• Conversion Program  

If you clicked Add or Copy on the previous form, the Conversion Program field is 
enabled. Enter the name of the conversion program that you want to add or copy. If 
you are making a copy, the string that you highlighted on the previous form appears 
in the Parameter String field.  

• Parameter String  
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The parameter string is entered automatically. It is based on the host from which you 
are printing (ISERIES, HP9000, etc.) and the type of printer (postscript, PCL, or 
line). For example:  

-s string_name -l library_name -f convertPDFToPS  

Where -s defines the string name, -l defines the library name (this value is the letter 
"l," not the number "1"), and -f defines the function name  

10. In the detail area at the bottom of the Printer Setup form, double-click the row header for 
each paper type that your printer supports. A checkvmark appears in the row header for each 
paper type that you choose.  

Note 

You can add new paper types as necessary. Instructions to do so are included later in this 
task.  

 

11. In the Default Type column, type the numeral 1 in the row for the paper type that you want to 
use as the default. You can choose only one default paper type. You can override the default 
paper type when a batch process is submitted.  

12. To add a new paper type, do the following:  

• From the Form menu, choose New Paper Type.  

• On Work With Paper Types, click Add.  

13. On Paper Type Revisions, complete the following fields, and click OK:  

• Paper Type  

• Paper Height  

• Paper Width  

• Unit of Measure  

EnterpriseOne saves the new paper type and displays the Work With Paper Types form. After 
you close Work With Paper Types, the new paper type will be available in the Printer Setup 
detail area form. All previous paper type selections are cleared and would need to be chosen 
again if you want to reuse them.  

14. When you finish entering information for the printer, click End.  

EnterpriseOne saves the new printer and displays the Printers form.  

► To define a default printer  

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, click Define Default Printer.  

2. On Work With Default Printers, click Add.  
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3. On Default Printer Revisions, complete the following fields, and then click OK.  

• User/Role  

Click the visual assist to choose either a particular user for this printer or to choose an 
entire group. If the field is left blank, the default value is *PUBLIC.  

• Report Name  

Click the visual assist to choose a specific report to print. If the field is left blank, the 
default value is *ALL.  

• Version Name  

Click the visual assist to choose a specific version to run. If the field is left blank, the 
default value is *ALL. If the Report Name is *ALL, the version name will default to 
*ALL and be disabled.  

• Environment  

EnterpriseOne automatically enters the name of the environment that you are currently 
signed onto. You can change this information.  

• Printer Name  

• Host Name  

Include the host server to where reports will run. The visual assist displays the 
appropriate host names, based on the printer name you select.  

• Object Status  

You can make this new printer the default printer by changing its status to active. If an 
error occurs, it means that another printer is currently the active default. You need to 
change the original default printer to inactive before you can activate the new printer. 
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You can perform multiple status changes from the Work With Default Printers form as 
explained at the end of this task.  

4. On Work With Default Printers, to change the status of a default printer from the Work With 
Default Printers form, click Find, choose a default record, and then from the Row menu, 
choose Change Status.  

If another printer is already specified as the active default, an error occurs. To change the 
original default printer to inactive, choose it, and from the Row menu, choose Change Status. 
Then make the new printer the default.  

► To modify an existing printer  

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, choose the Modify Printer option.  

 

2. On Work With Printers, click Find, choose the printer that you want to modify, and then click 
Select.  

The Printer Setup form appears. Use this form to change information for the printer, such as 
the printer model, physical location of the printer, printer definition language (PDL), and 
paper types.  
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3. On Printer Setup, modify the information for your printer as necessary and then click OK. 
You cannot modify the printer name and platform type. If you chose a line printer, the paper-
type grid at the bottom of the form is disabled.  

EnterpriseOne saves the new printer information and returns you to the Work With Printers 
form.  

► To copy an existing printer  

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, choose the Modify Printer option.  

2. On Work With Printers, click Find, choose the printer that you want to copy, and then click 
Copy.  

3. On Printer Setup, complete the following fields:  

• Printer Name  

Enter the entire printer name, including the server path. For example, if printer docprf2 is 
on server corprts1, the printer name for a Windows NT printer is: 
\\corprts1\docprf2. If you use multiple platforms, you must define a printer for 
each platform, using the following naming conventions:  

• iSeries: library name/outqueue name  

For the iSeries, the printer name must be the same as the outqueue name. If you use 
the default QGPL library to store your outqueues, you need only enter the outqueue 
name in this field. The information that you enter must be in upper case.  

Example: DEVDES3A  
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If your outqueues reside in a library other than the default QGPL library, you need to 
enter the library name and the outqueue name in this field.  

Example: QUSERSYS/DEVDES3A  

Note 

When you qualify your outqueue name with the library name, you avoid possible naming 
conflicts that might result in the submission of your report to an unexpected outqueue.  

 

• Windows NT: \\print server name\printer name  

Example: \\corprts1\docprf2  

The information that you enter must be in lower case.  

• UNIX: printer name (no slashes)  

Example: devprn16  

The information that you enter must be in lower case.  

• Platform Type  

Enter the platform that you are printing from, such as an AS/400 server.  

4. Click the Details tab, change any information as needed, and then click OK.  

► To delete a printer  

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, choose the Modify Printer option.  

2. On Work With Printers, click Find, choose a printer or choose multiple printers by holding 
down the Ctrl key, and then click Delete.  

This task removes the printer definition.  

► To delete a paper type  

From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, choose the Modify Printer option.  

2. On Work With Printers, click Find, choose a printer, and then click Select.  

3. On Printer Setup, choose New Paper Type from the Form menu.  

4. On Work With Paper Types, choose a paper type and click Delete.  

5. On Confirm Delete, click OK.  

The paper type that you deleted no longer appears in the detail area.  
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► To search for incorrect printer records  

Use the following batch process to search the Printer Capability table (F986163) and list printer 
records that are incomplete, or that contain incorrect printer information. This report lists information 
that can help you correct your printing records.  

Enter BV in the fast path.  

1. On Work With Batch Versions - Available Versions, in the Batch Application field, type 
R9861602, and click Find.  

The XJDE0001 version appears in the detail area.  

2. Run the version. 

Note 

For directions about running a version, see Submitting a Report in the EnterpriseOne Report 
Writing Guide. 

  

The report lists reports that have a logical printer name. Use this information to change 
existing printer settings, since logical and physical printer names are no longer used in 
PeopleSoft EnterpriseOne software.  

3. Go to the task To modify an existing printer in the EnterpriseOne Report Writing Guide, and, 
using the report, find the printer record and correct it.  

► To determine logical printers attached to batch processes  

Use the following batch process to determine which of your batch processes, if any, are attached to 
printers.  

Enter BV in the fast path.  

1. On Work With Batch Versions - Available Versions, in the Batch Application field, type 
R9861601, and click Find.  

The XJDE0001 version appears in the detail area.  

2. Run the version. 

Note 

For information about how to run the report, see Submitting a Report in the EnterpriseOne 
Report Writing Guide.  

 

The report lists reports that have a logical printer name. Use this information to change 
existing printer settings, since logical and physical printer names are no longer used in 
EnterpriseOne.  

3. Use Report Design Aid (RDA) to attach a valid printer to those batch processes that had been 
attached to a logical printer.  

Only someone familiar with RDA should attempt to attach a printer.  
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Generating and Retrieving Logs for Your Report  
When you run a report, you can specify whether you want to create logs for the report. The logs that 
you can create are the jde.log and the jdedebug.log. These logs allow you to review how your reports 
process on the server. These logs reside in a specific directory on the server. Your jde.ini settings 
determine the location of this directory. Also, depending on the platform that you use, the jde.ini 
setting differs slightly. The following list provides sample jde.ini settings for the directory where your 
report logs reside:  

• iSeries 

 [INSTALL]  

DefaultSystem=B9SYS  

Example path: B9SYS\PRINTQUEUE  

• UNIX  

 [INSTALL]  

B9=/usr/PeopleSoft/output  

Example path: /usr/PeopleSoft/output/PrintQueue  

• Windows NT Server  

 [INSTALL]  

B9=d:\PeopeleSoft\output  

Example path: d:\PeopleSoft\output\PrintQueue  

The default directory for your log files is PrintQueue, which becomes a subdirectory to the directory 
that you designate in the jde.ini file. You can change the location of this directory as necessary.  

Note 

These jde.ini settings also determine the location where your report output resides after processing. If 
you set your jde.ini to save the output for your reports, EnterpriseOne saves a PDF file for the report 
in the report output directory.  

 

 

► To create logs for your report  

Enter BV in the fast path.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field and click Find. For example, to locate a version for the One Line Per 
Address report, type R014021.  

2. Choose a version to submit, and then click Select.  

The Version Prompting form appears. On this form, you can choose to change the data 
selection, change the data sequencing, and access the Advanced Operations form.  
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3. On Version Prompting, choose Advanced from the Form menu.  

The Advanced Version Prompting form appears. On this form, you can override the location 
where your report processes, activate the jde.log, activate the jdedebug.log, and modify the 
level of information that your logs include.  

4. On Advanced Version Prompting, modify the following information and then click OK:  

• Logging (JDE.log)  

Turn on this option to activate a basic log that helps you determine when a fault occurs 
during a batch process.  

• Tracing (JDEDEBUG.log)  

Turn on this option to turn on advanced UBE logging that includes details about the batch 
process.  

• UBE Logging Level  

The value that you enter here, from 0-6, determines the level to which your batch process 
log shows errors ranging from error messages to object level messages and UBE function 
messages.  

Note 

When you choose a high value to receive more technical information, you also receive all 
the information for the lower values. For example, when you enter a value of 6 (UBE 
function messages), you also receive information for values 0-5.  

 

5. On Version Prompting, click Submit to run your report and create your logs.  

Setting Up a Null Pass-Through Print Filter 
The null pass-through print filter allows you to send a portable document format (.pdf) directly to a 
print queue without converting it to a printer language format. 

► To add a null pass-through print filter 

From the Batch Processing Setup menu (GH9013), choose Printers. 

1. On Printers, click Add Printer 

The welcome page for the Printer Setup Director appears. This page describes the tasks that 
the director helps you to perform. 

2. On Printer Setup Director, review the welcome page and click the Next button. 

The system displays the Platform Type depending on which operating system your 
PeopleSoft EnterpriseOne software is running on. 

3. On Platform Information, complete the following fields and click Next: 

• Print Server Name 
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• Print Shared Name 

4. On Printer Setup, click the Details tab. 

5. In the Printer Definition Language field, select Custom.  

6. From the Form menu, choose Advanced. 

7. On Work With Conversion Programs, click Add. 

8. On Advanced Conversion Program, type *JDE PDF in the Conversion Program field. 

9. In the Parameter String field, type –s POSTSCRIPT_PRINTER. 

10. Click OK. 

11. On Work With Conversion Programs, click Close. 

12. On Printer Setup, click the Visual Assist in the field under the Custom field. 

13. On Conversion Program Search & Select, choose the *JDE PDF conversion program and 
click Select. 

14. On Printer Setup, click End. 

EnterpriseOne saves the null pass-through print filter. 

Designing Reports to Run on Line Printers  
When you run a report on a line printer, you must follow certain guidelines to ensure that the 
information contained in the report prints successfully. These guidelines include font family, font 
size, grid spacing, the width of the fields on the report, paper dimensions, and line parameters.  

This section provides the information necessary to create line printer reports.  

See Also  
� The following topics in the Server and Workstation Administration Guide for information on 

setting up printers on iSeries, UNIX, and Windows NT servers: 

• Setting Up a Printer for iSeries 

• Setting Up a Printer for UNIX 

• Setting Up a Printer for Windows NT 

► To design a report to run on a line printer  

Important 

In the Batch Versions program (P98305), create a version of the report to use only on line printers. 
Make the following modifications to this report version. Do not make these modifications at the 
report level. If you make these modifications at the report level, the information in your report might 
not appear properly on other printer platforms. 
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From the Cross Application Development Tools menu (GH902), choose Report Design Aid. 

1. On Report Design, open the report with the version that you want to modify to support line 
printers.  

2. From the Layout menu, choose Grid Alignment.  

3. On Alignment Grid, set the value in the Vertical field to 16 to modify the vertical grid 
spacing for the report and click OK.  

4. From the File menu, choose Report Properties.  

5. On Properties, click the Font/Color tab, set the following font properties:  

• Change the font to Courier New.  

The Courier New font provides the best results; however, you can use other fixed-pitch 
fonts. For example, for reports that contain text in Japanese, users should use the fixed-
pitch version of the MS-Gothic font.  

• Change the font size to 10.  

6. Click the Apply settings to all objects option to make sure these settings apply to objects that 
may have individual font settings applied, and then click OK.  

7. After you change the font properties, you might need to increase the width of some of the 
fields on your report.  

Widen fields as necessary to provide enough room for information to appear on your report. 
Reposition the sections of your report so that all the report objects appear in the detail area.  

8. (Steps 7 through 10 apply to Group sections only.) If some data fields still do not properly 
align, press and hold the Ctrl key, then click on each field that you want to align.  

The last field that you choose is the field, the top edge of which you will use to align the other 
fields.  

9. From the Layout menu, choose Align.  

10. On Align Objects, click Current section in the Apply To box to enable the Top to Bottom 
box.  

11. In the Top to Bottom box, click Top Edges, and then click OK.  

12. When you complete the modifications to your report, save your report version.  

► To set up a line printer  

Important 

The following steps provide information about the values at which you should set the paper 
dimensions for a line printer. These steps should be used as a supplement to the steps that describe 
how to set up a printer in Working with the Printers Application in the EnterpriseOne Report Writing 
Guide.  
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From the Batch Processing Setup menu (GH9013), choose Printers.  

1. On Printers, click Modify Printer. 

2. On Work With Printers, click Find. Available printers are listed in the detail area. 

3. Choose the line printer from the detail area and click Select.  

4. On Printer Setup, click the Details tab. 

5. Click Line Printer. 

6. Complete the following fields: 

• Columns Per Page 

• Characters Per Inch 

• Line Per Page 

• Line Per Inch 

For an 8.5 x 77 inch piece of paper the values should be:  

• Characters Per Inch: 10  

• Columns Per Page: 85  

• Lines Per Inch: 6  

• Lines Per Page: 66  

Note 

You can use the following formula to calculate your paper dimensions:  

CPP / CPI = width in inches (85 / 10 = 8.5)  

LPP / LPI = height in inches (66 / 6 = 11)  

 

7. Click OK to save these settings.  

► To print multiple copies to a remote iSeries line printer  

Perform this task if the output queue for an iSeries line printer does not support printing multiple 
copies. A system administrator must perform this task, and only for remote output queues. 

1. End the remote writer to which the output queue is connected.  

2. Use the Change Output Queue (CHGOUTQ) command to change the Display Options 
(DSPOPT) parameter so that it contains the value "XAIX".  

3. Restart the remote writer.  

Your output queue should now be able to send multiple copies of your documents to the remote 
printer.  
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Setting Up a Printer to Use a Barcode Font  
EnterpriseOne supports the use of the BC C39 3 to 1 Medium barcode font. EnterpriseOne includes 
this barcode font with its software. After you set up your printers, you can assign a printer to use a 
barcode font for your reports. This section describes how to set a printer to support the barcode font 
BC C39.  

Note 

Printers that support barcodes must use either the PostScript or PCL printer definition languages.  

 

 

► To set up a printer to use a barcode font  

From the Batch Processing Setup menu (GH9013), choose Bar Code Support.  

1. On Work With Bar Code Font, click Add.  

2. On Bar Code Font Revisions, complete the following fields and options:  

• Printer Name  

Click the Search button for this field to access a list of printers.  

• PostScript or PCL  

Choose the appropriate option, depending on the printer definition language of the printer 
in the Printer Name field.  

• True Type Font  

Click this button to select the true type barcode font BC C39 3 to 1 Medium on the Font 
form.  

• Printer Font Name  

• (PCL only) Symbol Set ID  

This value defines the character and the character mapping for a particular symbol set. 
Contact your PCL printer font vendor to obtain this information.  

3. After you finish entering information for a barcode-capable printer, click OK.  

EnterpriseOne software saves the information and clears the revision form. You can continue 
to enter information for other printers that support barcodes, or click Cancel to exit the form.  
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► To modify barcode printer information  

From the Batch Processing Setup menu (GH9013), choose Bar Code Support.  

1. On Work With Bar Code Font, click Find.  

Printers previously set to support the barcode font appear in the detail area.  

2. Choose the printer, the information for which you want to modify, and click Select.  

3. On Bar Code Font Revisions, change the information on this form as necessary, and then 
click OK.  

► To copy barcode printer information for a new printer  

From the Batch Processing Setup menu (GH9013), choose Bar Code Support.  

1. On Work With Bar Code Font, click Find.  

Printers previously set to support the barcode font appear in the detail area.  

2. Choose the printer, the information for which you want to copy, and click Copy.  

3. On Bar Code Font Revisions, change the name of the printer.  

You can also change any other information on this form as necessary.  

4. Click OK to save your information.  

► To delete barcode support information from a printer  

From the Batch Processing Setup menu (GH9013), choose Bar Code Support.  

1. On Work With Bar Code Font, click Find.  

Printers previously set to support the barcode font appear in the detail area.  

2. Choose the printer that you want to delete, and click Delete.  

3. On Confirm Delete, click OK.  
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Additional Information for EnterpriseOne Report 
Writing 

This section provides useful information for creating reports by using EnterpriseOne Report Writing. 
The following subjects are included: 

• Edit Code Table 

Describes the edit codes that are available. Edit codes determine how data is formatted on a 
report. 

• Events 

Describes the events that can occur during report processing. 

• Report Examples 

Provides examples of reports that you can create and provides instructions for creating the 
example reports. 

• EnterpriseOne Reports 

Provides a partial list of reports that are provided by EnterpriseOne. 

• Smart Fields 

Describes how to create a smart field, define its data structure, define named mapping, 
perform calculations, create a data dictionary smart field item, create a smart field template, 
create a report director template, and create a new report by using smart fields. 

• Output Stream Access 

Describes the uses of the output stream access (OSA) interface to trigger events during report 
processing. 

Edit Code Table  
EnterpriseOne uses edit codes to determine how to display or format a particular value for a report. 
The default edit codes that pertain to reporting require particular attention because they account for a 
substantial amount of information. 

To choose the appropriate default edit code for your report, review the Negative Amount Notation 
column in the following table and choose the appropriate option for your report figures. This narrows 
your search to four codes. For example, if you choose a trailing minus sign as your negative amount 
notation, your search is narrowed to a code of J, K, L, or M.  

Review the Zero Balance column in the Default Edit Code table and determine whether you want to 
print zero balances. This narrows your search to two codes. For example, if you choose to print zero 
balances, your search is narrowed to a code of J or L.  
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Review the Commas column in the Default Edit Code table and determine whether you want commas 
to appear in the report figures on your report. For example, if you want commas in your report 
figures, choose J. If not, choose L.  

The table shows the available edit codes and their characteristics: 

Code Commas Y/N Zero Balance Y/N Negative Amount Notation
A Y Y Cr 

B Y N Cr 

C N Y Cr 

D N N Cr 

J Y Y - Trailing 

K Y N - Trailing 

L N Y - Trailing 

M N N - Trailing 

N Y Y - Preceding 

O Y N - Preceding 

P N Y - Preceding 

Q N N - Preceding 

R Y Y <  > 

S Y N <  > 

T N Y <  > 

U N N <  > 

1 Y Y No sign 

2 Y N No sign 

3 N Y No sign 

4 N N No sign 
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Events  
Events typically execute in a specific order. Additionally, most events have limitations. For example, 
some events are available only in specific sections.  

Events and Section Types  
Certain events are available only in specific section types. The tables show in this section list events 
that are available for the following levels:  

• Report  

• Section  

• Object  

Report Level Events  

The following table shows the report level events that are available. X indicates the events that are 
shown in RDA and O indicates the events that are supported by UBE.  

Event List  Report  
Do Initialize Printer  XO  
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Section Level Events  

Columnar Page 
Footer 

The following table shows the section level events available. X indicates the events that are shown in 
RDA and O indicates the events that are supported by UBE.  

 
Event 
List  

Report 
Header 

Page 
Header 

Group Tabular Child/ 
Custom 

(CG)  

Level 
Break 

Header 

Level 
Break 
Footer 

Report 
Footer 

Advance 
Section  

    XO  XO  XO  XO  XO        

After 
Last 
Object 
Printed  

XO  XO  XO  XO  XO  XO  XO  XO  XO  XO  

Before 
Level 
Break  

    XO  XO  XO  XO          

        XO            

Do 
Section  

XO  XO  XO  XO  XO  XO  XO  XO  XO  XO  

Do 
Tabular 
Break  

        XO            

End 
Break 
Section  

    XO  XO  XO  XO          

End Lvl 
Brk 
Footer 
Section  

              XO      

End Lvl 
Brk 
Header 
Section  

            XO        

End Page 
Header  

  XO                  

End 
Report 
Header  

XO                    

End 
Report 
Footer  

                  XO  

End 
Section  

    XO  XO  XO  XO          

Init 
Break 
Section  

    XO  XO  XO  XO          

Do 
Balance 
Auditor  
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Init Lvl 
Brk 
Footer 
Section  

              XO      

Init Lvl 
Brk 
Header 
Section  

    XO  XO    XO  X        

Initialize 
Page 
Header  

  XO                  

Initialize 
Page 
Footer  

                XO    

Initialize 
Report 
Header  

XO                    

Initialize 
Report 
Footer  

                  XO  

Initialize 
Section  

    XO  XO  XO  XO  XO  XO      

Refresh 
Section  

          XO          

Suspend 
Section  

    XO  XO  XO  XO  XO  XO      

Object Level Events  

The tables under Variable Objects and Constant Objects show the events that are available at an 
object level.  

Variable Objects  

The following table shows the events available at an object level. X indicates the events that are 
shown in RDA and O indicates the events that are supported by UBE. 

Event 
List  

Report 
Header  

Page 
Header  

Columnar Group Tabular Level 
Break 

Header 

Level 
Break 
Footer 

Page 
Footer  

Report 
Footer 

Column 
Inclusion  

        XO        

Do 
Variable  

XO  XO  XO  XO  XO  XO  XO  XO  XO  

End 
Column 
(future)  

    XO  XO  XO          

End 
Variable  

XO  XO  XO  XO  XO  XO  XO  XO  XO  
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Initialize 
Column 
(future)  

    XO  XO  XO          

Initialize 
Variable  

XO  XO  XO  XO  XO  XO  XO  XO  XO  

Constant Objects  

  

The following table shows the events available at an object level. X indicates the events that are 
shown in RDA and O indicates the events that are supported by UBE. 

Event 
List  

Report 
Header  

Page 
Header  

Columnar Group Tabular Level 
Break 

Header 

Level 
Break 
Footer 

Page 
Footer  

Report 
Footer 

Do 
Column 
Heading  

    XO    XO    XO      

Do 
Constant  

XO  XO  XO  XO  XO  XO  XO  XO  XO  

End 
Constant  

XO  XO  XO  XO  XO  XO  XO  XO  XO  

Initialize 
Const  

XO  XO  XO  XO  XO  XO  XO  XO  XO  

Available Objects  
Some objects are available only for specific events. This topic contains tables that list the available 
objects for:  

• Section level events  

• Object level events  

• Life span of objects in section level events  

RVs are considered as the print buffers. They obtain their run-time values in the event when the user 
assigns the values to them.  

RVs are printed to the report during the processing of the Do Variable event.  

Values in the RVs are cleared before the processing of the Advance Section event. Before current RV 
values are cleared, these values are used to populate the PVs.  

In B733 and prior releases, if an RV is derived from a BC, only the BC is shown through the event 
rules editor. In a nontabular section, accessing the BC has the same effect as accessing the RV. But in 
a tabular section, BCs are actually treated by the UBE engine as RVs, meaning the print buffer. Thus, 
the BCs contain cumulative values instead of the values of the record fetched from the database table. 
This BC/RV discrepancy will be addressed in the B81 release.  
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Section Level Events  

The tables in this section list the available objects for various section level events. The tables use the 
following abbreviations:  

• BC - Business View Column  

• TR - Tabular Row  

• TC - Tabular Cell  

• PC - Previous Business View Column  

• PV - Previous Variable  

Report Header Section  

  RV global  RV section  

Initialize Report Header  x  x  

Do Section  x  x  

After Last Object Printed  x  x  

End Report Header  x  x  

Page Header Section  

  RV global  RV section  

Initialize Page Header  x  x  

Do section  x  x  

After Last Object Printed  x  x  

End Page Header  x  x  
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Group Section  

  BC RV global  RV section  PC  PV 

Initialize Section    x      x  

Refresh Section (Child)    x  x  x    

Advance Section  x  x  x  x  x  

Before Level Break  x  x  x  x  x  

Init Lvl Break Header Section  x  x  x  x    

Do Section  x  x  x  x  x  

After Last Object Printed  x  x  x  x  x  

Init Break Section(conditional)  x  x  x  x  x  

End Break Section(conditional)  x  x  x  x  x  

End Section    x  x  x  x  

Suspend Section(conditional)  x  x  x  x  x  
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Columnar Section  

  BC RV global  RV section  PC  PV 

Initialize Section    x      x  

Refresh Section (Child)    x  x  x    

Advance Section  x  x  x  x  x  

Before Level Break  x  x  x  x  x  

Init Lvl Break Header Section  x  x  x  x    

Do Section  x  x  x  x  x  

After Last Object Printed  x  x  x  x  x  

Init Break Section(conditional)  x  x  x  x  x  

End Break Section(conditional)  x  x  x  x  x  

End Section    x  x  x  x  

Suspend Section(conditional)  x  x  x  x  x  
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Tabular Section  

 BC RV global RV section TR  TC  PC  PV 

Initialize Section                

Advance Section  x  x  x      x  x  

Before Level Break  x  x  x      x  x  

Do Tabular Break  x  x  x  x  x  x  x  

Do Section  x  x  x  x  x  x  x  

Do Balance Auditor(conditional)  x  x  x      x  x  

After Last Object Printed  x  x  x  x  x  x  x  

Init Break Section  x  x  x  x  x  x  x  

End Break Section  x  x  x  x  x  x  x  

End Section  x  x  x      x  x  

Suspend Section(conditional)  x  x  x  x  x  x  x  

Level Break Header Section  

 BC RV global  RV section  PC 

Initialize Section    x      

Do Section  x  x  x  x  

After Last Object Printed  x  x  x  x  

Advance Section  x  x  x  x  

End Lvl Break Header Section  x  x  x  x  

Suspend Section (conditional)  x  x  x  x  
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Level Break Footer Section  

 BC RV global  RV section  PC 

Initialize Section    x      

Init Lvl Brk Footer Section  x  x  x  x  

Do Section  x  x  x  x  

After Last Object Printed  x  x  x  x  

End Lvl Brk Footer Section  x  x  x  x  

Suspend Section (conditional)  x  x  x  x  

Page Footer Section  

 RV global  RV section  

Initialize Page Footer  x  x  

Do Section  x  x  

After Last Object Printed  x  x  

Report Footer Section  

 RV global  RV section  

Initialize Report Footer  x  x  

Do Section  x  x  

After Last Object Printed  x  x  

End Report Footer  x  x  
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Object Level Events  

The tables that follow list the available objects for object level events. The following list contains the 
abbreviations used in the tables: 

• BC - Business View Column  

• PC - Previous Business View Column  

• PV - Previous Variable  

Report Header Section  

 RV global  RV section  

Initialize Variable  x  x  

Do Variable  x  x  

End Variable  x  x  

Initialize Constant  x  x  

Do Constant  x  x  

End Constant  x  x  

Page Header Section  

 RV global  RV section  

Initialize Variable  x  x  

Do Variable  x  x  

End Variable  x  x  

Initialize Constant  x  x  

Do Constant  x  x  

End Constant  x  x  
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Group Section  

 BC RV global  RV section  PC  PV 

Initialize Column    x      x  

Initialize Variable  x  x  x  x  x  

Do Variable  x  x  x  x  x  

End Variable  x  x  x  x  x  

End Column    x  x  x  x  

Initialize Constant  x  x  x  x  x  

Do Constant  x  x  x  x  x  

End Constant  x  x  x  x  x  

Columnar Section  

 BC RV global  RV section  PC  PV 

Do Column Heading  x  x  x  x  x  

           

Initialize Column    x     x  

Initialize Variable  x  x  x  x  x  

Do Variable  x  x  x  x  x  

End Variable  x  x  x  x  x  

End Column    x  x  x  x  

            

Initialize Constant  x  x  x  x  x  

Do Constant  x  x  x  x  x  

End Constant  x  x  x  x  x  
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Tabular Section  

 BC RV global  RV section  PC  PV 

Do Column Heading  x  x  x  x  x  

Initialize Column            

Column Inclusion  x  x  x  x  x  

Initialize Variable  x  x  x  x  x  

Do Variable  x  x  x  x  x  

End Variable  x  x  x  x  x  

End Column  x  x    x  x  

Initialize Constant  x  x  x  x  x  

Do Constant  x  x  x  x  x  

End Constant  x  x  x  x  x  

Level Break Header Section  

 BC  RV global  RV section  PC  

Initialize Variable  x  x  x  x  

Do Variable  x  x  x  x  

End Variable  x  x  x  x  

Initialize Constant  x  x  x  x  

Do Constant  x  x  x  x  

End Constant  x  x  x  x  
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Level Break Footer Section  

 BC  RV global  RV section  PC  

Do Column Heading  x  x  x  x  

Initialize Variable  x  x  x  x  

Do Variable  x  x  x  x  

End Variable  x  x  x  x  

Initialize Constant  x  x  x  x  

Do Constant  x  x  x  x  

End Constant  x  x  x  x  

Page Footer Section  

  RV global  RV section  

Initialize Variable  x  x  

Do Variable  x  x  

End Variable  x  x  

Initialize Constant  x  x  

Do Constant  x  x  

End Constant  x  x  

313 



Report Footer Section  

 RV global  RV section  

Initialize Variable  x  x  

Do Variable  x  x  

End Variable  x  x  

Initialize Constant  x  x  

Do Constant  x  x  

End Constant  x  x  

Lifespan of Objects in Section Level Events  

The following are common life ranges for section level events:  

• BC/PC in Group and columnar section  

• BC/PC in Column style tabular section  

• BC/PC in Row style tabular section  

• RV/PV Life Span  

Report Examples  
Sometimes getting started is the most difficult part of creating a report. To help you get started, there 
are tasks which provide instructions for creating some typical reports. These include the following: 

Report techniques by example  • 

• Printing lists of information  

• Printing lists of information grouped by a specific field  

• Printing totals and auditing numeric data 

• Creating journal entries with Report Design 

Report Techniques by Example  
This section provides several specific reports with a variety of features such as level-break sections, 
totaling, hidden controls, and so forth. Steps describing how to create each report follow each 
example, providing a contextual reference for using many of the features in Report Design.  
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Printing Journal Entries by Batch Type  

This example illustrates a report that shows journal entries by batch type for batch types K, V, W, and 
Z and for batches 1000-3000:  

 

► To create a report that contains a column section  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose New from the File menu. 

2. On Report Director, enter the following information:  

• Report Name: R560001  

• Description: G/L Transaction Detail  

• Product Code: 56  

3. Select the No Update Report option and click OK. 

4. Choose the following options and then click Next: 

• Report Header 

• Page Header 

• Columnar 

5. Choose the following option and then click Next: 

• Automatically add the default information fields shown below to my page header section  

6. Choose the following option and then click Next: 

• I’ll find a business view myself 

7. Complete the following field with V0911G, click Find, and then click Next: 

• Object Name  
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8. Include the following business view columns in the following order and then click Next: 

• Batch Number (ICU)  

• Company (CO)  

• Document Type (DCT)  

• Document (DOC)  

• Date - For G/L (DGJ)  

• Object Account (OBJ)  

• Amount (AA)  

• Batch Type (ICUT)  

9. Sequence the data based on the following business view columns in the following order and 
then click Next:  

• Batch Type (ICUT)  

• Batch Number (ICU)  

• Company (CO)  

• Document (DOC)  

• Object Account (OBJ)  

10. Include a Level Break for Batch Type and click Next.  

11. Define criteria to select only batch types K, V, W, and Z and batch numbers 1000-3000. The 
first is a literal list, the second a literal range.  

12. Click Next. 

13. When you are finished defining the report parameters, choose the following option to create a 
report version and click Finish: 

• No, I will create a Version of this report later  

The system displays the report.  

► To change column spacing  

From the Report Writer menu, choose Report Design Tool. 

This process adds 25 pixels of space between each column to spread them evenly across the page. 
Furthermore, it adds 100 pixels of space before the first column to shift all of the columns to the right, 
thereby balancing the amount of white space to the left and right of the report body.  

1. On Report Design, click the columnar section. 

2. From the Layout menu, choose Spacing.  
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3. On Columnar Section Spacing, click Select All Columns.  

The system highlights all the columns on the form.  

4. Type 25 in the following field and click Apply: 

• Space before selected columns  

5. Choose Batch Number, type 100 in the following field, and then click OK: 

• Space before selected columns  

► To suppress redundant data  

From the Report Writer menu (GH9111), choose Report Design Tool. 

The sample report primarily sequences data by Batch Number. This process displays the batch 
number only once per group, when it changes.  

1. On Report Design, double-click the variable portion of the Batch Number column.  

2. On Column Variable Properties, click the Advanced tab and choose the following options:  

• Visible (accept the default value)  

• Print on Change Only  

3. Click OK. 
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► To change column justification  

In this sample report, the Batch Number, Document Type and G/L Date columns are centered; the 
rest of the columns are right justified. This process illustrates how to change column justification.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the columnar section and then click the Column tab.  

The system displays the specifications for each column in the section.  

2. Double-click the column to display the column properties. 

3. Select the Display tab. 

4. Change justification to Center and click OK.  

5. Using this same technique, change the justification for the remaining columns.  

6. Click the Report tab to return to the layout view of the report.  

► To change column titles  

In this sample report, two of the column titles have been changed from their default values as follows:  

• Do Ty to Document Type  

• Obj Acct to Object Account  

This process illustrates how to change column titles.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the columnar section and then click the Column tab.  

The system displays the specifications for each column in the section.  

2. Double-click Do in the Heading 1 cell and change it to Document.  

3. Double-click Ty in the Heading 2 cell and change it to Type.  

4. Using the same method, change the column titles for the Obj Acct column.  

5. Click the Report tab to return to the layout view of the report.  

► To total and count columns in a level-break footer  

In this sample report, the Amount column is totaled for all of the items in each Batch Type. 
Additionally, the total entries displayed for each batch type is indicated. These values must be 
calculated and displayed in a level-break footer. Because a level break was attached to Batch Type, 
this process is possible. This process illustrates how to create a level-break footer and how to display 
an aggregate function for a column.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. Click the columnar section.  

2. From the Section menu, choose Create, and then choose Level Break Footer.  

3. On Level Break Footer, choose Group Section, and then click OK.  
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4. On Level Break, choose only existing sort columns, choose the Batch Type column, and then 
click Next.  
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5. On Aggregations, double-click in the Operator column and double-click Total of from the 
resulting drop-down menu.  

6. Double-click in the Operand column and double-click Amount from the resulting drop-down 
menu.  

7. Double-click the next cell in the Operator column and double-click Count of from the 
resulting drop-down menu.  

8. Double-click the next cell in the Operand column and double-click Document Type from the 
resulting drop-down menu.  

9. Choose the Single overline option and click Finish.  

The count variable does not have an overline in this sample report; you will remove the line 
from that report object later.  

The level-break footer appears in the columnar section of the report.  

► To change the level-break footer  

In this sample report, the count value at each level break has the text Total entries for <batch type> 
after it. Furthermore, the total values for account display zero rather than a blank if the value is zero. 
This process illustrates how to add text to the report section, how to write an event rule for a variable, 
and how to change how a numeric field displays numbers.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the level-break footer section.  

2. From the Insert menu, choose Constant Field.  

When you move your cursor back into the level-break footer section, the cursor indicates that 
you can place the constant.  

3. Move the cursor to the right of the Batch Type column and click to place the constant field.  

4. Double-click the constant field.  

5. On Constant Properties, on the Description tab, type “Total entries for" in the following field 
and click OK:  

• Variable Name 

6. In the level-break footer, double-click the total field under the Amount column.  

7. On Variable Properties, click the Display tab, type an R in the following field and then click 
OK.  

• Edit Code 

8. In the level-break footer, click the constant component of the Batch Type control and choose 
Disconnect from the Edit menu.  

9. Delete the now disconnected constant component of the Batch Type control.  

The variable component remains.  

10. Double-click the variable field.  

11. On Variable Properties, click the Advanced tab, deselect the Visible option, and click OK.  
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Although you do not want it to appear, the Batch Type control must reside in the level-break 
footer so that the event rule created in the following steps will work properly.  

12. From the Insert menu, choose Alpha Variable.  

When you move your cursor back into the level-break footer section, the cursor indicates that 
you can place the variable.  

13. Move the cursor to the right of the Total entries for constant field and click to place the alpha 
variable.  

Because you are working so close to the report's edge and the default length for the alpha 
variable is so long, you might not be able to place the variable to the right of the constant 
field. If this is the case, place it below the constant field and then move it later after you have 
shortened the field length.  

14. Double-click the alpha variable.  

15. On Variable Properties, on the Description tab, change the variable name to Batch Type 
Variable.  

16. Click the Display tab, change the display length to 1, and click OK.  

If necessary, reposition the variable on the report.  

17. Save the report, click the alpha variable, and then choose Event Rules from the Edit menu.  

18. On Event Rules Design, choose Do Variable from the drop-down field at the top of the form.  

19. Click the Assignment/Expression button.  

20. On Assignment, choose the RV Batch Type Variable from the To Object column and then 
choose the PC Batch Type from the From Object/Literal column. 

21. Click OK.  

The Event Rules variable form reflects the event rule. You must set the variable equal to the 
previous value (rather than the current value) because of the way the report is processed.  

22. Click the Save and Exit button.  

► To create a level-break header and hide objects  

In this sample report, the batch type and its description appear at the top of every level break, but do 
not appear in the body of the report itself. This process illustrates how to add and format a level-break 
header and how to hide report objects.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the columnar section.  

2. From the Section menu, choose Create, and then choose Level Break Header.  

3. On Level Break, choose only existing sort columns, and then choose the Batch Type column.  

4. Choose the following option and then click Finish: 

• Display selected column as part of the section 

The level-break header appears in the columnar section of the report.  
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5. To display description text for the batch type, click the variable portion of the Batch Type 
control, and from the Edit menu choose Associate and then choose Description.  

When you move your cursor back into the level-break header section, the cursor indicates that 
you can place the constant.  

A control is to a group section (level-break headers are always group sections) as a column is 
to a columnar or tabular section.  

6. Move the cursor to the right of the Batch Type control and click to place the constant field.  

7. Double-click the level-break header section.  

8. On Associated Description Properties, click the Font/Color tab, and then choose Bold from 
the Font Style field and 10 from the Size field.  

9. Opt to apply settings to all objects and click OK.  

The system changes all the fields in the level-break header section to 10-point bold. You 
might need to reposition the fields to prevent overlap.  

10. In the columnar section, double-click the Batch Type column.  

11. On the appropriate properties form, click the Advanced tab, deselect the Visible option, and 
then click OK.  

The column disappears.  

You can select either component of the column for this operation (the header or the variable); 
if you hide one component, the system automatically hides the other as well.  

12. In the level-break footer section, double-click the variable that displays the batch type count.  

13. On Variable Properties, click the Style tab, choose No Lines, and click OK.  

► To add text to the report and page headers  

In this sample report, the report header says "This report is confidential and proprietary to J.D. 
Edwards." Additionally, the page header displays "Listing by Batch Type" centered below the default 
text. This process illustrates how to add these phases to these two sections.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. Click the Report Header and from the Insert menu, choose Constant Field.  

When you move your cursor back into the report header section, the cursor indicates that you 
can place the constant.  

2. Move the cursor to approximately the center of the section and click to place the constant.  

3. Double-click the constant field.  

4. On Constant Properties, on the Description tab, enter the following in the Variable Name 
field, and then click OK:  

• This report is confidential and proprietary to PeopleSoft.  

5. Use the same technique to add a constant to the page header and name it Listing by Batch 
Type.  
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6. Shift-click the two constants that you just added and the two default constants in the middle 
of the page header.  

One of the two default constants should have a dark box around it; ensure that you click the 
constants you just created first to accomplish this. The formatting accomplished in the next 
steps occurs relative to the object with the dark box around it.  

7. From the Layout menu, choose Align.  

8. On Align Objects, click Center, click Current Selection, and then click OK.  

The system centers the four constant fields.  

9. In the Page Header section, choose the variable component of the page number control and 
delete it.  

10. From the Insert menu, choose Runtime Field, and then choose Page n of Total.  

When you move your cursor back into the page header section, the cursor indicates that you 
can place the run-time field.  

11. Move the cursor to the right of the Page constant and click to place the run-time field.  

Note that this field is actually three fields placed closely together. If you want to reposition 
them, ensure that you select all three fields.  

Printing a Work Order Report  

This example illustrates a report that lists work orders and their status:  
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► To create a report that contains a group section  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose New from the File menu. 

2. On Create New Report, complete the following fields:  

• Report Name: R560002  

• Description: Work Order Report  

• Product Code: 56  

3. Select the No Update Report option and click OK. 

4. On Report Director, choose the following options and click Next:  

• Page Header 

• Group 

5. Choose the following option and click Next:  

• Automatically add the default informational fields shown below to my page header 
section 

6. Choose the following option and click Next:  

• I’ll find a business view myself 

7. Enter V1201JE in the following field and click Find:  

• Object Name 

8. Click Next.  

9. Include the following business view columns in the following order and then click Next:  

• Business Unit (MCU)  

• Document (DOCO)  

• Order Type (DCTO)  

• Type - W.O. (TYPS)  

• Status Code W.O. (SRST)  

• Asset Item Number (NUMB)  

• Unit or Tag Number (APID)  

• Units - Order/Transaction Quantity (UORG)  

• Item Number - Short (ITM)  

• 2nd Item Number (LITM)  

• Description (DL01)  

10. Sequence the data based on the following business view columns in the following order and 
then click Next:  

• Description (DL01)  

• Document (DOCO)  

324 



11. Click in the Level Break column for Description and click Next.  

12. Define criteria to display information for Documents between 400,000 and 460,000 and click 
Next.  

13. When you are finished defining the report parameters, choose the following option and click 
Finish: 

• No, I will create a version of this report later  

The system displays the report.  

► To format the group section  

In this sample report, the format of the group section varies from the default layout in these ways:  

• Placement of controls  

• Constant text of some controls  

• Spacing between lines  

A control is to a group section (level-break headers are always group sections) as a column is 
to a columnar or tabular section.  

This process illustrates how to reformat the group section in these ways.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose Grid Alignment from the Layout menu.  

2. On Alignment Grid, set the Horizontal Spacing to 20, ensure that Snap To Grid is enabled, 
and click OK.  

With the snap to grid feature enabled, you can manually align report objects relative to the 
grid.  

3. Click the Unit Number control and drag it out of the way.  

Note 

In a group section, you can select and move a variable and its constant text independently of 
each other. Clicking in the middle of the control selects both fields simultaneously.  

 

4. Move the Order Number control to the right of the Business Unit control.  

5. Double-click the constant field of the Order Number control.  

6. On Constant Properties, choose the following option: 

• Override Name 

7. Type Order Number and Type in the Variable Name field and then click OK.  

You might need to move the variable field of the Order Number control to avoid overlap.  

8. Click the constant field of the Order Type control and from the Edit menu, select Disconnect.  

9. Delete the Order Type constant and move the remaining variable field to the right of the 
Order Number and Type control.  
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By disconnecting the constant from the variable, you can delete it without deleting the 
variable as well.  

10. Repeat this process with the Type and Status controls, placing them to the right of the Order 
Number and Type control and changing the name of the Type control to W.O. Type and 
Status.  

11. Move the Asset Number control to the right of the W.O. Type and Status control.  

12. Move the Unit Number control directly below the Order Number and Type control.  

13. Move the Quantity control directly below the W.O. Type and Status control.  

14. Move the Item Number control directly below the Asset Number control, changing its name 
to Item.  

15. Disconnect and delete the constant field of the 2nd Item Control, and then move it to the right 
of the Item control.  

16. From the Insert menu, choose Constant Field.  

When you move your cursor back into the group section, the cursor indicates that you can 
place the constant.  

17. Place the constant and move the new control below the Unit Number control.  

18. Double-click the constant control.  

19. On Constant Properties, on the Description tab, delete the text from the Variable Name, and 
enter five spaces and click OK.  

This empty constant field adds white space between each data set.  

► To create a level-break header and hide objects  

In this sample report, the description appears at the top of every level break, but does not appear in 
the body of the report itself. This process illustrates how to add and format a level-break header and 
how to hide report objects.  

From Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the columnar section.  

2. From the Section menu, choose Create, and then choose Level Break Header.  

3. On Level Break, choose only existing sort columns, and then choose the Description column.  

4. Choose Display selected column as part of the section, and then click Finish.  

The level-break header appears in the columnar section of the report.  

5. Disconnect and delete the constant field of the Description control.  

6. Move the Description control to the upper left corner of the level-break header, and then 
double-click the control.  

7. On Variable Properties, click the Font/Color tab, and then choose Bold from the Font Style 
field and 10 from the Size field.  

8. Click the Style tab, click No Lines to unselect it and then choose Single Rectangle.  

9. Click the Display tab, change the Display Length to 110 and then click OK.  
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10. In the columnar section, double-click the variable field of the Description control.  

11. On Variable Properties, click the Advanced tab, deselect the Visible option, and then click 
OK.  

The control disappears.  

Printing Outstanding Balance by Company  

This example illustrates a report that displays amounts, by company, that are still outstanding. A 
grand total amount open for all companies appears at the end of the report.  

 

► To create a report that contains a tabular section  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, choose New from the File menu to create a new report object. 

2. On Create New Report, complete the following fields:  

• Report Name: R5501  

• Description: Purchase Order Detail Report  

• Product Code: 55  

3. Select the No Update Report option and click OK. 

4. On Report Director, choose the following options and click Next:  

• Page Header 

• Tabular  
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5. Choose the following option and click Next:  

• Automatically add the default informational fields shown below to my page header 
section 

6. Choose the following option and click Next:  

• I’ll find a business view myself 

7. Enter V4311A in the following field and click Find:  

• Object Name  

8. Click Next:  

9. Include the following business view columns in the following order and click Next:  

• Order Type (DTCO)  

• Address Number (AN8)  

• Amount Open (AOPN)  

10. Sequence the data based on the following business view columns in the following order and 
then click Next:  

• Order Company (KCOO)  

• 2nd Item Number (LITM)  

11. Click in the level break column for both Order Company and 2nd Item Number and click 
Next.  

Level breaks are critical to the appearance of tabular reports. The lowest level break 
defines the detail on the report. The higher level break defines subtotaling.  

12. Define the following data selection criteria (join each criterion with an AND operator):  

• Amount Open is greater than 0  

• Order Type is equal to OP  

• Status Code - Next is not equal to 999  

• Line Type is equal to S  

13. When you are finished defining the report parameters, choose the following option and then 
click Finish: 

• No, I will create a version of this report later  

The system displays the report.  

► To rename a column  

The sample report does not include an Address Number column, but it does include a Supplier 
Number column. In actuality, the data is the address number, but it has been renamed for clarity. This 
procedure illustrates how to change a column's name.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, double-click the Address Number column heading.  

328 



2. On Column Heading Properties, change the text in the Variable Name field to Supplier 
Number.  

3. Change the text in the Heading 1 field to Supplier 

4. Change the text in the Heading 2 field to Number.  

5. Click OK.  

► To add an approval column  

This sample report includes a column that indicates whether manager approval is required. The 
content of the column is assigned by an event rule. The first step in including this column in the 
report is to create the column itself.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the Amount Open column.  

2. From the Column menu, choose Create, then Alpha Variable.  

The system adds the new column to the right of the Amount Open column.  

3. Double-click the heading of the new column.  

4. On Column Heading Properties, change the text in the Variable Name and Heading 1 fields to 
Approval.  

5. Delete the text in the Heading 2 field and click OK.  

6. Double-click the variable portion (the body beneath the heading) of the Approval column.  

7. On Column Variable Properties, change the text in the Variable Name field to Approval and 
click OK.  

EnterpriseOne recommends that you change the variable names of both column components 
as it simplifies identifying the column in later processes.  

► To suppress printing columns at totals  

Tabular sections automatically total all their columns. Non-numeric fields display the last business 
view value unless their data dictionary definitions instruct them to suppress totaling. In this sample 
report, only the Amounts column displays a total value. This process illustrates how to keep a total 
value from appearing for a column.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, double-click the variable portion (the body beneath the heading) of the 
Description column.  

2. On Column Variable Properties, click the Advanced tab, choose the following options, and 
then click OK:  

• Visible (accept the default value)  

• Suppress At Totals  

3. Use this technique to suppress printing at totals for all the columns except Amount Open.  
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► To define and add event rules  

In this sample report, the Approvals column reads General Manager approval when the amount open 
exceeds 1000, Purchase Manager approval when the amount open is between 500 and 999, and No 
approval required when the amount open is less than 500. This process illustrates how to define and 
attach an event rule to display the appropriate text for each report line.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, click the Tabular Section. 

2. From the Section menu, choose Text Variables.  

3. On Text Variables, type the three phrases indicated at the beginning of this process, and then 
click OK.  

Click Add between each phrase to move your cursor to the next grid line.  

4. From the File menu, select Save.  

5. Click the Tabular Section (ensure that no column in the section is active) and from the Edit 
menu, choose Event Rules.  

6. On Event Rules Design, choose the Do Section event from the event drop-down menu.  

The system must apply the logic created in the following steps to each report row before it 
appears on the report. Do Section events are processed immediately after each record is 
fetched, but before it is written to the report.  

7. Click the If/While button.  

Hold your cursor for a few seconds over a button to see its title.  

8. On Criteria Design, add the following event rule and click OK:  

• If BC Amount - Open is less than 500  

BC stands for Business Column.  

The rule appears in the Event Rules Design form in an If/Then framework.  

9. Click the line that says If BC Amount - Open is less than "500" and then click the 
Assignment/Expression button.  

10. On Assignment, choose RV Approval from the To Object list. 

11. Choose TV No approval required from the From Object/Literal list.  

RV stands for Report Variable; TV stands for Text Variable. Ensure that you select RV 
Approval and not RC Approval (RC stands for Report Constant). Constant represents the 
header portion of the column; variable represents the body portion of the column.  

12. Click OK.  

The system adds the appropriate Then clause to the event rule.  

13. Click the line that says Else and then click the If/While button.  

14. On Criteria Design, add the following event rule and click OK:  

• If BC Amount - Open is greater than or equal to 500  
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• And BC Amount - Open is less than 1000  

The rule appears in the Event Rules Design form in an If/Then framework.  

15. Click the line you just created and then click the Assignment/Expression button.  

16. On Assignment, choose RV Approval from the To Object list. 

17. Choose TV Purchase manager approval from the From Object/Literal list and click OK.  

The system adds the appropriate Then clause to the event rule.  

18. Click the next line down that says Else and then click the If/While button.  

19. Add the following event rule and click OK:  

• If BC Amount - Open is greater than or equal to 1000  

The rule appears in the Event Rules Design form in an If/Then framework.  

20. Click the line that you just created and then click the Assignment/Expression button.  

21. On Assignment, from the To Object list, choose RV Approval.  

22. From Object/Literal list, choose TV General manager approval and click OK.  

The system adds the appropriate Then clause to the event rule.  

23. Click the Save and Exit button.  

Printing Lists of Information 
Several types of reports that you could create to present lists of information are:  

• Business units and descriptions for a company 

• Inventory items by stocking type 

• Address book information in a card file format 

• Employee listing 

► To print all business units and descriptions for a company  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, create a report object called Company/Business Units/Descriptions 
Listing. 

2. Create a group or columnar section.  

The advantage of using a group section is the ability to rearrange your fields. This lets you 
control the placement of fields as they appear on the report. If you choose a columnar section, 
you cannot change the format of the column headings over the data fields.  

3. Attach business view V0006D - Business Unit Setup.  
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4. Choose to include the following data fields on your report:  

• Company  

• Business Unit  

• Description01  

5. Sequence the report on the following fields:  

• Company  

• Business Unit  

6. Determine through data selection the records to appear on your report. For example, if you 
want to display the business units for all companies less than Company 00050, your data 
selection would be "Where Company is less than 00050."  

7. On Report Design, format your report to enhance the appearance.  

► To print a list of inventory items by stocking type  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, create a report object called Inventory Item List.  

2. Create a group or columnar section.  

3. Attach business view V4101A - Item Master Browse.  

4. Choose to include the following data fields on your report:  

• Stocking Type  

• Description  

• 2nd Item Number  

5. Sequence the report on the following fields:  

• Stocking Type  

• Description  

6. Sort both of these fields in ascending order.  

7. Determine through data selection the records to appear on your report.  

► To print address book information in a card file format  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, create a report object called Address Book Information.  

2. Create a group section.  

3. Attach business view V0101B - Address Book One-Line report.  

4. Choose to include the following data fields on your report:  

• Name - Alpha  

• Address Line 1  

• City  
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• State  

• Postal Code  

5. Sequence the report on the following field:  

• Name - Alpha  

6. Sort this field in ascending order.  

7. Determine through data selection the records to appear on your report.  

8. On Report Design, arrange the fields to print Name on the first line, Address on the second, 
and City, State, and Postal Code on the third.  

9. Disconnect the Name, Address, City, State, and Zip Code constants from their variables, 
delete the constants, and print only the variable information on the report.  

► To print an employee listing  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, create a report object called Employee Listing Information.  

2. Create a columnar section.  

3. Attach business view V060116A - Employee Master.  

4. Choose to include the following data fields on your report:  

• Name - Alpha  

• Business Unit - Home  

• Pay Class (H/S/P)  

• Date - Original Employment  

• Rate - Salary, Annual  

5. Sequence the report on the following fields:  

• Business Unit - Home  

• Name - Alpha  

6. Determine through data selection the records to appear on your report. For example, to list all 
employees on your report, your data selection could be "Where Search Type is equal to E."  

Printing Lists of Information Grouped by a Specific Field 
Several types of reports that you could create to present lists of information grouped by a specific 
field are: 

• Inventory items by stocking type 

• Total the number of business units per company  
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► To group a list of inventory items by stocking type  

Printing lists of information on a report might be more meaningful to the reader if a specific field, for 
example, Stocking Type, grouped the information. Adding a level-break header to a group or 
columnar section enables you to group information by a specific field.  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, open your existing report called Inventory Item List.  

2. Click the detail section to which you want to attach a level-break header. 

3. From the Section menu, choose Create and then choose Level Break Header.  

If the Level Break Header selection is grayed out on the Section menu, you did not click on 
the detail section.  

4. On Level Break, choose the following option under the Show heading:  

• only existing sort columns  

This option displays the fields you chose as your data sequencing fields when you created 
the detail section.  

5. Choose the Stocking Type field to designate it as the level-break field.  

You can designate another field as a level-break field by modifying the section properties of 
the level-break header.  

6. Turn the Display selected column as part of this section option on.  

7. Click Finish.  

8. Click the variable portion of the level-break header field.  

9. From the Edit menu, choose Associate, and then choose Description.  

The cursor changes, allowing you to add the description to the level-break header.  

10. Place the Description field anywhere within the level-break header. As with any field, you 
can drag it to a new location.  

11. To change the properties of this field, double-click the field.  

12. On Associated Description Properties, in the detail section, double-click the variable or 
column variable portion of the level-break field.  

13. On Variable or Column Variable Properties, on the Advanced tab, turn the Visible option off.  

If you ever need to make this field visible again, you can turn the Visible option on.  

See Also  
See the following topics in the EnterpriseOne Report Writing Guide: 

� To create a level-break header for additional information about level breaks  

� To associate a description with a level-break header for additional information about adding 
a description field to a level-break header  

� To hide the level-break field in the detail section for information about hiding the level-break 
field to prevent it from showing in both sections  
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► To total the number of business units per company  

Printing lists of information might be more meaningful if the lists could be totaled to give critical 
information. For example, you might want to print out all business units and their descriptions for 
your companies and total the number of business units that exist for a specific company. Adding a 
level-break footer to a group or columnar section gives you this capability.  

From the Report Writer menu (GH9111), choose Report Design Tool from. 

1. On Report Design, open your existing report called Company/Business Units/Descriptions 
Listing.  

2. Click the detail section to which you want to attach a level-break footer.  

3. From the Section menu, choose Create, and then choose Level Break Footer.  

If the Level Break Footer selection is grayed out on the Section menu, you did not click the 
detail section.  

4. On Level Break Footer, click the following options, and then click OK:  

• Group Section 

5. On Level Break, choose the following option under the Show heading:  

• only existing sort columns  

This option displays the fields that you chose as your data sequencing fields when you 
created the detail section.  

6. Choose the Company field to designate it as the level-break field.  

You can designate another field as a level-break field by modifying the section properties of 
the level-break footer.  

7. Ensure that the Display selected column as part of this section option is turned off.  

8. Click Next.  

An aggregate object is one that holds the result of a calculation on the values in other fields. 
For example, you might want to know the total of business units for a specific company.  

9. On Aggregations, choose the following option for the Operator:  

• Count of 

10. Choose the following option for the Operand:  

• Business Unit  

11. Click one of the following options under the Item display style heading:  

• Single overline  

• Double underline  

12. Click Reprint section at page break, if necessary.  

This option causes the last line from the previous page to be reprinted as the first line of the 
next page.  

13. Click Finish.  
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At any time in the future, you can modify the aggregate object by clicking the level-break 
footer and choosing Add Aggregates from the Section menu.  

14. Click the level-break footer section.  

15. From the Insert menu, choose Constant Field.  

16. Insert the constant field by clicking the level-break footer where you want the object to 
appear.  

17. Double-click the constant field.  

18. On Constant Properties, change the Name field to a meaningful description.  

See Also  
See the following topics in the EnterpriseOne Report Writing Guide: 

� To create a level-break footer for additional information about adding a level-break footer to 
a report  

� To insert a description into a level-break footer for additional information about making a 
level-break footer more meaningful with a description  

Printing Totals and Auditing Numeric Data 
Suppose a report is needed to help put a new sales commission structure into place in your company. 
This report needs to show projected sales commissions to be paid on all current sales orders. The 
standard commission is 5% of the extended price. An additional 1% bonus is paid for high volume 
orders. The following example illustrates a report you could create with a tabular section to present 
totals and audit numeric data:  

► To print totals and audit numeric data  

From the Report Writer menu(GH9111), choose Report Design Tool. 

1. On Report Design, create a report object called Sales Order Detail.  

2. Choose to create a tabular section.  

Tabular sections provide automatic totaling for any field with a numeric value. If the total is 
meaningless, you might need to use the advanced options on a variable to suppress the totals. 
In addition to totaling, tabular sections let you drill into the application to view the source of 
any questionable data in your report.  

3. Attach business view V4201C - Sales Order Header to Sales Order Detail - All.  

4. Choose to include the following data fields on your report:  

• Description field (automatically added)  

This field prints a description for each field selected as a level-break item.  

• Date - Order/Transaction  

• Quantity Shipped  

• Amount - Extended Price  
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5. Sequence the report on the following fields, and select these fields as level-break items:  

• Original Order Number  

• 2nd Item Number  

6. Determine through data selection the records to appear on your report. For example, apply to 
each of the fields used for column selection the condition greater than Zero.  

7. On Report Design, insert three Numeric Variables to the report to create columns to hold the 
calculations you are going to create.  

8. Name the columns the following:  

• 5% Commission  

• High Volume 1% Bonus  

• Total Commission  

9. Attach event rules to define 5% commission, High Volume 1% Bonus, and Total 
Commission.  

10. Focus on the tabular report section for which you want to activate the drill down feature.  

11. Do one of the following:  

• Double-click the report section.  

• From the Section menu, choose Section Properties. 

 

12. On Tabular Section, click the Financial tab or the tab that relates to the director template, for 
example, Financial Reports.  

13. Click the following, and then click Define:  

• Drill Down  

14. On Work With Applications, click Find. 
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This form displays a list of all available applications. You can limit your search by entering 
search criteria in the QBE line.  

15. Choose an application, and then click Select.  

Choose an application to be called from the report. This application is the one that you want 
to drill into to investigate balances. For this example, choose P4210 Sales Order Entry.  

16. On Work With Forms, choose a form, and then click Select.  

Many EnterpriseOne software applications consist of multiple forms. Choose the form to 
open when you drill into the application. For this example, choose W4210A Sales Order 
Detail Revisions.  

If versions for a given form and application exist, the Work With Versions form appears.  

17. On Work With Versions, do one of the following:  

• Choose a version, and then click Select.  

For this example, choose ZJDE0001 Sales Order Entry -SO Order Type.  

• Click Close to avoid choosing a specific version.  

18. On Form Interconnections, from the Available Objects column, double-click the object in the 
Available Objects list that you want to pass to the Value column. 

The values to be passed are determined by the form you have specified in the drill down. If 
you access the form you will see what fields need to be populated to display data in the grid. 
These You need to include these values in your form interconnection data structure.  

19. Click the directional arrow until it toggles to the right arrow icon (indicating that the data 
flows from the source or report to the target or application) and then click OK.  

20. On Tabular Section, click OK to return to the Report Design form.  

21. On Report Design, sequence the report on the following fields:  

• Company  

• Business Unit  

22. Determine through data selection the records to appear on your report. For example, if you 
want to display the business units for all companies less than Company 00050, your data 
selection would be Where Company is less than or equal to 00050.  

23. On Report Design, format your report to enhance the appearance.  

See Also  
� Reviewing an Audit Trail in the EnterpriseOne Report Writing Guide for information about 

viewing the detail about the data on the report  
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Creating Journal Entries with Report Design  
With Report Design, you can create a report that will create journal entries that can then be posted to 
the general ledger using the General Accounting system. For example, you might generate journal 
entries for budgeting purposes.  

You can submit a version of your report in proof or final mode. Both modes produce a report. If 
applicable, Work Center error messages is created as well. In final mode, if no errors exist, the 
Account Ledger table (F0911) is created that can be posted to the general ledger. Prior to posting, 
these journal entries can be deleted through the General Accounting system, if necessary.  

► To create journal entries with Report Design  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Report Design, create a financial report to perform the required calculations; ensure that 
you create a version of the report.  

2. Click the tabular section of the report; and from the Column menu, choose Create, and then 
choose Smart Field.  

If you have clicked one of the existing columns, the new smart field column appears to the 
right of that column. Otherwise, the new smart field column appears to the right of the last 
column in the report.  

3. On Create New Smart Field, choose the data item FINRPTJE - Create Journal Entry and click 
Next.  

4. On Smart Field Name, from the drop-down menu in the Select Report Variable field, select 
the column in the report upon which you want to base the journal entry on and then click 
Next.  

The journal entry column must be based on another column. Because of this situation, the 
journal entry column is often hidden so that it does not appear on the report.  

5. On Smart Field Parameters, enter your choices as appropriate and click Next to move to the 
next task. This director leads you through the steps required for setting up the smart field.  

The report has two results that are based on the variable in the column you choose to be the 
balance column; the originating account is debited the balance amount, and the target account 
is credited the balance amount. For example, due to a clerk input error, you might want to 
transfer 100 U.S. dollars from the revenue account 61.5100 to the account 63.5100. The 
resulting journal entry would show values similar to those in the following table:  

61.5100  63.5100  

100.00  0.00  

100.00DB    

 100.00CR  

0.00  100.00  
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6. On the final screen, click Finish.  

Any values appearing on the Finish form have no effect on how the smart field functions.  

The column you just created appears in the tabular section.  

7. Save and close the report.  

► To enter journal entry specifications  

You must create journal entries with Report Design before you can enter your journal entry 
specifications. 

From the Tools menu, choose Report Versions. 

1. On Work With Batch Versions - Available Versions, complete the following field with the 
report that you created and click Find: 

• Batch Application 

2. Highlight the version for which you wish to enter journal entry specifications and select 
Processing Options from the Row menu. 

3. Click the JE Creation tab. 

4. Complete the following fields and click OK:  

• Report Journal Entry Creation Mode 

Both modes create a report and any applicable Work Center errors. In final mode, F0911 
records are created if no errors are detected.  

• JE G/L Date 

This value can be different from the date that is used to base the report on.  

• Reverse Journal Entries 

• JE Document Type 

You should use a specific user-defined document type for Report Writer-created journal 
entries. In this way, journal entries created by Report Writer can be easily identified.  

• JE Name - Alpha Explanation 

5. Submit the report either in proof or final mode.  

When Report Writer creates journal entries, they must then be posted to the general journal 
using the General Accounting system. The journal entries can be deleted from the system 
before they are posted.  

6. If you submit the report in final mode, you can examine the journal entries by checking the 
Report Writer JE Batches folder in your Workflow Center.  
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EnterpriseOne Reports  
EnterpriseOne provides many reports, including reports for:  

• General Accounting  

• HR and Payroll Foundation  

• Inventory Management  

• Product Data Management  

You can use these reports as they are or you can modify them.  

General Accounting  
The following lists the reports for the General Accounting system: 

R00640 Supplemental Data by Data Type  

R00650 Supplemental Data by Business Unit  

R007011 Unposted Batches  

R007021 Transactions To Batch Headers  

R007031 Batch To Detail  

R09130 Refresh Reconciliation File  

R09301 General Journal by Batch Report 

R093021 Indexed Comps Compute And Print Report 

R093022 Variable Numerator Compute and Print  

R09311 General Journal by Account  

R09321 Transaction Journal  

R09410 Trial Balance Report  

R094121 Trial Balance By Object Report  

R09415 Monetary Account Valuation  

R09420 G/L by Business Unit  

R09421 G/L by Object Account  

R09470 General Ledger by Category Code  

R09472 Debit/Credit T/B by Category Code  

R097001 Companies in Balance  

R097011 Intercompany Account Balance Integrity Report  
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R097021 Transaction w/o Account Master  

R097031 Account Balance w/o Account Master  

R09705 Compare Account Balances to Transactions  

HR and Payroll Foundation  
The following lists the reports for the HR and Payroll Foundation systems: 

R051450 Job Evaluation Factor Data  

R05229 Payroll Journal Proof/Edit Proof  

R053001 Time and Pay Entry Register  

R058515 EE0-1 Report  

R064011 Employee Roster  

R064021 Employee Roster with Rate  

R080400 Employee Report by Data Type  

R080410 Employee Supplemental Data Report 

R080423 Employee History Inquiry  

R080424A Employee Salary History  

R080430 Turnover Report 

R080435 Workforce Analysis Report 

Inventory Management  
The following lists the reports for the Inventory Management system: 

R094121 Trial Balance By Object Account  

R09421 G/L by Object Account  

R41410A Print Cycle Count Sheets  

R41411 Select Items for Count  

R41510 Price Book  

R4152 Buyers Guide  

R41530 Stock Status  

R41543 Item Ledger/Account Integrity  

R41544 Item Balance/Ledger Integrity  

R41560 Item Master Directory  
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R41580 Unit Cost Warnings  

R41590 Inventory Valuation Analysis  

R4164 ABC Analysis  

R41700 Inventory Cost/Price Comparison  

Product Data Management  
The following lists the reports for the Product Data Management system: 

R30450 Kanban Size Calculation  

R30460 Bill of Material Print 

R30520 Where Used Bill of Material Update  

Smart Fields  
Smart Fields are data dictionary items with attached business functions. The business functions 
include a named mapping that maps the source for each parameter of the business function data 
structure. This simplifies selecting a data item with particular capability. Instead of needing to know 
which business function to use and what parameters to pass, the user merely selects a data item that 
inherently has this information. Smart fields can be used for deriving column headings or to populate 
a value in a report section using the Report Design tool.  

Smart fields are reusable objects that simplify using business functions in event rules. They are data 
dictionary items (group K) with business functions attached. The business function performs a 
specific task for the smart field such as a calculation.  

For example, you can create a smart field to add sales values for period 1, period 2, and period 3 to 
calculate a First Quarter column in a report. This calculation will be performed by the business 
function for each row of data fetched into the report. Every time you use this smart field, it will 
perform this calculation. Report Design uses the smart field to do the calculation automatically.  

With the use of this smart field, you will require only one column in your report that displays First 
Quarter sales. Without this smart field, your report would require four columns: one for each period 
and a quarterly amount column for the total. Additionally, you would need to write an event rule to 
add each period to populate the quarterly amount column. If you wanted to display a total for each 
quarter, you would need to write four event rules.  

Smart fields can be created for any detail section. Each business function can be placed on any event 
that is valid at that point. In addition to defining the smart field, you must also define a column 
heading and data selection.  

When the appropriate smart fields exist, you can create a smart field template to organize your smart 
fields. For example, existing EnterpriseOne smart field templates are organized by usage in Financial 
Reports, Fixed Assets, and 52Period Accounting.  

After the smart field is organized into an appropriate smart field template, a configurable director is 
created for all smart fields located in that template. You can use the configurable director to define 
report processing options, business views, and even the drill down feature in a tabular reporting 
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section. Information included in this configurable director leads the report creator through the process 
of creating a report using this group of associated smart fields. The smart field template and 
configurable director allow you to organize and present your smart fields for ease of use in Report 
Design.  

This topic uses the Quarter scenario described above to demonstrate how to create the following:  

• Smart field 

• Smart field template 

• Report director template 

• New report using smart fields 

The result is an application report you can use in Report Design to create a report with quarterly total 
columns.  

Creating a Smart Field  
The first step in making a smart field available to a user through the Director is to create the smart 
field. This topic demonstrates creating a smart field that will total sales values for period 1, period 2, 
and period 3 to calculate a First Quarter column in a report. The smart field will be named Quarterly 
Amount.  

The basic components of a smart field are:  

• A data dictionary item (user prompt)  

• A data structure  

• A named mapping  

• A business function or named event rule  

• A smart field data item  

Creating the Data Dictionary Item  

The first component required for a smart field is a data dictionary item to be used as a user prompt. 
This item must be a standard data dictionary item using a D glossary group. This data item serves as a 
prompt for the report creator. When using the Quarterly Amount smart field, the report creator will be 
prompted for a value, which will represent the quarter for which sales totals should be displayed.  

Therefore, if the report creator wanted to show a column for the first quarter, the smart field would 
then add period 1, period 2, and period 3 sales to display a total for the first quarter. If the report 
creator added a second sales column and chooses to use the Quarterly Amount smart field again for 
the second quarter, the smart field would then add period 4, period 5, and period 6 sales together to 
display a total for the second quarter.  

This data dictionary item prompts the user for a value while creating the report with the Director. The 
form used to prompt the user in Report Design is called Smart Field Parameters. The name of the 
prompt appears on this form as well as in the help entered in the glossary.  

When you create or copy and modify a data item to be used as a user prompt, be sure to enter the 
glossary text. The text should explain the purpose of the data item and will appear on the Smart Field 
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Parameters form in Report Design. This text assists the user in determining which value to enter in 
the user prompt.  

► To create the data dictionary item  

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench. 

1. On Object Management Workbench, highlight the project in which you wish to add the new 
data dictionary item and click Add. 

2. On Add J.D. Edwards Object to the Project, select Data Item and click OK. 

3. On Data Dictionary Item Type, click No. 

4. On Data Item Specifications, complete the following fields with the indicated values: 

• Data Item 

For Data Item, enter QuarterlyAmount.  

• Alias 

For Alias, enter QUAMT. 

• Glossary Group 

For Glossary Group, enter D. 

• Description 

For Description, enter Quarterly Amount. 

• Product Code 

For Product Code, enter 55. 

• Data Type 

For Data Type, enter 9. 

• Size 

For Size, enter 1. 

• Display Decimals 

For Display Decimals, enter 0. 

• Control Type 

For Control Type, enter 4. 

• Row Description 

For Row Description, enter Quarterly Amount. 
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• Column Title 

In the top field of Column Title, enter Quarterly. 

In the bottom field of Column Title, enter Amount. 

5. Click the Item Glossary tab and enter the following four text lines:  

Enter a 1 to display a total for first quarter data.  

Enter a 2 to display a total for second quarter data.  

Enter a 3 to display a total for third quarter data.  

Enter a 4 to display a total for fourth quarter data.  

This text appears on the Smart Field Parameters form in Report Design to tell the report 
creator what the valid input values are.  

6. Click OK. 

See Also  
� Defining a Data Item in the Development Tools Guide for detailed instructions on creating a 

data item  

Defining the Data Structure  

The second component required for a smart field is a data structure. A data structure is a list of 
parameters used to pass values between your report and the database tables, and it contains all data 
items required to complete the function of the smart field. The Quarterly Amount smart field requires 
twelve periods for use in calculating each quarter. It also requires a return value to hold the value that 
the smart field calculates for each quarter. Each of these data items must be added to the data 
structure for the smart field.  

All data items added to this data structure must reside in the same business view. If you find that you 
need to add data items that are not included in single business view, you will need to create a business 
view with all of the required data items.  

See Also  
See the following topics in the Development Tools Guide: 

� Business View Design for information about creating business views  

� Data Structures for detailed information about creating data structures  

► To define the data structure  

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench. 

1. On Object Management Workbench, highlight the project in which you wish to define the 
data structure and click Add. 

2. On Add J.D. Edwards Object to the Project, select Data Structure, and then click OK. 
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3. On Add Object, create a new regular data structure named D55830001, and then click OK. 

4. On Data Structure Design, on the Design Tools tab, click Data Structure Design. 

5. In the Dictionary Item section of the data structure design tool, search for the data dictionary 
item QuarterlyAmount.  

6. Drag the data dictionary item QuarterlyAmount to the left, and then rename the Structure 
Member Name to cQuarterlyAmount.  

7. Make cQuarterlyAmount a required field and place a right-pointing arrow in its Input/Output 
column.  

8. Search for the dictionary item AmountNetPosting*.  

You must use the asterisk.  

9. Drag the dictionary item AmountNetPosting001 to the left, and then rename the Structure 
Member Name to mnQuarterlyAmount.  

10. Place a left-pointing arrow in the Input/Output column.  

11. Drag the dictionary items AmountNetPosting001 through AmountNetPosting012 to the left 
and place a right-pointing arrow in the Input/Output column for each item.  

The Required field displays a check mark, which is the user prompt,  for the Quarterly 
Amount data item.   

Two AmountNetPosting001 data items are posted. The Structure Member Name has been 
changed on the first AmountNetPosting001 so that this data item can be used as the return 
value to hold the Quarterly Amount after it is calculated. The remaining AmountNetPosting 
data items represent each of the twelve months or periods needed to calculate each quarterly 
sales figure.  

12. Click OK. 

Defining Named Mapping  

The named mapping is a part of the data structure and is used only for smart fields. The named 
mapping defines each of the data items included in the data structure. It can also hold default values 
to be used for the business function so that the values do not need to be passed in the Report Design 
Tool.  

The named mapping is used to map the source for each parameter (or data item) of the data structure. 
For example, source values are determined for the prompts, tables, and return values. Data structure 
data items can originate from one of several sources:  

Literal  A literal is used to assign a specific value to the data item. If your calculation will need 
to use a tax rate for instance, enter the tax rate, in the value field.  

Prompt  Specify the data item to be used as the prompt. In our example the Quarterly Amount 
data item is the prompt. In Report Design, the report creator will be prompted to enter 
the quarter to calculate for the report.  

Table  Specify the data items that originate from a table. Browse to locate the table name and 
associate the data item in the data structure with a data item from the table.  
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Data 
Dictionary 
Item  

Use this option if you will need to pass values from a processing option into your data 
structure. Some values used in smart fields might be known to a business function 
without requiring user input. For example, the desired fiscal year or period might 
already be specified in a processing option that can be passed into the data structure. If 
this is the case, the data item needs to be defined as a data dictionary item and a 
processing option in the named mapping.  

System 
Value  

Associate system value as the origin of the data item and browse for the appropriate 
system value. These system values, such as system date, are used throughout the 
system. System values are fetched from the F98VAR table.  

► To define named mapping  

Immediately after creating a data structure, the Data Structure Design form appears. 

1. Double-click Named Mapping from the Design Tools tab.  

2. On Named Mapping, click Add and add the Quarter scenario's data structure (M5583001) to 
the Named Mapping List.  

3. Choose cQuarterlyAmount and click the Prompt option under Origin Types.  

In the Quarter scenario's named mapping, the first data item in the data structure, Quarterly 
Amount, is a user prompt. In the named mapping, it must be defined as a prompt by 
performing this step. The user prompt should have been set as a required item in the actual 
data structure.  

4. Choose mnQuarterlyAmount and indicate that it is a returned value by clicking the Return 
Value field.  

Note 

The Required field is chosen automatically. You cannot inactivate the Required field for a 
Return Value.  

 

5. Choose mnAmountNetPosting001_2 and click the Required field.  

6. Define mnAmountNetPosting001_2 as originating from a table by choosing the data item and 
then clicking the Table option under Origin Types.  

7. Click Browse to bring up the Select a Table form.  

8. Choose table F0902 and click Next.  

This action indicates the table where the data item can be located. The last twelve data items 
in the Quarter scenario reside in table F0902.  

9. Choose AmountNetPosting001 and click Finish.  

On Select a Column, you indicate which data item in the table will be the basis for the data 
item in the data structure. These data items must be defined as required by clicking the 
Required field.  

10. Repeat steps 5-8 for the remaining 11 data items, mapping structure item 
mnAmountNetPosting002 to table item AmountNetPosting002, structure item 
mnAmountNetPosting003 to table item AmountNetPosting003, and so forth.  
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Hint 

If you position the Select a Column form as shown below, you can reference which data item 
with which you are currently working.  

 

Performing Calculations with Business Functions and Named Event Rules  

You can use either a business function or a named event rule to set up the criteria for the smart field. 
Business functions are written in C language, while named event rules are written in scripting 
language using the EnterpriseOne toolset.  

The advantage of using a business function or named event rule is that they are reusable. The code is 
written once and can be used in multiple events and reports. In the Quarter scenario, without the 
named event rule, you would require four columns in your report: one column for each period, and a 
total column for the quarterly amount. You would then need to write an event rule to add each period 
to populate the quarterly amount column. If you need to display a total for each quarter you would 
need to write four different event rules. Instead, with the use of the named event rule, you can write 
the criteria once and reuse it for each of the four columns displaying quarterly amounts. This same 
named event rule can be used in other reports as well.  

The next step in the Quarter scenario is to create a named event rule to perform the smart field's 
calculations. When a named event rule is created, a data structure is associated with it. For the 
Quarter scenario, you need to associate the Quarterly Amount data structure to this named event rule.  

► To perform calculations with a named event rule  

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench. 

1. On Object Management Workbench, highlight the project to which you wish to add the 
named event rule and click Add. 

2. On Add J.D. Edwards Object to the Project, select Business Function and click OK. 

3. On Add Object, complete the following fields, select NER, and click OK. 

• Object Name 

• Description 

• Product Code 

• Product System Code 

• Object Use 

4. On the Design Tools tab of the Business Function Design form, click Start Business Function 
Design Aid. 

5. Create a function called QuarterlyAmount and associate the Quarterly Amount data structure 
with it.  

QuarterlyAmount will become the name of the event rule.  

6. Edit the function and enter the event rule as discussed below.  
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In the Quarter scenario, the named event rule will perform the following calculation to 
accumulate quarterly amounts:  

Sales for Period 1 + Sales for Period 2 + Sales for Period 3 

One item to define in the named event rule is what to do with the value that the user inputs. 
For example, if a user inputs a 1 in the user prompt, the user expects to see sales totals for the 
first quarter. Therefore, the named event rule must set up an If/While statement to that effect. 
An If statement will be added to the named event rule as follows:  

If <user prompt> is equal to a 1 

     Sales for Period 1 + Sales for Period 2 + Sales for Period 3 

     Else 

Related information for each option for displaying data needs to be available to the user. 
Therefore, the following information must be included in the named event rule as well:  

If <user prompt> is equal to a 2 

     Sales for Period 4 + Sales for Period 5 + Sales for Period 6 

     Else 

If <user prompt> is equal to a 3 

     Sales for Period 7 + Sales for Period 8 + Sales for Period 9 

     Else 

If <user prompt> is equal to a 4 

     Sales for Period 10 + Sales for Period 11 + Sales for Period 12 

     End If 

     End If 

     End If 

     End If 

7. Save the event rule and click OK.  

8. On Object Librarian Business Function Design, click the Design Tools tab, and then click 
Build Business Function.  

See Also  
See the following topics in the Development Tools Guide: 

� Business Functions  

� Creating Business Function Event Rules for detailed information about creating business 
functions and named event rules  

Creating a Data Dictionary Smart Field Item  

The last component required for a smart field is a data dictionary smart field item. This data item 
defines the business function or named event rule and named mapping associated with the smart field. 
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Smart field data dictionary items and any other data dictionary item differ in two ways: glossary 
group K and information in the Smart Field tab.  

Prerequisite 
� Check in the data structure before creating the smart field data dictionary item so that the 

system can locate the named mapping.  

► To create the data dictionary smart field item  

From the Cross Application Development Tools menu (GH902), choose Object Management 
Workbench. 

1. On Object Management Workbench, highlight the project in which you wish to add the new 
data dictionary item and click Add. 

2. On Add J.D. Edwards Object to the Project, select Data Item and click OK. 

3. On Data Item Type, click No. 

4. On Data Item Specifications, complete the following fields with the indicated values: 

• Data Item 

For Data Item, enter QuarterlySales.  

• Alias 

For Alias, enter QSALES. 

• Glossary Group 

For Glossary Group, enter K. 

• Description 

For Description, enter Quarterly Sales. 

• Product Code 

For Product Code, enter 55. 

• Data Type 

For Data Type, enter 9. 

• Size 

For Size, enter 15. 

• Class 

For Class, enter CURRENCY. 
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• Display Decimals 

For Display Decimals, enter 2. 

• Control Type 

For Control Type, enter 4. 

• Row Description 

For Row Description, enter Quarterly Sales. 

• Column Title 

In the top field of Column Title, enter Quarterly. 

In the bottom field of Column Title, enter Sales. 

5. From the Form menu, select Smart Field to launch the Smart Field Criteria form.  

6. Associate the QuarterlyAmount business function (the named event rule that you created in 
the last topic) with the smart field.  

7. In the Event Name column, indicate from which event the smart field can be called.  

The Quarterly Amount smart field in the Quarter scenario will probably be used in financial 
reporting, which generally uses a tabular section. Therefore, the column inclusion event is a 
good choice for this smart field.  

8. In the Named Mapping column, associate the named mapping you set up earlier with the 
smart field.  

The last step on this form is to associate the named mapping that this smart field will use.  

9. As you did with the user prompt data dictionary item, enter help text using the Item Glossary 
tab for this smart field data item.  

See Also  
� Defining a Data Item in the Development Tools Guide for detailed instructions about creating 

data items  

Creating a Smart Field Template  
The smart field template is used to group smart fields that will be included in a single configurable 
director that prompts the report creator for data. Because you will define a business view and other 
reporting and processing components in this configurable director, the smart fields in a given 
template must be alike. For example: the Financial Report smart fields included in smart field 
template S09001 all use the same business view, processing options, and data sequencing and use the 
same configurable director.  
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► To create a smart field template  

From the Advanced Report Setup menu (GH9141), choose Smart Fields Templates.  

1. On Work With Smart Field Templates, click Add. 

2. On Smart Field Template Revisions, complete the following fields: 

• Smart Field Template 

Type S55830001 in the Smart Field Template field. 

• Description 

Type Quarterly Smart Fields in the Description field.  

3. Type QSALES in the following field and then click OK.  

• Data Item 

4. On Smart Field Template Criteria Revisions, indicate smart field data selection prompts by 
typing the following three data items in the Data Item field:  

• Fiscal Year (FY) 

• Ledger Type (LT) 

• Object Account (OBJ) 

In the Quarter scenario, the report creator must be prompted to enter values for Fiscal Year, 
Ledger Type, and Object Account. Since Fiscal Year and Ledger Type do not require a range 
of values, the Range Values field can be set to 0. However, Object Account may include a 
range of accounts, so the Range Values Field must be set to 1.  

The system prompts the report creator for these three values in the sequence shown via Smart 
Field Data Selection forms.  

Note  

Pre-determined data selection can be overridden in Report Design.  

 

5. Click OK to save your changes.  

See Also  
� Working with Smart Field Templates in the EnterpriseOne Report Writing Guide for more 

information about creating smart field templates  

Creating a Report Director Template  
The report director template is used to create a director that leads the report creator through the steps 
of using the smart field. This director is similar to the Director that you use when creating a simple 
columnar or group report template.  
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► To create a Report Director template  

From the Advanced Report Setup menu (GH9141), choose Report Director Templates.  

1. On Work With Report Director Templates, click Add. 

2. On Report Director Templates Revisions, complete the following fields: 

• Report Template 

• Type S55830001 in the template field. 

• Description 

Type Quarterly Smart Fields in the description field. 

The EnterpriseOne naming convention is for the report director template to share the same 
name as the smart field template. This report director name appears in the Application Report 
drop-down list on the Report Design Director's Welcome form when creating the report in 
Report Design. The description appears on the Business View Selection Options form when 
creating a report template.  

3. On the Building Blocks tab, type 46 in the following field to instruct the director that this 
smart field will be used in a tabular section: 

• Section Type 

Although you can use any detail section when setting up a report director template, the 
Quarter scenario uses a tabular section.  

4. Type V8300001 in the following field:  

• Default View 

The business view you select must include all of the data items used in the data structure 
associated with the smart field. It is this business view that is used when the report creator 
selects the option, I'll use the pre-defined business view when using the Director in Report 
Design.  

5. Type S55830001 in the following field:  

• Smart Field ID 

6. Add the following data items in the Default Sequence and Level Breaks grid: 

• Company (CO) 

• Business Unit (MCU) 

• Object Account (OBJ) 

The data items on this grid appear on the Director's Data Sequencing Help form. The first two 
data items entered in this grid are used as Level Break fields when using a tabular section. 
The remaining fields are used to sequence the data in the report. These choices can be 
overridden.  

The Quarter scenario report template uses Company, Business Unit, and Object Account to 
sequence the data. Company and Business Unit are the level breaks.  
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7. Click the Properties tab and select the following options:  

• Use Financial Description 

• Display Level of Detail 

• Display Adjust Sign 

• Display Suppress Zero Rows 

• Display Financial Criteria 

Many of these choices are specific to financial reporting. Even if you are creating a financial 
report director template, you might not want the report creator to have some of these options 
available to them. If you turn off the Display Level of Detail, for example, the report creator 
will be unable to choose that option when moving through the Director. The option in the 
section properties will be grayed out as well. Therefore, the report creator will be unable to 
control the level of detail in the report.  

This tab is only available with a tabular section.  

8. Click the Drill Down tab and choose the following option: 

• Drill Down 

9. On Work With Applications, type P83001 in the Object Name field, click Find, and then 
click Select. 

10. On Work With Forms, choose the W83001A form name and click Select. 

11. On Work With Versions, choose the XJDE0001 version and click Select.  

Remember that the drill down feature takes time and resources to process. The report creator 
is not required to enable drill down when creating the report. If drill down is requested, 
however, these settings become the default drill down values.  

The Define button leads you through search and select forms to complete your application, 
form, and version choices. The actual form interconnect mapping must be accomplished 
when creating the report template itself.  

This tab is only available in conjunction with a tabular section.  

12. On Report Director Templates Revisions, click OK.  

See Also  
See the following topics in the Enterprise Report Writing Guide: 

� Working with Smart Field Templates for more information about creating smart field 
template 

� Working with the Drill Down Feature for more information about using drill down 
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Creating a New Report Using Smart Fields  
As the final step in this process, you should test the template. For this example, it is useful to look at 
how the Director displays all the information to the report creator so that you can see precisely from 
where the data originates and how the choices you made when setting up all of the objects to this 
point affect what the report creator sees.  

► To create a new report using smart fields  

From the Report Writer menu (GH9111), choose Report Design Tool. 

1. On Create New Report, complete the following fields and click OK: 

• Report Name 

• Description 

• Product Code 

2. On Report Director, click Application Reports, choose Quarterly Smart Fields from the pull-
down menu, and click Next.  

The last item in the list is the Quarterly Smart Fields report director template you created. The 
name comes from the description you entered when you created the report director template.  

3. On Page Header Details, accept the page header defaults and click Next.  

4. On Business View Selection Options, accept the pre-defined business view and click Next.  

The name of the report director template that you created appears at the top of the Business 
View Selection Options form.  

Displayed are three options for choosing a business view, one of which is to use the pre-
defined business view, which is the business view V830001 that you entered on the Building 
Blocks tab of the report director template. It is set as the default but you can choose one of 
the other two options to override this default.  

If the report creator accepts the pre-defined business view, the Director uses the business 
view V830001 that you indicated when you created the report director template. Of course, 
the report creator can select a different business view.  

5. On Select Columns, drag the QuarterlySales smart field from the Available Smart Fields 
section to the Columns in Report Section.  

This list comes from the smart field template you associated with the report director template. 
QuarterlySales is the name of the smart field that you created and associated with the 
template. Because you created only the one smart field, Quarterly Sales is the only smart field 
displayed.  

The smart field director launches and displays a set of forms beginning with the Smart Field 
Name form.  
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6. Change the Variable Name field to First Quarter Sales and the first Report Column Headings 
field to First Quarter.  

You set the default variable name and the names of the column when you created the smart 
field.  

The Smart Field Parameters form appears, prompting you to enter the quarter for the column.  

7. Enter a 1 in the field and click Next.  

This prompt exists because of the data dictionary item QuarterlyAmount that you created. 
This is the data dictionary item created as a user prompt for the first component of this smart 
field. Furthermore, notice the item glossary text you entered when you created the data 
dictionary item appears here to tell the report creator what the applicable values are.  

8. On Smart Field Data Selection, to display results for the year 2005 with a ledger type of 
actual amounts of the two accounts that hold sales data (Sales - Product Class 1 and Sales 
Product Class 2), type 05 in the Fiscal Year field, type AA in the Ledger Type field, type 
5100 in the Object Account: From field, and type 5200 in the Object Account: To field.  

9. Click Finish.  

The items on this form come from the Smart Field Template where you attached the smart 
field data dictionary item and defined the data selection fields. In the smart field template you 
can include up to five data items. Object Account was set up as a range of values, so it takes 
up the space of two data items on this form.  

An alternate way to use this smart field is to show trend information. For example, instead of 
having four columns, in your report each representing a quarter of the current year, you could 
have four columns where each column represents the first quarter of four consecutive years in 
order.  

Note 

If you intend to have the same data selection on each smart field column, you can leave this 
form blank and just fill in the data selection for the entire report.  

 

Defining data selection for the columns might be unnecessary. For an income statement, if 
you set up only one smart field column, or if all of the smart field columns of this type use the 
same data selection (such as when you display a column for each quarter for the same year, 
ledger type, and account), it is more efficient to leave data selection blank at this point and 
then define data selection for the entire report later on.  

The Select Columns form reappears. You can add additional Quarterly Sales columns to the 
report by repeating steps 6 through 8 for each new smart field column.  

10. When finished adding columns to the report, click Next.  

11. On Data Sequencing Help, click Next.  

The Data Sequencing Help form displays the data sequence and level breaks that you defined 
in the report director template. Company and Business Unit were the first two fields entered 
into the grid in the report director template and will be the level breaks in this report. The 
third field, Object Account, was included in the report director template and will also be used 
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for sequencing. You can define Object Account as a level break by clicking the text so that it 
will display in the field directly above the box where it currently resides.  

If you would like to override the pre-defined data sequencing and level breaks, click the 
checkbox I'd like to setup the sequencing and level breaking myself located in the Advanced 
box. The Section Data Sequencing form appears so that you can set up your own data 
sequencing and level breaks. The fields listed in the Available Columns section are fields 
from the pre-defined business view. In this example, the pre-defined business view is 
V8300001  

12. On Help with Section Data Selection, choose to create an income statement and to add your 
own data selection, and click Next.  

Because you chose in the Properties tab in the report director template to display Financial 
Criteria, the next form asks what financial data you would like to see.  

The Section Data Selection form appears with one line of data selection.  

13. On Section Data Selection, change the Right Operand on the existing line to read 5100-5200, 
and add the following lines:  

• And Fiscal Year is equal to 5  

• And Ledger Type is equal to AA  

• And Company is equal to 60  

As stated previously, data selection for each smart field column might be unnecessary when 
the same smart field columns each have the same data selection in an income statement. If 
you do not define data selection for each column in that case, you must define it here as this 
step demonstrates. Defining data selection for the entire report as opposed to defining data 
selection for each smart field column is more efficient and might result in a faster-running 
report.  

14. On Additional Properties, choose to show Revenue+, Expense- in the Reverse Sign for field 
and click Next.  

This setting suppresses negative signs on the sales data in your report.  

15. On Finish, click Finish and then save and preview your report.  

Understanding the Report  
You can examine the smart field's event rules to see how the objects you created are implemented in 
the report. On Report Design, click the Report tab, and then click the variable portion of the smart 
field column. From the Edit menu, choose Event Rules, and then look at the Column Inclusion event 
rule. You wrote this event when you created the Quarterly Sales smart field data dictionary item.  

Double-click the Quarterly Amount ER text to view the data structure. The named event rule 
information, as well as the data structure name, is displayed in the upper left corner of the Business 
Functions form. The data structure displays all of the mappings complete in the Data Structure section 
in the lower right section of the form.  
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Notice that the first data item, the Quarterly Amount, is the user prompt and is mapped to a 1. This 
number is the number that you input when you began creating your report and added the first smart 
field column. A 1 indicates that you wanted to display first quarter data.  

The remainder of the parameters are passed according to the named mapping. None of these fields 
needs to be mapped in Report Design by the report creator. Without the use of this smart field, the 
report creator would have to know which business function to use and how to pass the values.  
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Output Stream Access  
A UBE application processes its components in a specific order. At different points during its 
execution, you can trigger an event via the Output Stream Access (OSA) interface.  

These execution points are illustrated in the following diagram:  

 

 

At each of these execution points, with the exception of PRT_InitializeLib and PRT_TerminateLib, 
you can call an OSA function. You can create your own functions, or you can use existing XML 
libraries and their functions.  
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Creating and Associating OSA Interfaces  
Before a report can be output using OSA, you must define the interface. Typically, once designed, 
OSAs are associated with targeted reports or batch versions; a user can override the default OSA at 
submission, however. A user can also output a report with any defined OSA at submission, although 
the results might vary depending on the robustness of the selected OSA. OSAs can also be associated 
with environments, hosts, and users or groups, in the same way that default printers can be assigned. 
Associating an OSA interface with an object is optional.  

Depending on your output needs, you might need to define multiple interfaces.  

► To create an OSA interface definition  

From the Batch Processing Setup menu (GH9013), choose Output Stream Access Setup. 

1. On Output Stream Access Setup, click Add or Modify the Output Stream Access Interface 
Definition.  

2. On Work with Output Stream Access Interface Definition, click Add.  

3. On Output Stream Access Interface Definition Revisions, enter a name for the OSA interface 
in the following field: 

• Output Stream Access Interface Name 

Note 

EnterpriseOne OSA interfaces begin with the letters JDE. PeopleSoft recommends that you 
do not begin your interface names with JDE.  

 

4. For each execution point where you want to trigger an event, enter the name of the desired 
function in the associated row.  

Execution points with no associated function are ignored when the OSA interface executes.  

5. When finished, click OK.  

► To associate an OSA interface with an object  

From the Batch Processing Setup menu (GH9013), choose Output Stream Access Setup. 

1. On Output Stream Access Setup, click Add or modify the Output Stream Access Interface 
Usage specification.  

2. On Work With Output Stream Access Interface Usage, click Add.  

3. On Output Stream Access Interface Usage Revisions, enter the OSA interface name that you 
want to associate in the following field: 

• Output Stream Access Interface Name 

You can also use the Search button for this field to find the interface name.  

4. Associate the interface with the desired objects, and then click OK.  
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How the System Resolves Priority Conflicts 

The following table shows how the system resolves priority conflicts when you associate the interface 
with more than one object.  

Default OSA disambiguation, highest priority to lowest priority 

User/Group  Report  Version  Environment  Host Type  

report  version  environment  hosttype  

report  version  environment  *ALL  

report  version  *ALL  hosttype  

report  version  *ALL  *ALL  

      

*ALL  environment  hosttype  

report  *ALL  environment  *ALL  

report  *ALL  *ALL  hosttype  

report  *ALL  *ALL  *ALL  

        

*ALL  *ALL  environment  hosttype  

*ALL  *ALL  environment  *ALL  

*ALL  *ALL  *ALL  hosttype  

*ALL  *ALL  *ALL  *ALL  

username  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

        

report  version  environment  hosttype  

report  version  environment  *ALL  

report  version  *ALL  hosttype  

report  version  *ALL  *ALL  

        

report  *ALL  environment  hosttype  

groupname  

  

  

  

  

  

  

  

  report  *ALL  environment  *ALL  

  

report  
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report  *ALL  *ALL  hosttype  

report  *ALL  *ALL  *ALL  

        

*ALL  *ALL  environment  hosttype  

*ALL  *ALL  environment  *ALL  

*ALL  *ALL  *ALL  hosttype  

*ALL  *ALL  *ALL  *ALL  

  

  

  

  

  

  

        

report  version  environment  hosttype  

report  version  environment  *ALL  

report  version  *ALL  hosttype  

report  version  *ALL  *ALL  

        

report  *ALL  environment  hosttype  

report  *ALL  environment  *ALL  

report  *ALL  *ALL  hosttype  

report  *ALL  *ALL  *ALL  

        

*ALL  *ALL  environment  hosttype  

*PUBLIC  

  

  

  

  

  

  

  

  

  

  

  

*ALL  *ALL  environment  *ALL  

Creating an OSA Library  
A library is a collection of functions; a function must be included in a library before you can use the 
function. If necessary, you can create your own functions and libraries.  

PeopleSoft EnterpriseOne software includes an OSA library called OSASample. EnterpriseOne 
provides OSASample, along with its source code, as an example of how to create an OSA library. 
The reference information following this topic is provided for developers who need to create their 
own libraries.  
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Function Signatures  

OSA functions are called using the function pointers defined in the JDEOSA file. Therefore, OSA 
functions should be defined using the same parameters and return values, as in the following example 
set of function prototypes:  

void MyStartDoc (POSA_REPORT_INFO);  

void MySetFont (POSA_REPORT_INFO, POSA_FONT_INFO);  

void MySetColor (POSA_REPORT_INFO, unsigned long int);  

void MyStartPage (POSA_REPORT_INFO);  

void MyTextOut (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyDrawObject (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyUnderline (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyEndPage (POSA_REPORT_INFO, POSA_LINK_INFO, unsigned long);  

void MyEndDoc (POSA_REPORT_INFO, POSA_PAGEOF_INFO, unsigned long);  

void MyFinalize (POSA_REPORT_INFO);  

void MyStartDoc (POSA_REPORT_INFO);  

void MySetFont (POSA_REPORT_INFO, POSA_FONT_INFO);  

void MySetColor (POSA_REPORT_INFO, unsigned long int);  

void MyStartPage (POSA_REPORT_INFO);  

void MyTextOut (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyDrawObject (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyUnderline (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

void MyEndPage (POSA_REPORT_INFO, POSA_LINK_INFO, unsigned long);  

void MyEndDoc (POSA_REPORT_INFO, POSA_PAGEOF_INFO, unsigned long);  

void MyFinalize (POSA_REPORT_INFO);  

Definition File Structures  

Definition file structures describe the following file structures:  

• Report Information Structure 

• Section Information Structure 

• Item Information Structure 

• Object Information Structure 

• Font Information Structure 

• Link Information Structure 

• Page of Information Structure 
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Report Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. It is loaded at the beginning of report processing and is passed by pointer to all OSA 
functions. It includes an External Data Pointer member, which can be used by OSA functions to 
retain and pass report level data between function calls. External applications can also return a log 
message and message severity from each execution point, which will be sent on to the 
UBELogMessage function.  

struct tagOSA_REPORT_INFO  

{  

char szReport[11];  

char szVersion[11];  

char szMachineKey[16];  

char szEnhv[11];  

char szUser[21];  

char szOneWorldRelease[11];  

char szReportTime[12];  

char szDateToday[11];  

unsigned int nLocalCodePage;  

unsigned int nRemoteCodePage;  

int nLocalOperatingSystem;  

int nRemoteOperatingSystem;  

char szPrinter[256];  

unsigned long ulPageSizeVertical;  

unsigned long ulPageSizeHorizontal;  

ulong ulNumberOfCopies;  

ulong ulPaperSource;  

unsigned short nPageOrientation;  

unsigned short nPrinterLinesPerInch;  

unsigned short nPrinterCharactersPerInch;  

unsigned short nPrinterDefaultFontSize;  

char szPDLProgram[11];  

char szDecimalString[2];  

char cThousandsSeparator;  

char szDateFormat[5];  

char cDateSeparator;  

char *szReportTitle;  

char szCompanyName[31];  
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unsigned long ulJobNum;  

unsigned long ulCurrentPageNumber;  

unsigned long ulActualCurrentPageNumber;  

char szUBEFileName[300];  

char szOSAFileName[300];  

unsigned long ulNumberOfSections;  

OSA_SECTION_INFO *pOSASectionInfo;  

void *pExternalDataPointer;  

unsigned short *pnLogMessageSeverity;  

char szLogMessage[256];  

char szFutureUse[256];  

};  

Section Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. An array of these structures is loaded at the beginning of report processing and the array 
pointer and counter is stored as part of the OSAReportInfo structure. This structure also includes an 
External Data Pointer member, which can be used by OSA functions to retain and pass section level 
data between function calls.  

struct tagOSA_SECTION_INFO  

{  

char *szSectionName;  

char szSectionType[50];  

char szBusinessViewName[11];  

unsigned long idSection;  

unsigned long idParentSection;  

unsigned long ulNumberOfObjects;  

OSA_OBJECT_INFO *pOSAObjectInfo;  

void *pExternalDataPointer;  

char szFutureUse[256];  

};  
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Item Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. For each OSAObjectInfo structure, one OSAItemInfo structure is loaded prior to object level 
execution points, such as Text Out and Insert Draw Object.  

struct tagOSA_ITEM_INFO  

{  

unsigned long ulOccurenceCount;  

unsigned long ulRecordFetchCount;  

unsigned long ulNumPDFLines;  

unsigned short nReprinting;  

unsigned short nUnderlineThickness;  

unsigned short nUnderlineMargin;  

unsigned long int ColorRef;  

OSA_FONT_INFO zFontInfo;  

unsigned short nPointSize;  

unsigned short nDisplayStyle;  

float fObjectHorizontalPosition;  

float fObjectVerticalPosition;  

float fValueHorizontalPosition;  

float fValueVerticalPosition;  

float fValueEndingHorizontalPosition;  

float fValueEndingVerticalPosition;  

char *szValue;  

char *szFullText;  

};  

Object Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. For each section, an array of these structures is loaded at the beginning of report processing. 
Each SectionInfo structure contains a pointer to an array of ObjectInfo structures as well as a member 
indicating the number of elements contained in the array. However, for some execution points, an 
individual ObjectInfo structure is passed by pointer to the associated OSA function. Each 
OSAObjectInfo structure contains an OSAItemInfo structure which encapsulates the more dynamic 
pieces of object level data. This structure also includes an External Data Pointer member, which can 
be used by OSA functions to retain and pass object level data between function calls.  
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struct tagOSA_OBJECT_INFO  

{  

char szDataDictionaryAlias[41];  

char szObjectName[31];  

unsigned long idObject;  

unsigned long idSection;  

unsigned long idRow;  

char szObjectType[3];  

unsigned short nLength;  

unsigned short idEverestType;  

char cDataType;  

OSA_ITEM_INFO zOSAItemInfo;  

POSA_SECTION_INFO pOSASectionInfo;  

void *pExternalDataPointer;  

char szFutureUse[256];  

};  

Font Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. This structure is loaded prior to execution of the appropriate OSA functions, as described 
below, and passed by pointer to such functions.  

struct tagOSA_FONT_INFO  

{  

long int lfHeight;  

long int lfWidth;  

long int lfEscapement;  

long int lfOrientation;  

long int lfWeight;  

unsigned char lfItalic;  

unsigned char lfUnderline;  

unsigned char lfStrikeOut;  

unsigned char lfCharSet;  

unsigned char lfOutPrecision;  

unsigned char lfClipPrecision;  

unsigned char lfQuality;  

unsigned char lfPitchAndFamily;  

unsigned char lfFaceName[32];  
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unsigned short nPointSize;  

char szAdobeFontName[100];  

};  

Link Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. An array of these structures is populated and sent at the End Page execution point whenever 
applicable.  

struct tagOSA_LINK_INFO  

{  

float fLowerLeftHorizontal;  

float fLowerLeftVertical;  

float fUpperRightHorizontal;  

float fUpperRightVertical;  

char szApplication[11];  

char szForm[11];  

char *szParms;  

};  

Page Of Information Structure  

This structure definition is available in a common header file so that external applications can make 
use of it. An array of these structures is populated and sent at the End Document execution point.  

struct tagOSA_PAGEOF_INFO  

{  

unsigned long ulBeginPage;  

unsigned long ulEndPage;  

unsigned long ulTotalPage;  

};  

Function Parameters  

Function parameters describe the following function parameters:  

• Start Document Parameters 

• Set Font Parameters 

• Set Color Parameters 

• Start Page Parameters 

• Text Out Parameters 
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• Insert Draw Object Parameters 

• Draw Underline Parameters 

• End Page Parameters 

• End Document Parameters 

• Finalize Document Parameters 

Start Document Parameters  

The OSA function that is associated with the Start Document execution point is called with the 
following parameter:  

OSA_REPORT_INFO *pOSAReportInfo  

OSA_REPORT_INFO *pOSAReportInfo  

Set Font Parameters  

The OSA function that is associated with the Set Font execution point is called with the following 
parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

OSA_FONT_INFO *pOSAFontInfo  

Set Color Parameters  

The OSA function that is associated with the Set Color execution point is called with the following 
parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

unsigned long int zColorRef  

Start Page Parameters  

The OSA function that is associated with the Start Page execution point is called with the following 
parameter:  

OSA_REPORT_INFO *pOSAReportInfo  

Text Out Parameters  

The OSA function that is associated with the Text Out execution point is called with the following 
parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

OSA_OBJECT_INFO *pOSAObjectInfo  
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Insert Draw Object Parameters  

The OSA function that is associated with the Draw Lines execution point is called with the following 
parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

OSA_OBJECT_INFO *pOSAObjectInfo  

Draw Underline Parameters  

The OSA function that is associated with the Draw Lines execution point is called with the following 
parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

OSA_OBJECT_INFO *pOSAObjectInfo  

End Page Parameters  

The OSA function that is associated with the End Page execution point is called with the following 
parameter:  

OSA_REPORT_INFO pOSAReportInfo,  

OSA_LINK_INFO *pOSALinkInfo,  

unsigned long ulNumberOfLinks  

End Document Parameters  

The OSA function that is associated with the End Document execution point is called with the 
following parameters:  

OSA_REPORT_INFO *pOSAReportInfo,  

OSA_PAGEOF_INFO *pOSAPageOfInfo,  

unsigned long ulNumberOfPageOf  

Finalize Document Parameters  

The OSA function that is associated with the Finalize Document execution point is called with the 
following parameter:  

OSA_REPORT_INFO *pOSAReportInfo 

Retrieving OSA Documents  

Within the OSAReportInfo structure, the szOSAFileName member allows external applications to 
specify the name of a file created by OSA functions. A member of the same name is added to the 
UBEVar structure. After the End Document execution point has been processed, any value that exists 
in the OSAReportInfo member for szOSAFileName is copied to the corresponding UBEVar member. 
When a job has finished processing, the UBEVar structure is updated into the Job Control Status 
Master file (F986110) for the job.  
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Include File  

The structure and function definitions required for functions interfacing through OSA are contained in 
the JDEOSA.H file, which is located in the system\include directory for ERP. The current contents of 
this file are as follows:  

/*********************************************************  

Header File Description  

* JDEOSA.H Header file to support Output Stream Access functions  

*  

**********************************************************  

*  

Copyright (c) 1999 - 2004  

PeopleSoft, Inc  

*  

This material is proprietary to PeopleSoft, Inc.  

All rights reserved. The methods and techniques described herein are 
considered trade secrets and/or confidential. Reproduction or 
distribution, in whole or in part, is forbidden except by express written 
permission of PeopleSoft, Inc.  

*  

*********************************************************/  

#ifndef JDEOSA_H  

#define JDEOSA_H  

/** Page Of Information Structure **/  

struct tagOSA_PAGEOF_INFO  

{  

unsigned long ulBeginPage;  

unsigned long ulEndPage;  

unsigned long ulTotalPage;  

};  

typedef struct tagOSA_PAGEOF_INFO OSA_PAGEOF_INFO, *POSA_PAGEOF_INFO;  

/** Link Information Structure **/  

struct tagOSA_LINK_INFO  

{  

float fLowerLeftHorizontal;  

float fLowerLeftVertical;  

float fUpperRightHorizontal;  

float fUpperRightVertical;  
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char szApplication[11];  

char szForm[11];  

char *szParms;  

};  

typedef struct tagOSA_LINK_INFO OSA_LINK_INFO, * POSA_LINK_INFO;  

/** Font Information **/  

struct tagOSA_FONT_INFO  

{  

long int lfHeight;  

long int lfWidth;  

long int lfEscapement;  

long int lfOrientation;  

long int lfWeight;  

unsigned char lfItalic;  

unsigned char lfUnderline;  

unsigned char lfStrikeOut;  

unsigned char lfCharSet;  

unsigned char lfOutPrecision;  

unsigned char lfClipPrecision;  

unsigned char lfQuality;  

unsigned char lfPitchAndFamily;  

char lfFaceName[32];  

unsigned short nPointSize;  

char szAdobeFontName[100];  

};  

typedef struct tagOSA_FONT_INFO OSA_FONT_INFO, * POSA_FONT_INFO;  

/** Item Information **/  

struct tagOSA_ITEM_INFO  

{  

unsigned long ulOccurenceCount;  

unsigned long ulRecordFetchCount;  

unsigned long ulNumPDFLines;  

unsigned short nReprinting;  

unsigned short nUnderlineThickness;  

unsigned short nUnderlineMargin;  

unsigned long int ColorRef;  

OSA_FONT_INFO zFontInfo;  
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unsigned short nDisplayStyle;  

float fObjectHorizontalPosition;  

float fObjectVerticalPosition;  

float fObjectEndingHorizontalPosition;  

float fObjectEndingVerticalPosition;  

float fValueHorizontalPosition;  

float fValueVerticalPosition;  

float fValueEndingHorizontalPosition;  

float fValueEndingVerticalPosition;  

char *szValue;  

char *szFullText;  

};  

typedef struct tagOSA_ITEM_INFO OSA_ITEM_INFO, * POSA_ITEM_INFO;  

/** Object Information **/  

struct tagOSA_OBJECT_INFO  

{  

char szDataDictionaryAlias[41];  

char szObjectName[31];  

unsigned long idObject;  

unsigned long idSection;  

unsigned long idRow;  

char szObjectType[3];  

unsigned short nLength;  

unsigned long idEverestType;  

char cDataType;  

OSA_ITEM_INFO zOSAItemInfo;  

void *pOSASectionInfo;  

void *pExternalDataPointer;  

char szFutureUse[256];  

};  

typedef struct tagOSA_OBJECT_INFO OSA_OBJECT_INFO, * POSA_OBJECT_INFO;  

/** Section Information Structure **/  

struct tagOSA_SECTION_INFO  

{  

char *szSectionName;  

char szSectionType[50];  

char szBusinessViewName[11];  
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unsigned long idSection;  

unsigned long idParentSection;  

unsigned long ulNumberOfObjects;  

unsigned long ulRecordFetchCount;  

OSA_OBJECT_INFO *pOSAObjectInfo;  

void *pExternalDataPointer;  

char szFutureUse[256];  

};  

typedef struct tagOSA_SECTION_INFO OSA_SECTION_INFO, * POSA_SECTION_INFO;  

/*** Report Information Structure ***/  

struct tagOSA_REPORT_INFO  

{  

char szReport[11];  

char szVersion[11];  

char szMachineKey[16];  

char szEnhv[11];  

char szUser[21];  

char szOneWorldRelease[11];  

char szReportTime[12];  

char szDateToday[11];  

unsigned int nLocalCodePage;  

unsigned int nRemoteCodePage;  

int nLocalOperatingSystem;  

int nRemoteOperatingSystem;  

char szPrinter[256];  

unsigned long ulPageSizeVertical;  

unsigned long ulPageSizeHorizontal;  

unsigned long ulNumberOfCopies;  

unsigned long ulPaperSource;  

unsigned short nPageOrientation;  

unsigned short nPrinterLinesPerInch;  

unsigned short nPrinterCharactersPerInch;  

unsigned short nPrinterDefaultFontSize;  

char szPDLProgram[11];  

char szDecimalString[2];  

char cThousandsSeparator;  

char szDateFormat[5];  
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char cDateSeparator;  

char *szReportTitle;  

char szCompanyName[31];  

unsigned long ulJobNum;  

unsigned long ulCurrentPageNumber;  

unsigned long ulActualCurrentPageNumber;  

char szUBEFileName[300];  

char szOSAFileName[300];  

unsigned long ulNumberOfSections;  

OSA_SECTION_INFO *pOSASectionInfo;  

void *pExternalDataPointer;  

unsigned short *pnLogMessageSeverity;  

char szLogMessage[256];  

char szFutureUse[256];  

};  

typedef struct tagOSA_REPORT_INFO OSA_REPORT_INFO, * POSA_REPORT_INFO;  

/** Execution Point Identification Numbers **/  

#define OSA_EXPN_START_DOC 1  

#define OSA_EXPN_SET_FONT 2  

#define OSA_EXPN_SET_COLOR 3  

#define OSA_EXPN_START_PAGE 4  

#define OSA_EXPN_TEXT_OUT 5  

#define OSA_EXPN_DRAW_OBJECT 6  

#define OSA_EXPN_UNDERLINE 7  

#define OSA_EXPN_END_PAGE 8  

#define OSA_EXPN_END_DOC 9  

#define OSA_EXPN_FINALIZE_DOC 10  

/** OSA Function Prototypes **/  

typedef void (*FP_OSA_START_DOC) (POSA_REPORT_INFO);  

typedef void (*FP_OSA_SET_FONT) (POSA_REPORT_INFO, POSA_FONT_INFO);  

typedef void (*FP_OSA_SET_COLOR) (POSA_REPORT_INFO, unsigned long int);  

typedef void (*FP_OSA_START_PAGE) (POSA_REPORT_INFO);  

typedef void (*FP_OSA_TEXT_OUT) (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

typedef void (*FP_OSA_DRAW_OBJECT) (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

typedef void (*FP_OSA_UNDERLINE) (POSA_REPORT_INFO, POSA_OBJECT_INFO);  

typedef void (*FP_OSA_END_PAGE) (POSA_REPORT_INFO, POSA_LINK_INFO, 
unsigned long);  
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typedef void (*FP_OSA_END_DOC) (POSA_REPORT_INFO, POSA_PAGEOF_INFO, 
unsigned long);  

typedef void (*FP_OSA_FINALIZE_DOC) (POSA_REPORT_INFO);  

#endif  

File Locations and Names  

UBE performs the following steps to load an OSA Library:  

If the library name, as defined in the OSA Interface Definition table (F986169), contains a period (.) 
character, UBE ignores the period and any characters that follow.  

UBE adds prefixes, extensions, or both according to the platform on which UBE is executing, as 
shown in the following table:  

PLATFORM EXTENDED LIBRARY NAME 
PC  libname + ".dll"  

HPUX  "lib" + libname + ".sl"  

AIX, SUN  "lib" + libname + ".so"  

iSeries libname  

UBE passes the resulting library name to the LoadLibrary function, which, in turn, uses a standard 
search strategy to locate the desired library.  

OSA File Names  

When EnterpriseOne is retrieving an OSA file from the server, it makes some assumptions about the 
format of the OSA file name. For iSeries, it assumes that the file name will be stored in the format 
"LIBRARY/FILE(MEMBER)" and it stores the file on the client machine by  using the name 
"MEMBER.FILE". For NT servers, EnterpriseOne assumes that the file name is stored in the format 
"DIRECTORY\FILE.EXT". For all other platforms, EnterpriseOne expects the file name in the 
format "DIRECTORY/FILE.EXT".  

OSASample Source Code  

OSASample has three components:  

• 

•  

OSAStruct.h  

OSASample.h 

• OSASample.c  
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OSAStruct.h  

#ifndef OSASAMPLE_DEF_HPP  

#define OSASAMPLE_DEF_HPP  

#define chAmpersand '&'  

#define chOpenAngle '<'  

#define chCloseAngle '>'  

#define chDoubleQuote '"'  

#define PAGEOF_TYPE "TP"  

typedef struct tagOSASAMPLE_STRUCT  

{  

unsigned short nCount;  

FILE *fpOutput;  

} OSASAMPLE_STRUCT, *POSASAMPLE_STRUCT;  

#endif  

OSASample.h  

#ifndef __OSASAMPLE_H__  

#define __OSASAMPLE_H__  

#include <string.h>  

#include <assert.h>  

#include <stdio.h>  

#include <jdeosa.h>  

#if defined (_WIN32)  

#undef CDECL  

#define CDECL _cdecl  

#if defined(IAMOSASAMPLE)  

#define APIEXPORT _declspec(dllexport)  

#else  

#define APIEXPORT _declspec(dllimport)  

#endif  

#else  

#define CDECL  

#define APIEXPORT  

#endif  

#define CLASSEXPORT APIEXPORT  

#undef EXTERNC  
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#if defined(__cplusplus)  

#define EXTERNC extern "C"  

#else  

#define EXTERNC  

#endif  

EXTERNC APIEXPORT void CDECL OSASample_StartDoc(POSA_REPORT_INFO pOSAReportInfo);  

EXTERNC APIEXPORT void CDECL OSASample_SetFont(POSA_REPORT_INFO pOSAReportInfo, 

POSA_FONT_INFO pOSAFontInfo);  

EXTERNC APIEXPORT void CDECL OSASample_SetColor(POSA_REPORT_INFO pOSAReportInfo, 

unsigned long int zColorRef);  

EXTERNC APIEXPORT void CDECL OSASample_EndDoc(POSA_REPORT_INFO pOSAReportInfo,  

POSA_PAGEOF_INFO pOSAPageofInfo,  

unsigned long ulNumberOfStructs);  

EXTERNC APIEXPORT void CDECL OSASample_StartPage(POSA_REPORT_INFO pOSAReportInfo);  

EXTERNC APIEXPORT void CDECL OSASample_EndPage(POSA_REPORT_INFO pOSAReportInfo,  

POSA_LINK_INFO pOsaLinkInfo,  

unsigned long ulNumberOfLinks);  

EXTERNC APIEXPORT void CDECL OSASample_TextOut(POSA_REPORT_INFO pOSAReportInfo, 

POSA_OBJECT_INFO pOSAObjectInfo);  

EXTERNC APIEXPORT void CDECL OSASample_DrawObject(POSA_REPORT_INFO pOSAReportInfo, 

POSA_OBJECT_INFO pOSAObjectInfo);  

EXTERNC APIEXPORT void CDECL OSASample_DrawUnderLine(POSA_REPORT_INFO 

pOSAReportInfo, POSA_OBJECT_INFO pOSAObjectInfo);  

EXTERNC APIEXPORT void CDECL OSASample_FinalizeDoc(POSA_REPORT_INFO 

pOSAReportInfo);  

#endif  

OSASAMPLE.c  

#include "OSASample.h"  

#include "OSAStruct.h"  

/*-------------------------------------------------------------------------  

* Function Name: OSA_ReportInfoOut  

* Parameters: OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* OSA_REPORT_INFO * Pointer to Report Info structure  

* Exceptions: None  

* Return Value: None  

* Description: Output data from the Report Info structure  

*------------------------------------------------------------------------- */  
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void OSA_ReportInfoOut(POSASAMPLE_STRUCT pOSAStruct, POSA_REPORT_INFO 

pOSAReportInfo)  

{  

/* Check for valid parameter values. If pointers are void, return. */  

if (!pOSAStruct || !pOSAStruct->fpOutput || !pOSAReportInfo)  

{  

return;  

}  

/* Print values to the output file */  

fprintf(pOSAStruct->fpOutput, "****** REPORT INFO ******\n\n");  

fprintf(pOSAStruct->fpOutput, "Report: %s\n", pOSAReportInfo->szReport);  

fprintf(pOSAStruct->fpOutput, "Version: %s\n", pOSAReportInfo->szVersion);  

fprintf(pOSAStruct->fpOutput, "MachineKey: %s\n", pOSAReportInfo->szMachineKey);  

fprintf(pOSAStruct->fpOutput, "Environment: %s\n", pOSAReportInfo->szEnhv);  

fprintf(pOSAStruct->fpOutput, "User: %s\n", pOSAReportInfo->szUser);  

fprintf(pOSAStruct->fpOutput, "Release: %s\n", pOSAReportInfo->szOneWorldRelease);  

fprintf(pOSAStruct->fpOutput, "Time: %s\n", pOSAReportInfo->szReportTime);  

fprintf(pOSAStruct->fpOutput, "Date: %s\n", pOSAReportInfo->szDateToday);  

fprintf(pOSAStruct->fpOutput, "Local Code Page: %d\n", pOSAReportInfo-

>nLocalCodePage);  

fprintf(pOSAStruct->fpOutput, "Remote Code Page: %d\n", pOSAReportInfo-

>nRemoteCodePage);  

fprintf(pOSAStruct->fpOutput, "Local Operating System: %d\n", pOSAReportInfo-

>nLocalOperatingSystem);  

fprintf(pOSAStruct->fpOutput, "Remote Operating System: %d\n", pOSAReportInfo-

>nRemoteOperatingSystem);  

fprintf(pOSAStruct->fpOutput, "Printer: %s\n", pOSAReportInfo->szPrinter);  

fprintf(pOSAStruct->fpOutput, "Page Height: %d\n", pOSAReportInfo-

>ulPageSizeVertical);  

fprintf(pOSAStruct->fpOutput, "Page Width: %d\n", pOSAReportInfo-

>ulPageSizeHorizontal);  

fprintf(pOSAStruct->fpOutput, "Number Of Copies: %d\n", pOSAReportInfo-

>ulNumberOfCopies);  

fprintf(pOSAStruct->fpOutput, "Paper Source: %d\n", pOSAReportInfo->ulPaperSource);  

fprintf(pOSAStruct->fpOutput, "Orientation: %d\n", pOSAReportInfo-

>nPageOrientation);  

fprintf(pOSAStruct->fpOutput, "Lines Per Inch: %d\n", pOSAReportInfo-

>nPrinterLinesPerInch);  

fprintf(pOSAStruct->fpOutput, "Default Font Size: %d\n", pOSAReportInfo-

>nPrinterDefaultFontSize);  
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fprintf(pOSAStruct->fpOutput, "Printer Type: %s\n", pOSAReportInfo->szPDLProgram);  

fprintf(pOSAStruct->fpOutput, "Decimal Separator: %s\n", pOSAReportInfo-

>szDecimalString);  

fprintf(pOSAStruct->fpOutput, "Thousands Separator: %c\n", pOSAReportInfo-

>cThousandsSeparator);  

fprintf(pOSAStruct->fpOutput, "Date Format: %s\n", pOSAReportInfo->szDateFormat);  

fprintf(pOSAStruct->fpOutput, "Date Separator: %c\n", pOSAReportInfo-

>cDateSeparator);  

fprintf(pOSAStruct->fpOutput, "Report Title: %s\n", pOSAReportInfo->szReportTitle);  

fprintf(pOSAStruct->fpOutput, "Company Name: %s\n", pOSAReportInfo->szCompanyName);  

fprintf(pOSAStruct->fpOutput, "Job Number: %d\n", pOSAReportInfo->ulJobNum);  

fprintf(pOSAStruct->fpOutput, "Current Page Number: %d\n", pOSAReportInfo-

>ulCurrentPageNumber);  

fprintf(pOSAStruct->fpOutput, "Actual Page Number: %d\n", pOSAReportInfo-

>ulActualCurrentPageNumber);  

fprintf(pOSAStruct->fpOutput, "UBE File Name: %s\n", pOSAReportInfo-

>szUBEFileName);  

fprintf(pOSAStruct->fpOutput, "OSA File Name: %s\n", pOSAReportInfo-

>szOSAFileName);  

fprintf(pOSAStruct->fpOutput, "Number of Sections: %d\n", pOSAReportInfo-

>ulNumberOfSections);  

fprintf(pOSAStruct->fpOutput, "\n****** END REPORT INFO ******\n");  

return;  

}  

/*-------------------------------------------------------------------------  

* Function Name: OSA_SectionInfoOut  

* Parameters: OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* OSA_SECTION_INFO * Pointer to Section Info structure  

* Exceptions: None  

* Return Value: None  

* Description: Output data from the Section Info structure  

*------------------------------------------------------------------------- */  

void OSA_SectionInfoOut(POSASAMPLE_STRUCT pOSAStruct, POSA_SECTION_INFO 

pOSASectionInfo)  

{  

/* Check for valid parameter values. If pointers are void, return. */  

if (!pOSAStruct || !pOSAStruct->fpOutput || !pOSASectionInfo)  

{  

return;  
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}  

fprintf(pOSAStruct->fpOutput, "\n\t****** SECTION INFO ******\n\n");  

fprintf(pOSAStruct->fpOutput, "\tSection Name: %s\n", pOSASectionInfo-

>szSectionName);  

fprintf(pOSAStruct->fpOutput, "\tSection Type: %s\n", pOSASectionInfo-

>szSectionType);  

fprintf(pOSAStruct->fpOutput, "\tBusiness View Name: %s\n", pOSASectionInfo-

>szBusinessViewName);  

fprintf(pOSAStruct->fpOutput, "\tSection ID: %d\n", pOSASectionInfo->idSection);  

fprintf(pOSAStruct->fpOutput, "\tParent Section ID: %d\n", pOSASectionInfo-

>idParentSection);  

fprintf(pOSAStruct->fpOutput, "\tNumber of Objects: %d\n", pOSASectionInfo-

>ulNumberOfObjects);  

fprintf(pOSAStruct->fpOutput, "\tRecord Fetch Count: %d\n", pOSASectionInfo-

>ulRecordFetchCount);  

fprintf(pOSAStruct->fpOutput, "\n\t****** END SECTION INFO ******\n");  

return;  

}  

/*-------------------------------------------------------------------------  

* Function Name: OSA_ObjectInfoOut  

* Parameters: OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* OSA_OBJECT_INFO * Pointer to Object Info structure  

* unsigned short int Flag to control output of Item Info  

* Return Value: None  

* Description: Output data from the Object Info and Item Info structures  

*------------------------------------------------------------------------- */  

void OSA_ObjectInfoOut(POSASAMPLE_STRUCT pOSAStruct,  

POSA_OBJECT_INFO pOSAObjectInfo,  

{  

/* Check for valid parameter values. If pointers are void, return. */  

if (!pOSAStruct || !pOSAStruct->fpOutput || !pOSAObjectInfo)  

{  

return;  

fprintf(pOSAStruct->fpOutput, "\n\t\t****** OBJECT INFO ******\n\n");  

fprintf(pOSAStruct->fpOutput, "\t\tData Dictionary Item: %s\n", pOSAObjectInfo-

>szDataDictionaryAlias);  

* Exceptions: None  

unsigned short int nPrintItemInfo)  

}  
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fprintf(pOSAStruct->fpOutput, "\t\tObject Name: %s\n", pOSAObjectInfo-

>szObjectName);  

fprintf(pOSAStruct->fpOutput, "\t\tObject ID: %d\n", pOSAObjectInfo->idObject);  

fprintf(pOSAStruct->fpOutput, "\t\tSection ID: %d\n", pOSAObjectInfo->idSection);  

fprintf(pOSAStruct->fpOutput, "\t\tRow ID: %d\n", pOSAObjectInfo->idRow);  

fprintf(pOSAStruct->fpOutput, "\t\tObject Type: %s\n", pOSAObjectInfo-

>szObjectType);  

fprintf(pOSAStruct->fpOutput, "\t\tObject Length: %d\n", pOSAObjectInfo->nLength);  

fprintf(pOSAStruct->fpOutput, "\t\tOneWorld Data Type: %d\n", pOSAObjectInfo-

>idEverestType);  

fprintf(pOSAStruct->fpOutput, "\t\tGeneral Data Type: %c\n", pOSAObjectInfo-

>cDataType);  

fprintf(pOSAStruct->fpOutput, "\n\t\t****** END OBJECT INFO ******\n");  

/* Only output Item Info if the parameter indicates to do so */  

if (nPrintItemInfo)  

{  

POSA_ITEM_INFO pOSAItemInfo = &(pOSAObjectInfo->zOSAItemInfo);  

fprintf(pOSAStruct->fpOutput, "\n\t\t****** ITEM INFO ******\n\n");  

fprintf(pOSAStruct->fpOutput, "\t\tOccurence Count: %d\n", pOSAItemInfo-

>ulOccurenceCount);  

fprintf(pOSAStruct->fpOutput, "\t\tRecord Fetch Count: %d\n", pOSAItemInfo-

>ulRecordFetchCount);  

fprintf(pOSAStruct->fpOutput, "\t\tNumber Of Lines: %d\n", pOSAItemInfo-

>ulNumPDFLines);  

fprintf(pOSAStruct->fpOutput, "\t\tReprinting: %d\n", pOSAItemInfo->nReprinting);  

fprintf(pOSAStruct->fpOutput, "\t\tUnderline Thickness: %d\n", pOSAItemInfo-

>nUnderlineThickness);  

fprintf(pOSAStruct->fpOutput, "\t\tUnderline Margin: %d\n", pOSAItemInfo-

>nUnderlineMargin);  

fprintf(pOSAStruct->fpOutput, "\t\tColor Reference: %d\n", pOSAItemInfo->ColorRef);  

fprintf(pOSAStruct->fpOutput, "\t\tFont Face Name: %s\n", pOSAItemInfo-

>zFontInfo.lfFaceName);  

fprintf(pOSAStruct->fpOutput, "\t\tFont Point Size: %d\n", pOSAItemInfo-

>zFontInfo.nPointSize);  

fprintf(pOSAStruct->fpOutput, "\t\tAdobe Font Name: %s\n", pOSAItemInfo-

>zFontInfo.szAdobeFontName);  

fprintf(pOSAStruct->fpOutput, "\t\tDisplay Style: %d\n", pOSAItemInfo-

>nDisplayStyle);  

fprintf(pOSAStruct->fpOutput, "\t\tObject Start X: %f\n", pOSAItemInfo-

>fObjectHorizontalPosition);  
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fprintf(pOSAStruct->fpOutput, "\t\tObject Start Y: %f\n", pOSAItemInfo-

>fObjectVerticalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tObject End X: %f\n", pOSAItemInfo-

>fObjectEndingHorizontalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tObject End Y: %f\n", pOSAItemInfo-

>fObjectEndingVerticalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tValue Start X: %f\n", pOSAItemInfo-

>fValueHorizontalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tValue Start Y: %f\n", pOSAItemInfo-

>fValueVerticalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tValue End X: %f\n", pOSAItemInfo-

>fValueEndingHorizontalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tValue End Y: %f\n", pOSAItemInfo-

>fValueEndingVerticalPosition);  

fprintf(pOSAStruct->fpOutput, "\t\tValue Text: %s\n", pOSAItemInfo->szValue);  

fprintf(pOSAStruct->fpOutput, "\t\tFull Object Text: %s\n", pOSAItemInfo-

>szFullText);  

fprintf(pOSAStruct->fpOutput, "\n\t\t****** END ITEM INFO ******\n");  

}  

else  

{  

fprintf(pOSAStruct->fpOutput, "\n\t\t****** No Item Info At This Point ******\n");  

}  

return;  

}  

/*-------------------------------------------------------------------------  

* Function Name: OSA_LinkInfoOut  

* Parameters: OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* OSA_LINK_INFO * Pointer to array of Link Info structures  

* unsigned long The number of elements in the Link Info array  

* Exceptions: None  

* Return Value: None  

* Description: Output data from the Link Info structures, if any.  

*------------------------------------------------------------------------- */  

void OSA_LinkInfoOut(POSASAMPLE_STRUCT pOSAStruct,  

POSA_LINK_INFO pOSALinkInfo,  

unsigned long ulNumberOfLinks)  

{  

unsigned short i =0;  
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/* Check for valid parameter values. If pointers are void, return. */  

if (!pOSAStruct || !pOSAStruct->fpOutput)  

{  

return;  

}  

/* Check for valid parameter values. If pointer is void or array is empty,  

output a message and return. */  

if (!pOSALinkInfo || !ulNumberOfLinks)  

{  

fprintf(pOSAStruct->fpOutput, "\n** No Link Information **\n");  

return;  

}  

fprintf(pOSAStruct->fpOutput, "\n****** LINK INFO ******\n\n");  

for (i=0; i<ulNumberOfLinks; i++)  

{  

fprintf(pOSAStruct->fpOutput, "Lower Left X: %f\n", 

pOSALinkInfo[i].fLowerLeftHorizontal);  

fprintf(pOSAStruct->fpOutput, "Lower Left Y: %f\n", 

pOSALinkInfo[i].fLowerLeftVertical);  

fprintf(pOSAStruct->fpOutput, "Upper Right X: %f\n", 

pOSALinkInfo[i].fUpperRightHorizontal);  

fprintf(pOSAStruct->fpOutput, "Upper Right Y: %f\n", 

pOSALinkInfo[i].fUpperRightVertical);  

fprintf(pOSAStruct->fpOutput, "Application Name: %s\n", 

pOSALinkInfo[i].szApplication);  

fprintf(pOSAStruct->fpOutput, "Form Name: %s\n", pOSALinkInfo[i].szForm);  

fprintf(pOSAStruct->fpOutput, "Parameter String: %s\n\n", pOSALinkInfo[i].szParms);  

}  

fprintf(pOSAStruct->fpOutput, "\n****** END LINK INFO ******\n");  

return;  

}  

/*-------------------------------------------------------------------------  

* Function Name: OSA_FontInfoOut  

* Parameters: OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* OSA_FONT_INFO * Pointer to Font Info structure  

* Exceptions: None  

* Return Value: None  

* Description: Output data from the Font Info structure  
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*------------------------------------------------------------------------- */  

void OSA_FontInfoOut(POSASAMPLE_STRUCT pOSAStruct,  

POSA_FONT_INFO pFontInfo)  

{  

/* Check for valid parameter values. If pointers are void, return. */  

if (!pOSAStruct || !pOSAStruct->fpOutput || !pFontInfo)  

{  

return;  

}  

fprintf(pOSAStruct->fpOutput, "\n****** FONT INFO ******\n\n");  

fprintf(pOSAStruct->fpOutput, "Font Face Name: %s\n", pFontInfo->lfFaceName);  

fprintf(pOSAStruct->fpOutput, "Font Point Size: %d\n", pFontInfo->nPointSize);  

fprintf(pOSAStruct->fpOutput, "Adobe Font Name: %s\n", pFontInfo->szAdobeFontName);  

fprintf(pOSAStruct->fpOutput, "\n****** END FONT INFO ******\n");  

return;  

}  

/*-------------------------------------------------------------------------  

* Function Name: OSA_OpenOutputFile  

* Parameters: OSA_REPORT_INFO * Pointer to Report Info Structure  

* OSASAMPLE_STRUCT * Pointer to OSA Sample Structure  

* Exceptions: None  

* Return Value: None  

* Description: Create the file which will contain the sample output  

*------------------------------------------------------------------------- */  

void OSA_OpenOutputFile (POSA_REPORT_INFO pOSAReportInfo,  

POSASAMPLE_STRUCT pOSAStruct)  

{  

/* Formulate the output file name based on information from Report Info. */  

strcpy(pOSAReportInfo->szOSAFileName, pOSAReportInfo->szUBEFileName);  

#if defined JDENV_AS400  

/* On iSeries, the UBE file name is of the form LIBRARY/PRINTQUEUE(F99999),  

where 99999 is the job number. We will just switch an O for the F to  

indicate an OSA file. */  

pStrPtr = strrchr( pOSAReportInfo->szOSAFileName, 'F' );  

*pStrPtr = 'O';  
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#else  

/* On platforms other than iSeries, just replace the PDF file extension with OSA. 

*/  

if( !strstr( pOSAReportInfo->szOSAFileName, ".pdf" ) )  

{  

/* If there is no .pdf extension, just tack on a .osa extension */  

  strcat( pOSAReportInfo->szOSAFileName, ".osa" );  

}  

else  

{  

  sprintf( strstr( pOSAReportInfo->szOSAFileName, ".pdf" ), ".osa");  

}  

#endif  

/* Open the OSA file for output. */  

pOSAStruct->fpOutput= fopen(pOSAReportInfo->szOSAFileName, "w+b");  

if (!pOSAStruct->fpOutput)  

{  

/* If the file could not be opened, send an error message back to the UBE log */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = 1;  

}  

sprintf(pOSAReportInfo->szLogMessage, "Could not open OSA file: %s\n", 

pOSAReportInfo->szOSAFileName);  

return;  

}  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_StartDoc */  

/* Parameters: OSA_REPORT_INFO* */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Open the output file, */  

/* Output Report, Section and Object */  

/* properties. */  

/*------------------------------------------------------------------------- */  
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EXTERNC APIEXPORT void CDECL OSASample_StartDoc(OSA_REPORT_INFO* pOSAReportInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

POSA_SECTION_INFO pOSASectionInfo = NULL;  

POSA_OBJECT_INFO pOSAObjectInfo = NULL;  

 char *pStrPtr = NULL;  

unsigned long i = 0;  

unsigned long j = 0;  

if(!pOSAReportInfo )  

{  

return;  

}  

/* Allocate memory to hold severity value.  

Deallocated in OSASample_EndDoc */  

if (!pOSAReportInfo->pnLogMessageSeverity)  

{  

pOSAReportInfo->pnLogMessageSeverity = malloc(sizeof( unsigned short));  

}  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

pOSAReportInfo->pnLogMessageSeverity[0] = 0;  

}  

/* Create the common structure for passing values between functions,  

if it has not been created before this point. */  

if (!pOSAReportInfo->pExternalDataPointer)  

{  

pOSAStruct = malloc(sizeof( OSASAMPLE_STRUCT));  

if (pOSAStruct)  

{  

memset(pOSAStruct, 0, sizeof(OSASAMPLE_STRUCT));  

}  

else  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: Could not allocate External Data 

Pointer.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  
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{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

}  

/* Record the pointer as the external data pointer in Report Info. */  

pOSAReportInfo->pExternalDataPointer=pOSAStruct;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at End 

Doc.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Create output file if it has not been created yet */  

if (!pOSAStruct->fpOutput)  

{  

OSA_OpenOutputFile (pOSAReportInfo, pOSAStruct);  

if (pOSAReportInfo->pnLogMessageSeverity[0] > 0)  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "****** START DOC EXECUTION POINT ******\n\n");  

/* Output Report Info to file. */  

OSA_ReportInfoOut(pOSAStruct, pOSAReportInfo);  

/* Output Section Info to file. */  

if (!pOSAReportInfo->pOSASectionInfo || !pOSAReportInfo->ulNumberOfSections)  

{  

if (pOSAReportInfo->pnLogMessageSeverity)  
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{  

*(pOSAReportInfo->pnLogMessageSeverity) = 2;  

}  

sprintf(pOSAReportInfo->szLogMessage, "No Section Info present.\n");  

return;  

}  

pOSASectionInfo = pOSAReportInfo->pOSASectionInfo;  

for (i=0; i<pOSAReportInfo->ulNumberOfSections; i++)  

{  

OSA_SectionInfoOut(pOSAStruct, pOSASectionInfo);  

/* Output Object Info to file. */  

if (!pOSASectionInfo->pOSAObjectInfo || !pOSASectionInfo->ulNumberOfObjects)  

{  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = 3;  

}  

sprintf(pOSAReportInfo->szLogMessage,  

"No Object Info present for Section %s.\n",  

pOSASectionInfo->szSectionName);  

return;  

}  

pOSAObjectInfo = pOSASectionInfo->pOSAObjectInfo;  

for (j=0; j<pOSASectionInfo->ulNumberOfObjects; j++)  

{  

OSA_ObjectInfoOut(pOSAStruct, pOSAObjectInfo, 0); /* Do not print Item Info at this 

time. */  

pOSAObjectInfo++;  

}  

pOSASectionInfo++;  

}  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_EndDoc */  

/* Parameters: OSA_REPORT_INFO*, OSA_PAGEOF_INFO*, unsigned long */  

/* Exceptions: None */  

/* Return Value: None */  
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/* Description: Open the output file, */  

/* Output Report, Section and Object */  

/* properties. */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_EndDoc(OSA_REPORT_INFO* pOSAReportInfo,  

OSA_PAGEOF_INFO* pOSAPageofInfo,  

unsigned long ulNumberOfStructs)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at End 

Doc.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Close Output File */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** END DOC EXECUTION POINT ******");  

if (pOSAStruct->fpOutput)  

{  

fclose (pOSAStruct->fpOutput);  

}  

/* Delete the structure created to hold the external data */  
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free (pOSAStruct);  

if (pOSAReportInfo->pnLogMessageSeverity)  

free(pOSAReportInfo->pnLogMessageSeverity);  

pOSAReportInfo->pExternalDataPointer = NULL;  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_StartPage */  

/* Parameters: OSA_REPORT_INFO* */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Report Info to output file. */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_StartPage(OSA_REPORT_INFO* pOSAReportInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at Start 

Page.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Output Report Info */  
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pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Start 

Page.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** START PAGE EXECUTION POINT ******\n");  

OSA_ReportInfoOut(pOSAStruct, pOSAReportInfo);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_EndPage */  

/* Parameters: OSA_REPORT_INFO*, OSA_LINK_INFO*, unsigned long */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Report Info and Link Info */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_EndPage(POSA_REPORT_INFO pOSAReportInfo,  

POSA_LINK_INFO pOSALinkInfo,  

unsigned long ulNumberOfLinks)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  
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cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at End 

Page.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at End Page.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** END PAGE EXECUTION POINT ******\n");  

OSA_ReportInfoOut(pOSAStruct, pOSAReportInfo);  

/* Output Link Info */  

OSA_LinkInfoOut(pOSAStruct, pOSALinkInfo, ulNumberOfLinks);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_SetFont */  

/* Parameters: OSA_REPORT_INFO*, OSA_FONT_INFO* */  

/* Exceptions: None */  
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/* Return Value: None */  

/* Description: Output Font Info */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_SetFont(POSA_REPORT_INFO pOSAReportInfo,  

POSA_FONT_INFO pOSAFontInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* Allocate memory to hold severity value.  

Deallocated in OSASample_EndDoc */  

if (!pOSAReportInfo->pnLogMessageSeverity)  

{  

pOSAReportInfo->pnLogMessageSeverity = malloc(sizeof( unsigned short));  

}  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

pOSAReportInfo->pnLogMessageSeverity[0] = 0;  

}  

/* Create the common structure for passing values between functions,  

if it has not been created before this point. */  

if (!pOSAReportInfo->pExternalDataPointer)  

{  

pOSAStruct = malloc(sizeof( OSASAMPLE_STRUCT));  

if (pOSAStruct)  

{  

memset(pOSAStruct, 0, sizeof(OSASAMPLE_STRUCT));  

}  

else  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: Could not allocate External Data 

Pointer.\n");  

/* Set the correct severity to error message severity */  
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if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

}  

/* Record the pointer as the external data pointer in Report Info. */  

pOSAReportInfo->pExternalDataPointer=pOSAStruct;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Create output file if it has not been created yet */  

if (!pOSAStruct->fpOutput)  

{  

OSA_OpenOutputFile (pOSAReportInfo, pOSAStruct);  

if (pOSAReportInfo->pnLogMessageSeverity[0] > 0)  

return;  

}  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Set Font.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** SET FONT EXECUTION POINT ******\n");  

OSA_FontInfoOut(pOSAStruct, pOSAFontInfo);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_SetColor */  

/* Parameters: OSA_REPORT_INFO*, unsigned long int */  
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/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Color Reference Number */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_SetColor(POSA_REPORT_INFO pOSAReportInfo,  

unsigned long int zColorRef)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at Set 

Color.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Set 

Color.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  
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{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** SET COLOR: %d ******\n", zColorRef);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_TextOut */  

/* Parameters: OSA_REPORT_INFO*, OSA_OBJECT_INFO* */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Font Info */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_TextOut(POSA_REPORT_INFO pOSAReportInfo,  

POSA_OBJECT_INFO pOSAObjectInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at Text 

Out.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  
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}  

return;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Text Out.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** TEXT OUT EXECUTION POINT ******\n");  

OSA_ObjectInfoOut(pOSAStruct, pOSAObjectInfo, 1);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_Underline */  

/* Parameters: OSA_REPORT_INFO*, OSA_OBJECT_INFO* */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Font Info */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_DrawUnderline(POSA_REPORT_INFO 

pOSAReportInfo,  

POSA_OBJECT_INFO pOSAObjectInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  
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return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at Draw 

Underline.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Draw 

Underline.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** DRAW UNDERLINE EXECUTION POINT ******\n");  

OSA_ObjectInfoOut(pOSAStruct, pOSAObjectInfo, 1);  

return;  

}  

/*------------------------------------------------------------------------- */  

/* Name: OSASample_DrawObject */  
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/* Parameters: OSA_REPORT_INFO*, OSA_OBJECT_INFO* */  

/* Exceptions: None */  

/* Return Value: None */  

/* Description: Output Font Info */  

/* */  

/*------------------------------------------------------------------------- */  

EXTERNC APIEXPORT void CDECL OSASample_DrawObject(POSA_REPORT_INFO pOSAReportInfo,  

POSA_OBJECT_INFO pOSAObjectInfo)  

{  

POSASAMPLE_STRUCT pOSAStruct = NULL;  

/* If OSA does not provide the needed parameter (Highly unlikely), then return */  

if(!pOSAReportInfo )  

{  

return;  

}  

/* If the external data pointer does not exist execution  

cannot go on. Set severity to the highest value, assign a message for the  

log and return */  

if(!pOSAReportInfo->pExternalDataPointer)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No External Data Pointer at Draw 

Object.\n");  

/* Set the correct severity to error message severity */  

if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Output Report Info */  

pOSAStruct=pOSAReportInfo->pExternalDataPointer;  

/* Check for valid file pointer */  

if (!pOSAStruct->fpOutput)  

{  

strcpy(pOSAReportInfo->szLogMessage, "OSA: No Output File pointer at Draw 

Object.\n");  

/* Set the correct severity to error message severity */  
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if (pOSAReportInfo->pnLogMessageSeverity)  

{  

*(pOSAReportInfo->pnLogMessageSeverity) = (unsigned short)1;  

}  

return;  

}  

/* Identify the Execution Point */  

fprintf(pOSAStruct->fpOutput, "\n****** DRAW OBJECT EXECUTION POINT ******\n");  

OSA_ObjectInfoOut(pOSAStruct, pOSAObjectInfo, 1);  

return;  

}  
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EnterpriseOne PeopleBooks Glossary 

“as of” processing A process that is run at a specific point in time to summarize item transactions. 

52 period accounting A method of accounting that uses each week as a separate accounting period. 

account site In the invoice process, the address to which invoices are mailed. Invoices can go 
to a different location or account site from the statement. 

active window The window that contains the document or display that will be affected by current 
cursor movements, commands, and data entry in environments that are capable of 
displaying multiple on-screen windows. 

ActiveX A technology and set of programming tools developed by Microsoft Corporation 
that enable software components written in different languages to interact with 
each another in a network environment or on a web page. The technology, based 
on object linking and embedding, enables Java applet-style functionality for Web 
browsers as well as other applications (Java is limited to Web browsers at this 
time). The ActiveX equivalent of a Java applet is an ActiveX control. These 
controls bring computational, communications, and data manipulation power to 
programs that can “contain” them—for example, certain Web browsers, Microsoft 
Office programs, and anything developed with Visual Basic or Visual C++. 

activity In Advanced Cost Accounting, an aggregation of actions performed within an 
organization that is used in activity-based costing. 

activity driver A measure of the frequency and intensity of the demands that are placed on 
activities by cost objects. An activity driver is used to assign costs to cost objects. 
It represents a line item on the bill of activities for a product or customer. An 
example is the number of part numbers, which is used to measure the 
consumption of material-related activities by each product, material type, or 
component. The number of customer orders measures the consumption of order-
entry activities by each customer. Sometimes an activity driver is used as an 
indicator of the output of an activity, such as the number of purchase orders that 
are prepared by the purchasing activity. See also cost object. 

activity rule The criteria by which an object progresses from a given point to the next in a 
flow. 

actual cost Actual costing uses predetermined cost components, but the costs are 
accumulated at the time that they occur throughout the production process. 

adapter A component that connects two devices or systems, physically or electronically, 
and enables them to work together. 

add mode The condition of a form where a user can enter data into it. 

advanced interactive 
executive 

An open IBM operating system that is based on UNIX. 

agent A program that searches through archives or other repositories of information on 
a topic that is specified by the user. 

aging A classification of accounts by the time elapsed since the billing date or due date. 
Aging is divided into schedules or accounting periods, such as 0-30 days, 31-60 
days, and so on. 
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aging schedule A schedule that is used to determine whether a payment is delinquent and the 
number of days which the payment is delinquent. 

allegato IVA clienti In Italy, the term for the A/R Annual VAT report. 

allegato IVA fornitori In Italy, the term for the A/P Annual VAT report. 

application layer The seventh layer of the Open Systems Interconnection Reference Model, which 
defines standards for interaction at the user or application program level. 

application 
programming 
interface (API) 

A set of routines that is used by an application program to direct the performance 
of procedures by the computer's operating system. 

AS/400 Common A data source that resides on an AS/400 and holds data that is common to the co-
existent library, allowing PeopleSoft EnterpriseOne to share information with 
PeopleSoft World. 

assembly inclusion 
rule 

A logic statement that specifies the conditions for using a part, adjusting the price 
or cost, performing a calculation, or using a routing operation for configured 
items. 

audit trail The detailed, verifiable history of a processed transaction. The history consists of 
the original documents, transaction entries, and posting of records and usually 
concludes with a report. 

automatic return A feature that allows a user to move to the next entry line in a detail area or to the 
first cell in the next row in several applications. 

availability The expression of the inventory amount that can be used for sales orders or 
manufacturing orders.  

available inventory The quantity of product that can be promised for sale or transfer at a particular 
time, considering current on-hand quantities, replenishments in process, and 
anticipated demand. 

back office The set of enterprise software applications that supports the internal business 
functions of a company. 

backhaul The return trip of a vehicle after delivering a load to a specified destination. The 
vehicle can be empty or the backhaul can produce less revenue than the original 
trip. For example, the state of Florida is considered a backhaul for many other 
states—that is, many trucking companies ship products into the state of Florida, 
but most of them cannot fill a load coming out of Florida or they charge less. 
Hence, trucks coming out of Florida are either empty or produce less revenue than 
the original trip. 

balance forward The cumulative total of inventory transactions that is used in the Running Balance 
program. The system does not store this total. You must run this program each 
time that you want to review the cumulative inventory transactions total. 

balance forward 
receipt application 
method 

A receipt application method in which the receipt is applied to the oldest or 
newest invoices in chronological order according to the net due date. 

bank tape (lock box) 
processing 

The receipt of payments directly from a customer’s bank via customer tapes for 
automatic receipt application. 

base location [In package management] The topmost location that is displayed when a user 
launches the Machine Identification application. 
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basket discount A reduction in price that applies to a group or “basket” of products within a sales 
order.  

basket repricing A rule that specifies how to calculate and display discounts for a group of 
products on a sales order. The system can calculate and display the discount as a 
separate sales order detail line, or it can discount the price of each item on a line-
by-line basis within the sales order.  

batch job A job submitted to a system and processed as a single unit with no user 
interaction. 

batch override An instruction that causes a batch process to produce output other than what it 
normally would produce for the current execution only. 

batch process A type of process that runs to completion without user intervention after it has 
been started. 

batch program A program that executes without interacting with the user. 

batch version A version of a report or application that includes a set of user-defined 
specifications, which control how a batch process runs. 

batch/lot tracking The act of identifying where a component from a specific lot is used in the 
production of goods. 

batch/mix A manufacturing process that primarily schedules short production runs of 
products. 

batch-of-one 
processing 

A transaction method that allows a client application to perform work on a client 
workstation, and then submit the work all at once to a server application for 
further processing. As a batch process is running on the server, the client 
application can continue performing other tasks. See also direct connect, store-
and-forward. 

binary large object 
(BLOB) 

A collection of binary data stored as a single entity in a [file]. 

binder clip See paper clip. 

black products Products that are derived from the low or heavy end of the distillation process—
for example, diesel oils and fuel oils. See also white products.  

blend note Document that authorizes a blending activity, and describes both the ingredients 
for the blend and the blending steps that occur. 

blend off Reworking off-specification material by introducing a small percentage back into 
another run of the same product. 

blind execution The mode of execution of a program that does not require the user to review or 
change the processing options set for the program, and does not require user 
intervention after the program has been launched. 

boleto In Brazil, the document requesting payment by a supplier or a bank on behalf of a 
supplier. 

bolla doganale VAT-Only Vouchers for Customs. In Italy, a document issued by the customs 
authority to charge VAT and duties on extra-EU purchasing. 

bookmark A shortcut to a location in a document or a specific place in an application or 
application suite. 
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bordero & cheque In Brazil, bank payment reports. 

broker A program that acts as an intermediary between clients and servers to coordinate 
and manage requests. 

BTL91 In the Netherlands, the ABN/AMRO electronic banking file format that enables 
batches with foreign automatic payment instructions to be delivered. 

budgeted volume A statement of planned volumes (capacity utilization) upon which budgets for the 
period have been set. 

bunkering A rate per ton or a sum of money that is charged for placing fuel on board; can 
also mean the operation itself.  

business function An encapsulated set of business rules and logic that can normally be re-used by 
multiple applications. Business functions can execute a transaction or a subset of 
a transaction (check inventory, issue work orders, and so on). Business functions 
also contain the APIs that allow them to be called from a form, a database trigger, 
or a non-EnterpriseOne application. Business functions can be combined with 
other business functions, forms, event rules, and other components to make up an 
application. Business functions can be created through event rules or third-
generation languages, such as C. Examples of business functions include Credit 
Check and Item Availability. 

business function 
event rule 

Encapsulated, reusable business logic that is created by using through event rules 
rather than C programming. Contrast with embedded event rule. See also event 
rule. 

business object 
library 

[In interoperability] The repository that stores EnterpriseOne business objects, 
which consist of Java or CORBA objects.  

business unit A financial entity that is used to track the costs, revenue, or both, of an 
organization. A business unit can also be defined as a branch/plant in which 
distribution and manufacturing activities occur. Additionally, in manufacturing 
setup, work centers and production lines must be defined as business units; but 
these business unit types do not have profit/loss capability. 

business view Used by EnterpriseOne applications to access data from database tables. A 
business view is a means for selecting specific columns from one or more tables 
with data that will be used in an application or report. It does not select specific 
rows and does not contain any physical data. It is strictly a view through which 
data can be handled. 

business view design 
aid (BDA) 

An EnterpriseOne GUI tool for creating, modifying, copying, and printing 
business views. The tool uses a graphical user interface. 

buy-back crude In foreign producing oil countries, that portion of the host government’s share of 
“participation crude” which it permits the company holding a concession to “buy 
back.”  

CAB In Italy, the bank branch code or branch ID. A five-digit number that identifies 
any agency of a specific bank company in Italy. 

cadastro de pessoas 
físicas 

Cadastro de pessoas físicas. In Brazil, the federal tax ID for a person. 

category code A code that identifies a collection of objects sharing at least one common 
attribute. 
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central object A software component that resides on a central server. 

central objects merge A process that blends a customer’s modifications with the objects in a current 
release with objects in a new release. 

central server A computer that has been designated to contain the originally installed version of 
the software (central objects) for deployment to client computers. 

certificate input See direct input. 

certificate of analysis 
(COA) 

A document that is a record of all of the testing which has been performed against 
an item, lot, or both, plus the test results for that item and lot. 

change management [In software development] A process that aids in controlling and tracking the 
evolution of software components. 

change order In PeopleSoft, an addendum to the original purchase order that reflects changes in 
quantities, dates, or specifications in subcontract-based purchasing. A change 
order is typically accompanied by a formal notification. 

chargeback A receipt application method that generates an invoice for a disputed amount or 
for the difference of an unpaid receipt. 

chart EnterpriseOne term for tables of information that appear on forms in the software. 
See forms. 

check-in location The directory structure location for the package and its set of replicated objects. 
This location is usually \\deploymentserver\release\path_code\ 
package\packagename. The subdirectories under this path are where the central C 
components (source, include, object, library, and DLL file) for business functions 
are stored. 

checksum value A computed value that depends on the contents of a block of data, and that is 
transmitted or stored with the data to detect whether errors have occurred in the 
transmission or storage. 

class [In object-oriented programming] A category of objects that share the same 
characteristics. 

clean cargo Term that refers to cargoes of gasoline and other refined products. See also dirty 
cargo. 

client access The ability to access data on a server from a client machine. 

client machine Any machine that is connected to a network and that exchanges data with a 
server. 

client workstation A network computer that runs user application software and is able to request data 
from a server. 

ClieOp03 In the Netherlands, the euro-compliant uniform electronic banking file format that 
enables batches with domestic automatic direct debit instructions and batches 
with domestic payment instructions to be delivered. 

ClieOp2 In the Netherlands, the uniform electronic banking file format that enables 
batches with domestic automatic direct debit instructions and batches with 
domestic payment instructions to be delivered. 
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cluster Two or more computers that are grouped together in such a way that they behave 
like a single computer. 

co-existence A condition where two or more applications or application suites access one or 
more of the same database tables within the same enterprise. 

cold test The temperature at which oil becomes solid. Generally considered to be 5 degrees 
F lower than the pour point. 

commitment The number of items that are reserved to fill demand. 

common object 
request broker 
architecture 

An object request broker standard that is endorsed by the Object Management 
Group. 

compa-ratio An employee’s salary divided by the midpoint amount for the employee’s pay 
grade. 

component changeout See component swap. 

component object 
model (COM) 

A specification developed by Microsoft for building software components that 
can be assembled into programs or add functionality to existing programs running 
on Microsoft Windows platforms. COM components can be written in a variety 
of languages, although most are written in C++, and can be unplugged from a 
program at runtime without having to recompile the program. 

component swap In Equipment/Plant Management, the substitution of an operable component for 
one that requires maintenance. Typically, you swap components to minimize 
equipment downtime while servicing one of the components. A component swap 
can also mean the substitution of one parent or component item for another in its 
associated bill of material. 

conference room pilot 
environment  

An EnterpriseOne environment that is used as a staging environment for 
production data, which includes constants and masters tables such as company 
constants, fiscal date patterns, and item master. Use this environment along with 
the test environment to verify that your configuration works before you release 
changes to end-users. 

configurable network 
computing (CNC) 

An application architecture that allows interactive and batch applications that are 
composed of a single code base to run across a TCP/IP network of multiple server 
platforms and SQL databases. The applications consist of re-usable business 
functions and associated data that can be configured across the network 
dynamically. The overall objective for businesses is to provide a future-proof 
environment that enables them to change organizational structures, business 
processes, and technologies independently of each other. 

configurable 
processing engine 

Handles all “batch” processes, including reporting, Electronic Data Exchange 
(EDIt) transactions, and data duplication and transformation (for data 
warehousing). This ability does not mean that it exists only on the server; it can 
be configured to run on desktop machines (Windows 95 and NT Workstation) as 
well. 

configuration 
management 

A rules-based method of ordering assemble-to-order or make-to-order products in 
which characteristics of the product are defined as part of the Sales Order Entry 
process. Characteristics are edited by using Boolean logic, and then translated 
into the components and routing steps that are required to produce the product. 
The resulting configuration is also priced and costed, based on the defined 
characteristics. 
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configured item 
segment 

A characteristic of a configured item that is defined during sales order entry. For 
example, a customer might specify a type of computer hard drive by stating the 
number of megabytes of the hard drive, rather than a part number. 

consuming location The point in the manufacturing routing where a component or subassembly is 
used in the production process. In kanban processing, the location where the 
kanban container materials are used in the manufacturing process and the kanban 
is checked out for replenishment. 

contra/clearing 
account 

A G/L account used by the system to offset (balance) journal entries. For 
example, you can use a contra/clearing account to balance the entries created by 
allocations. 

contribution to profit Selling price of an item minus its variable costs. 

control table A table that controls the program flow or plays a major part in program control. 

control table 
workbench 

During the Installation Workbench process, Control Table Workbench runs the 
batch applications for the planned merges that update the data dictionary, user 
defined codes, menus, and user overrides tables. 

control tables merge A process that blends a customer’s modifications to the control tables with the 
data that accompanies a new release. 

corrective work order A work order that is used to formally request unscheduled maintenance and 
communicate all of the details pertaining to the requested maintenance task. 

corrective work order A work order that is used to formally request unscheduled maintenance and 
communicate all of the details pertaining to the requested maintenance task. 

cost assignment Allocating resources to activities or cost objects.  

cost component An element of an item’s cost—for example, material, labor, or overhead. 

cost object Any customer, product, service, contract, project, or other work unit for which 
you need a separate cost measurement. 

cost rollup A simulated scenario in which work center rates, material costs, and labor costs 
are used to determine the total cost of an item. 

costing elements The individual classes of added value or conversion costs. These elements are 
typically materials, such as raw and packaging; labor and machine costs; and 
overhead, such as fixed and variable. Each corporation defines the necessary 
detail of product costs by defining and tracking cost categories and subcategories. 

credit memo A negative amount that is used to correct a customer’s statement when he or she 
is overcharged. 

credit notice The physical document that is used to communicate the circumstances and value 
of a credit order. 

credit order A credit order is used to reflect products or equipment that is received or returned 
so that it can be viewed as a sales order with negative amounts. Credit orders 
usually add the product back into inventory. This process is linked with delivery 
confirmation. 
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cross segment edit A logic statement that establishes the relationship between configured item 
segments. Cross segment edits are used to prevent ordering of configurations that 
cannot be produced. 

crude oil assay A procedure for determining the distillation curve and quality characteristics of a 
crude oil.  

cumulative update A version of software that includes fixes and enhancements that have been made 
since the last release or update. 

currency 
relationships 

When converting amounts from one currency to another, the currency relationship 
defines the from currency and the to currency in PeopleSoft software. For 
example, to convert amounts from German marks to the euro, you first define a 
currency relationship between those two currencies. 

currency restatement The process of converting amounts from one currency into another currency, 
generally for reporting purposes. It can be used, for example, when many 
currencies must be restated into a single currency for consolidated reporting. 

current cost The cost that is associated with an item at the time a parts list and routing are 
attached to a work order or rate schedule. Current cost is based on the latest bill of 
material and routing for the item. 

customer pricing 
rules 

In Procurement, the inventory pricing rules that are assigned to a supplier. 

In Sales, inventory pricing rules that are assigned to a customer. 

D.A.S. 2 Reporting 
(DAS 2 or DADS 1) 

In France, the name of the official form on which a business must declare fees 
and other forms of remuneration that were paid during the fiscal year. 

data dictionary A dynamic repository that is used for storing and managing a specific set of data 
item definitions and specifications. 

data source 
workbench 

During the Installation Workbench process, Data Source Workbench copies all of 
the data sources that are defined in the installation plan from the Data Source 
Master and Table and Data Source Sizing tables in the Planner data source to the 
System - release number data source. It also updates the Data Source Plan detail 
record to reflect completion. 

data structure A description of the format of records in a database such as the number of fields, 
valid data types, and so on. 

data types Supplemental information that is attached to a company or business unit. 
Narrative type contains free-form text. Code type contains dates, amounts, and so 
on. 

datagram A self-contained packet of information that is forwarded by routers, based on their 
address and the routing table information. 

date pattern A period of time that is set for each period in standard and 52-period accounting 
and forecasting. 

DCE See distributed computing environment. 

DEB See déclaration d’echange de biens. 
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debit memo In Accounts Payable, a voucher that is entered with a negative amount. Enter this 
type of voucher when a supplier sends you a credit so that you can apply the 
amount to open vouchers when you issue payment to the supplier. 

debit memo A form that is issued by a customer, requesting an adjustment of the amount, 
which is owed to the supplier. 

debit statement A list of debit balances. 

de-blend When blend off does not result in a product that is acceptable to customers. The 
further processing of product to adjust specific physical and chemical properties 
to within specification ranges. See also blend off. 

déclaration d’echange 
de biens (DEB) 

The French term that is used for the Intrastat report. 

delayed billing The invoicing process is delayed until the end of a designated period.  

delta load A batch process that is used to compare and update records between specified 
environments. 

denominated-in 
currency 

The company currency in which financial reports are based. 

deployment server A server that is used to install, maintain, and distribute software to one or more 
enterprise servers and client workstations. 

detail The specific information that makes up a record or transaction. Contrast with 
summary. 

detail information Information that primarily relates to individual lines in a sales or purchase order. 

direct connect A transaction method in which a client application communicates interactively 
and directly with a server application. See also batch-of-one immediate, store-
and-forward. 

direct input The system calculates the net units when you enter gross volume, temperature, 
and gravity or density. This data is generally entered during product receiving 
from the certificate that is prepared by an independent inspector. 

direct ship orders A purchase order that is issued to a third-party supplier who designates the 
destination as the customer. A direct ship sales order is also created for the 
customer. Direct ship orders occur when a product is not available from a 
company-owned or company-operated source, so the system creates an order to 
ship the product from a third-party source directly to the customer. Sometimes 
referred to as a drop ship or third-party supply. 

direct usage Consumption of resources that are attributable to specific production runs because 
the resources were directly issued to the schedule/order.  

director An EnterpriseOne user interface that guides a user interactively through an 
EnterpriseOne process. 

dirty cargo Term that refers to crude oil cargoes or other non-refined petroleum cargoes. See 
also clean cargo. 
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dispatch planning Efficient planning and scheduling of product deliveries. Considerations include: 

Dispatch groups 

Scheduled delivery date  

Scheduled delivery time 

Preferred delivery date  

Preferred delivery time 

Average delivery time for that geographical location 

Available resources 

Special equipment requirements at the product’s source or destination.  

displacement days The number of days that are calculated from today’s date by which you group 
vouchers for payment. For example, if today’s date is March 10 and you specify 
three displacement days, the system includes vouchers with a due date through 
March 13 in the payment group. Contrast with pay-through date. 

display sequence A number that the system uses to re-order a group of records on the form. 

distributed 
computing 
environment (DCE) 

A set of integrated software services that allows software which is running on 
multiple computers to perform seamless and transparently to the end-users. DCE 
provides security, directory, time, remote procedure calls, and files across 
computers running on a network. 

distributed data 
processing 

Processing in which some of the functions are performed across two or more 
linked facilities or systems. 

distributed database 
management system 
(DDBMS) 

A system for distributing a database and its control system across many 
geographically dispersed machines. 

do not translate 
(DNT) 

A type of data source that must exist on the AS/400 because of BLOB 
restrictions. 

double-byte character 
set (DBCS) 

A method of representing some characters by using one byte and other characters 
by using two bytes. Double-byte character sets are necessary to represent some 
characters in the Japanese, Korean, and Chinese languages. 

downgrade profile A statement of the hierarchy of allowable downgrades. Includes substitutions of 
items, and meeting tighter specifications for those products with wider or 
overlapping specification ranges. 

DTA Datenträgeraustausch. A Swiss payment format that is required by Telekurs 
(Payserv). 

dual pricing To provide prices for goods and services in two currencies. During the euro 
transition period, dual pricing between the euro and Economic and Monetary 
Union (EMU) member currencies is encouraged.  

dynamic link library 
(DLL) 

A set of program modules that are designed to be invoked from executable files 
when the executable files are run, without having to be linked to the executable 
files. They typically contain commonly used functions. 

dynamic partitioning The ability to dynamically distribute logic or data to multiple tiers in a 
client/server architecture. 
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economy of scale A phenomenon whereby larger volumes of production reduce unit cost by 
distributing fixed costs over a larger quantity. Variable costs are constant; but 
fixed costs per unit are reduced, thereby reducing total unit cost. 

edit mode A processing mode or condition where the user can alter the information in a 
form. 

edit rule A method that is used for formatting user entries, validating user entries, or both, 
against a predefined rule or set of rules. 

embedded event rule An event rule that is specific to a particular table or application. Examples include 
form-to-form calls, hiding a field that is based on a processing option value, or 
calling a business function. Contrast with business function event rule. See also 
event rule. 

employee work center A central location for sending and receiving all EnterpriseOne messages (system 
and user-generated), regardless of the originating application or user. Each user 
has a mailbox that contains workflow and other messages, including Active 
Messages. With respect to workflow, the Message Center is MAPI compliant and 
supports drag-and-drop work reassignment, escalation, forward and reply, and 
workflow monitoring. All messages from the message center can be viewed 
through EnterpriseOne messages or Microsoft Exchange. 

Emulator An item of software or firmware that allows one device to imitate the functioning 
of another. 

encapsulation The ability to confine access to and manipulation of data within an object to the 
procedures that contribute to the definition of that object. 

engineering change 
order (ECO) 

A work order document that is used to implement and track changes to items and 
resulting assemblies. The document can include changes in design, quantity of 
items required, and the assembly or production process. 

enhanced analysis 
database 

A database containing a subset of operational data. The data on the enhanced 
analysis database performs calculations and provides summary data to speed 
generation of reports and query response times. This solution is appropriate when 
external data must be added to source data, or when historical data is necessary 
for trend analysis or regulatory reporting. See also duplicated database, enterprise 
data warehouse. 

enterprise server A computer containing programs that collectively serve the needs of an enterprise 
rather than a single user, department, or specialized application. 

EnterpriseOne object A re-usable piece of code that is used to build applications. Object types include 
tables, forms, business functions, data dictionary items, batch processes, business 
views, event rules, versions, data structures, and media objects. See also object. 

EnterpriseOne 
process 

Allows EnterpriseOne clients and servers to handle processing requests and 
execute transactions. A client runs one process, and servers can have multiple 
instances of a process. EnterpriseOne processes can also be dedicated to specific 
tasks (for example, workflow messages and data replication) to ensure that critical 
processes do not have to wait if the server is particularly busy. 

EnterpriseOne web 
development 
computer 

A standard EnterpriseOne Windows developer computer with the additional 
components installed: 

Sun’s JDK 1.1. 
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JFC (0.5.1). 

Generator Package with Generator.Java and JDECOM.dll. 

R2 with interpretive and application controls/form. 

environment 
workbench 

During the Installation Workbench process, Environment Workbench copies the 
environment information and Object Configuration Manager tables for each 
environment from the Planner data source to the System release number data 
source. It also updates the Environment Plan detail record to reflect completion. 

equivalent fuel A barrel of equivalent fuel supplies six million BTUs of heat. Fuel gas quantities 
are usually calculated as equivalent fuel barrels in economic calculations for 
refinery operations. 

escalation monitor A batch process that monitors pending requests or activities, and restarts or 
forwards them to the next step or user after they have been inactive for a specified 
amount of time. 

ESR Einzahlungsschein mit Referenznummer. A pay slip with a reference number. 

event rule [In EnterpriseOne] A logic statement that instructs the system to perform one or 
more operations that are based on an activity that can occur in a specific 
application, such as entering a form or exiting a field. 

exit bar [In EnterpriseOne] The tall pane with icons in the left portion of many 
EnterpriseOne program windows.  

facility An entity within a business for which you want to track costs. For example, a 
facility might be a warehouse location, job, project, work center, or branch/plant. 
Sometimes referred to as a business unit. 

fast path [In EnterpriseOne] A command prompt that allows the user to move quickly 
among menus and applications by using specific commands. 

file handle A temporary reference (typically a number) that is assigned to a file which has 
been opened by the operating system and is used throughout the session to access 
the file. 

file server A computer that stores files to be accessed by other computers on the network. 

find/browse A type of form used to: 

Search, view, and select multiple records in a detail area.  

Delete records.  

Exit to another form.  

Serve as an entry point for most applications.  

firm planned order 
(FPO) 

A work order that has reached a user defined status. When this status is entered in 
the processing options for the various manufacturing programs, messages for 
those orders are not exploded to the components. 

fiscal date pattern A representation of the beginning date for the fiscal year and the ending date for 
each period in that year. 

fix/inspect A type of form used to view, add, or modify existing records. A fix/inspect form 
has no detail area. 
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fixed quantity A term that indicates the bill of material relationship between a parent item and its 
components or ingredients. When a bill of material component has a fixed 
quantity relationship to its parent, the amount of the component does not change 
when the software calculates parts list requirements for different work order 
quantities. Contrast with variable quantity. 

flexible account 
numbers 

The format of account numbers for journal entries. The format that you set up 
must be the three segments: 

Business unit. 

Object. 

Subsidiary. 

form design aid 
(FDA) 

The EnterpriseOne GUI development tool for building interactive applications 
and forms. 

form exit [In EnterpriseOne] An option that is available as a button on the Form Exit bar or 
as a selection in the Form menu. It allows users to open an interconnected form.  

form interconnection Allows one form to access and pass data to another form. Form interconnections 
can be attached to any event; however, they are normally used when a button is 
clicked. 

form type The following form types are available in EnterpriseOne: 

Find/browse.  

Fix/inspect.  

Header detail.  

Headerless detail.  

Message.  

Parent/child.  

Search/select. 

form-to-form call A request by a form for data or functionality from one of the connected forms. 

framework [In object-oriented systems] A set of object classes that provide a collection of 
related functions for a user or piece of software.  

frozen cost The cost of an item, operation, or process after the frozen update program is run; 
used by the Manufacturing Accounting system.  

frozen update 
program 

A program that freezes the current simulated costs, thereby finalizing them for use 
by the Manufacturing Accounting system. 

globally unique 
identifier (GUI) 

A 16-byte code in the Component Object Model that identifies an interface to an 
object across all computers and networks. 

handle [In programming] A pointer that contains the address of another pointer, which, in 
turn, contains the address of the desired object. 

The number of items that are reserved for a sales order, work order, or both, from 
a specific location, lot, or both. 

hard commitment 
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hard error An error that cannot be corrected by a given error detection and correction 
system. 

header Information at the beginning of a table or form. Header information is used to 
identify or provide control information for the group of records that follows. 

header information Information that pertains to the entire order. 

hover help A help function that provides contextual information or instructions when a 
cursor moves over a particular part of the interface element for a predefined 
amount of time.  

ICMS Imposto sobre circulação de mercadoria e servicos. In Brazil, a state tax that is 
applied to the movement of merchandise and some services. 

ICMS Substituto Imposto sobre circulacao de mercadoria e servicos substituto. In Brazil, the ICMS 
tax that is charged on interstate transactions, or on special products and clients. 

ICMS Substituto-
Markup 

See imposto sobre circulação de mercadoria e servicos substituto-markup. 

imposto de renda (IR) Brazilian income tax. 

imposto sobre 
produtos 
industrializados 

In Brazil, a federal tax that applies to manufactured goods (domestic and 
imported). 

imposto sobre 
services (ISS) 

In Brazil, tax on services. 

inbound document A document that is received from a trading partner using Electronic Data 
Interface (EDI). This document is also referred to as an inbound transaction. 

indented tracing Tracking all lot numbers of intermediates and ingredients that are consumed in 
the manufacture of a given lot of product, down through all levels of the bill of 
material, recipe, or formula. 

indexed allocations A procedure that allocates or distributes expenses, budgets, adjustments, and so 
on, among business units, based on a fixed percentage. 

indirect measurement Determining the quantity on-hand by:  

Measuring the storage vessels and calculating the content’s balance quantity.  

or 

Theoretically calculating consumption of ingredients and deducting them from 
the on-hand balance.  

indirect usage Determining what should have been used by multiplying receipt quantity of the 
parent times the quantity per statement in the formula, recipe, or bill of material. 
This transaction typically affects both consumption on schedule as well as issue 
from on-hand balances. 

in-process rework Recycling a semi processed product that does not meet acceptable standards. 
Further processing takes the product out of a given operation and sends it back to 
the beginning of that operation or a previous operation (for example, unreacted 
materials).  

Rework that is detected prior to receipt of finished goods and corrected during the 
same schedule run. 
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INPS withholding tax Instituto Nazionale di Previdenza Sociale withholding tax. In Italy, a 12% social 
security withholding tax that is imposed on payments to certain types of 
contractors. This tax is paid directly to the Italian social security office. 

inscrição estadual ICMS tax ID. In Brazil, the state tax ID. 

inscrição municipal ISS tax ID. In Brazil, the municipal tax ID. 

integrated toolset Unique to EnterpriseOne is an industrial-strength toolset that is embedded in the 
already comprehensive business applications. This toolset is the same toolset that 
is used by PeopleSoft to build EnterpriseOne interactive and batch applications. 
Much more than a development environment, however, the EnterpriseOne 
integrated toolset handles reporting and other batch processes, change 
management, and basic data warehousing facilities. 

integrity test A process that is used to supplement a company’s internal balancing procedures 
by locating and reporting balancing problems and data inconsistencies. 

interbranch sales 
order 

A sales order that is used for transactions between branch/plants other than the 
selling branch/plant. 

Interoperability The ability of different computer systems, networks, operating systems, and 
applications to work together and share information. 

inventory pricing rule A discount method that is used for purchases from suppliers and sales to 
customers. The method is based on effectivity dates, up-to quantities, and a factor 
by which you can mark up or discount the price or cost. 

inventory turn The number of times that the inventory cycles, or turns over, during the year. A 
frequently used method to compute inventory turnover is to divide the annual 
costs of sales by the average inventory level. 

invoice An itemized list of goods that are shipped or services that are rendered, stating 
quantities, prices, fees, shipping charges, and so on. Companies often have their 
invoices mailed to a different address than where they ship products. In such 
cases, the bill-to address differs from the ship-to address. 

IP See imposto sobre produtos industrializados. 

IR See imposto de renda. 

IServer Service Developed by PeopleSoft, this Internet server service resides on the Web server 
and is used to speed up delivery of the Java class files from the database to the 
client. 

ISS See imposto sobre servicos. 

jargon An alternate data dictionary item description that EnterpriseOne or PeopleSoft 
World displays, based on the product code of the current object. 

java application 
server 

A component-based server that resides in the middle-tier of a server-centric 
architecture and provides middleware services for security and state maintenance, 
along with data access and persistence. 

JDBNET A database driver that allows heterogeneous servers to access each other’s data. 

jde.ini A PeopleSoft file (or member for AS/400) that provides the runtime settings that 
are required for EnterpriseOne initialization. Specific versions of the file or 
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member must reside on every machine that is running EnterpriseOne, including 
workstations and servers. 

JDE.LOG The main diagnostic log file of EnterpriseOne. Always located in the root 
directory on the primary drive. Contains status and error messages from the 
startup and operation of EnterpriseOne. 

JDEBASE Database 
Middleware 

PeopleSoft proprietary database middleware package that provides two primary 
benefits: 

1. Platform-independent APIs for multidatabase access. These APIs are 
used in two ways: 

a. By the interactive and batch engines to dynamically generate platform-
specific SQL, depending on the data source request. 

b. As open APIs for advanced C business function writing. These APIs are 
then used by the engines to dynamically generate platform-specific SQL. 

2. Client-to-server and server-to-server database access. To accomplish this 
access, EnterpriseOne is integrated with a variety of third-party database drivers, 
such as Client Access 400 and open database connectivity (ODBC). 

JDECallObject An application programming interface that is used by business functions to 
invoke other business functions. 

JDEIPC Communications programming tools that are used by server code to regulate 
access to the same data in multiprocess environments, communicate and 
coordinate between processes, and create new processes. 

JDENET PeopleSoft proprietary middleware software. JDENET is a messaging software 
package. 

JDENET 
communications 
middleware 

PeopleSoft proprietary communications middleware package for EnterpriseOne. 
It is a peer-to-peer, message-based, socket-based, multiprocess communications 
middleware solution. It handles client-to-server and server-to-server 
communications for all EnterpriseOne supported platforms. 

just in time 
installation (JITI) 

EnterpriseOne’s method of dynamically replicating objects from the central 
object location to a workstation. 

just in time 
replication (JITR) 

EnterpriseOne’s method of replicating data to individual workstations. 
EnterpriseOne replicates new records (inserts) only at the time that the user needs 
the data. Changes, deletes, and updates must be replicated using Pull Replication. 

Kagami In Japan, summarized invoices that are created monthly (in most cases) to reduce 
the number of payment transactions. 

latitude The X coordinate of the location of an item in the warehouse. The system can use 
latitude, longitude, and height when suggesting locations for putaway, 
replenishment, and picking. 

laytime (or layhours) The amount of time that is allotted to a tanker at berth to complete loading or 
discharging cargo. This time is usually expressed in running hours, and is fixed 
by prior agreement between the vessel owner and the company that is chartering 
the vessel. Laytime is stipulated in the charter, which states exactly the total of 
number of hours that are granted at both loading and unloading ports, and 
indicates whether such time is reversible. A statement of “Seventy-Two Hours, 
Reversible” means that a total of 72 hours is granted overall at both ports, and any 
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time saved at one port can be applied as a credit at the other port.  

For example, if the vessel uses only 32 hours instead of 36 hours to load cargo, it 
can apply an additional four hours to the 36 hours allotted at the discharge port. 
Such considerations are important for purposes of computing demurrage. 

leading zeros A series of zeros that certain facilities in PeopleSoft systems place in front of a 
value that is entered. This situation normally occurs when you enter a value that is 
smaller than the specified length of the field. For example, if you enter 4567 in a 
field that accommodates eight numbers, the facility places four zeros in front of 
the four numbers that you enter. The result appears as 00004567. 

ledger type A code that designates a ledger which is used by the system for a particular 
purpose. For example, all transactions are recorded in the AA (actual amounts) 
ledger type in their domestic currency. The same transactions can also be stored 
in the CA (foreign currency) ledger type. 

level break The position in a report or text where a group of similar types of information ends 
and another one begins. 

libro IVA Monthly VAT report. In Italy, the term for the report that contains the detail of 
invoices and vouchers that were registered during each month. 

line of business A description of the nature of a company’s work; also a tool to control the 
relationship with that customer, including product pricing. 

linked service type A service type that is associated with a primary service type. Linked service types 
can be cancelled, and the maintenance tasks are performed when the primary 
service type to which they are linked comes due. You can specify whether the 
system generates work orders for linked service types, as well as the status that 
the system assigns to work orders that have already been generated. Sometimes 
referred to as associated service types. See also primary service type and service 
type. 

livro razao In Brazil, a general ledger report. 

load balancing The act of distributing the number of processes proportionally to all servers in a 
group to maximize overall performance. 

location workbench During the Installation Workbench process, Location Workbench copies all 
locations that are defined in the installation plan from the Location Master table 
in the Planner data source to the System data source. 

log files Files that track operations for a process or application. Reviewing log files is 
helpful for troubleshooting problems. The file extension for log files is .LOG. 

logic data source Any code that provides data during runtime. 

logical compartment One of two ways that is identified in the transportation constants to display 
compartments on vehicles. Logical display numbers the compartments 
sequentially.  

For example, if two vehicles are on a trip and each vehicle has three 
compartments, the logical display is 1,2,3,4,5,6. 

logical file A set of keys or indices that is used for direct access or ordered access to the 
records in a physical file. Several logical files can have different accesses to a 
physical. 
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logical shelf A logical, not physical, location for inventory that is used to track inventory 
transactions in loan/borrow, or exchange agreements with other companies. See 
also logical warehouse. 

logical warehouse Not a physical warehouse containing actual inventory, but a means for storing and 
tracking information for inventory transactions in loan/borrow, or exchange 
agreements with other companies. 

longitude The Y coordinate of the location of an item in the warehouse. The system can use 
latitude, longitude, and height when suggesting locations for putaway, 
replenishment, and picking. 

LSV Lastschriftverfahren. A Swiss auto debit format that is required by Telekurs 
(Payserv). 

mail merge A mass-mail facility that takes names, addresses, and (sometimes) pertinent facts 
about recipients and merges the information into a form letter or a similarly basic 
document. 

mailmerge 
workbench 

[In EnterpriseOne] An application that merges Microsoft Word 6.0 (or higher) 
word-processing documents with EnterpriseOne records to automatically print 
business documents. 

main fuels Usually refers to bulk fuel products, but sometimes includes packaged products. 

maintenance loop See maintenance route. 

maintenance route A method of performing PMs for multiple pieces of equipment from a single 
preventive maintenance work order. A maintenance route includes pieces of 
equipment that share one or more identical maintenance tasks which can be 
performed at the same time for each piece of equipment. Sometimes referred to as 
maintenance loop. 

maintenance work 
order 

In PeopleSoft EnterpriseOne systems, a term that is used to distinguish work 
orders created for the performance of equipment and plant maintenance from 
other work orders, such as manufacturing work orders, utility work orders, and 
engineering change orders. 

manufacturing and 
distribution planning 

Planning that includes resource and capacity planning, and material planning 
operations. Resource and capacity planning allows you to prepare a feasible 
production schedule that reflects your demand forecasts and production 
capability. Material Planning Operations provides a short-range plan to cover 
material requirements that are needed to make a product. 

mapping A set of instructions that describes how one data structure passes data to another. 

master business 
function 

An interactive master file that serves as a central location for adding, changing, 
and updating information in a database. 

master business 
function 

A central system location for standard business rules about entering documents, 
such as vouchers, invoices, and journal entries. Master business functions ensure 
uniform processing according to guidelines that you establish. 

master table A database table that is used to store data and information that is permanent and 
necessary to the system’s operation. Master tables might contain data such as paid 
tax amounts, supplier names, addresses, employee information, and job 
information. 
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matching document A document that is associated with an original document to complete or change a 
transaction. For example, a receipt is the matching document of an invoice. 

media object An electronic or digital representation of an object.  

media storage objects Files that use one of the following naming conventions that are not organized into 
table format: Gxxx, xxxGT, or GTxxx. 

memory violation An error that occurs as the result of a memory leak. 

menu selection An option on a menu that initiates a software function directly.  

message center A central location for sending and receiving all EnterpriseOne messages (system- 
and user-generated), regardless of the originating application or user. 

messaging application 
programming 
interface (MAPI) 

An architecture that defines the components of a messaging system and how they 
behave. It also defines the interface between the messaging system and the 
components. 

metal content A series of properties of a blended product that help to determine its suitability for 
a prescribed purpose. 

metals management The process of maintaining information about the location and status of durable 
product containers such as liquid petroleum gas (LPG) cylinders. 

mobile inventory Inventory that is transferred from a depot to a barge or truck for milk-run 
deliveries. 

modal A restrictive or limiting interaction that is created by a given condition of 
operation. Modal often describes a secondary window that restricts a user’s 
interaction with other windows. A secondary window can be modal with respect 
to its primary window or to the entire system. A modal dialog box must be closed 
by the user before the application continues. 

model work order For scheduled preventive maintenance or for a condition-based alert, a model 
work order functions as a template for the creation of other work orders. You can 
assign model work orders to service types and condition-based alerts. When the 
service type comes due or the alert is generated, the system automatically 
generates a work order that is based on information from the model work order. 

modeless Not restricting or limiting interaction. Modeless often describes a secondary 
window that does not restrict a user’s interaction with other windows. A modeless 
dialog box stays on the screen and is available for use at any time, but also 
permits other user activities. 

multiple stocking 
locations 

Authorized storage locations for the same item number at locations, in addition to 
the primary stocking location. 

multitier architecture A client/server architecture that allows multiple levels of processing. A tier 
defines the number of computers that can be used to complete some defined task. 

named event rules 
(NER) 

Also called business function event rules. Encapsulated, re-usable business logic 
that is created by using event rules, rather than C programming. 

national language 
support (NLS) 

Mechanisms that are provided to facilitate internationalization of both system and 
application user interfaces. 
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natureza da operação Transaction nature. In Brazil, a code that classifies the type of commercial 
transaction to conform to the fiscal legislation. 

negative pay item An entry in an account that indicates a prepayment. For example, you might 
prepay a supplier before goods are sent or prepay an employee’s forecasted 
expenses for a business trip. The system stores these pending entries, assigning 
them a minus quantity as debit amounts in a designated expense account. After 
the prepaid goods are received or the employee submits an expense report, 
entering the actual voucher clears all of the negative pay items by processing 
them as regular pay items. Note that a negative pay item can also result from 
entering a debit memo (A/P) or a credit memo (A/R). 

net added cost The cost to manufacture an item at the current level in the bill of material. Thus, 
for manufactured parts, the net added cost includes labor, outside operations, and 
cost extras applicable to this level in the bill of material, but not materials (lower-
level items). For purchased parts, the net added cost also includes the cost of 
materials. 

next status The next step in the payment process for payment control groups. The next status 
can be either WRT (write) or UPD (update). 

node A termination point for two or more communications links. A node can serve as 
the control location for forwarding data among the elements of a network or 
multiple networks, as well as performing other networking and, in some cases, 
local processing. 

non-inventory items See non-stock items. 

non-list price A price for bulk products that is determined by its own algorithms, such as a 
rolling average or commodity price plus. 

non-prime product A manufactured product with revenue potential that is less than the product 
planned for, or scheduled to be produced. 

non-stock items Items that the system does not account for as part of the inventory. For example, 
office supplies, or packaging materials can be non-stock items. 

nota fiscal In Brazil, a legal document that must accompany all commercial transactions. 

nota fiscal fatura In Brazil, a nota fiscal and invoice information. 

notula In Italy, the process whereby a business does not recognize value added tax until 
the payment of a voucher. 

object configuration 
manager (OCM) 

EnterpriseOne’s object request broker and the control center for the runtime 
environment. It keeps track of the runtime locations for business functions, data, 
and batch applications. When one of these objects is called, the Object 
Configuration Manager directs access to it by using defaults and overrides for a 
given environment and user. 

object embedding When an object is embedded in another document, an association is maintained 
between the object and the application that created it; however, any changes made 
to the object are also only kept in the compound document. See also object 
linking. 

object librarian A repository of all versions, applications, and business functions that are re-
usable in building applications. 
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object linking When an object is linked to another document, a reference is created with the file 
in which the object is stored, as well as with the application that created it. When 
the object is modified, either from the compound document or directly through 
the file in which it is saved, the change is reflected in that application as well as 
anywhere it has been linked. See also object embedding. 

object linking and 
embedding (OLE) 

A technology for transferring and sharing information among applications by 
allowing the integration of objects from diverse applications, such as graphics, 
charts, spreadsheets, text, or an audio clip from a sound program. OLE is a 
compound document standard that was developed by Microsoft Corporation. It 
enables you to create objects with one application, and then link or embed them in 
a second application. Embedded objects retain their original format and links to 
the application that created them. See also object embedding, object linking. 

object management 
workbench (OMW) 

The change management system that is used for EnterpriseOne development. 

object-based 
technology (OBT) 

A technology that supports some of the main principles of object-oriented 
technology:  

Classes. 

Polymorphism.I 

Inheritance. 

Encapsulation. 

object-oriented 
technology (OOT) 

Brings software development past procedural programming into a world of re-
usable programming that simplifies development of applications. Object 
orientation is based on the following principles:  

Classes. 

Polymorphism.I 

Inheritance. 

Encapsulation. 

offsetting account An account that reduces the amount of another account to provide a net balance. 
For example, a credit of 200 to a cash account might have an offsetting entry of 
200 to an A/P Trade (liability) account. 

open database 
connectivity (ODBC) 

Defines a standard interface for different technologies to process data between 
applications and different data sources. The ODBC interface comprises set of 
function calls, methods of connectivity, and representation of data types that 
define access to data sources. 

open systems 
interconnection (OSI) 

The OSI model was developed by the International Standards Organization (ISO) 
in the early 1980s. It defines protocols and standards for the interconnection of 
computers and network equipment. 

order detail line A part of an order that contains transaction information about a service or item 
being purchased or sold, such as quantity, cost, price, and so on. 

order hold A flag that stops the processing of an order because it has exceeded the credit or 
budget limit, or has another problem. 

order-based pricing Pricing strategy that grants reductions in price to a customer. It is based upon the 
contents and relative size (volume or value) of the order as a whole. 
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outbound document A document that is sent to a trading partner using EDI. This term is also referred 
to as an outbound transaction. 

outturn The quantity of oil that is actually received into a buyer’s storage tanks when a 
vessel is unloaded. For various reasons (vaporization, clingage to vessel tank 
walls, and so on), the amount of a product pumped into shore tankage at 
unloading is often less than the quantity originally loaded onto the vessel, as 
certified by the Bill of Lading. Under a delivered or CIF outturn transaction, the 
buyer pays only for the barrels actually “turned out” by the vessel into storage.  

When a buyer is paying CIF Bill of Lading figures, a loss of 0.5% of total cargo 
volume is considered normal. Losses in excess of 0.5%, however, are either 
chargeable to the seller or are covered by specialized insurance that covers partial, 
as well as total, loss of the cargo. 

overhead In the distillation process, that portion of the charge that leaves the top of the 
distillation column as vapor. This definition is strictly as it relates to ECS. 

override conversion 
method 

A method of calculating exchange rates that is set up between two specific 
currencies. For those specific currencies, this method overrides the conversion 
method in General Accounting Constants and does not allow inverse rates to be 
used when calculating currency amounts. 

package / package 
build 

A collection of software that is grouped into a single entity for modular 
installation. EnterpriseOne objects are installed to workstations in packages from 
the deployment server. A package can be compared to a bill of material or kit that 
indicates the necessary objects for that workstation and where the installation 
program can find them on the deployment server. It is a point-in-time “snapshot” 
of the central objects on the deployment server. 

package location The directory structure location for the package and its set of replicated objects. 
This location is usually \\deployment server\release\path_code\package\ package 
name. The replicated objects for the package are placed in the subdirectories 
under this path. This location is also where the package is built or stored. 

package workbench During the Installation Workbench process, Package Workbench transfers the 
package information tables from the Planner data source to the System - release 
number data source. It also updates the Package Plan detail record to reflect 
completion. 

packaged products Products that, by their nature, must be delivered to the customer in containers 
which are suitable for discrete consumption or resale. 

pane/panel A resizable subarea of a window that contains options, components, or other 
related information. 

paper clip An icon that is used to indicate that a media object is attached to a form or record. 

parent/child form A type of form that presents parent/child relationships in an application on one 
form: 

The left portion of the form presents a tree view that displays a visual 
representation of a parent/child relationship.  

The right portion of the form displays a detail area in browse mode. The detail 
area displays the records for the child item in the tree.  

The parent/child form supports drag and drop functionality. 
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parent/child 
relationship 

See parent/component relationship. 

parent/component 
relationship 

1. In Capital Asset Management, the hierarchical relationship of a parent piece of 
equipment to its components. For example, a manufacturing line could be a parent 
and the machinery on the line could be components of the line. In addition, each 
piece of machinery could be a parent of still more components.  

2. In Product Data Management, a hierarchical relationship of the components 
and subassemblies of a parent item to that parent item. For example, an 
automobile is a parent item; its components and subassemblies include: engine, 
frame, seats, and windows.  

Sometimes referred to as parent/child relationship. 

partita IVA In Italy, a company fiscal identification number. 

pass-through A process where data is accepted from a source and forwarded directly to a target 
without the system or application performing any data conversion, validation, and 
so on. 

pay on consumption The method of postponing financial liability for component materials until you 
issue that material to its consuming work order or rate schedule. 

payment group A system-generated group of payments with similar information, such as a bank 
account. The system processes all of the payments in a payment group at the same 
time. 

PeopleSoft database See JDEBASE Database Middleware. 

performance tuning The adjustments that are made for a more efficient, reliable, and fast program. 

persistent object An object that continues to exist and retains its data beyond the duration of the 
process that creates it. 

pervasive device A type of intelligent and portable device that provides a user with the ability to 
receive and gather information anytime, from anywhere. 

planning family A means of grouping end items that have similarity of design or manufacture. 

plug-in A small program that plugs into a larger application to provide added 
functionality or enhance the main application. 

polymorphism A principle of object-oriented technology in which a single mnemonic name can 
be used to perform similar operations on software objects of different types. 

portal A Web site or service that is a starting point and frequent gateway to a broad 
array of on-line resources and services.  

Postfinance A subsidiary of the Swiss postal service. Postfinance provides some banking 
services. 

potency Identifies the percent of an item in a given solution. For example, you can use an 
80% potent solution in a work order that calls for 100% potent solution, but you 
would use 25% more, in terms of quantity, to meet the requirement (100 / 80 = 
1.25). 
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preference profile The ability to define default values for specified fields for a user defined 
hierarchy of items, item groups, customers, and customer groups. In Quality 
Management setup, this method links test and specification testing criteria to 
specific items, item groups, customers, or customer groups. 

preflush A work order inventory technique in which you deduct (relieve) materials from 
inventory when the parts list is attached to the work order or rate schedule. 

preventive 
maintenance cycle 

The sequence of events that make up a preventive maintenance task, from its 
definition to its completion. Because most preventive maintenance tasks are 
commonly performed at scheduled intervals, parts of the preventive maintenance 
cycle repeat, based on those intervals. 

preventive 
maintenance schedule 

The combination of service types that apply to a specific piece of equipment, as 
well as the intervals at which each service type is scheduled to be performed. 

primary service type A service type to which you can link related service types. For example, for a 
particular piece of equipment, you might set up a primary service type for a 1000-
hour inspection and a linked service type for a 500-hour inspection. The 1000-
hour inspection includes all of the tasks performed at 500 hours. When a primary 
service type is scheduled to be performed, the system schedules the linked service 
type. See also linked service type. 

pristine environment An EnterpriseOne environment that is used to test unaltered objects with 
PeopleSoft demonstration data or for training classes. You must have this 
environment so you can compare pristine objects that you modify. 

processing option A data structure that allows users to supply parameters that regulate the execution 
of a batch program or report.  

product data 
management (PDM) 

In PeopleSoft EnterpriseOne software, the system that enables a business to 
organize and maintain information about each item which it manufactures. 
Features of this system, such as bills of material, work centers, and routings, 
define the relationships among parents and components, and how they can be 
combined to manufacture an item. PDM also provides data for other 
manufacturing systems including Manufacturing Accounting, Shop Floor 
Management, and Manufacturing and Distribution Planning. 

product line A group of products with similarity in manufacturing procedures, marketing 
characteristics, or specifications that allow them to be aggregated for planning; 
marketing; and, occasionally, costing.  

product/process 
definition 

A combination of bill of material (recipe, formula, or both) and routing (process 
list). Organized into tasks with a statement of required consumed resources and 
produced resources. 

production 
environment 

An EnterpriseOne environment in which users operate EnterpriseOne software. 

program temporary 
fix (PTF) 

A representation of changes to PeopleSoft software that your organization 
receives on magnetic tapes or diskettes. 

project [In EnterpriseOne] A virtual container for objects being developed in Object 
Management Workbench. 

projected cost The target expenditure in added value for material, labor, and so on, during 
manufacture. See also standard cost. 
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promotion path The designated path for advancing objects or projects in a workflow. 

protocollo See registration number. 

PST Provincial sales tax. A tax that is assessed by individual provinces in Canada. 

published table Also called a “Master” table, this is the central copy to be replicated to other 
machines and resides on the “publisher” machine. The Data Replication Publisher 
Table (F98DRPUB) identifies all of the published tables and their associated 
publishers in the enterprise. 

publisher The server that is responsible for the published table. The Data Replication 
Publisher Table (F98DRPUB) identifies all of the published tables and their 
associated publishers in the enterprise. 

pull replication One of the EnterpriseOne methods for replicating data to individual workstations. 
Such machines are set up as pull subscribers that use EnterpriseOne’s data 
replication tools. The only time that pull subscribers are notified of changes, 
updates, and deletions is when they request such information. The request is in 
the form of a message that is sent, usually at startup, from the pull subscriber to 
the server machine that stores the Data Replication Pending Change Notification 
table (F98DRPCN). 

query by example 
(QBE) 

Located at the top of a detail area, this area is used to search for data to display in 
the detail area. 

rate scheduling A method of scheduling product or manufacturing families, or both.  

Also a technique to determine run times and quantities of each item within the 
family to produce enough of each individual product to satisfy demand until the 
family can be scheduled again.  

rate type For currency exchange transactions, the rate type distinguishes different types of 
exchange rates. For example, you can use both period average and period-end 
rates, distinguishing them by rate type. 

real-time Pertaining to information processing that returns a result so rapidly that the 
interaction appears to be instantaneous. 

receipt routing A series of steps that is used to track and move items within the receipt process. 
The steps might include in-transit, dock, staging area, inspection, and stock. 

referential integrity Ensures that a parent record cannot be deleted from the database when a child 
record for exists. 

regenerable Source code for EnterpriseOne business functions can be regenerated from 
specifications (business function names). Regeneration occurs whenever an 
application is recompiled, either for a new platform or when new functionality is 
added. 

register types and 
classes 

In Italian VAT Summary Reporting, the classification of VAT transactions. 

relationship Links tables together and facilitates joining business views for use in an 
application or report. Relationships that are created are based on indexes. 

rélevé d’identité 
bancaire (RIB) 

In France, the term that indicates the bank transit code, account number, and 
check digit that are used to validate the bank transit code and account number. 
The bank transit code consists of the bank code and agency code. The account 
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number is alphanumeric and can be as many as 11 characters. PeopleSoft supplies 
a validation routine to ensure RIB key correctness. 

remessa In Brazil, the remit process for A/R. 

render To include external data in displayed content through a linking mechanism. 

repasse In Brazil, a discount of the ICMS tax for interstate transactions. It is the 
adjustment between the interstate and the intrastate ICMS tax rates. 

replenishment point The location on or near the production line where additional components or 
subassemblies are to be delivered. 

replication server A server that is responsible for replicating central objects to client machines. 

report design aid 
(RDA) 

The EnterpriseOne GUI tool for operating, modifying, and copying report batch 
applications. 

repost In Sales, the process of clearing all commitments from locations and restoring 
commitments, based on quantities from the Sales Order Detail table (F4211). 

resident Pertaining to computer programs or data while they remain on a particular storage 
device. 

retorno In Brazil, the receipt process for A/R. 

RIB See rélevé d’identité bancaire. 

ricevute bancarie 
(RiBa) 

In Italy, the term for accounts receivable drafts. 

riepilogo IVA Summary VAT monthly report. In Italy, the term for the report that shows the 
total amount of VAT credit and debit. 

ritenuta d’acconto In Italy, the term for standard withholding tax. 

rollback [In database management] A feature or command that undoes changes in database 
transactions of one or more records. 

rollup See cost rollup. 

row exit [In EnterpriseOne] An application shortcut, available as a button on the Row Exit 
bar or as a menu selection, that allows users to open a form that is related to the 
highlighted grid record. 

runtime The period of time when a program or process is running. 

SAD The German name for a Swiss payment format that is accepted by Postfinance. 

SAR See software action request. 

scalability The ability of software, architecture, hardware, or a network to support software 
as it grows in size or resource requirements. 

scripts A collection of SQL statements that perform a specific task. 

scrub To remove unnecessary or unwanted characters from a string. 

search/select A type of form that is used to search for a value and return it to the calling field. 
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selection Found on PeopleSoft menus, selections represent functions that you can access 
from a menu. To make a selection, type the associated number in the Selection 
field and press Enter. 

serialize To convert a software object into a stream of bytes to store on a disk or transfer 
across a network.  

server map The server view of the object configuration mapping. 

server workbench During the Installation Workbench process, Server Workbench copies the server 
configuration files from the Planner data source to the System release number 
data source. It also updates the Server Plan detail record to reflect completion. 

service interval The frequency at which a service type is to be performed. Service intervals can be 
based on dates, periods, or statistical units that are user defined. Examples of 
statistical units are hours, miles, and fuel consumption. 

service type An individual preventive maintenance task or procedure, such as an inspection, 
lubrication, or overhaul. Service types can apply to a specific piece of equipment 
or to a class of equipment. You can specify that service types come due based on 
a predetermined service interval, or whenever the task that is represented by the 
service type becomes necessary. 

servlet A [small] program that extends the functionality of a Web server by generating 
dynamic content and interacting with Web clients by using a request-response 
paradigm. 

share path The network node under which one or more servers or objects reside. 

shop floor 
management 

A system that uses data from multiple system codes to help develop, execute, and 
manage work orders and rate schedules in the enterprise.  

silent mode A method for installing or running a program that does not require any user 
intervention. 

silent post A type of post that occurs in the background without the knowledge of the user. 

simulated cost After a cost rollup, the cost of an item, operation, or process according to the 
current cost scenario. This cost can be finalized by running the frozen update 
program. You can create simulated costs for a number of cost methods—for 
example, standard, future, and simulated current costs. See also cost rollup. 

single-byte character 
set (SBCS) 

An encoding scheme in which each alphabetic character is represented by one 
byte. Most Western languages, such as English, can be represented by using a 
single-byte character set. 

single-level tracking Finding all immediate parents where a specific lot has been used (consumed).  

single-voyage (spot) 
charter 

An agreement for a single voyage between two ports. The payment is made on the 
basis of tons of product delivered. The owner of the vessel is responsible for all 
expenses. 

slimer A script that changes data in a table directly without going through a regular 
database interface. 

smart field A data dictionary item with an attached business function for use in the Report 
Design Aid application. 
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SOC The Italian term for a Swiss payment format that is accepted by Postfinance. 

soft commitment The number of items that is reserved for sales orders or work orders in the 
primary units of measure. 

soft error An error from which an operating system or program is able to recover. 

software action 
request (SAR) 

An entry in the AS/400 database that is used for requesting modifications to 
PeopleSoft software. 

SOG The French term for a Swiss payment format that is accepted by Postfinance. 

source directory The path code to the business function source files belonging to the shared library 
that is created on the enterprise server. 

special period/year The date that determines the source balances for an allocation. 

specification merge The Specification merge is comprised of three merges:  

Object Librarian merge (via the Object Management Workbench). 

Versions List merge. 

Central Objects merge.  

The merges blend customer modifications with data that accompanies a new 
release. 

specification table 
merge workbench 

During the Installation Workbench process, Specification Table Merge 
Workbench runs the batch applications that update the specification tables. 

specifications A complete description of an EnterpriseOne object. Each object has its own 
specification, or name, which is used to build applications. 

spot charter See single-voyage charter. 

spot rates An exchange rate that is entered at the transaction level. Spot rates are not used on 
transactions between two EMU member currencies because exchange rates are 
irrevocably fixed to the euro.  

stamp tax In Japan, a tax that is imposed on drafts payable, receipts over 30000 Japanese 
yen, and all contracts. The party that issues any of the above documents is 
responsible for this tax. 

standalone Operating or capable of operating independently of certain other components of a 
computer system. 

standard cost The expected, or target cost of an item, operation, or process. Standard costs 
represent only one cost method in the Product Costing system. You can also 
calculate, for example, future costs or current costs. However, the Manufacturing 
Accounting system uses only standard frozen costs. 

standard costing A costing method that uses cost units that are determined before production. For 
management control purposes, the system compares standard costs to actual costs 
and computes variances. 

subprocess A process that is triggered by and is part of a larger process, and that generally 
consists of activities. 
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subscriber table The Subscriber table (F98DRSUB), which is stored on the Publisher Server with 
the Data Replication Publisher table (F98DRPUB), that identifies all of the 
subscriber machines for each published table. 

summary The presentation of data or information in a cumulative or totaled manner in 
which most of the details have been removed. Many systems offer forms and 
reports that summarize information which is stored in certain tables. Contrast with 
detail. 

super backflush To create backflush transactions for material, labor, or both, against a work order 
at predefined pay points in the routing. By doing so, you can relieve inventory 
and account for labor amounts at strategic points throughout the manufacturing 
process.  

supersession Specification that a new product is replacing an active product on a specified 
effective date. 

supplemental data Additional types of data for customers and suppliers. You can enter supplemental 
data for information such as notes, comments, plans, or other information that you 
want in a customer or supplier record. The system maintains this data in generic 
databases, separate from the standard master tables (Customer Master, Supplier 
Master, and Address Book Master). 

supplying location The location from which inventory is transferred once quantities of the item on 
the production line have been depleted. In kanban processing, the supplying 
location is the inventory location from which materials are transferred to the 
consuming location when the containers are replenished. 

system code A numeric or alphanumeric designation that identifies a specific system in 
EnterpriseOne software. 

system function [In EnterpriseOne] A named set of pre-packaged, re-usable instructions that can 
be called from event rules. 

table access 
management (TAM) 

The EnterpriseOne component that handles the storage and retrieval of user 
defined data. TAM stores information such as data dictionary definitions; 
application and report specifications; event rules; table definitions; business 
function input parameters and library information; and data structure definitions 
for running applications, reports, and business functions. 

table conversion 
workbench 

During the Installation Workbench process, Table Conversion Workbench runs 
the table conversions that change the technical and application tables to the 
format for the new release of EnterpriseOne. It also updates the Table 
Conversions and Controls detail records to reflect completion. 

table design aid 
(TDA) 

An EnterpriseOne GUI tool for creating, modifying, copying, and printing 
database tables. 

table event rules Use table event rules to attach database triggers (or programs) that automatically 
run whenever an action occurs against the table. An action against a table is 
referred to as an event. When you create an EnterpriseOne database trigger, you 
must first determine which event will activate the trigger. Then, use Event Rules 
Design to create the trigger. Although EnterpriseOne allows event rules to be 
attached to application events, this functionality is application-specific. Table 
event rules provide embedded logic at the table level. 

table handle A pointer into a table that indicates a particular row. 
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table space [In relational database management systems] An abstract collection of containers 
in which database objects are stored. 

task [In Solution Explorer and EnterpriseOne Menu] A user defined object that can 
initiate an activity, process, or procedure. 

task view A group of tasks in Solution Explorer or EnterpriseOne Menu that are arranged in 
a tree structure. 

termo de abertura In Brazil, opening terms for the transaction journal. 

termo de 
encerramento 

In Brazil, closing terms for the transaction journal. 

three-tier processing The task of entering, reviewing, approving, and posting batches of transactions. 

three-way voucher 
match 

The process of comparing receipt information to supplier’s invoices to create 
vouchers. In a three-way match, you use the receipt records, the purchase order, 
and the invoice to create vouchers. 

threshold percentage In Capital Asset Management, the percentage of a service interval that you define 
as the trigger for maintenance to be scheduled. For example, you might set up a 
service type to be scheduled every 100 hours with a threshold percentage of 90 
percent. When the equipment accumulates 90 hours, the system schedules the 
maintenance. 

throughput 
agreement 

A service agreement in which a business partner agrees to store and manage 
product for another business partner for a specified time period. The second 
partner actually owns the stock that is stored in the first partner’s depot, although 
the first partner monitors the stock level; suggests replenishments; and unloads, 
stores, and delivers product to the partner or its customers. The first partner 
charges a fee for storing and managing the product. 

throughput 
reconciliation 

Reconcile confirmed sales figures in a given period with the measured 
throughput, based on the meter readings. This process is designed to catch 
discrepancies that are due to transactions not being entered, theft, faulty meters, or 
some combination of these factors. This reconciliation is the first stage. See also 
operational reconciliation. 

token [In Object Management Workbench] A flag that is associated with each object 
which indicates whether you can check out the object. 

tolerance range The amount by which the taxes that you enter manually can vary from the tax that 
is calculated by the system. 

TP monitor Transaction Processing monitor. A monitor that controls data transfer between 
local and remote terminals and the applications that originated them. TP monitors 
also protect data integrity in the distributed environment and can include 
programs that validate data and format terminal screens. 

tracing The act of researching a lot by going backward, to discover its origin. 

tracking The act of researching a lot by going forward, to discover where it is used. 

transaction set An electronic business transaction (EDI Standard document) composed of 
segments.  
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transclude To include the external data in the displayed content through a linking 
mechanism. 

transfer order An order that is used to ship inventory between branch/plants within your 
company and to maintain an accurate on-hand inventory amount. An interbranch 
transfer order creates a purchase order for the shipping location and a sales order 
for the receiving location. 

translation 
adjustment account 

An optional G/L account used in currency balance restatement to record the total 
adjustments at a company level. 

translator software The software that converts data from an application table format to an EDI 
Standard Format, and from EDI Standard Format to application table format. The 
data is exchanged in an EDI Standard, such as ANSI ASC X12, EDIFACT, UCS, 
or WINS. 

tree structure A type of graphical user interface that displays objects in a hierarchy. 

trigger Allows you to attach default processing to a data item in the data dictionary. 
When that data item is used on an application or report, the trigger is invoked by 
an event which is associated with the data item. EnterpriseOne also has three 
visual assist triggers:  

Calculator. 

Calendar.  

Search form. 

two-way voucher 
match 

The process of comparing purchase order detail lines to the suppliers’ invoices to 
create vouchers. You do not record receipt information. 

universal batch 
engine (UBE) 

[In EnterpriseOne] A type of application that runs a noninteractive process. 

unnormalized Data that is a random collection of data elements with repeating record groups 
scattered throughout. Also see Normalized. 

user overrides merge The User Overrides merge adds new user override records into a customer’s user 
override table. 

user-defined code 
(UDC) 

A value that a user has assigned as being a valid entry for a given or specific field. 

utility A small program that provides an addition to the capabilities which are provided 
by an operating system. 

variable numerator 
allocations 

A procedure that allocates or distributes expenses, budgets, adjustments, and so 
on, among business units, based on a variable. 

variable quantity A term that indicates the bill of material relationship between a parent item and its 
components or ingredients. When a bill of material component has a variable 
quantity relationship to its parent, the amount of the component changes when the 
software calculates parts list requirements for different work order quantities. 
Contrast with fixed quantity. 

variance 1. In Product Costing and Manufacturing Accounting, the difference between the 
frozen standard cost, the current cost, the planned cost, and the actual cost. For 
example, the difference between the frozen standard cost and the current cost is 
an engineering variance. Frozen standard costs come from the Cost Components 
table, and the current costs are calculated by using the current bill of material, 
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routing, and overhead rates.  

2. In Capital Asset Management, the difference between revenue that is generated 
by a piece of equipment and costs that are incurred by the equipment. 

versions list merge The Versions List merge preserves any non-XJDE and non-ZJDE version 
specifications for objects that are valid in the new release as well as their 
processing options data. 

VESR Verfahren Einzahlungsschein mit Referenznummer. The processing of an ESR 
pay slip with reference line through accounts receivable and accounts payable. 

visual assist Forms that can be invoked from a control to assist the user in determining what 
data belongs in the control. 

voucher logging The process of entering vouchers without distributing amounts to specific G/L 
accounts. The system initially distributes the total amount of each voucher to a 
G/L suspense account, where it is held until you redistribute it to the correct G/L 
account. 

wareki date format In Japan, a calendar format, such as Showa or Heisei. When a new emperor 
begins to reign, the government chooses the title of the date format and the year 
starts over at one. For instance, January 1, 1998, is equal to Heisei 10, January 
1st. 

wash down A minor cleanup between similar product runs. Sometimes used in reference to 
the sanitation process of a food plant. 

wchar_t An internal type of a wide character. Used for writing portable programs for 
international markets. 

web server A server that sends information as requested by a browser and uses the TCP/IP set 
of protocols. 

work order life cycle In Capital Asset Management, the sequence of events through which a work order 
must pass to accurately communicate the progress of the maintenance tasks that it 
represents. 

workfile A system-generated file that is used for temporary data processing. 

workflow According to the Workflow Management Coalition, worlflow means “the 
automation of a business process, in whole or part, during which documents, 
information, or tasks are passed from one participant to another for action, 
according to a set of procedural rules.”  

workgroup server A network server usually containing subsets of data that are replicated from a 
master network server. 

WorldSoftware 
architecture 

The broad spectrum of application design and programming technology that 
PeopleSoft uses to achieve uniformity, consistency, and complete integration 
throughout its software. 

write payment A step in processing payments. Writing payments includes printing checks, drafts, 
and creating a bank tape table. 

write-off A method for getting rid of inconsequential differences between amounts. For 
example, you can apply a receipt to an invoice and write off the difference. You 
can write off both overpayments and underpayments. 
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Z file For store and forward (network disconnected) user, EnterpriseOne store-and-
forward applications perform edits on static data and other critical information 
that must be valid to process an order. After the initial edits are complete, 
EnterpriseOne stores the transactions in work tables on the workstation. These 
work table are called Z files. When a network connection is established, Z files 
are uploaded to the enterprise server; and the transactions are edited again by a 
master business function. The master business function then updates the records 
in your transaction files. 

z-process A process that converts inbound data from an external system into an 
EnterpriseOne software table or converts outbound data into an interface table for 
an external system to access. 

zusammenfassende 
melding 

In Germany, the term for the EU Sales Listing. 

435 



Index 

: values in the run-time structures, 239, 242, 
246 

Advanced report enhancements, 156 :batch processes 
Advanced Version Prompting form, 263 subsystem jobs, 272 
After last object 

A values in the run-time structures, 241, 245 
Aggregate objects 

About object naming conventions, 19 definition, 114, 335 
Accessing BrowsER for a report or version, 215 Aggregations form, 114, 335 
Accessing properties for table conversion 

versions, 206 
types of totals, 115, 335 

Aligning fields or columns within or across 
sections, 139 Accessing the Work With Batch Versions form, 

199 Aligning report objects within or across sections 
Activating the drill down feature, 176 guidelines, 139 
Adding a calculation row, 133 Alignment 
Adding a constant row, 134 setting the grid alignment, 106 
Adding a data row, 132 Alignment of text, 153 
Adding a date title to a financial report, 170 Alpha variable 
Adding a detail section, 31 data field, 122 
Adding a new printer, 282 Alternative favorites descriptions, 180 
Adding a smart field, 109 Application reports, 40 
Adding a sum row, 133 create with the Director, 79 
Adding a tab to a processing options template, 

183 
creating, 81 
definition, 79, 81 

Adding an API record to the subsystem table, 
275, 276 

level breaks, 90 
page breaks, 90 

Adding an underline row, 134 sort properties, 90 
Adding attachments/comments to a report, 100 Applications 
Adding business view columns to the detail 

section 
batch processing, 220 

Assigning your accounting periods to the 
column headings, 174 group, 57 

Adding lines or a box to a field, 154 Assignment, 157 
Adding notes to a favorite, a folder, or a 

subfolder, 180 
Assignment form, 160 
Associated Description Properties form, 334 

Adding or modifying a director template, 189 Associating a description with a level-break 
header, 113 Adding or removing a business view column in 

a detail section, 120 Associating OSA interfaces, 361 
Adding smart fields, 108 Attaching a system function to an event, 163 
Adding smart fields to an application report, 84 Attaching logic for custom sections, 168 
Adding text variables, 162 Attaching logic to joined sections, 227 
Adding, modifying, or deleting comments to a 

data field, 101 
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access data selection and sequencing, 203 Available objects, 304 
accessing the Work With Batch Versions 

form, 199 
batch processing, 237 
lifespan of objects in section level events, 314 

change Batch Versions (P98305) processing 
options, 212 

section level events, 305 

B change processing options, 202 
change the design, 199 Barcode font, 146, 153 characteristics, 196 copying barcode printer information for a 

new printer, 298 check in or out, 210 
copy, 208 deleting barcode support information for a 

printer, 298 create, 209 
erase the check-out record, 211 modifying printer information, 298 move specifications to an enterprise server, 

213 setting up, 146 
setting up for EnterpriseOne, 297 reports, 196 Basic report enhancements, 99 run, 198 Batch database maintenance version detail, 207 database output, 216 Before level break table conversion, 216 values in the run-time structures, 239, 243 table I/O (in event rules), 216 Boolean logic Batch events, 232 sort information for a report, 262 additional batch events, 232 Boxes Do_Section event, 232 defining for data fields, 154 page footer section level events, 235 BrowsER page header section level events, 234 access for a report or version, 215 report footer section level events, 235 Business functions report header section level events, 235 performing calculations, 349 section level events, 233 Business Functions form, 171 system functions, 236 Business view, 6 variable events, 235 add or remove columns in detail section, 33 Batch processes adding to favorites folder or subfolder, 179 subsystem jobs, 272 alternative favorites descriptions, 180 subsystem jobs, defining, 274 choose from a list of favorites, 42, 55, 68, 82 Subsystem jobs, defining, 274 choose from Favorites, 32 Batch processing, 220 columns batch events, 232 add to a columnar section, 120 batch run-time processing, 237 add to a group section, 120 data selection and sequencing, 227 add to a tabular section, 120 database output, 216 select for a detail section, 31 level-break processing, 229 setting up as favorites, 178 overview, 5 subsection join, 118 report design tool, 220 translating descriptions of favorites, 180 report sections, 220 Business View Column Browser, 107 section processing, 223 Business view columns, 120 Batch run-time processing 

C available objects, 237 
Batch version 

overriding specifications, 214 Calculating percentages, 131 
Batch Version Calculation column 

Web client, 197 create, 129 
Web Only, 197 Calculation row variable 

Batch versions, 6, 197 override cell properties, 136 
access BrowsER, 215 Calculation rows, 131 
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add or remove, 33 adding, 133 
align within or across sections, 139 Cell 
calculation, 129 definition, 135 
Description column, 130 override a calculation row variable, 136 
percentage, 131 override a constant row variable, 137 
smart field, 128 override a data row variable, 136 
spacing, 142 override an underline row variable, 137 
tabular section, 127 properties 
width, 140 override, 135 

Column Data Selection form, 88 tabular section, 127 
Column header Changing a detail section's description, 138 

changing text, 124 Changing a field's length, 141 
Column Inclusion event, 167 Changing Batch Versions (P98305) processing 

options, 212 Column properties 
viewing, 102, 104 Changing column spacing, 142 

Columnar report Changing decimal scaling for a field, 126 
create with the Director, 40 Changing decimal scaling for all fields in a 

report, 127 definition, 40 
Columnar section Changing decimal scaling for all fields in a 

report section, 126 add or remove business view columns, 33 
business view columns Changing how numbers are displayed, 154 

add to the section, 120 Changing processing options for batch versions, 
202 characteristics, 7 

column sort order, 34 Changing row spacing for a columnar section, 
143 conditional display, 138 

data selection, 37 Changing row spacing for a tabular report with 
added rows, 143 deciding when to use, 8 

design capabilities, 7 Changing text justification for a report object, 
153 filtering data, 37 
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specific field, 333 Data selection and sequencing, 227 
Data sequencing 

439 



Defintion file structures, 364 changing, 262 
Deleting a paper type, 290 overriding, 261 
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changing sequence, 159 function parameters, 371 
functionality Financial Account Level of Detail Row 

Generation form, 135 adding and attaching text variables, 161 
Financial report 

441 
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Smart Field Data Selection, 87 barcode, 146, 153 
Smart Field Parameters, 86 changing properties, 143 
Smart Field Search_Select, 186 color, 151 
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hide/show, 105 INIT_level break footer, 231 
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Number of Non Optimized Inclusion Rows, 132 END_level-break header and footer, 231 
Number of Optimized Inclusion Rows, 132 INIT_level break footer, 231 
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data field, 122 Lifespan of objects in section level events, 314 
formatting, 153 Line printers 

designing reports to run on line printers, 294 O setting up a line printer, 295 
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object level events, 313 defining a default printer, 286 Page footer section level events, 235 deleting a paper type, 290 Page header deleting a printer, 290 characteristics, 13 deleting barcode support information for a 
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sample report, 331 Removing a column calculation, 130 
Printing lists of information grouped by a 

specific field 
Removing attachments/comments from a report, 

100 
sample report, 333 Report 

Printing multiple copies to a remote printer, 296 batch versions, 196 
Printing outstanding balance by company, 327 checking status, 267 
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PrintQueue directory submit, 256 
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add additional tab, 183 configure your design workspace, 105 
attach to a report, 184 create an application report, 81 
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independent (level-one) sections, 220 Report director template 
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Report time Properties tab, 189 
data field, 122 Report event rule variable 

Report title naming conventions, 23 
data field, 122 Report footer 

Report version, 6 characteristics, 13 
delete, 29 creating, 109, 110 
open, 30 illustration, 13 
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access BrowsER, 215 Report footer section 
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designing for line printers, 294 Report generation 
examples, 314 database output, 216 
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inventory management system, 342 illustration, 12 
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printing a work order, 323 object level events, 310 
printing journal entries by batch type, 315 section level events, 305 
product data management system, 343 Report header section level events, 235 
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Retrieving OSA documents, 371 Report output, 247 
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deciding when to use, 11 UBE log file 
Description column, 11, 34, 130 Tabular Optimization, 132 
design capabilities, 11 Underline row 
filtering data, 37 adding, 134 
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450 



451 

ZJDE, 22 
View a report, 99 
Viewing a column's properties using the column 
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